SONY SONY.

(22

§g .

1o J .

2 3 Mult1 Format

~ N .

=3 Switcher System
S = MVS-8000/8000SF System

& (With CCP-8000 Series Center Control Panel)
@

User’s Guide

Volume 1
User’s Guide 2nd Edition (Revised 2)
Volume 1
2nd Edition (Revised 2) 3-206-016-13 (1)

| English |




SONY.

MVS-8000/8000SF System

(With CCP-8000 Series Center Control Panel)

User’s Guide

Multi Format Switcher System

Volume 1
2nd Edition (Revised 2)
Software Version 8.00 and Later



NOTICE TO USERS

© 2001 Sony Corporation. All rights reserved. This
manual or the software described herein, in whole or in
part, may not be reproduced, translated or reduced to
any machine readable form without prior written approval
from Sony Corporation.

SONY CORPORATION PROVIDES NO WARRANTY
WITH REGARD TO THIS MANUAL, THE SOFTWARE
OR OTHER INFORMATION CONTAINED HEREIN AND
HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE WITH REGARD TO
THIS MANUAL, THE SOFTWARE OR SUCH OTHER
INFORMATION. IN NO EVENT SHALL SONY
CORPORATION BE LIABLE FOR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES,
WHETHER BASED ON TORT, CONTRACT, OR
OTHERWISE, ARISING OUT OF OR IN CONNECTION
WITH THIS MANUAL, THE SOFTWARE OR OTHER
INFORMATION CONTAINED HEREIN OR THE USE
THEREOF.

Sony Corporation reserves the right to make any
modification to this manual or the information contained
herein at any time without notice.

The software described herein may also be governed by
the terms of a separate user license agreement.



<Organization of This User’s Guide>
The User’s Guide for this system comprises Volumes 1 to 3.

Volume 1
This book. For the contents of this volume, see “Table of Contents” at the front.
Chapter I MVS-8000 Functions
Chapter 2 Menus and Control Panel
Chapter 3  Signal Selection and Transitions
Chapter 4 Keys
Chapter 5 Wipes
Chapter 6 DME Wipes
Chapter 7 Frame Memory
Chapter 8 Color Backgrounds, Copy and Swap, and Other Settings
Chapter 9 Color Corrector
Chapter 10 Special Functions
Appendix (Volume 1)
* Wipe Pattern List
* DME Wipe Pattern List
* Resizer DME Wipe Pattern List
* Menu Tree
Index

Volume 2
The volume comprises the following chapters.
Chapter 11 DME Operations
Chapter 12 External Devices
Chapter 13 Keyframe Effects
Chapter 14 Snapshots
Chapter 15 Utility/Shotbox
Chapter 16 Macros
Chapter 17 Files
Appendix (Volume 2)
* SpotLighting
* Functional Differences With Models of DME
* Macro File Editing Rules
* About the Macro Attachment List Display
* Menu Operations Not Recorded in a Menu Macro
Index

Volume 3

The volume comprises the following chapters.
Chapter 18 System Setup (System)

Chapter 19 Control Panel Setup (Panel)
Chapter 20 Switcher Setup (Switcher)
Chapter 21 DME Setup (DME)

Chapter 22 DCU Setup (DCU)



Chapter 23 Setup Relating to Router Interface and Tally (Router/Tally)
Chapter 24 Simple Connection of the MKS-8080/8082 AUX Bus Remote
Panel
Chapter 25 DIAGNOSIS
Appendix (Volume 3)
» Data Saved by [Setup Define] and [Initial Status Define]
* Error Messages
Index



Functions Newly Supported in Version 8.00

The functions newly supported in the MVS-8000 system version 8.00 are as
follows.

Functions relating to operability

Classification

Functions supported

Menu No.

See page

Vol.1 | Vol.2

Vol.3

Control panel
configuration

The CCP-6224 2M/E or CCP-6324
3MV/E control panel can be
incorporated into the conventional
control panel configuration, including
the Multifunction Flexi Pad control
block and the auxiliary bus-
compatible cross-point control block.

97 -

78,
86

Menu operations

A VGA monitor can be used for the
menu control block by using an USB
mouse.

121 |-

Router control

The source for each destination can
be switched with the Router Control
menu.

5111

440 |-

104
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Introduction

This manual is the User’s Guide for the MVS-8000/8000SF Multi Format
Switcher system. The MVS-8000 and MV S-8000SF have different numbers of
M/E banks and input/output signals, but are otherwise functionally identical.
This manual refers to these generically as the “MVS-8000 system,” and
describes principally the operation of the system using the CCP-8000 series of
center control panels.

The User's Guide for this system comprises three volumes.

For the contents of each volume, see the section “Organization of This User’s
Guide” at the front of this volume.

Devices and system nomenclature

Introduction

In this manual, when discussing the principal components of the MVS-8000
system, in place of the formal product names, abbreviated names
characterizing the functions and features are sometimes used. When
distinctions between system configurations must be drawn, the terms in the
following table are used.

Principal components and naming
The formal product names of the principal components of the MVS-8000
system, and the terms used in this manual are as follows.

Formal product name Term used in this manual

MVS-8000/8000SF/8000A/8000ASF/8000G/ | Switcher or switcher processor
8000GSF Multi Format Switcher Processor @

MVE-8000 (MKS-8800)/8000A Multi Format | DME or DME processor or MVE-8000/

DME Processor 8000A
MVE-9000 Multi Format DME Processor DME or DME processor or MVE-9000
CCP-8000-series, CCP-6224, CCP-6324 Control panel or center control panel

Center Control Panel

DCU-8000 (MKS-8700) Device Control Unit DCU or MKS-8700

DCU-2000 (MKS-2700) Device Control Unit DCU or MKS-2700

a) Where there are differences among the MVS-8000/8000SF system, MVS-8000A/8000ASF
system, and MVS-8000G/8000GSF system, these may be noted specifically in the relevant
place.

System nomenclature
The following terms are used for systems, depending on the combination of
installed options, and the signal format.



System configuration and features Term for system

System with installed option boards and HD system
settings to support HDTV format

System with installed option boards and SD system
settings to support SDTV format

A system in which the center control panel has | 4M/E system
four M/E banks

A system in which the center control panel has | 3M/E system
three M/E banks

A system in which the center control panel has | 2M/E system
two M/E banks

Related manuals

The following manuals are supplied with the individual products of the MV S-
8000 Multi Format Switcher system.

MVS-8400/8300/8200 Switcher Processor Pack
* MVS-8400/8300/8200 Operation Manual
e MVS-8400/8300/8200 Installation Manual

MVS-8000A-C/8000AS-C Switcher Processor Pack
¢ MVS-8000A-C/8000AS-C Operation Manual
¢ MVS-8000A-C/8000AS-C Installation Manual

MVS-8000G-C/8000GS-C Switcher Processor Pack
* MVS-8000G-C/8000GS-C Operation Manual
¢ MVS-8000G-C/8000GS-C Installation Manual

MYVS-8000SF-C Switcher Processor Pack
¢ MVS-8000SF-C Operation Manual
¢ MVS-8000SF-C Installation Manual

MVE-8000-C DME Processor Pack
* MVE-8000-C Operation Manual
¢ MVE-8000-C Installation Manual

MVE-8000A DME Processor Pack
¢ MVE-8000A Operation Manual
¢ MVE-8000A Installation Manual

MYVE-9000-C DME Processor Pack

* MVE-9000-C Operation Manual
* MVE-9000-C Installation Manual

Introduction
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Introduction

CCP-6000/8000 Center Control Panel Pack
* CCP-6000/8000 Operation Manual
¢ CCP-6000/8000 Installation Manual

DCU-8000 Device Control Unit Pack
* DCU-8000 Operation Manual
¢ DCU-8000 Installation Manual

DCU-2000 Device Control Unit Pack
* DCU-2000-C Operation Manual
¢ DCU-2000-C Installation Manual



Features of the MVS-8000 Multi Format
Switcher System

The MVS-8000 Multi Format Switcher system boasts extensible high
performance and multifunctionality. The following are some of the principal
features of this system.

System configuration flexibility

Multiformat support

This system supports both HDTV and SDTV signal formats. The format
selection can be switched by a simple control panel operation. The MVS-
8000G supports either the HDTV or SDTV signal format, depending on the
software option selection.

Extensible system configuration

By suitable combination of options, the switcher can be configured with
various inputs and outputs, and different numbers of M/E banks. The system
offers the flexibility to change and expand as required.

You can connect up to two MVE-8000/8000A or MVE-9000 extensible DME
processors, each of which provides any number from one to four channels, for
a maximum of eight channels of DME functionality.

Powerful external device interfaces

By connecting to a Sony routing switcher or similar, a large system can be
built. From the control panel, it is also possible to operate other equipment,
including VTRs and disk recorders.

Powerful tally system

The complete system including routing switcher provides an all-inclusive tally
system. The system can be adapted to different applications and settings, using
multiple tally outputs, including both on-air and recording tallies.

Comprehensive video manipulation

M/E banks

Each mix/effects bank (M/E bank) is equipped with four keyers, and each
keyer is capable not only of chroma keying, but also independent key
transitions separate from the background transitions. The four keys can be
freely combined, to carry out four different program outputs.

Features of the MVS-8000 Multi Format Switcher System
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Powerful frame memory functions

In an MVS-8000 system, an HDTV system can hold 58 still image frames (88
frames in 720P/59.94 format), and an SDTV system can store 222 frames in
memory, while up to eight frames can be recalled and used simultaneously.
In an MVS-8000A system and MVS-8000G system, an HDTV system can
hold approximately 1,000 still image frames or 2,000 frames in 720P/59.94
format, and an SDTV system can hold approximately 5,000 frames in 480i/
59.94 format or 4,000 frames in 576i/50 format in memory, and up to eight
frames can be recalled and used simultaneously.

Link operation with DME

By means of the dedicated DME interface, a range of DME functions including
DME wipes and processed keys can be handled as switcher functions.

By connecting two MVE-8000/8000A or MVE-9000 units, in any
combination, you can interface to a maximum of eight DME channels.

Designed for use in a live broadcasting environment

Flexible control panel layout

Because of its modular design, the various sections of the control panel can be
laid out as required. This allows a flexible layout appropriate to the system
operation.

High-performance user interface

The menu control block provides a large color LCD panel, with rapid touch-
panel menu selection.

The source name displays and buttons in the Flexi Pad™ and shotbox control
blocks have color backlit LCD displays. The signal names, and graphical
representations of the patterns associated with buttons provide intuitive
feedback, and allow the immediate decisions that are required in a live
operating environment.

Features of the MVS-8000 Multi Format Switcher System



Basic Video Processing

This section introduces basic functions used for video processing on the
switcher.

Transitions

In the M/E banks and PGM/PST bank, the switch from the current video stream
(appearing on the corresponding program monitor) to a new video stream is
referred to as a transition.

In the M/E banks and PGM/PST bank, you can change one of the images, the
background, and keys 1 to 4 (downstream keys 1 to 4 in the PGM/PST bank),
and also vary combinations of these simultaneously.

The following are examples of transition.

Changing the background

A background transition switches from the video currently selected on the
background A bus (the current video) to the video selected on the background
B bus (the new video).

Transition

.

Background A Background B

In the default selection of flip-flop mode (see page 173), the background
always switches in the direction from the A bus to the B bus. When the
transition completes, the cross-point selections on the A and B buses are
interchanged.

Basic Video Processing
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Inserting and deleting a key

You can insert one or more of the four keys (downstream keys on the PGM/
PST bank).

If you select a key which is already inserted, the transition will delete the key.
A simultaneous combination of deleting and inserting keys is also possible.

Key 2

Deleting key 1 and inserting key 2

Basic Video Processing



Simultaneously changing the background and keys

You can change any of the four keys (downstream keys on the PGM/PST bank)

and the background at the same time.

Key 1

Changing the background and key 2 simultaneously

Key 1

Key 2

Selecting the transition type determines the way in which the transition occurs.

Changing the background and keys 1 to 4 simultaneously

The following are the transition type.

Mix

NAM (non-additive mix)

Super mix

Preset color mix (color matte)

Wipe

DME wipe
Clip transition

Cut

Basic Video Processing
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There are two modes for carrying out a transition: auto transitions are carried
out by a button operation, and manual transitions are carried out using the fader
lever. It is also possible to combine these two modes.

Independent Key Transitions

In addition to common transitions, it is possible to carry out independent
transitions on the keyers of the M/E banks and PGM/PST bank. These are
called “independent key transitions.”

By carrying out an independent key transition in combination with a common
transition, different transition types can be used for the background and keys.
The following description compares the independent key transition with a
common transition, taking a simultaneous change of the background and key
as an example.

Video used in the transition

Background A Background B Key to insert

Effect of a common transition
In the case shown in the previous illustration, carrying out a common transition

produces the following change in the image.

Transition type: wipe Same wipe is applied to
background and key.

Effect of a common transition

Basic Video Processing




Effect of use with an independent key transition
The key is inserted with an independent key transition as the background
changes with a common transition, providing the following result.

Transition type:  Independent key Different wipe patterns are applied to
wipe transition type: the background and key transitions.
wipe

Effect of a background transition and independent key transition

For details of transitions, see Chapter 3 “Signal Selection and Transitions”
(page 131).

Keys

A key is an effect in which a part of the background image is replaced by an
image or superimposed text. The signal determining how the background is cut
out is termed “key source,” and the signal that replaces the cut-out part is
termed “key fill.” The system component responsible for processing a key is
referred to as a keyer.

Each switcher bank has four keyers, each providing the same functionality.

On each switcher bank, you can use the following key types (methods of
processing the key source).

e Luminance key

* Linear key

* Color vector key

* Chroma key

* Wipe pattern key

* Key wipe pattern key

Key modifiers
You can apply borders and other modifiers to the edge of the key image.

Basic Video Processing
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Masks

Resizer

A mask allows a part of the image to be replaced by the background or a key.
To prevent unwanted holes in the background, or if a key is not the desired
shape, you can correct this with a mask.

This function allows you to apply effects, similar to a DME, such as zoom,

movement, or aspect ratio change to a part of a created key. You can use the

following operations.

* Two-dimensional transform of a key

* Resizer interpolation settings

* Resizer crop/border settings

* Resizer effect settings (wide key border, drop shadow, edge enhancement,
mosaic, defocus, mask)

For details, see Chapter 4 “Keys” (page 195).

Wipes

A wipe is a transition from the current video stream to a new video stream,
using a wipe pattern.

Changing the background by means of a wipe is referred to as a “background
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition,
and those that can be selected in an independent key transition.

The patterns that can be used for a wipe are as follows.
 Standard wipe patterns

* Enhanced wipes

* Rotary wipes

* Mosaic wipe pattern

¢ Random and diamond dust wipe patterns

You can combine two selected patterns (referred to as main and “sub”) to
create a new pattern (pattern mix).

You can also specify the wipe direction, or set the pattern position, applying
various changes and modifiers to the selected wipe pattern.

For details, see Chapter 5 “Wipes” (page 275).

Basic Video Processing



DME Wipes

A DME wipe is a wipe transition that uses a DME effect to change from one
video image to the next.

There are two types of DME wipe: those which can be selected for a normal
transition, and those which can be selected for an independent key transition.

The patterns that can be used for a DME wipe are as follows.
Slide, Squeeze, Split, Door, Flip tumble, Mirror, Sphere, Character trail,
Wave, Ripple, Page turn, Page roll, Frame in-out, Picture-in-picture, 2D
trans, 3D trans, Sparkle, Split slide, Mosaic, Defocus, Brick, and User
programmable DME

You can also specify the wipe direction, or set the pattern position, applying
various changes and modifiers to the selected DME wipe pattern.

Resizer DME wipes

Using the resizer, you can carry out key DME wipes.

For details, see Chapter 6 “DME Wipes” (page 321 ).

Frame Memory

Frame memory is a function for using a still image or video (frame memory
clip) as material for editing.

You can create a still image by capturing a frame of input video or a clip by
specifying a range of input video. The created images and clips can be written
to memory for playback, editing, and output.

For details, see Chapter 7 “Frame Memory” (page 363).

Color Backgrounds

This function can be used to obtain color background video.
Two color signals generated from the dedicated generators can be switched or
mixed, and then output.

For details, see “Color Background” (page 422).

Basic Video Processing 27
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Copy and Swap

This function can be used to copy and swap the settings among the M/E-1 to
M/E-3, and PGM/PST banks or between keyers.

The following settings can be copied or swapped.

Overall settings for the M/E and PGM/PST banks

Keyer settings

Wipe settings in a transition control block

Wipe settings in an independent key transition control block
DME wipe settings in a transition control block

DME wipe settings in an independent key transition control block
Matte data (color 1, color 2, and how to compose them)

Color settings

DME channel settings

Format converter input settings (copy only)

Format converter output settings (copy only)

For details, see “Copy and Swap” (page 426).

Video Process

The term “video process” is applied to adjustments to the gain, hue, black level
of the input video signal. There are two types of adjustment; adjustment of an
individual primary input signal and adjustment as image effects on a particular
bus

For details, see “Video Process” (page 442).

Color Corrector

The color corrector enables video signal color correction (black balance/white
balance adjustment, gamma correction, knee correction, etc.).
The color corrector includes the following adjustments.

Input video processing

Primary color correction

Secondary color correction

RGB clip

Luminance processing

Spot color adjustment

Output video processing

YUV clip

For details, see Chapter 9 “Color Corrector” (page 445).

28 | Basic Video Processing



Side Flags

The term “side flags” refers to the areas to left and right of an image with aspect
ratio 4:3 embedded within a 16:9 frame, when these areas are filled with a
separate image selected from the utility 1 bus.

Image to fill the side flag Input source with aspect ratio

areas (selected from utility 1
bus)

Turn the side flag
function on

Side flag area Side flag area

For details, see “Side Flags” (page 468).

Multi Program 2

By operating the switcher in Multi Program 2 mode, a single switcher mix/
effects bank can be used to create two separate video outputs, referred to as
“main” and “sub.” You can set backgrounds, keys, and transitions for each of
main and sub. Keys 2 to 4, however, are common to main and sub.

For example, immediately after a score in baseball two versions of the scene
can be provided as shown below, and switched simultaneously.

Basic Video Processing
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Key3 Background A

(signal from utility 2 bus)

S

Background A

TEAM A

I
Key 1 Background B
(signal from utility 3 bus)

Background B

Program output for “Main” Program output for “Sub”

For details, see “Multi Program 2” (page 473).

Simple P/P Software

By installing the BZS-8250 Simple P/P Software in the MVS-8000A/
8000ASF/8000G/8000GSF Switcher Processor, you can use a separate
program/preset function without using the M/E hardware.

For details, see “Simple P/P Software” (page 488).

Dual Link Support

By installing the BZS-8560 switcher upgrade software in the MVS-8000G, or
the BZDM-8560 DME upgrade software in the MVE-8000A, you can switch
the signal format to 1080P/59.94 or 1080P/50. In this case, signal input/output
uses a dual link.

For details, see “Dual Link Support” (page 492).

Basic Video Processing



Creation of Special Effects and
Management of Data and Operations

This section introduces functions used for creation of special effects, control of
external devices or switcher operations, and data management.

Digital Multi Effects (DME)

When used with the switcher, DME allows you to add three-dimensional
effects such as image movement, rotation, magnification and shrinking, as well
as a wide variety of special effects.

Each channel can be used on its own or in combination with other channels,
which allows you to create advanced effects with more complexity.

The following types of DME special effects are available.

Edge effects: Border, Crop, Beveled Edge, Key Border, Art Edge, Flex
Shadow

Effects for entire image: Defocus, Blur, Multi Move

Effects for video image: Sepia, Mono, Posterization, Solarization, Nega,
Contrast, Mosaic, Mask, Sketch, Metal, Dim and Fade, Glow

Freeze effects

Nonlinear effects: Wave, Mosaic Glass, Flag, Twist, Ripple, Rings, Broken
Glass, Flying Bar, Blind, Split, Split Slide, Mirror, Multi Mirror,
Kaleidoscope, Lens, Circle, Panorama, Page Turn, Roll, Cylinder, Sphere,
Explosion, Swirl, Melt, Character Trail

Lighting effects: Lighting, Spotlighting

Recursive effects: Trail, Motion Decay, Keyframe Strobe

Background color

Separate Sides (effects for front and back sides)

Signal inversion (Invert effect)

Key density adjustment

Key source selection

Global effects
Global effects are special effects created by combining the images of
successive channels. The following types of global effects are available.

Combiner
Brick
Shadow

For details, see Chapter 11 “DME” (Volume 2).

Creation of Special Effects and Management of Data and Operations
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External Devices

In this system, you can operate while controlling the following types of
external device:

 Devices supporting P-Bus (Peripheral II protocol)

 Devices supporting GPI

* VIRs
* Disk recorder (Sony disk 9-pin protocol and video disk communications

protocol)
* Extended VTR (Abekas A53 protocol)

For details on the devices that can be connected, consult your Sony
representative.
You can control an external device by previously registering timeline

keyframes.

For details, see Chapter 12 “External Devices” (Volume 2).

Keyframes

A keyframe represents an instantaneous state of an image; it can be saved in a
register (see “Registers” in Chapter 13 (Volume 2)) and recalled for reuse.
By arranging a number of keyframes on the time axis, and interpolating
between successive keyframes, you can create an effect in which there is a
continuous change from each keyframe to the next.

Creation of Special Effects and Management of Data and Operations



The following figure shows three keyframes created with a wipe pattern (the
circle) in different positions. This is interpolated to create the effect shown.

[] Background A " Interpolated images
@ Background B

Keyframe 1 Keyframe 2 Keyframe 3

Effect execution

Example of keyframes and effect execution

You can save the sequence of keyframes representing a single effect in a
register. Then by recalling this register, you can replay the same effect.

For details, see Chapter 13 “Keyframe Effects” (Volume 2).

Snapshots

The term “snapshot” refers to a function whereby the various settings required
to apply a particular effect to an image are saved in a register as a set of data,
for recall as required, to recover the original state.

Snapshots are divided as follows.

* Snapshots applying to a particular region (functional block of the switcher or
DME)

* Master snapshot

» Key snapshot

* Wipe snapshot

* DME wipe snapshot:

An individual snapshot may also have attached special conditions relating to
switcher or DME operation when the snapshot is recalled.

Creation of Special Effects and Management of Data and Operations

suoiound 0008-SAN | Jexdeyd



suonoung 0008-SAIN | 4eideyd

These conditions are called “attributes” of the snapshot, and can be added when
the snapshot is saved or recalled.

For details, see Chapter 14 “Snapshots” (Volume 2).

Utility

The utility function refers to a function whereby you can assign an arbitrary
action or a shortcut for frequently used menu to a particular button, then
instantly recall the action or menu by pressing the button.

For details, see “Utility Execution” in Chapter 15 (Volume 2).

Shotbox

The term “shotbox” refers to a function whereby for each specified region (see
“Regions” in Chapter 13 (Volume 2)) any snapshot or keyframe effect can be
recalled simultaneously.

For details, see “Shotbox” in Chapter 15 (Volume 2).

Macros

The term “macro” refers to the function whereby a sequence of signal
selections and other operations on the control panel is saved as data in memory,
so that it can be recalled as required to automatically execute the same
sequence of operations.

The individual control panel operations constituting a macro are termed
“events.

Macros also provide the following functions.

Menu macros

The term “menu macro” refers to the function whereby a sequence of menu
operations is saved as data in memory, so that it can be recalled as required to
automatically execute the same sequence of operations.

Macro timeline
By recording macro recall and execute action on a timeline, in the same way as
for keyframes in an effect, you can automatically execute them in a sequence.

Creation of Special Effects and Management of Data and Operations



Macro attachment

Macro attachment is a function whereby a macro register is assigned to a
control panel button or a particular position of a fader lever, linking the
execution of the button function or a fader lever operation with a macro
execution.

For details, see Chapter 16 “Macros” (Volume 2).

Files

You can save register data, including setup information and snapshot
information, as a file on a hard disk or memory card, and recall it as required.
You can operate on individual files or registers, or together in a batch.
Regarding frame memory, it is possible to capture image data stored in an
external device into frame memory. You can also convert the format of image

data in frame memory into a different format and save it in an external device.

The following files can be saved and recalled.
* Operation mode setup data for system as a whole and individual devices
 Device status data for system startup

* Key memory setting data

* Video process memory setting data

» Keyframe effect setting data

* Snapshot setting data

* Wipe snapshot setting data

* DME wipe snapshot setting data

» Key snapshot setting data

» Shotbox setting data

* Macro setting data

* Macro attachment data

* Menu macro setting data

¢ Frame memory image data

For details, see Chapter 17 “Files” (Volume 2).

Creation of Special Effects and Management of Data and Operations
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Setup

Various settings are required, in order to operate the switcher, control panel,
DME, external devices, and so on, connected together in a single system.
This is referred to as “setup,” and you can carry out the setup operations from
the Engineering Setup menu.

The settings in the Engineering Setup menu are grouped under the following
headings.

* System setup (System)
For details, see Chapter 18 “System Setup” (Volume 3).

* Panel setup (Panel)
For details, see Chapter 19 “Control Panel Setup (Panel)” (Volume 3).

* Switcher setup (Switcher)
For details, see Chapter 20 “Switcher Setup (Switcher)” (Volume 3).

* DME setup (DME)
For details, see Chapter 21 “DME Setup (DME)” (Volume 3).

* DCU setup (DCU)
For details, see Chapter 22 “DCU Setup (DCU)” (Volume 3).

* Router/tally setup (Router/Tally)

For details, see Chapter 23 “Setup Relating to Router Interface and Tally
(Router/Tally)” (Volume 3).
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Names and Functions of Parts of the
Control Panel

Control Panel: Example Configuration 1
(With Standard Transition Modules)

The MVS-8000 system control panel
comprises a number of modules.

The following illustration shows a typical
32-button, 4-M/E configuration, with
standard transition modules used in the
transition control block.
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Auxiliary bus control block (page 75)

oooog
00000000000000000000000000000000 B0000
O b= O

M/E-1 bank —]
M/E-2 bank
M/E-3 bank _| 50000000000000800000000000000000 888

\(

PGM/PST (program/ _ |
preset) bank

Cross-point control block (page 45)

Control panel configuration 1 (left side)
(with standard transition modules)
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Keyframe control block (page 69)
Menu control block (page 79)

Key control block (page 56)

Device control block (page 60/page 64)

Memory card/USB adaptor block (page 80)
° “Memory Stick”/USB connections block (page 81)
g Utility/Shotbox control
P block (page 83)
o
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Transition control block Downstream key control block (page 90)

(standard type) (page 49)

Numeric keypad control block (page 72)

Fade to black control block (page 74)

Flexi Pad control block (standard type) (page 54)

Control panel configuration 1 (right side)
(with standard transition modules)
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Control Panel: Example Configuration 2
(With Simple Transition Modules)

The following illustration shows a typical Except for the simple modules, this is the
configuration, with simple transition same configuration as in example
modules used in the transition control configuration 1.

block.
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00000

Control panel configuration 2 (left side)
(with simple transition modules)
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Transition control block and Flexi Pad control
block (simple type) (page 84)

Independent key transition control block
(simple type) (page 88)
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Control panel configuration 2 (right side)
(with simple transition modules)
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Control Panel: Example Configuration 3
(With Compact Transition Modules)

The following illustration shows a typical

configuration, with compact transition

modules used in the transition control
block.

Transition control block (compact type) (page 94)

S — |
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Control panel configuration 3
(with compact transition modules)
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Cross-Point Control Block

In the cross-point control block, you can
select the signals to be used in this M/E
bank or PGM/PST bank.

There are also modules without the source
name displays shown in the following
figure.

All operations except those of the [SHIFT]
button are the same as for a module with
source name displays.

Key 2 row

Key 1 row

© Cross-point buttons

Reentry buttons
© M/E bank display

T Key bus selection buttons

Background B row

Background A row

@ Source name displays

© Macro buttons

O UTIL button

@® XPT HOLD buttons

Reentry buttons

O SHIFT button

© Cross-point buttons

These buttons select the signals used for
video creation on this M/E bank or PGM/
PST bank. Each row of buttons corresponds

to one or more signal buses within the

switcher.

Key 1 row: The buttons in this row select
the key 1 or key 3 signals to be inserted

Names and Functions of Parts of the Control Panel
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into the video on this M/E bank or
PGM/PST bank.

To select the key 1 fill signal, check
that the right-hand [KEY3] button in
the M/E bank (or the [DSK3] button in
the PGM/PST bank) is off, then press
the button assigned to the desired
signal. To select the key 3 fill signal,
press the [KEY3] button, turning it on.
While the [UTIL] button on the right
hand side is held down, these buttons
are assigned to the DME external video
bus allowing you to select the signal on
that bus.

Key 2 row: The buttons in this row select
the key 2 or key 4 signals to be inserted
into the video on this M/E bank or
PGM/PST bank.

To select the key 2 fill signal, check
that the right-hand [KEY4] button in
the M/E bank (or the [DSK4] button in
the PGM/PST bank) is off, then press
the button assigned to the desired
signal. To select the key 4 fill signal,
press the [KEY4] button, turning it on.
While the [UTIL] button on the right
hand side is held down, these buttons
are assigned to the DME utility 1 or 2
bus as follows.
¢ When the [KEY 4] button is off:
DME utility 1 bus
* When the [KEY 4] button is on:
DME utility 2 bus

Background A row: Press the desired
button to select the signal as the current
background video on this M/E bank or
PGM/PST bank.

While the [UTIL] button on the right
hand side is held down in Hold mode,
these buttons are assigned to the utility
1 bus, and can be used to select the
signal on that bus.

Background B row: Press the desired
button to select the signal as the
background video after the transition
on this M/E bank or PGM/PST bank.

Names and Functions of Parts of the Control Panel

While the [UTIL] button on the right
hand side is held down in Hold mode,
these buttons are assigned to the utility
2 bus, and can be used to select the
signal on that bus.

Reentry buttons: These allow you to select
the video created on another bank as
background A or B or one of the keys 1
to 4. For example, to use the video
created on the M/E-1 bank as
background B on the M/E-2 bank, press
the reentry button [M/E 1] in the
background B row of buttons on the M/
E-2 bank.

Cross-point button numbers
Cross-point button and reentry buttons are
respectively numbered.

For details, see “Cross-point button
control block button numbers” (page 140).

Assigning signals to button
You can assign a signal to each button using
the Setup menu.

For details on the operation, see “Cross-
Point Settings (Xpt Assign Menu)” in
Chapter 19 (Volume 3).

Visual indications on cross-point buttons

For details on the operation, see “Colors of
lit cross-point buttons” (page 144).

@ XPT (cross-point) HOLD buttons
Turning one of these buttons on enables
you to recall a keyframe or snapshot while
keeping the current cross-point selection
unchanged.

Function of this button varies depending on
the operation mode selected in the Setup
menu.

For details, see “Selecting the Bank to
Make the Settings” in Chapter 20 (Volume
3).



©® Key bus selection buttons

KEY3 button: Press this button, turning it
on, to assign the key 1 cross-point
buttons to the key 3 fill bus.

KEY4 button: Press this button, turning it
on, to assign the key 2 cross-point
buttons to the key 4 fill bus.

Pressing one of the key delegation buttons

[KEY1] to [KEY4] in the transition control

block (standard type) twice in rapid

succession changes the state of the
corresponding one of these buttons, so that
you can make cross-point selections on the

key bus (see page 52).

O UTIL (utility) button

While this button is held down, the cross-

point buttons are assigned to the following

buses, respectively.

Background A row: utility 1 bus

Background B row: utility 2 bus

Key 1 row: DME external video bus

Key 2 row: DME utility 1 bus when the

[KEY4] button is off, or DME utility 2
bus when the [KEY4] button is lit.

In a Setup menu, you can select either of the

following two modes for these buttons.

» The button takes effect while being held
down.

» Every time the button is pressed, it
toggles between the on and off states for
key 1 and key 2 rows. For background A
and background B rows, utility buses
remain disabled.

© Source name displays

These show the names of the signals which
can be selected on the cross-point buttons,
in two or four characters, or in auto mode.
While the [SHIFT] button on the right hand
side or the [SHIFT] button assigned to the
column of cross-point buttons is enabled,
the source name of the signal assigned to
the column of cross-point buttons in shift
mode appears. You can select green,
orange, or yellow for the background color

of the source name display, for each source
separately. You can set the source name
display mode and background color in a
Setup menu.

© SHIFT button

When this button is enabled, either the
source name displays show the shifted
signal names, or the shifted signals for all
buses in this M/E (P/P) bank are enabled.
You can select either mode in a Setup
menu.

Each press of the button toggles between
the enabled and disabled states.

In the case of a module without source
name displays, when “Display” is selected
in the Setup menu, this button is invalid.

©@ MJE bank display

This indicates the notional mix/effect bank
name to which the particular M/E or PGM/
PST bank is assigned, as a four-character
identifier.

© Macro buttons

PRE MCRO (pre macro) button: Use this
button to set a macro attachment in pre
macro mode. For setting in macro only
mode, use this in combination with a
macro only set button assigned to the
utility/shotbox control block or a user
preference button. Alternatively,
without using the button, you can make
the selection simply, by pressing
simultaneously with the [PRE MCRO]
button.
Function of this button varies as
follows depending on the operation
mode selected in the Setup menu.
» Switching dual background bus

mode

» Switching utility/shotbox mode

Names and Functions of Parts of the Control Panel
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* Disabling cross-point button
operations

For details, see “Setting the
Assignment of Macro Operation
Buttons” in Chapter 19 (Volume 3).

POST MCRO (post macro) button: Use
this button to set a macro attachment in
post macro mode. For setting in macro
only mode, use this in combination
with a macro only set button assigned
to the utility/shotbox control block or a
user preference button. Alternatively,
without using the button, you can make
the selection simply, by pressing
simultaneously with the [PRE MCRO]
button.

This button is disabled when some
operation modes are selected in the
Setup menu.

For details, see “Setting the
Assignment of Macro Operation
Buttons” in Chapter 19 (Volume 3).

MCRO ATTCH ENBL (macro
attachment enable) button: When
this button is on, the macro attachments
set for the buttons of the M/E bank are
enabled.
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Transition Control Block (Standard Type)

In the transition control block, you can common transition and independent key
modify the output of the M/E bank or PGM/ transition operations are possible.
PST bank, and perform transitions. Both

© PRIOR SET button

© Next transition selection buttons

O Key status display

@ Transition type selection buttons

@ Key snapshot setting buttons N
@ Key delegation buttons

® Key source name display/key
snapshot buttons

J
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@® Independent key transition
execution section

@ Independent key transition type
selection buttons

© KF button

@ Pattern limit buttons

© TRANS PVW button

©® Transition execution section

® Wipe direction selection buttons
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© Next transition selection buttons

Press these buttons, turning them on, to

determine what the next transition will

apply to.

BKGD: Next transition changes the
background.

KEY1 to KEY4 (DSK1 to DSK4 in the
PGM/PST bank): Press this button,
turning it on, to make the next
transition insert or remove the
corresponding key (keys 1 to 4). If a
key is currently inserted it will be
removed, and vice versa.

In the PGM/PST bank, this inserts or
removes downstream keys 1 to 4.

KEY PRIOR (priority): When this button
is lit, the setting of the key priority after
the next transition is enabled. The key
priority after the next transition appears
in the key status display.

ALL: Pressing this button turns on a
preselected set of the [BKGD], [KEY1]
to [KEY4], and [KEY PRIOR] buttons.
Make this setting in a Setup menu.

@ Transition type selection buttons

You can assign these buttons in setup to any

transition type (see “Overall Control Panel

Settings (Config Menu)” in Chapter 19

(Volume 3)).

Press one of these buttons, turning it on, to

determine the type of the next transition.

When multi-program mode is selected in

the Setup menu (see “Settings for Switcher

Configuration (Config Menu)” in Chapter

20 (Volume 3)), two or more of the

following buttons may light.

You can also assign a function to these

buttons to select whether or not the fader

levers are used as keyframe faders.

MIX: In a background transition, the new
video fades in as the current video
fades out. During the transition, the
overall signal level is maintained at
100%.

Names and Functions of Parts of the Control Panel

In a key transition, the key fades in (for
insertion) or out (for removal).

NAM (non-additive mix): The current and
new video signals are compared, and
the signal with the higher luminance
level is given priority in the output.
The current video is maintained at
100% output for the first half of the
transition as the new video increases
progressively to 100%, then the current
video is progressively reduced from
100% to zero in the second half while
the new video is maintained at 100%.

SUPER MIX: The current video is
maintained at 100% output for the first
half of the transition as the new video is
mixed while increasing progressively
to 100%. The current video is then
progressively reduced from 100% to
zero in the second half while the new
video is maintained at 100%.

PST (preset) COLOR MIX: In the first
transition, the current video is replaced
by the color matte in a mix (dissolve),
then in the second transition the color
matte is replaced by the new video also
in a mix (dissolve).

In place of a color matte, you can select
any signal on the utility 2 bus.

WIPE: The current video is replaced by the
new video, using the wipe pattern
selected in the Wipe menu.

DME: A wipe type of transition is carried
out, using the DME effect selected in
the DME Wipe menu.

FM1&2CLIP, FM3&4CLIP,
FM5&6CLIP, FM7&8CLIP: A
recorded clip is played back together
with the transition. At this point, you
can also carry out a transition (wipe or
mix (dissolve)) simultaneously
together with the clip.

KF (keyframe): Press this button, turning
it on, to enable using the fader lever as
a keyframe fader.



© Transition execution section

Transition indicator: This comprises
multiple LEDs, which show the
progress of the transition.

Fader lever: Move up or down to carry out
the transition. When the [KF] button or
a transition type selection button to
which the KF button function has been
assigned is lit, you can use this as a
keyframe fader.

Transition rate display: This shows the
“transition rate” (the time from the
beginning of a transition to its
completion) set for an auto transition,
in frames.

You can set the transition rate using the
numeric keypad control block, Flexi
Pad control block, or menu.

AUTO TRANS (transition) button:
Pressing this button carries out an auto
transition of the set transition rate
(duration). The transition starts
immediately, and the button lights
amber. When the transition completes,
the button goes off.

CUT button: Pressing this button carries
out the transition as a cut (i.e.
instantaneously).

O Wipe direction selection buttons
When you have selected a wipe or DME
wipe as the transition type, press one of
these buttons, turning it on, to select the
wipe direction.

NORM (normal): The wipe proceeds in
the direction from black to white as
shown on the pattern in the lists of
patterns see “Wipe Pattern List” (page
497) and “DME Wipe Pattern List”
(page 503), or in the direction of the
arrow.

When the VTR/disk recorder/frame
memory operation mode is enabled in
setup, pressing this button plays the
tape.

REYV (reverse): The wipe proceeds in the
opposite direction to that when the
[NORM] button is pressed.

When the VTR/disk recorder/frame
memory operation mode is enabled in
setup, pressing this button cues the tape
automatically to the start point.

NORM/REY (normal/reverse): The wipe
direction alternates between normal
and reverse every time a transition is
executed.

When the VTR/disk recorder/frame
memory operation mode is enabled in
setup, pressing this button stops the
tape.

© TRANS PVW (transition preview)
button

When this button is lit, you can check in

advance the video changes during the

transition, on the preview output from the

M/E or PGM/PST bank.

During the preview, you can use the fader

lever, [AUTO TRANS] button, and [CUT]

button. One of the following functions of

this button can be selected in a Setup mode.

* When the transition completes, the
system returns to the normal mode.

* The transition preview mode is
maintained while this button is pressed.

» Switching is made between the transition
preview mode and normal mode every
time this button is pressed.

@ Pattern limit buttons

PTN (pattern) LIMIT: Pressing this
button, turning it on, enables the
pattern limit function.
When the VTR/disk recorder/frame
memory operation mode is enabled in
setup, pressing this button plays the
tape.

LIMIT SET: Use this button to set a
pattern limit when the [PTN LIMIT]
button is off.
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Move the fader lever to the position of
a particular pattern size, and stop it
there, then press this button to set the
pattern limit range.

When the VTR/disk recorder/frame
memory operation mode is enabled in
setup, pressing this button stops the
tape.

© KF (keyframe) button

When the VTR/disk recorder/frame
memory operation mode is enabled in
setup, pressing this button cues the tape
automatically to the start point. When not,
pressing this button to turn it on allows you
to use the fader lever as a keyframe fader.

O Key status display

For each of keys 1 to 4, the corresponding
ON indicator lights when the key is
inserted. It also shows the priority (1 to 4)
of each key.

© PRIOR (priority) SET button

While this button is held down, you can set

the key priority.

The setting mode when this button is

pressed depends on whether or not the

[KEY PRIOR] button is lit, as follows.

¢ When the [KEY PRIOR] button is off, the
current key priority is set.

¢ When the [KEY PRIOR] button is lit, the
key priority after the next transition is set.

Press the [KEY PRIOR] button as required,

to switch between these two modes.

In either mode, hold down the [PRIOR

SET] button, and press the button ([KEY1]

to [KEY4]) corresponding to the key you

want to bring to the front.

The following controls are used as the
independent key transition control block.

@ Key delegation buttons

These buttons delegate this independent
key transition control block to a desired

Names and Functions of Parts of the Control Panel

keyer. Press one of the [KEY1] to [KEY4]
buttons ([DSK1] to [DSK4] in the PGM/
PST bank), turning it on.

You can press more than one button to
select two or more keyers.

While these buttons are held down, you can
select a key source with the cross-point
buttons for the key bus.

Pressing one of these buttons twice in rapid
succession changes its state so that you can
make cross-point selections on the
corresponding key bus.

Key delegation button Corresponding
(double press) key bus

[KEY1] key 12)

[KEY2] key 2 P)

[KEY3] key 39

[KEY4] key 49

a) The key bus selection button [KEY3] in the cross-
point control block goes off.

b) The key bus selection button [KEY4] in the cross-
point control block goes off.

¢) The key bus selection button [KEY3] in the cross-
point control block lights.

d) The key bus selection button [KEY4] in the cross-
point control block lights.

@ Independent key transition type
selection buttons

Press one of the following buttons, turning

it on, to select the independent key

transition type.

MIX: Faded in or out.

WIPE: Inserted or deleted with a wipe.

DME (DME wipe): Inserted or deleted
with a DME wipe.

@ Independent key transition
execution section

KEY1 ON to KEY4 ON (DSK1 ON to
DSK4 ON in the PGM/PST bank)
buttons: Press the corresponding one
of these buttons to cut key 1 to key 4 in
or out instantaneously. When the key



corresponding to the button appears in
the final program output, the button
lights red, and otherwise lights amber.

AUTO TRANS (transition) buttons:
These correspond to keys 1 to 4 from
left to right; press one to carry out an
auto transition. The transition rate for
an independent key transition can be
set in the numeric keypad control
block, in the Flexi Pad control block, or
in a menu.

@® Key source name display/key
snapshot buttons

These display the source name selected on

the corresponding keyer. In key snapshot

mode, press these buttons, corresponding to

registers 1 to 4 for the selected keyer, to

save or recall a key snapshot.

@ Key snapshot setting buttons

K-SS (key snapshot): This enables key
snapshot mode.

K-SS STORE (key snapshot store): To
save a key snapshot, hold down this
button, and press the key source name
display/key snapshot button
corresponding to the register you want
to save.

K-MOD ENBL (key modifier enable): To
recall key adjustment values and key
modifier settings when recalling a key
snapshot, press this button, turning it
on.

K-TR ENBL (key transition enable): To
recall independent key transition
settings when recalling a key snapshot,
press this button, turning it on.
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Flexi Pad Control Block (Standard Type)

The Flexi Pad control block is used for effects, and shotbox content, and for
saving and recalling wipe snapshots, DME entering the transition rate.
wipe snapshots, and snapshots, for recalling

© Mode selection buttons

© XPT HOLD status display

O Numeric display
© UNDO button

RANS
RATE
lIIIII

B

IIEIIII

AUTO

TRAN B/
N/

)| L))

@ Bank selection buttons

©® Memory recall section

@ Mode selection buttons SNAPSHOT: To save or recall a snapshot,
WIPE: To save or recall a wipe snapshot, use this in combination with the
or recall the pattern number of a wipe buttons of the memory recall section.
pattern, use this in combination with EFF (effect): To recall the master timeline
the buttons of the memory recall or run an effect, use this in combination
section. with the buttons in the memory recall
DME: To save or recall a DME wipe section.
snapshot, or recall the pattern number SHOTBOX: To recall or execute a
of a DME wipe pattern, use this in shotbox, use this in combination with
combination with the buttons of the the buttons of the memory recall
memory recall section. section.
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MCRO (macro): To save, recall or edit a
macro, use this in combination with the
buttons of the memory recall section.

TRANS RATE (transition rate): To enter
the transition rate, press this button,
turning it on. To enter the independent
key transition rate, hold down this
button, and press the key delegation
button in the independent key
transition control block. To select
whether the value is entered in frames
or as a timecode value, switch the [TC]
button in the memory recall section on
or off.

@ Bank selection buttons

BANKO (bank 0): Assigns the memory
recall section to bank 0, of registers 1 to
10.

BANKT1 (bank 1): Assigns the memory
recall section to bank 1, of registers 11
to 20.

BANK SEL (bank selection): After
pressing this button, press a button in
the memory recall section to select
banks 0 to 9.

© Memory recall section

This consists of 12 buttons with LCDs.
These display changes, according to
various operation modes.

O UNDO button

UNDO: After recalling a register, press this
button to return to the state before
recalling the register.

When contents have been saved to a
register, hold down the [STORE
STATS] button and press this button to
return the register to its state before the
save operation.

STORE STATS (store status): When a
save or delete operation has been
carried out on a register, this button
lights amber. After saving to a register,
hold down this button and press the

relevant register button to delete the
data in the register. Again, after a save
operation on a register, hold down this
button and press the [UNDO] button to
restore the register to its state before the
save operation.

© XPTHOLD (cross-point hold) status
display

A bus for which cross-point hold is set

appears as a green light.

O Numeric display

Depending on the operation mode, this
shows the pattern number of a wipe or
DME wipe, a bank number, a register
number, a transition rate, and so on in up to
four digits.
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Key Control Block

Each of the M/E banks and the PGM/PST any desired keyer. In this control block, you
bank includes four keyers (for keys 1 to 4), can adjust and modify keys.
and you can delegate this control block to

© Key fill’/key source selection buttons

@ Key type selection buttons

@ Delegation buttons @ ON AIR indicators
® RESIZER button @ Displays
© DME channel © Knobs

selection buttons

gooo

gooo

goooo

O O O Of

oooo
SHOW KEY button L AUTO DELEG button
O Key modifier buttons ® Output destination specification
buttons

@® TRACE button

® OVERRIDE button

© MORE button

@ Delegation buttons MV/E delegation: Press one of the [M/E 1]

Key delegation: Press one of the [KEY 1] to [M/E 3], and [P/P] buttons to select
to [KEY4] buttons to delegate the key the bank (an M/E bank or the PGM/
control block to the corresponding PST bank) to which the key control
keyer. block is delegated.
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TRANS: By pressing this button, you can
check the DME channel used for DME
wipes on the M/E or PGM/PST bank.
Also, by pressing this button, then
pressing one of the DME channel
selection buttons, you can preset the
DME channel to be used when a DME
wipe is selected as the transition type
for the transition.

When presetting the DME channel for
an independent key transition, hold
down this button, then press one of the
[KEY 1] to [KEY4] buttons, turning the
two buttons on, beforehand.

@ Key type selection buttons

Press one of these buttons, turning it on, to
select the desired key type.

Depending on the selected key type,
various parameters are displayed, and you
can set the values with the knobs.

The following key types can be selected.
LUM: luminance key

LIN: linear key

CRK: chroma key

CVK: color vector key

PTN: key wipe pattern key

For details, see “Key Types” (page 197).

© Key fill/key source selection buttons

AUTO SEL (selection): Use the signal
selected on the key fill bus, and the
paired key source signal. The setting of
key fill and key source pairs is carried
out in a Setup menu.

SPLIT: To use the signal selected on the
key fill bus as key fill, and a signal
separate from the signal assigned in a
pair with key fill for key source, press
this button, turning it on.

To select the signal on the key source
bus, hold down this button, and press a
button in the key 1 or key 2 row in the
cross-point control block.

To use the signal selected on the key fill bus

as key source (self keying), press the

[AUTO SEL] button and [SPLIT] button at

the same time, so that both are off.

MATTE FILL: To use a color matte from
the internal generator as key fill, press
this button, turning it on. You can
adjust the color matte using the knobs.
When this button is off, the signal
selected on the key fill bus is used as
key fill.

O Key modifier buttons

To add an edge modifier to the key, press

one of these buttons, turning it on.

Depending on the edge type selected,

parameters appear in the displays, and you

can set the values with the knobs.

KEY DROP: When drop border or shadow
is selected, turning this button on
lowers the key fill and key source
position by four or eight scan lines as
set in the key menu.

To select 4H or 8H, use the Key menu.

When the selected edge type is
“normal” and soft edge is selected or
when border, outline, or emboss is
selected, this button lights
automatically.

BDR (border): Apply a border of a
uniform thickness to the whole key.

DROP BDR (drop border): Apply a
border to two sides of the key (for
example, below and to the right, or
below and to the left).

SHDW (shadow): Apply a shadow to two
sides of the key (for example, below
and to the right, or below and to the
left).

OUTLINE: Use the outline of the key.
EMBOS (emboss): Apply an embossing
effect to the periphery of the key.

* To select a “normal” as the edge type

(that is, a plain edge), set all five of the
above buttons off.
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¢ When border, drop border, or shadow is
selected, you can use a special color
matte or a signal selected on the utility 1
bus for the edge.

¢ When emboss is selected, you can use the
dedicated color matte signal for the
emboss function.

* When outline is selected, the signal
selected on the key fill bus is used to fill
the edge.

MAIN MASK: Press this button, turning it
on, to enable the key mask using the
main pattern. It also enables you to set
the parameters with the knobs.

SUB MASK: Press this button, turning it
on, to enable the key mask using the
sub pattern. It also enables you to set
the parameters with the knobs.

ZABTN (zabton): When this is pressed,
turning it on, a translucent pattern is
inserted behind the key. With the
knobs, you can adjust the color, size,
density, and softness parameters.

SOFT EDGE: Soften the edge of the key.

© MORE button

When there are more than four parameters,
this button lights amber. When it is pressed,
it changes from amber to green and the fifth
and subsequent parameters are assigned to
the knobs, allowing them to be adjusted.

© SHOW KEY button

While this button is held down, a key
processed key source signal is output from
the specified output port. You can make the
output specification independently for each
of edit preview and the preview of each M/
E or PGM/PST bank in a Setup menu.

©@ Knobs

Turn the knobs to adjust the parameter
values.
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© Displays

Each display shows the initial letters of the
parameter name and the parameter value
(maximum three digits including a minus
sign for a negative value).

© DME channel selection buttons
Press one of these buttons, turning it on, to
delegate a DME channel to the keyer.

The number of valid DME channel
selection buttons depends on the number of
channels installed in the DME processor.
A maximum of four consecutively
numbered DME channels from the two sets,
DME 1 to 4 and DME 5 to 8, can be
assigned to one keyer.

A DME channel assigned to a keyer cannot
be selected on another keyer.

However, using the override function it is
possible to allocate a channel already
allocated to another keyer to the currently
selected keyer. If DME channel allocations
have been made in a Setup menu, these
buttons cannot be used to make DME
channel allocations. Using the trace
function, it is possible to check which keyer
a DME channel is allocated to.

@ ON AIR indicators

These light red when the corresponding
DME channels are included in the final
program output.

@® Output destination specification
buttons

MON (DME monitor): Hold down this
button and press the selection button
for the DME channel you want to
assign to the monitor output; you can
then monitor the output signal on the
DME monitor output.
‘While this button is held down, the
DME channel selection buttons light as
follows, allowing you to check the
monitor assignment.



Lit amber: DME channel that can
currently be monitored

Lit green: DME channel currently
assigned to the monitor output

FM FEED (frame memory feed): When
you press this button, it lights
momentarily amber, then for the
currently selected keyer, the key
processed signals are selected for frame
memory sources 1 and 2. If a DME is
selected on the currently selected
keyer, the key fill and key source
signals to which a DME effect is
applied are assigned; otherwise the key
fill and key source are assigned.
Carrying out a frame memory feed
causes the [PROC KEY] button to light
amber.

PROC KEY (processed key): When this
button is on, the key fill/source signal
subjected to key processing or signal
subjected to a DME effect on the
currently selected keyer can be selected
as a reentry signal (PROC V or PROC
K) for the M/E or PGM/PST bank, on
the auxiliary bus or the like. If a DME
is selected on the currently selected
keyer, the key fill and key source
signals to which a DME effect is
applied are assigned; otherwise the key
fill and key source are assigned.

(® OVERRIDE button

To select a DME channel already allocated
to another keyer or transition to the
currently selected keyer (or transition), hold
down this button, and press the DME
channel selection button.

® TRACE button

When a DME channel is already allocated
to another keyer or transition, hold down
this button, and press the corresponding
DME channel selection button, to switch to
the state in which the keyer (or transition) to

which the DME channel is allocated is
currently selected.

@ AUTO DELEG (auto delegation)
button

When this button is on, the key delegation

selection state of the key control block is

linked to the key delegation selection state

of the independent key transition control
block.

@ RESIZER button
Enables or disables resizer on the MVS-
8000G.

For details on resizer, see page 255.
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Device Control Block (Trackball)

The description below of frame memory DME, for wipe pattern position setting, and
clip operations applies only to the MVS- for VTR/disk recorder/frame memory clip
8000A/8000G. operation.

The device control block is used for three-
dimensional transform operations using a

© MENU button
© Region selection buttons

© Trackball

@ Operating buttons L Z-ring

(1) Region selection buttons When the [DME1] to [DMES] buttons
The operation mode allocated to the device are selected: This enables the three-
control block depends on the selection state dimensional transform operation mode
of the region selection buttons. in the device control block.

When the [M/E 1], [M/E 2], [M/E 3], and Press a button, turning it on, to select a
[P/P] buttons are selected: This DME channel. You can select multiple
enables the wipe pattern position buttons simultaneously.
setting (positioner) operation mode in The number of valid buttons depends
the device control block. You can on the number of DME processor
select multiple buttons simultaneously. channels installed.

When the [USER] button is selected: This When the [DEV] button is selected: This
enables pattern position setting used enables the VTR/disk recorder/frame
for color backgrounds. memory operation mode in the device
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control block. Each button functions as

follows.

(From upper left to right in the above

figure)

[M/E1] to [M/E3]: DEV1 (device 1) to
DEV3 (device 3)

[P/P]: DEV4 (device 4)

[USER]: FMICLIP (frame memory
clip 1)

[Unused]: FM2CLIP (frame memory
clip 2)

[DME1] to [DME4]: DEVS5 (device 5)
to DEVS (device 8)

[Unused]: FM LOOP (frame memory
loop)

[DMES5] to [DMES]: DEVO (device 9)
to DEV12 (device 12)

To exit from this mode, press the

[DEV] button again, turning it off.

When the [RUN CTRL] button is
selected: This enables the effect run
control mode in the device control
block.

When the [RSZR CTRL] button is
selected: This enables the resizer
control mode in the device control
block of the MVS-8000G.

For details on resizer, see page 255.

The functions of the operation buttons,
trackball, and Z-ring vary with the
operation mode as follows.

@ Operation buttons

When the positioner operation mode is

enabled

K1 CB1: Press this button to enable wipe
pattern position setting for key 1
(DSK1).
When the [USER] button is selected,
pattern position setting for color
background 1 is enabled.

K2 CB2: Press this button to enable wipe
pattern position setting for key 2

(DSK2).

When the [USER] button is selected,
pattern position setting for color
background 2 is enabled.

K3: Press this button to enable wipe pattern
position setting for key 3 (DSK3).
K4: Press this button to enable wipe pattern
position setting for key 4 (DSK4).

MAIN: Press this button to enable main
wipe pattern position setting for normal
transitions.

SUB: Press this button to enable sub wipe
pattern position setting for normal
transitions.

Among the [K1 CB1] button, [K2 CB2]
button, [K3] button, [K4] button, [MAIN]
button, and [SUB] button, you can select
multiple buttons.

POS: Press this button to enable pattern
movement in the x-axis and y-axis
directions with the trackball.

When the [USER] button is selected,
this enables the trackball to move the
pattern in the x-axis and y-axis
directions, and the Z-ring to adjust the
size of the pattern.

X, Y: These restrict the axes affected by the
trackball and Z-ring to the x- or y-axis.

Z: This restricts the axes affected by the
trackball and Z-ring to the z-axis.

CTR (center): When this button is pressed,
the pattern position returns to the
center. When the [USER] button is
selected, the pattern size also returns to
50.00.

SHIFT/CLR WORK BUFR: Press this
button twice in rapid succession to
reset all parameters on the target M/E
or PGM/PST to their initial values.
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When the three-dimensional transform
operation mode is enabled

The Buttons are used for three-dimensional
DME transformations.

For details, see “Basic Operations” in
Chapter 11 (Volume 2).

When the VTR/disk recorder/frame
memory operation mode is enabled
The Buttons are used for VTR control or
playback of frame memory clips.

For details, see “Controlling the Tape/Disk
Transport” in Chapter 12 (Volume 2).

When the resizer control mode is enabled

(for the MVS-8000G only)

LOCAL (K1): Select key 1.

GLB (K2): Select key 2.

SRC (K3): Select key 3.

TRGT (K4): Select key 4.

LOC SIZE (ASP: aspect): Pressing this
button and operating the trackball or Z-
ring changes the aspect ratio of a key to
which the resizer function is applied to.
When this button is held down, the
trackball or Z-ring operation is
switched to a finer control. (fine mode)

LOC XYZ (LOC: location): Pressing this
button and operating the trackball or Z-
ring moves, shrinks, or magnifies a key
to which the resizer function is applied
to. When this button is held down, the
trackball or Z-ring operation is
switched to a finer control. (fine mode)

ROT (RSZE: resizer): Press this button,
turning it on, to enable the resizer.

CLR WORK BUFR (clear work buffer):
Pressing this button once returns the
two-dimensional transformation
settings to the defaults. Pressing twice
in rapid succession returns all resizer
parameter values to the defaults.

X, Y: These restrict the axes affected by the
trackball and Z-ring to the x- or y-axis.
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Z: This restricts the axes affected by the
trackball and Z-ring to the z-axis.

CTR (center): Pressing this button once
changes the two-dimensional
transformation settings to the closest
detent values. Pressing twice in rapid
succession returns the two-dimensional
transformation settings to the defaults.

© Trackball

When the positioner operation mode is
enabled

By moving this, you can move the pattern
in the x-axis and y-axis directions.

When the three-dimensional transform
operation mode is enabled

Move the trackball to control the x- and y-
axes in a three-dimensional transform.
When the [SRC] or [TRGT] button is held
down, the trackball operation is switched to
a finer control. (fine mode)

When the resizer control mode is enabled
(for the MVS-8000G only)

By turning the trackball, you can move in
the x- and y-directions of the key to which
the resizer is applied, and change the aspect
ratio.

When the [LOC SIZE] or [LOC XYZ]
button is held down, the trackball operation
is switched to a finer control. (fine mode)

O Z-ring

When the positioner operation mode is
enabled

When the [USER] button is selected, by
turning the ring you can adjust the size of
the pattern.

When the three-dimensional transform
operation mode is enabled

Turn this ring to control the z-axis in a
three-dimensional transform.



When the [SRC] or [TRGT] button is held
down, the Z-ring operation is switched to a
finer control. (fine mode)

When the effect run control mode is
enabled

By turning the Z-ring, you can run the
keyframe effect, independent of the STOP
NEXT KF, EFF LOOP, and similar settings
in the keyframe control block. Turn
clockwise to run the effect in the normal
direction, and counterclockwise for the
reverse direction.

When the resizer control mode is enabled
(for the MVS-8000G only)

By turning the ring, you can zoom the key
to which the resizer is applied, and change
the aspect ratio.

When the [LOC SIZE] or [LOC XYZ]
button is held down, the Z-ring operation is
switched to a finer control. (fine mode)

When the VTR/disk recorder/frame
memory operation mode is enabled
Turning the Z-ring controls the tape
transport/disk drive/frame memory clip
operations, at a speed determined by the
operating buttons. Turn clockwise for the
normal direction, and counterclockwise for
the reverse direction.

© MENU button

Press this button, turning it on, to enable
adjusting the parameters allocated to the
knobs in the menu using the trackball and
Z-ring.

In the case of the DME menu, the operation
applies to the selected DME channel.

In VTR/disk recorder/frame memory
operation mode, press this button, setting it
to On. This makes it possible to carry out
timeline start/stop point setting operation
for the device selected with the device
selection buttons.
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Device Control Block (Joystick)

The description below of frame memory
clip operations applies only to the MVS-
8000A/8000G.

All functions of the joystick type device

control block are equivalent to the functions

of the trackball type, except that the
trackball and Z-ring operations are carried
out with the joystick.

MENU button

Region selection buttons

© Joystick

Operating buttons

© Joystick

When the positioner operation mode is
enabled

By moving this, you can move the pattern
in the x-axis and y-axis directions.

When the three-dimensional transform
operation mode is enabled

By moving this, you can carry out
operations in the x-, y-, and z-axes.
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When the following buttons are held down,
the joystick operation is switched to a finer
control. (fine mode)

* The button on the end of the joystick

¢ [SRC] button

¢ [TRGT] button

Depending on the settings made in the
Setup menu, the operation speed multiple
can be changed.



When the effect run control mode is
enabled

By moving the joystick sideways, you can
run the keyframe effect, independent of the
STOP NEXT KF, EFF LOOP, and similar
settings in the keyframe control block.
Move to the right to run the effect in the
normal direction, and to the left for the
reverse direction.

When the VTR/disk recorder/frame
memory operation mode is enabled
Moving the joystick sideways controls the
tape transport/disk drive/frame memory
clip operation, at a speed determined by the
operating buttons.

When the resizer control mode is enabled
(for the MVS-8000G only)

Move for operations in the x-, y-, and z-
axes. Hold down the button on the tip of the
joystick to switch the joystick operation to
a finer control. (fine mode)

Names and Functions of Parts of the Control Panel

65

|aued |04ju0) pue snusyy g Jeideyn



|oued |0J1U0D pue shusy g Jeideyn

66

Device Control Block (Search Dial)

The description below of frame memory
clip operations applies only to the MVS-
8000A/8000G.

Using the device control block (search
dial), you can directly operate an XDCAM,

disk recorder, VTR, other external device,

frame memory clip, or shot box. The device
control block (trackball) and device control
block (joystick) can be used together.

O DELAY button

@ Device selection buttons

@ Timecode display

@ TIMELINE button
© STOP button

O External device
operation buttons

[ ]

@ Editing
buttons

© Search dial
© SBOX buttons

© Timecode display

This shows the current time (CURRENT)
and the start and stop point timecode values
for the current reference device (START
TC, STOP TC). When you press a device
selection button, the button lights, selecting
the assigned device as the reference device,
and displaying its setting value.

In the case of the [SBOX] buttons, the
display does not change. When the
operation applies to a VTR/disk recorder,
the displayed setting value depends on
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whether the [TIMELINE] button is on or
off, as follows.

When the [TIMELINE] button is on:
Displays the start and stop points of the
last set keyframe on the timeline. When
the keyframe number is changed and
the last register and keyframe change,
the display also changes. (timeline
setting mode)



When the [TIMELINE] button is off:
Displays the Cueup & Play (rewind
action) start and stop points.

@ Device selection buttons
These buttons are used for selecting
assigned external devices or frame memory
clips. Each button can only be assigned to a
single device. Carry out the assignment in
the Setup menu (see “Overall Control
Panel Settings (Config Menu)” in Chapter
19 (Volume 3)). To select an assigned
device, press the corresponding button,
which lights green. To select more than one
device simultaneously, hold down the
button for the first selection, while pressing
the buttons for the other selections in turn.
The second and subsequent selected
buttons light amber. If you press another
button without holding down the first
selected button, the second button will be
the reference device and light green.
DEV: Assign external devices DEV1 to
DEVI12.
FM CLIP: Assign frame memory clips
FM1 to FMS8.
Device selection buttons can be set as
SBOX buttons or DELAY button in the
Setup menu.

©® SBOX (shotbox) buttons

Assign a shotbox saved in registers 1 to 99.
When you press a button, the assigned
shotbox is selected, and executed. Carry out
the assignment in the Setup menu (see
“Overall Control Panel Settings (Config
Menu)” in Chapter 19 (Volume 3)).
SBOX buttons can be set as device
selection buttons or DELAY button in the
Setup menu.

O DELAY button

When pressed, this button lights green, the
numeric keypad control block display
changes to DELAY__ : , and you can set
the start delay time for the selected device.

The setting range is from 00:00 to 59:29
(depends on the video format). This button
goes off when another timecode setting
button ([START TC], [STOP TC], [SET
START TC], [SET STOP TC], or [SET
DURY]) is pressed.

The DELAY button can be set as a device
selection button or an SBOX button in the
Setup menu. Carry out the assignment in
the Setup menu (see “Overall Control
Panel Settings (Config Menu)” in Chapter
19 (Volume 3)).

@ Editing buttons

These buttons set start and stop points.

These operations are only valid while a

device is selected with the device selection

buttons.

START TC: Press this button to set the
timecode of the start point at that time.
The timecode of the start point is
updated to the current time each time
this button is pressed.

When the device the operation applies
to is a VTR/disk recorder, the start
point updated by the setting of the
[TIMELINE] button is as follows.
When the [TIMELINE] button is
On: start point of the timeline
When the [TIMELINE] button is
Off: start point of Cueup & Play

STOP TC: Press this button to set the
timecode of the stop point at that time.
The timecode of the stop point is
updated to the current time each time
this button is pressed.

When the device the operation applies
to is a VTR/disk recorder, the stop
point updated by the setting of the
[TIMELINE] button is as follows.
When the [TIMELINE] button is
On: stop point of the timeline
When the [TIMELINE] button is
Off: stop point of Cueup & Play

SET START TC, SET STOP TC, SET

DUR: When pressed, these buttons
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light green, “START TC”, “STOP TC”
or “DUR” appears in the numeric
keypad control block display, and you
can enter a timecode from the numeric
keypad. If you enter a numeric value
and press the [ENTER] button, the
button goes off, whereas if you press
the [ENTER] button without entering a
numeric value the numeric keypad
control block display shows
“--i--:--:--". To exit the numeric value
entry mode, either repeat pressing the
same button, or press a different
numeric keypad control block linked
button, or a mode selection button such
as the [EFF] and [SNAPSHOT]
buttons in the numeric keypad control
block. If the timecode has been set
correctly, the entered numeric value
appears in the timecode display.

STB (standby) OFF: When pressed, this
button flashes amber, and the device
selected with the device selection
buttons exits from the standby mode.
This button cannot be used for frame
memory clip operations.

CUE: When pressed, this button flashes
amber together with the [ALL STOP]
button, and the device selected with the
device selection button is cued up to the
start point of the material. When more
than one device is selected, the amber
flashing continues until the reference
device is cued up, and when the cueing
up is finished, this button lights green.

REW: When pressed, this button lights
amber, and material of the device
selected with the device selection
buttons is rewound. To stop during the
rewind, press the [STOP] button or
[ALL STOP] button.

PLAY: When pressed, this button lights
amber, and the device selected with the
device selection buttons plays. The
playback stops not only if the [STOP]
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button is pressed, but also if any of the
[STB OFF], [SHTL], [JOG], [CUE],
[REW], [PLAY], [FF], and [ALL
STOP] buttons is pressed. When the
[VAR] button is pressed while the
device is playing back, the device plays
at one times normal speed in variable
mode.

FF: When pressed, this button lights amber,
and the material of the device selected
with the device selection buttons is fast
forwarded. To stop during the fast-
forward, press the [STOP] button or
[ALL STOP] button.

ALL STOP: When pressed, all device
material playback and other operations
stop. During cueing up of any of the
devices, this button flashes amber, and
when all cueing up operations are
completed, it lights green.

REC: When pressed simultaneously with
the [PLAY] button, this button lights
red (the [PLAY] button lights amber),
and the image from the selected device
is recorded.

This button cannot be used for frame
memory clip operations.

@ External device operation buttons

ENBL (enable): When this is pressed,
turning it on, the search dial [VAR],
[JOG], and [SHTL] button operations
are enabled.

VAR (variable): Sets the search dial to
variable mode.

JOG: Sets the search dial to jog mode.

SHTL (shuttle): Sets the search dial to
shuttle mode.

©@ TIMELINE button

Press to switch the device selected with the
device selection buttons to timeline setting
mode.



© STOP button

When pressed, this lights amber, and
operation of the device selected with the
device selection buttons stops.

© Search dial

Use this for search and other operations on
the material of an external device.

For details of the method of use, see
“Controlling Tape/Disk Transport” in
Chapter 12 (Volume 2).

Keyframe Control Block

In the keyframe control block, you can
carry out effect editing and execution.

@ Effect execution direction selection
buttons

@ EFF LOOP button
© STOP NEXT KF button

© EDIT ENBL button

® AUTO INS

O Duration setting buttons

button

6 KF LOOP button
G PAUSE button

<t
| o | | I
Next
o7

jé

@ Effect execution section

@ Editing buttons

@ Edit point
specification
buttons

© EDIT ENBL (edit enable) button
Press this button, turning it on, to enable
effect editing operations with the keyframe
control block.

When macro editing is carried out, this

button lights red.
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@ Edit point specification buttons

GO TO TC (Go to timecode): Press this
button, turning it on, to enter a numeric
value from the numeric keypad control
block, and move the edit point to the
specified timecode position.

GO TO KF (Go to keyframe): Press this
button, turning it on, to enter a numeric
value from the numeric keypad control
block, and move the edit point to the
specified keyframe.

During macro editing, pressing this
button moves the edit point to the event
number specified by numeric entry
with the numeric keypad control block.

PREYV KF (previous keyframe): When
this button is pressed, the edit point
moves to the keyframe immediately
before the current time (the position
where the effect is currently stopped).
During macro editing, pressing this
button moves the edit point to the event
immediately before the current event.

NEXT KF (next keyframe): When this
button is pressed, the edit point moves
to the keyframe immediately after the
current time.

During macro editing, pressing this
button moves the edit point to the event
immediately after the current event.

©® Editing buttons

ALL: Press this button, turning it on, to
select all keyframes (during macro
editing, all events) in the effect.

FROM TO: Press this button, turning it on,
to enter numeric values from the
numeric keypad control block, and
select a specified range of keyframes
(during macro editing, the specified
range of events).

INS (insert): When this button is pressed, a
new keyframe is inserted after the
current keyframe. Pressing this button
while holding down the [SHIFT]
button inserts a new keyframe before
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the current keyframe.

During macro editing, pressing this
button registers an event after the
current event.

MOD (modify): When this button is
pressed, the selected keyframe is
modified with the values of the current
keyframe. When the edit point is
between two keyframes, the
immediately preceding keyframe is
modified. You can also select multiple
keyframes, and modify them in a single
operation. At this time, pressing this
button while holding down the
[SHIFT] button modifies all selected
keyframes with the changed values
taken as relative values.

During macro editing, pressing this
button amends the selected event.

DEL (delete): When this button is pressed,
the selected keyframe is deleted. When
the edit point is between two
keyframes, the immediately preceding
keyframe is deleted. During macro
editing, pressing this button deletes the
selected event. You can also select
multiple keyframes or macro events,
and delete them in a single operation.

COPY: When this button is pressed, the
selected keyframe (during macro
editing, macro event) is copied. You
can also select multiple keyframes or
macro events, and copy them in a
single operation.

PASTE: When this button is pressed, the
deleted or copied keyframe (during
macro editing, macro event) is inserted
after the current keyframe (during
macro editing, macro event). Pressing
this button while holding down the
[SHIFT] button inserts the deleted or
copied keyframe (during macro
editing, macro event) before the current
keyframe (during macro editing, macro
event).



SHIFT: Hold down this button, and press
the [INS] button, [MOD] button, or
[PASTE] button, to obtain the shifted
function for the button.

UNDO: When this button is pressed, the
last executed keyframe (during macro
editing, macro event) insertion,
modification, or deletion, or paste
operation is canceled.

O Duration setting buttons

KF DUR (keyframe duration): Press this
button, turning it on, to set the
keyframe duration of the selected
keyframe, by numeric value entry from
the numeric keypad control block.

EFF DUR (effect duration): Press this
button, turning it on, to set the effect
duration from the numeric keypad
control block.

DELAY: Press this button, turning it on, to
enter a delay value from the numeric
keypad control block.

CONST DUR (constant duration): Select
the duration mode. When this is lit, the
mode is constant duration mode, and
when off, variable duration mode.

© KF LOOP (keyframe loop) button
Press this button, turning it on, to execute
the effect the specified number of times
through the keyframes in the specified
range.

O PAUSE button

When this button is pressed, a pause is
applied to the selected keyframe.

When editing a macro, press this button,
turning it on, to include a pause event in the
macro. The pause length can be set in the
numeric keypad control block.

@ Effect execution section

RUN: When this button is pressed, the
effect is run from the first keyframe to
the last keyframe. However, if a pause

is set on a keyframe, the effect stops at
that point. Press this button again to
resume execution, and continue to the
next pause point or the end of the
effect.

Effect indicator: This comprises multiple
LEDs, which show the progress of the
effect.

Fader lever: Moving this up or down
manually runs the effect.

REWIND: When this button is pressed, the
currently recalled effect is rewound to
the first keyframe.

FF (fast forward): When this button is
pressed, the currently recalled effect is
advanced to the last keyframe.

© Effect execution direction selection
buttons

NORM (normal): When this button is lit,
effect execution runs from the first
keyframe to the last keyframe.

REYV (reverse): When this button is lit,
effect execution runs from the last
keyframe to the first keyframe.

Pressing one of these buttons automatically

turns the other off.

NORM/REY (normal/reverse): Press this
button, turning it on, to reverse the
direction of the effect when it reaches
the last keyframe or first keyframe.

© STOP NEXT KF (stop next
keyframe) button

When this button is pressed, turning it on,

the effect execution range is from the

current time to the next keyframe.

@ EFF LOOP (effect loop) button
When the effect reaches the last keyframe
with this button on, it returns to the first
keyframe and repeats.

@ AUTO INS (auto insert) button
When editing a macro, press this button,
turning it on, to enable the auto insert
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function, so that every control panel
operation you carry out is added to the
macro as an event.

Numeric Keypad Control Block

The numeric keypad control block is used
for region selection, for saving and
recalling snapshots, effects and shotboxes,

for entering numeric values for trackball
operation and keyframe operation, and for
transition rate entry.

© Mode selection buttons @ Display

[ ooooootooooo
, ~
+-

EFF
HIIH

N

DISS

cLR
AUTO

TRANS

N

GPI
ENBL

]

([

B -
S ),

@ Region selection buttons

O Numeric keypad

© Function selection buttons

@ Mode selection buttons

EFF (effect): Press to save or recall an
effect.

SNAPSHOT: Press to save or recall a
snapshot.

SHOTBOX: Press to save or recall a
shotbox.

MCRO (macro): Press to save, recall or
edit a macro.

Names and Functions of Parts of the Control Panel

TRANS RATE (transition rate): Press to
set the transition rate.
Hold down this button, and press one of
the key delegation buttons [KEY 1] to
[KEY4] in the transition control block
to set an independent key transition
rate.



@ Region selection buttons

These select the functional block (“region’)

of the control panel to which operations

apply.

You can select more than one region at the

same time.

The first button you press is taken as the

reference region, and lights green, while the

next pressed button lights amber.

With the exception of the [MASTER] and

[ALL] buttons, you can change the region

assignment to the buttons as desired in the

Setup menu.

MASTR: Press this, turning it on, to save
region information in a master
snapshot register or master timeline
register, or to recall such region
information.

ALL: Select all regions. When any region
is already selected, pressing this button
makes all regions unselected.

MV/E 1 to M/E 3, P/P: Select the
corresponding regions, M/E-1, M/E-2,
M/E-3, and PGM/PST.

USER 1 to USER 8: Select a User region.

DME1 to DMES: Select a DME channel.

P-Bus: Select the P-Bus region.

GPI: Select the GPI region.

RTR: Select the router region.

DEV1 to DEV12: Select the Device 1 to
Device 12 regions respectively.

MCRO: Select the macro region.

© Function selection buttons

UNDO: After recalling a register, press this
button to return to the state before
recalling the register.

STORE STATS (store status): This lights
amber when data is stored in a register.
After saving data to a register, hold
down this button and press the
[UNDO] button to return the register to
the state before the data was saved.

TC (timecode): Press this button, turning it
on, to switch transition rate entry to the
timecode entry mode.

STORE: Press this button to switch to the
mode for saving a snapshot, effect,
shotbox or macro in a register.

RCALL (recall): Press this button to
switch to the mode for recalling a
snapshot, effect, shotbox or macro
from a register.

[STORE] button or [RCALL] button

flashes amber when one or more of the

regions assigned to the Region selection
buttons are not selected by the Region

Select menu.

O Numeric keypad

In addition to the buttons for numeric input,

this includes buttons for adding attributes to

snapshots.

0 to 9: Used to input numeric digits.

. (period): Enters the decimal point.
When the [TRANS RATE] button is lit,
enters “00.” When the [EFF] button,
[SNAPSHOT] button or [SHOTBOX]
button is lit, this is used to find an
empty register.

+/—/ EFF DISS (effect dissolve): Invert the
sign, negative or positive.

When the [SNAPSHOT] button is lit,
applies the effect dissolve attribute to a
snapshot.

CLR/AUTO TRANS (clear/auto
transition): Clear an input value,
returning to the previous state.

When the [SNAPSHOT] button is lit,
applies the auto transition attribute to a
snapshot.

TRIM/GPI ENBL (enable): After
entering a difference value to be added
to an existing setting, press this button
to confirm the change.

ENTER: Confirm an entered value.

© Display

This shows the selected region name and
entered numeric values.
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Fade to Black Control Block

©® AUTO button

© FTB button

@ Preview selection buttons

@ FTB (fade to black) button

Press this button to fade to black the
program output of the PGM/PST bank, at
the set transition rate. You can set the fade
to black transition rate in the menu.

@ Preview selection buttons

Press one of these buttons to select a signal

on the edit preview bus. Each button can be

assigned to any preview output in setup (see

“Overall Control Panel Settings (Config

Menu)” in Chapter 19 (Volume 3)).

PST (preset): When this button is pressed,
the signal selected on the background B
row of the PGM/PST bank is selected
on the edit preview bus.

M/E 1 to M/E 3, P/P (M/E1 to M/E 3, P/P
preview): The preview signal (M/E-1
PVW, M/E-2 PVW, M/E-3 PVVW, P/P
PVW) of the M/E or PGM/PST bank
corresponding to the pressed button is
selected on the edit preview bus.

M/E1K to M/E3 K, P/P K (M/E1 to M/E
3, P/P key preview): The key preview

Names and Functions of Parts of the Control Panel

signal (M/E-1 K-PVW, M/E-2 K-
PVW, M/E-3 K-PVW, P/P K-PVW) of
the M/E or PGM/PST bank
corresponding to the pressed button is
selected on the edit preview bus.
DME V (DME monitor video): When this
button is pressed, the DME monitor
output video signal (DME MON V) is
selected on the edit preview bus.
DME K (DME monitor key): When this
button is pressed, the DME monitor
output key signal (DME MON K) is
selected on the edit preview bus.

© AUTO button

When this button is pressed, the M/E or
PGM/PST bank preview signal selected on
the edit preview bus is automatically
switched to the program signal depending
on the on-air status.



Auxiliary Bus Control Block (for AUX Buses)

There are also models without the selected
source name displays and source name
displays shown in the following figure.

All operations except those of the [DEST]
button and [SHIFT] button are the same as
for a model with selected source name
displays and source name displays.

@ AUX delegation buttons

@ Selected source name displays

@ KEY button —

© 2ND button —

@ RTR button -~

© DEST button

@ Level selection buttons

—)
a

—\
— @ @ @@ @.
C0ddd)
2nd © Cross-point buttons
1st
© Source name displays @ SHIFT button —/
@O XPT HOLD buttons J
O Selected bus display J

© AUX delegation buttons

Press one of these buttons, turning it on, to
select the bus to which to assign the cross-
point buttons in the auxiliary bus control
block.

For buses that can be selected, see “Bus
Selection” (page 136).
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@ Selected source name displays
These show the name of the currently
selected signal (source) on the bus
corresponding to the delegation button.

© DEST (destination) button

Press this button, turning it on, to display
the names of buses allocated to the
delegation buttons in the selection source
name displays.

In the case of a module without selected
source name displays, this button is invalid.

O Selected bus display
This shows the name of the bus selected by
the auxiliary bus delegation buttons.

© Cross-point buttons

The cross-points in the auxiliary bus control
block are arranged in two rows: an upper
row (1st row) and a lower row (2nd row),
and are allocated to the buses selected with
the AUX delegation buttons. The 1st row
contains the cross-point buttons for
unshifted buses, and the 2nd row contains
the cross-point buttons for shifted buses.
When the DME 1V/K to 8V/K buses are
selected with the AUX delegation buttons,
the 1st row cross-point buttons are for the
currently showing side of DME, and the
2nd row are for the reverse side.

By holding down the [2ND] button and
making an AUX delegation selection, you
can allocate the 2nd row to a different bus
from the 1st row.

In this case, if the 32nd button is set to be a
[SHIFT] button (in a 32-button system), the
cross-point buttons switch to the shifted
allocation while the [SHIFT] button is
enabled.

@ XPT HOLD (cross-point hold)
buttons

Press one of these buttons, turning it on, to

enable cross-point hold.
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© KEY button

While this button is held down, you can use
the cross-point row of buttons to select key
signals.

© 2ND button

After selecting a bus with an AUX
delegation button, hold down this button,
and select another AUX delegation, thus
allocating a different bus in the 2nd row
from the 1st row.

© Source name displays

These show the names of the source signals
which can be selected by the cross-point
buttons. While the [SHIFT] button is
enabled, the shifted signal name is
displayed. If a different bus is allocated to
the 2nd row, while the [2ND] button is held
down, the 2nd row signal name is
displayed.

While the [KEY] button is held down, the
source name of the key signal assigned to
the cross-point buttons appears.

@ SHIFT button

‘While this button is enabled, the shifted
signal names appear in the source name
display. Pressing this buttons toggles the
source name display between the shifted
signal names and unshifted signal names.
In the case of a module without source
name displays, this button is invalid.

@ RTR (router) button

Press this button, turning it on, to assign the
auxiliary bus control block to router
control.

For details of the names and functions of
parts for router control, see the next
section.

@ Level selection buttons
Used when the auxiliary bus control block
is carrying out router control.



Auxiliary Bus Control Block (for Router Control)

Press the [RTR] button, turning it on, to
assign the auxiliary bus control block to
router control.

@ Destination selection buttons

@ Selected source name displays

@ KEY button —_—

O 2ND button —

@ RTR button —~

© DEST button

@ Level selection buttons

‘@@@l—“

)8 L] B—
r—[@@@@@l

eeeees

2nd © Source selection
button rows

1st

© Source name displays

@ SHIFT button —/

@ XPT HOLD buttons J

O Selected destination display J

@ Destination selection buttons

Press a button, turning it on, to select the
destination to which the router source is
assigned.

The button pressed to assign a destination
to a source selection button in the 1st row
lights amber. When another button is
pressed to assign a different destination to a

source selection button in the 2nd row, it
lights green.

@ Selected source name displays
These show the source name selected for
the destination.

If the source names and destination names
are set in the Setup menu to “SW’er Local”
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mode, then the description names appear
here.

©® DEST (destination) button

Press this button, turning it on, to display
the names of the destinations assigned to
the destination selection buttons in the
selected source name displays.

O Selected destination display

This shows the name of the destination
selected by the destination selection
buttons. If a protected destination is
selected, the indication “PROTECT”
appears.

© Source selection button rows

The destination selected with a destination
selection button is assigned to a source
selection button. Press a source selection
button to select a source. The 1st row of
buttons are source selection buttons for the
unshifted destinations, and the 2nd row are
shifted source selection buttons. By holding
down the [2ND] button, and selecting a
destination, you can assign a different
destination from the 1st row to the 2nd row.
In the 1st row, the button to which a
destination is assigned lights amber. If a
different destination is assigned to a button
in the 2nd row, the button lights green.
When the 32nd button is set as a [SHIFT]
button (in a 32-button system), while the
[SHIFT] button is active, these switch to the
shifted source selection buttons. By using
the [KEY] button, you can expand the
source selection as follows.

Source [SHIFT] | [KEY] | Selection

selection operation

1to 31 Off Off Press the source
selection button.

32t062 |[On Off Press the

[SHIFT] button,
then press the
source selection
button.
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[KEY] | Selection

operation

Source
selection

[SHIFT]

631093 |Off On Hold down the
[KEY] button,
and press the
source selection

button.

Hold down the
[KEY] button,
and press the
[SHIFT] button,
turning it on (the
[SHIFT] button
locks here, even
when in Hold
mode), then
press the source
selection button.

94 t0 124 |On On

@O XPT HOLD (cross-point hold)
buttons
Not used in router control mode.

© KEY button

When this button is enabled by a setting in
the Setup menu, by holding it down during
a source selection you can expand the
function of the [SHIFT] button. (See
“Cross-Point Settings (Xpt Assign Menu)”
in Chapter 19 (Volume 3).)

© 2ND button

After selecting a destination with the
destination selection buttons, hold down
this button and make another destination
selection to assign a different destination
from the 1st row to the 2nd row.

© Source name displays

These display the names of signals
(sources) that can be selected with the
cross-point buttons. While the [SHIFT]
button is active, the shifted signal names
appear. While the [KEY] button is held
down, the expanded signal names appear.
When a different destination is assigned to
the 2nd row, the 2nd row signal names



appear only while the [2ND] button is held
down.

(@ SHIFT button

While this button is active, the source name
displays show the shifted signal names.
Press this button to toggle between the
shifted and unshifted states.

@ RTR (router) button

Press this button, turning it on, to assign the
auxiliary bus control block to router
control.

@ Level selection buttons

To each of the four buttons, plural S-Bus
levels are assigned in the Setup menu. Press
a button, turning it on, to make operations
apply to those S-Bus levels.

Menu Control Block

Top menu selection buttons

@ Menu display

(e NoXNoNoXo)

O User preference buttons

Knobs

© Top menu selection buttons

These select the menu appearing in the
menu display.

It is also possible to change the assignment
of these buttons in setup.

For details, see “Overall Control Panel
Settings (Config Menu)” in Chapter 19
(Volume 3).
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©® Menu display
This shows the menu currently in use.

©®© Knobs
These adjust the parameter values
appearing in the menu.

O User preference buttons

These recall the functions or menus
assigned to them in the Setup menu.

In the default setup, nothing is assigned to
the [PREFS 1] to [PREFS 7] buttons.

It is also possible to change the assignment
of these buttons in setup.

For details, see “Overall Control Panel
Settings (Config Menu)” in Chapter 19
(Volume 3).

PREFS 8 button: When this button is on,
control of an editor from the Remotel
port on the rear panel of the switcher is
possible. However, even when it is off,
control of the Edit PVW bus is always
possible.
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Memory Card/USB Adaptor Block

T Memory card slot

@ DEVICE connectors

Ve

[]

© Memory card slot

This slot accepts a PCMCIA Type 11
compliant memory card. You can use it in
software installation, and for saving and
reading in data, such as snapshot, keyframe,
effect, and setup data.

©® DEVICE connectors
There are three USB connectors.

Names and Functions of Parts of the Control Panel

You can connect a device such as a mouse,
keyboard, USB storage, and so on, that is
equipped with a USB interface to any of
these connectors.

For details on the devices that can be
connected, consult your Sony
representative.




“Memory Stick”/USB Connections Block

© “Memory Stick” status indicator

@ “Memory Stick” slot

=

=]

© DEVICE connectors

© “Memory Stick” status indicator
Lights in red during access to a “Memory
Stick.”

Do not power the unit off or remove a
“Memory Stick” when the “Memory Stick”
status indicator is lit.

©® “Memory Stick” slot

Insert “Memory Sticks.” You can use it in
software installation, and for saving and
reading data, such as snapshot, keyframe,
effect, and setup data.

See the next item, “Memory Sticks” for
more information about the usable
“Memory Sticks” and their handling.

©® DEVICE connectors

There are three USB connectors.

You can connect a device such as a mouse,
keyboard, USB storage, and so on, that is
equipped with a USB interface to any of
these connectors.

For details on the devices that can be
connected, consult your Sony
representative.

About “Memory Sticks”

Usable “Memory Sticks”

This unit has been confirmed to operate
with those of the following “Memory
Sticks” that have a capacity of 8 GB
(gigabytes) or less. However, operation
with all “Memory Sticks” is not guaranteed.
* “Memory Stick”
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“Memory Stick PRO”
“Memory Stick Duo”
“Memory Stick PRO Duo”

When using a “Memory Stick PRO,”
high-rate data transfer using parallel
interface is not supported.

A “MagicGate Memory Stick” can also
be used, but this system does not support
the MagicGate function.

When using a “Memory Stick Duo,” be
sure to use it with a “Memory Stick Duo
Adaptor” (MSAC-M2 or equivalent). If
you insert a “Memory Stick Duo”
without using the adaptor, there is the
possibility that the stick cannot be
removed, resulting in a serious accident.

Handling “Memory Sticks”
When using “Memory Sticks,” pay
attention to the following points.

Do not touch the connector of the

“Memory Stick” with anything, including

your finger or metallic objects.

Do not attach anything other than the

supplied label to the “Memory Stick”

labeling position.

Attach the label so that it does not stick

out beyond the labeling position.

Carry and store the “Memory Stick” in its

case.

Do not strike, bend, or drop the “Memory

Stick.”

Do not disassemble or modify the

“Memory Stick.”

Do not allow the “Memory Stick” to get

wet.

Do not use or store the “Memory Stick”

in a location that is:

— Extremely hot, such as in a car parked
in the sun

— Under direct sunlight

— Very humid or subject to corrosive
substances

Names and Functions of Parts of the Control Panel



Utility/Shotbox Control Block

© Bank selection buttons
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@ Memory recall buttons

@ Bank selection buttons

Press any of the [BANKI1] to [BANK4]
buttons to select a bank of 24 memory recall
buttons. The selected button lights amber.

© Memory recall buttons

You can use these buttons to recall
frequently used menus, utility functions,
shotbox registers, or macro registers that
you have assigned.

When a utility function is allocated to a
button, the button lights orange (or green
depending on the status), and the allocated
function name appears. Pressing the button
executes the allocated function. When the
function constitutes a switching on/off
operation, the button lights green;
otherwise, it only momentarily lights green.
When a shotbox register or macro register
recall is assigned to a button, the button
lights orange, and the assigned register
name appears. (If the register is empty, the

button goes off.) In the case of a shotbox
function, pressing the button executes the
assigned shotbox function, and the button
lights yellow. In the case of a macro
register, pressing the button executes the
assigned macro, and the button flashes
yellow.
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Transition Control Block and Flexi Pad Control Block
(Simple Type)

The simple versions of the transition using these simple-type control blocks are
control block and Flexi Pad control block also referred to as “simple transitions” in
shown in the following figure is designed to this User’s guide.

allow simplified operations than with the
standard type. The transitions carried out

@ Numeric display N

@O XPT HOLD status display ————

@ Key transition selection buttons

O Key status display

Transition type selection buttons

XPT HOLD
ABUU:1234
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© Transition execution section

© Pattern limit buttons

O Wipe direction selection buttons

@ Mode selection buttons ——

© UNDO button——/

J

@ Memory recall section

Shown above is the right-hand type transition control block (with the right-hand fader lever).
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Transition Control Block and Flexi Pad Control Block (with INH

button)
@ INH button
A
4 N XPT HOLD
i
ABUU:1234
LT"A’;JT - D D
B D
SHOT
\\//
~. = E]
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Memory recall section

UNDO button

@ Transition type selection buttons
You can assign these buttons in setup to any
transition type (see “Overall Control Panel
Settings (Config Menu)” in Chapter 19
(Volume 3)). Press any of the following
buttons, turning it on, to select the transition
type.

Press one of these buttons, turning it on, to
determine the type of the next transition for
a background.

To select the key transition type, hold down
the [KEY 1] or [KEY?2] button, and press
one of the following buttons, turning it on.
When multi-program mode is selected in
the Setup menu (see “Settings for Switcher
Configuration (Config Menu)” in Chapter
20 (Volume 3)), two or more of the
following buttons may light.

You can also assign a function to these
buttons to select whether or not the fader
levers are used as key frame faders.

MIX: In a background transition, the new
video fades in as the current video
fades out. During the transition, the
overall signal level is maintained at
100%.

In a key transition, the key fades in (for
insertion) or out (for removal).

NAM (non-additive mix): The current and
new video signals are compared, and
the signal with the higher luminance
level is given priority in the output.
The current video is maintained at
100% output for the first half of the
transition as the new video increases
progressively to 100%, then the current
video is progressively reduced from
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100% to zero in the second half while
the new video is maintained at 100%.

WIPE: The current video is replaced by the
new video, using the wipe pattern
selected in the Wipe menu.

DME: This applies a wipe-like transition,
using the DME effect selected in the
DME Wipe menu.

FM1&2CLIP, FM3&4CLIP,
FM5&6CLIP, FM7&8CLIP: A
recorded clip is played back together
with the transition. At this point, you
can also carry out a background
transition (wipe or mix (dissolve))
simultaneously together with the clip.

KF (key frame): Press this button, turning
it on, to enable using the fader lever as
a key frame fader.

©® Key transition selection buttons

To insert or delete key 1 on the next
transition, hold down the [KEY 1] button,
and select the type of transition using the
transition type selection buttons. If the key
is currently not inserted, the transition will
insert it, and if the key is currently inserted,
the transition will delete it. You can use the
[KEY?2] button in a similar way.

While these buttons are held down, you can
select a key source with the cross-point
buttons on the key bus.

Pressing one of these buttons twice in rapid
succession changes the state of the
corresponding key bus so that a cross-point
can be selected.

Key delegation button Corresponding
(double press) key bus

[KEY1] key 12

[KEY2] key 2 )

a) The key bus switching button [KEY3] in the cross-
point control block goes off.

b) The key bus switching button [KEY4] in the cross-
point control block goes off.
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© Transition execution section

Fader lever: Move this vertically to carry
out a transition.

When the [KF] button or a transition
type selection button to which the KF
button function has been assigned is lit,
you can use this as a key frame fader.
When the split fader function is
enabled, by pressing the projection on
the left side of the grip you can release
the lock and separate the two halves of
the fader lever. With the split fader
lever, in a background mix transition,
you can control the background A and
B buses independently.

Transition indicator: This comprises
multiple LEDs, which show the
progress of the transition.

Transition rate display: This displays the
transition rate (the time from the
beginning of the transition to its
completion) set for an auto transition,
in frames.

You can set the transition rate using the
numeric keypad control block or menu.

TAKE button: Pressing this button carries
out an auto transition of the set
transition rate. The transition starts
immediately, and the button lights
amber. When the transition completes,
the button goes off.

@ Wipe direction selection buttons

For details, see “Wipe direction selection
buttons” (page 51).

© Pattern limit buttons

LIMIT SET: Move the fader lever to the
position of a particular pattern size, and
stop it there, then press this button to
set the pattern limit range. This button
is enabled when the [PTN LIMIT]
button is off.

PTN (pattern) LIMIT: When a wipe or
DME wipe is selected, pressing this



button, turning it on, enables the
pattern limit function.

O Key status display

For each of keys 1 and 2, when the key is
inserted, the corresponding ON indicator
lights. The OVER indicators show the
priority between keys 1 and 2, by lighting
when the corresponding key is on top. For
example, when key 1 appears over key 2 on
the program monitor, the OVER indicator
for key 1 lights.

The following is the Flexi Pad control
block.

@ Mode selection buttons

WIPE: When saving or recalling a wipe
snapshot, use this in combination with
the buttons of the memory recall
section.

DME: When saving or recalling a DME
wipe snapshot, use this in combination
with the buttons of the memory recall
section.

SNAPSHOT: When saving or recalling a
snapshot, use this in combination with
the buttons of the memory recall
section.

© Memory recall section

This consists of eight buttons with LCDs,
whose display changes according to the
operation mode. Use these in combination
with the mode selection buttons to save or
recall wipe snapshots, DME wipe
snapshots, or snapshots.

© UNDO button

After recalling a register, press this button
to return to the state before recalling the
register.

With a setup setting, this can be switched to
a mode selection button for macro setting,
and used in combination with the buttons in

the memory recall section for recalling and
executing a macro.

@ XPT HOLD (cross-point hold) status
display

A bus for which cross-point hold is set

appears as a green light.

@ Numeric display

Depending on the operation mode, this
shows a wipe or DME wipe pattern number,
or a register number in up to four digits.

In macro mode, this provides indications
for macro editing.

@ INH (inhibit) button

Pressing this button, turning it on, disables
the buttons in the memory recall section
and the [UNDO] button.

Names and Functions of Parts of the Control Panel
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Independent Key Transition Control Block (Simple

Type)

The left side of this control block controls
key 3, and the right side controls key 4.
The control block for key 3 only is
described as an example, but the operations
on the key 4 control block are the same.

In setup you can assign any key to either
side of this control block. For details, see
“Assigning Keys to the Independent Key
Transition Control Block (Simple Type)” in
Chapter 19 (Volume 3).

© K-SS button

O Key source name display/key snapshot buttons

\DHD

@ Independent key transition execution section

© Independent key transition type selection buttons

© Independent key transition type
selection buttons

Press one of the following buttons, turning

it on, to select the independent key

transition type.

MIX: Faded in or out.

WIPE: Inserted or deleted with a wipe.

DME: Switches the key with a DME wipe.

CUT: Inserted or deleted instantaneously.

Names and Functions of Parts of the Control Panel

SHIFT: This has the following functions.
* When setting is made in the Setup

menu to allow a different transition
type for inserting or deleting a key, it
is possible to display and set the
transition type after the next
transition while this button is held
down.



* While this button is held down, you
can select a key source with the
cross-point buttons for the key bus.

* If you press this button twice in rapid
succession, the key bus selection
button [KEY3] in the cross-point
control block lights, and a key 3 key
bus cross-point can be selected.

* If you press this button, while
holding down [TRANS RATE]
button in the numeric keypad control
block, you can set the independent
key transition rate on the control
block.

@ Independent key transition
execution section

KEY3 ON button: This inserts or deletes
key 3 instantaneously. When key 3 is
present in the final program output
from the switcher, this lights red, and
otherwise lights amber.

TAKE button: This carries out an auto
transition on key 3.

©® K-SS (key snapshot) button

This enables key snapshot mode. In key
snapshot mode, it is possible to save and
recall key snapshots.

O Key source name display/key
snapshot buttons
These show the signal name of the key fill
selected for key 3 and the transition rate on
two buttons. In key snapshot mode, these
correspond to registers 1 and 2 for key 3;
press to save or recall a key snapshot.
To save a key snapshot, with the [K-SS]
button lit amber, hold down [SHIFT] button
and press one of the key snapshot buttons.
This saves a key snapshot in the button you
pressed, which lights yellow.

Names and Functions of Parts of the Control Panel
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Downstream Key Control Block

© Key delegation buttons

© Key source name display/key snapshot

buttons
. O Key snapshot setting

buttons

@ Independent key transition type

© Independent key transition execution section

selection buttons

© Key delegation buttons

Press one of the [DSK1] to [DSK4] buttons
to delegate this control block to the
corresponding keyer.

Using the Setup menu, it is possible to
delegate this control block to key 1 to key 4
of the M/E bank.

While these buttons are held down, you can
select a key source with the cross-point
buttons for the key bus.

Pressing one of these buttons twice in rapid
succession changes its state so that you can
make cross-point selections on the
corresponding key bus.

Names and Functions of Parts of the Control Panel

© Independent key transition type
selection buttons

Press one of these buttons, turning it on, to

select the downstream key transition type.

MIX: Carry out a dissolve with the key
selected with the key delegation
buttons.

WIPE: Carry out a wipe with the key
selected with the key delegation
buttons.

DME: This switches the key selected with
the key delegation buttons, using a
DME wipe.

CUT: Instantaneously insert or delete the
key selected with the key delegation
buttons.



SHIFT: When setting is made in the Setup
menu to allow a different transition
type for inserting or deleting a key, it is
possible to display and set the
transition after the next transition while
this button is held down.

©® Independent key transition
execution section

DSK1 (downstream key 1) ON to DSK4
ON buttons: Press these to
instantaneously cut the downstream
keys 1, 2, 3, and 4 in or, when the
downstream keys are already inserted,
cut them out. When the key
corresponding to the button appears in
the final program output, the button
lights red, and otherwise lights amber.

TAKE buttons: These correspond to
downstream keys 1, 2, 3, and 4 from
left to right; press to execute an auto
transition. The transition starts
immediately, and the button lights
amber. When the transition completes,
the button goes off.

Fader lever: Move this to carry out a
manual downstream key transition.

Transition indicator: This comprises
multiple LEDs, which show the
progress of the downstream key
transition.

O Key snapshot setting buttons

K-SS (key snapshot): This enables key
snapshot mode.

K-SS STORE (key snapshot store): To
save a key snapshot, hold down this
button, and press the key source name
display/key snapshot button for the
register you want to save.

UNDO (key snapshot recall undo): This
undoes the last key snapshot recall.

O Key source name display/key
snapshot buttons

These display the selected source name for

each corresponding keyer. In snapshot

mode, they correspond to registers 1 to 4 of

the selected keyer, and pressing the button

saves or recalls a key snapshot.

Names and Functions of Parts of the Control Panel
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Downstream Key/Fade-to-Black Control Block

O Key source name display/key snapshot buttons

® K-SS button
© FTB button

@ Independent key
transition

© Key delegation
buttons

execution section

$ Preview selection buttons
O AUTO button

© Key delegation buttons

Press DSK1 or DSK2, to select the keyer.
Each button can be assigned to any key in
setup (see “Overall Control Panel Settings
(Config Menu)” in Chapter 19 (Volume 3)).
While these buttons are held down, you can
select a key source with the cross-point
buttons on the key bus.

Pressing one of these buttons twice in rapid
succession changes its state so that you can
make cross-point selections on the
corresponding key bus in the PGM/PST
bank.

Key delegation button | Corresponding
(double press) key bus
[DSK1] key 12

[DSK2] key 29

Names and Functions of Parts of the Control Panel

a) The key bus selection button [KEY3] in the P/P
cross-point control block goes off.

b) The key bus selection button [KEY4] in the P/P
cross-point control block goes off.

@® Independent key transition
execution section

DSK1 ON, DSK2 ON buttons: Press these
to cut in the corresponding downstream
key 1 or 2. When the key is already
inserted, pressing the button cuts it out.
Each button lights red when the
corresponding key is inserted in the
program output (final output from the
switcher), and lights amber at other
times.

AUTO TRANS buttons: The left button
applies to DSK1 and the right button to
DSK2; press these buttons to carry out



an auto transition. The transition
immediately starts, and the button
lights amber. When the transition
completes, the button goes off.

©® K-SS (key snapshot) button
Pressing this button, turning it on, enables
the key snapshot mode. In this mode, you
can save and recall key snapshots.

O Key source name display/key
snapshot buttons
Each column of two buttons relates to the
corresponding downstream key 1 or 2. The
upper button displays the name of the key
fill signal selected for the key, and the
lower button shows the transition rate.
In key snapshot mode, these buttons
correspond to registers 1 to 4 of the keyer
selected with the key delegation buttons,
and pressing a button recalls the key
snapshot. To save a key snapshot, hold
down the [STORE] button in the numeric
keypad control block, and press the button
for the desired register.

© FTB (fade to black) button

Press this button to fade to black the
program output of the PGM/PST bank, at
the set transition rate. You can set the fade
to black transition rate in the menu.

O AUTO button

When this button is pressed, the M/E or
PGM/PST bank preview signal selected on
the edit preview bus is automatically
switched to the program signal depending
on the on-air status.

@ Preview selection buttons

Press one of these buttons to select a signal
on the edit preview bus. Each button can be
assigned to any preview output in setup (see
“Overall Control Panel Settings (Config
Menu)” in Chapter 19 (Volume 3)).

PST (preset): When this button is pressed,
the signal selected on the background B
row of the PGM/PST bank is selected
on the edit preview bus.

M/E 1 to M/E 3, P/P (M/E1 to M/E 3, P/P
preview): The preview signal (M/E-1
PVW, M/E-2 PVW, M/E-3 PVW, P/P
PVW) of the M/E or PGM/PST bank
corresponding to the pressed button is
selected on the edit preview bus.

M/E1K to M/E3 K, P/P K (M/E1 to M/E
3, P/P key preview): The key preview
signal (M/E-1 K-PVW, M/E-2 K-
PVW, M/E-3 K-PVW, P/P K-PVW) of
the M/E or PGM/PST bank
corresponding to the pressed button is
selected on the edit preview bus.

DME V (DME monitor video): When this
button is pressed, the DME monitor
output video signal (DME MON V) is
selected on the edit preview bus.

DME K (DME monitor key): When this
button is pressed, the DME monitor
output key signal (DME MON K) is
selected on the edit preview bus.

Names and Functions of Parts of the Control Panel
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Transition Control Block (Compact Type)

The compact version of the transition also be controlled with the compact
control block shown in the following figure transition control block.

has fewer buttons than the standard type.

Independent key transition operations can

@ PRIOR SET button
@ Next transition selection buttons

O Key status display

@ Transition type selection buttons

@ Independent key transition
execution section

ON ON ON ON
1234123412341234

KEYT
TRANS

]

KEY2
TRANS

KEYS
TRANS

KEY4
TRANS

L

© TRANS PVW button

©® Transition execution section

O Wipe direction selection buttons

@ Next transition selection buttons KEY1 to KEY4 (DSK1 to DSK4 in the
Press these buttons, turning them on, to PGM/PST bank): Press this button,
determine what the next transition will turning it on, to make the next
apply to. transition insert or remove the

BKGD: Next transition changes the corresponding key (keys 1 to 4). If a
background. key is currently inserted it will be

Names and Functions of Parts of the Control Panel



removed, and if it is not currently
inserted, it will be inserted.
In the PGM/PST bank, this inserts or
removes downstream keys 1 to 4.
KEY PRIOR (priority): When this button
is lit, the setting of the key priority after
the next transition is enabled. The key
priority after the next transition appears
in the key status display.

ALL: Pressing this button turns on a
preselected set of the [BKGD], [KEY1]

to [KEY4], and [KEY PRIOR] buttons.

Make this setting in a Setup menu.

@ Transition type selection buttons

You can assign these buttons in setup to any

transition type (see “Overall Control Panel

Settings (Config Menu)” in Chapter 19

(Volume 3)).

Press one of these buttons, turning it on, to

determine the type of the next transition.

When multi-program mode is selected in

the Setup menu (see “Settings for Switcher

Configuration (Config Menu)” in Chapter

20 (Volume 3)), two or more of the

following buttons may light.

You can also assign a function to these

buttons to select whether or not the fader

levers are used as keyframe faders.

MIX: In a background transition, the new
video fades in as the current video
fades out. During the transition, the
overall signal level is maintained at
100%.

In a key transition, the key fades in (for
insertion) or out (for removal).

NAM (non-additive mix): The current and
new video signals are compared, and
the signal with the higher luminance
level is given priority in the output.
The current video is maintained at
100% output for the first half of the
transition as the new video increases
progressively to 100%, then the current
video is progressively reduced from

100% to zero in the second half while
the new video is maintained at 100%.

SUPER MIX: The current video is
maintained at 100% output for the first
half of the transition as the new video is
mixed while increasing progressively
to 100%. The current video is then
progressively reduced from 100% to
zero in the second half while the new
video is maintained at 100%.

PST (preset) COLOR MIX: In the first
transition, the current video is replaced
by the color matte in a mix (dissolve),
then in the second transition the color
matte is replaced by the new video also
in a mix (dissolve).

WIPE: The current video is replaced by the
new video, using the wipe pattern
selected in the Wipe menu.

DME: A wipe type of transition is carried
out, using the DME effect selected in
the DME Wipe menu.

FM1&2CLIP, FM3&4CLIP,
FM5&6CLIP, FM7&8CLIP: A
recorded clip is played back together
with the transition. At this point, you
can also carry out a transition (wipe or
mix (dissolve)) simultaneously
together with the clip.

KF (key frame): Press this button, turning
it on, to enable using the fader lever as
a key frame fader.

© Transition execution section

Transition indicator: This comprises
multiple LEDs, which show the
progress of the transition.

Fader lever: Move this to carry out a
manual transition. When the [KF]
button or a transition type selection
button to which the KF button function
has been assigned is lit, you can use this
as a keyframe fader.

Transition rate display: This shows the
“transition rate” (the time from the
beginning of a transition to its
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completion) set for an auto transition,
in frames.

You can set the transition rate using the
numeric keypad control block, Flexi
Pad control block, or menu.

AUTO TRANS (transition) button:
Pressing this button carries out an auto
transition of the set transition rate
(duration). The transition starts
immediately, and the button lights
amber. When the transition completes,
the button goes off.

CUT button: Pressing this button carries
out the transition as a cut (i.e.
instantaneously).

O Wipe direction selection buttons

For details, see “Wipe direction selection
buttons” (page 51).

© TRANS PVW (transition preview)
button

When this button is lit, you can check in

advance the video changes during the

transition, on the preview output from the

M/E or PGM/PST bank.

During the preview, you can use the fader

lever, [AUTO TRANS] button, and [CUT]

button. One of the following functions of

this button can be selected in a Setup menu.

* When the transition completes, the
system returns to the normal mode.

* The transition preview mode is
maintained while this button is pressed.

» Switching is made between the transition
preview mode and normal mode every
time this button is pressed.

0O Key status display

For each of keys 1 to 4, the corresponding
ON indicator lights when the key is
inserted. It also shows the priority (1 to 4)
of each key.

Names and Functions of Parts of the Control Panel

@ PRIOR (priority) SET button

While this button is held down, you can set

the key priority.

The setting mode when this button is

pressed depends on whether or not the

[KEY PRIOR] button is lit, as follows.

¢ When the [KEY PRIOR] button is off, the
current key priority is set.

¢ When the [KEY PRIOR] button is lit, the
key priority after the next transition is set.

Press the [KEY PRIOR] button as required,

to switch between these two modes.

In either mode, hold down the [PRIOR

SET] button, and press the button ([KEY1]

to [KEY4]) corresponding to the key you

want to bring to the front.

© Independent key transition
execution section

KEY1 TRANS (transition) to KEY4
TRANS (DSK1 TRANS to DSK4
TRANS in the PGM/PST block)
buttons: Press the corresponding one
of these buttons to cut key 1 to key 4 in
or out automatically at the set transition
rate. When the key corresponding to
the button appears in the final program
output, the button lights red, and
otherwise lights amber. During a
transition, the button lights green.



CCP-6224 2M/E Control Pane

In this system, you can use the built-in
CCP-6224 2M/E Control Panel. This panel
has two cross-point control blocks, two

transition control blocks (compact type),
one device control block (track ball), and

one Multifunction Flexi Pad control block.

@®Device control block

(track ball)
@Transition control block
(compact type)
8888 o' O
ool E BEES o
0ooo Doooo O
0000 000
0000
oDaoo [m}
508)138%8 =R o
00 00||| ooooo [m]
(m]

& Cross-point control block

O Multifunction Flexi Pad
control block

© Cross-point control block

For details of cross-point control block
operation, see “Cross-Point Control
Block” (page 45) and “Cross-Point
Control Block (CCP-6224/6324) in the
AUX Operating Mode” (page 99).

For operations in AUX control mode, see
“Auxiliary Bus Control Block (for AUX
Buses)” (page 75).

@ Transition control block (compact
type)

For details of operations, see “Transition
Control Block (Compact Type)” (page 94).

©® Device control block (track ball)

For details of operations, see “Device
Control Block (Trackball)” (page 60).

O Multifunction Flexi Pad control
block

For details of operations, see
“Multifunction Flexi Pad Control Block”
(page 101).
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CCP-6324 3M/E Control Panel

In this system, you can use the built-in
CCP-6324 3M/E Control Panel. This panel
has three cross-point control blocks, three

transition control blocks (compact type),
one device control block (trackball), and
one Multifunction Flexi Pad control block.

@ Transition control block
(compact type)
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‘L Cross-point control block

OMultifunction Flel-xi Pad
control block

@®Device control block )
(track ball)

© Cross-point control block

For details of operations, see “Cross-Point
Control Block” (page 45) and “CCP-6224
2M/E Control Panel” (page 97).

@ Transition control block (compact
type)

For details of operations, see “Transition

Control Block (Compact Type)” (page 94).

©® Device control block (track ball)

For details of operations, see “Device
Control Block (Trackball)” (page 60).

Names and Functions of Parts of the Control Panel

O Multifunction Flexi Pad control
block

For details of operations, see
“Multifunction Flexi Pad Control Block”
(page 101).




Cross-Point Control Block (CCP-6224/6324) in the AUX

Operating Mode

On the CCP-6224/6324, when using a [24-
column] cross-point control block, if the
[PRE MCROY] button is assigned to switch
to AUX operating mode, by pressing this

button you can switch the control block
button functions as follows, and select the
AUX bus and its source signals (AUX
panel-less function).

AUX cross-point buttons

AUX CTRL (AUX control) button

@ AUX control block

@AUX CTRL (AUX control) button
DEST (destination) button
OKEY button

‘ 3
‘

JUodoe
JUOdoe)

._ —

MCRO

ATTCH
ENBL
uTL

A/B bus control block

@Source/bus name displays

©OAUX DSPLY (AUX
display) button

© AUX control block

This selects the AUX bus and the assigned
source signals.

This cross-point control block can be
switched to AUX control mode with the
[AUX CTRL] button, and the key 1 row
used as AUX delegation buttons, and the
key 2 row used as AUX bus cross-point
selection buttons, with the source name
display showing the source names or the

bus names (AUX panel-less function). To
use this function, the function for switching
to AUX control mode must first be assigned
to the [PRE MCRO] and [POST MCRO]
buttons.

For the method of making this assignment,
see Chapter 19 “Control Panel Setup
(Panel)” (Volume 3).
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AUX delegation buttons: These select the
AUX bus. When you press a button,
turning it on, this selects the assigned
bus as the AUX bus. You can make the
rightmost button a [SHIFT] button, in
which case each button can be used to
select two buses.

For details of the buses that can be
selected, see “Bus Selection” (page 136).

AUX cross-point buttons: These select the
source signal to be assigned to the
AUX bus. When you press a button,
turning it on, this selects the assigned
video/key source signal and assigns it
to the bus selected with the AUX
delegation buttons. To select a key,
hold down the [KEY] button and press
the AUX cross-point button to which
the desired key signal is assigned. You
can make the rightmost button a
[SHIFT] button, in which case each
button can be used to select two video/
key source signals.

When one of the DME 1V/K to 4V/K
buses is selected with the AUX
delegation buttons, this selects the
video side currently visible on the
DME, and if you hold down
[repeatedly press] the AUX delegation
button, you can also select the reverse
side of the video.

©® AUX CTRL (AUX control) button
This switches the cross-point control block
to the AUX operating mode. However,
using this function requires an assignment
to have been made in the Setup menu.

For details of assigning the function for
switching to AUX operating mode, see
“Assigning the AUX Bus Control Mode
Switching Function” in Chapter 19
(Volume 3).

Names and Functions of Parts of the Control Panel

©® DEST (destination) button

When you press this button, turning it on,
the source name displays show the names
of the buses assigned to the AUX
delegation buttons.

O KEY button

When you press this button, turning it on,
the source name displays show the names
of the key source signals assigned to the
AUX cross-point buttons, and they are now
selectable.

© AUXDSPLY (AUX display) button
This switches the source name displays to
the AUX operating mode (by default
showing the video source signal names).

O A/B bus control block
Select the source signals for the background
A/B buses.

@ Source/bus name displays

In the AUX operating mode, these show the
information in the following table,
according to the states of the [AUX
DSPLY], [DEST], and [KEY] buttons.

[AUX [DEST] | [KEY] |Indication

DSPLY]

Off Off Off Background A/B
bus source signal
names

On Off Off Video source
signal names for
AUX bus

On On Off Bus names for
AUX bus

On Off On Key source signal
names for AUX
bus




Multifunction Flexi Pad Control Block

You can use the Multifunction Flexi Pad
control block for creating, saving, and
recalling snapshots, wipe snapshots, and

DME wipe snapshot key snapshots, effects,
shot box recall, macro execution, transition
rate settings, and key adjustments.

@ EDIT ENBL button

@ Mode selection
buttons

O Alphanumeric display

|0 Adjustment knobs

p S
SNAP SHOT
il

[

gooo

+
T

\ EDIT TRANS
NBL RATE

KEY

ADJ

DME DME

ME ME
1 2

gooo

TRIM

HEaE
HBaE
H8EE
H|BIE

USES DEV
4 1
\ J

ENTR

gooo

9
oo O
O
O

© Region selection
buttons

O Adjustment knob displays

@ Memory recall section

@ Mode selection buttons

EFF (effect): Press this to carry out effect
creation/recall/editing/execution/
deletion.

SNAPSHOT: Press this to carry out
snapshot creation/recall/editing/
deletion.

SHOTBOX: Press this to carry out shot
box creation/recall/editing/execution/
deletion.

MCRO (macro): Press this to carry out
macro creation/editing/execution/
deletion.

WIPE (wipe snapshot): Press this to carry
out wipe snapshot creation/recall/
deletion and wipe adjustments.

DME WIPE (DME wipe snapshot): Press
this to carry out DME wipe snapshot
creation/recall/deletion and DME wipe
adjustments.

TRANS RATE (transition rate): Press
this to set the transition rate.

KEY ADJ (key adjust): Press this to carry
out key adjustments and set modifiers.

KEY SS (key snapshot): Press this to carry
out key snapshot creation/recall/
deletion. By default, this is not
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assigned to a mode selection button, so
before use it is necessary to assign to a
mode selection button in the Setup
menu.

© EDIT ENBL (edit enable) button
By pressing this, turning it on, you can
carry out the following operations.

« Effect creation/editing

* Snapshot attribute setting

» Shot box creation/editing

* Macro creation/editing

* Wipe adjustments

* DME wipe adjustments

©® Region selection buttons

These select the function block to which

operations apply.

When the mode selection button selection is

EFF/SNAPSHOT/SHOT BOX/MCRO,

you can select multiple region selection

buttons simultaneously. In this case, the
first button pressed lights green as the
reference region, and the other buttons
pressed light amber (the buttons for the
regions shown in the memory recall section
are yellow).

ALL: Selects all regions. When any region
is selected, press this button to unset
the selection of all regions.

DMEI1 to DME2: Select DME channels.

M/E1, M/E2, P/P: Select the M/E-1, M/E-
2, and PGM/PST regions respectively.

USERA4: Selects the USER4 region.

DEV1: Selects the device 1 region.

MORE: Displays buttons in the memory
recall section for regions not assigned
to aregion selection button, so that they
can be selected. By default the
following regions are shown on the
memory recall section buttons.

MSTR (master snapshot, master
timeline registers), USER1 to 3,
USERS5 to 8, MCRO (macro),
DEV2 (device 2), PBUS, GPI,
RTR(router)

Names and Functions of Parts of the Control Panel

To revert the button displays in the
memory recall section, press the
[MORE] button once more, or press the
[EXIT] button that appears in the
memory recall section.

Note that except for the [ALL],
[EXIT], and [MORE] buttons, you can
freely change the assignment to regions
in the Setup menu.

O Alphanumeric display

This shows the selected region name or
register number, and entered numeric
values.

© Memory recall section

This comprises 16 LCD buttons, each with
a display that changes according to the
operating mode.

O Adjustment knob displays

Each of these shows the initial letter of the
parameter that can be adjusted with the
knob to the right, and the setting value
(three digit places, including the minus
sign).

© Adjustment knobs
Use these to adjust the parameters selected
with the memory recall section buttons.



Basic Menu Operations

Menu Organization

Operations on the MVS-8000 switcher
system make frequent use of menu
operations.

This section describes the menus and their
interrelationships.

If you display the menus in an external
monitor, operated with a mouse, the method
of operation is basically the same, but with
mouse clicks in place of button presses.
There is no difference in the menu control
block operation described here. However,
since the monitor has no knobs for
adjusting the parameters in the menu
control block, for details of operations
corresponding to these knob operations, see
the section below, “Operation With a
Mouse” (page 121).

Overview

All detailed settings for basic operations
such as transitions, keys, DME, or wipes,
are made in menus. There are also menus
for carrying out general system control,
managing setting data, and initial setup.

About the Top Menu List

When the control panel is powered on, the
top menu list appears as shown below.
You can also display this by selecting VF1
‘Top Menu List’ after pressing the [HOME]
button at the upper left in the top menu
selection button area of the menu control
block.

me [ me [ me
1 2 3

AU
‘MON

COLOR |
BKGD

[ FRAME |
MEM

COPY MISC

SWapP

STATS

DME GLE

To display the top menu

In the same way as for the top menu
selection buttons in the menu control block,
press each button to display the particular
top menu in the menu display.

The top menu list button is the same as the
default layout of the top menu selection
buttons. However, even if the assignment of
the top menu selection buttons is changed,
this does not affect the top menu list.

To shut down the menus

Press the [Shutdown] button at the lower
right.

This operation is the same as the shut down
operation in the top menu window.

For details, see “Shutting down the menus”
(page 125).

Basic Menu Operations
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Accessing Menus

You can use any of the following methods display a fixed page or the page selected
to access a menu, and the initially displayed last time you accessed the menu.
menu page depends on the method used. * Press the menu page selection button at
* Pressing a top menu selection button in the top left of the menu display.
the menu control block. The top menu window appears; press the
This displays the page you last accessed top menu selection button for the
in the particular menu. After initially particular menu, or enter the menu
powering on the system, however, the number with the numeric keypad, and
page of VF1 - HF1 of the particular menu press the Enter button.
is always selected. For details of the VF buttons and HF

Pressing a button other than a top menu
button twice in rapid succession (see
page 105).

Depending on the button, this may

buttons, see “Interpreting the Menu
Screen” (page 113).

Menus accessed from a top menu selection button

Buttons Menus Function See
HOME Home Recalling menus using the top Top menu list: page 103
menu list or shortcut menu Shortcut menu: page 127
M/E 1 M/E-1 Transition, keys, and wipe page 156 (transitions), page
settings for the M/E-1 bank 198 (keys), page 277 (wipes)
M/E 2 M/E-2 Transition, keys, and wipe
settings for the M/E-2 bank
M/E 3 M/E-3 Transition, keys, and wipe
settings for the M/E-3 bank
P/P PGM/PST Transition, downstream key, and
wipe settings for the PGM/PST
bank
FRAME Frame Memory Frame memory settings page 369
MEM
COLOR Color Bkgd Color background settings page 422
BKGD
AUX/MON | Aux/Mon AUX bus settings page 438
CCR CCR Color corrector settings page 445
COPY Copy/Swap Copy and swap settings page 426
SWAP
MISC Misc Safe title settings page 435
STATS Status Status display page 439
DME DME DME special effect settings Chapter 11 (Volume 2)
GLB EFF | Global Effect Global effect settings Chapter 11 (Volume 2)
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Menus accessed by pressing a button twice

For relevant buttons other than the top
menu selection buttons, pressing twice in
rapid succession directly recalls a related

menu page. The following table lists these

Cross-point control block

buttons of each control block, together with
the menus they recall. (XX represents the
HF menu recalled last in the VF menu.)

Buttons Menus See

FM1 to 8 signals assigned Frame Memory >Still >Recall page 379

buttons

Color Bkgd1 signal assigned | Color Bkgd >Color Bkgd1 page 422

button

Color Bkgd2 signal assigned | Color Bkgd >Color Bkgd2

button

CCR1 signal assigned button | CCR >CCR1 >XX Chapter 19
- - (Volume 3)

CCR2 signal assigned button | CCR >CCR2 >XX

FMS1 Frame Memory>Still>Recall

FMS2 Frame Memory>Still>Recall

Basic Menu Operations
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Buttons Menus Function See
RTR Router Destination, source and level page 440
selections
DEV Device Settings for external device Chapter 12 (Volume 2)
operation
MCRO Macro Macro register settings Chapter 16 (Volume 2)
KEY Key Frame Keyframe settings Chapter 13 (Volume 2)
FRAME
EFF Effect Keyframe effect register settings | Chapter 13 (Volume 2)
SNAP Snapshot Snapshot register settings Chapter 14 (Volume 2)
SHOT
SHOTBOX | Shotbox Shotbox register settings Chapter 15 (Volume 2)
FILE File File settings Chapter 17 (Volume 2) -
ENG Engineering Setup | Setup functions Chapter 18 to Chapter 24 —
SETUP (Volume 3) —
DIAG Diagnosis Status information display Appendix (Volume 3)
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Transition control block (standard type, compact type)

Buttons Menus See
KEY1 (DSK1) a) * M/E-1, 2, 3 >Key1 >XX page 204
* PGM/PST >DSK1 >XX
KEY2 (DSK2) @ o M/E-1, 2, 3 >Key2 >XX
* PGM/PST >DSK2 >XX
KEY3 (DSK3) @ * M/E-1, 2, 3 >Key3 >XX
¢ PGM/PST >DSK3 >XX
KEY4 (DSK4) @ * M/E-1, 2, 3 >Key4 >XX
¢ PGM/PST >DSK4 >XX
WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 277
DME M/E-1, 2, 3, PGM/PST >DME Wipe >XX page 334
—— SUPER MIX M/E-1, 2, 3, PGM/PST >Misc >Transition page 157
—— PST COLOR MIX M/E-1, 2, 3, PGM/PST >Misc >Transition page 158
Q FM1&2 CLIP, M/E-1, 2, 3, PGM/PST >Misc >Clip Transition page 408
5 FM3&4 CLIP,
5] FM5&6 CLIP,
> FM7&8 CLIP
§ PRIOR SET M/E-1, 2, 3, PGM/PST >Misc >Key Priority page 153
E KEY PRIOR M/E-1, 2, 3, PGM/PST >Misc >Next Key Priority page 154
% WIPE (Independent key * M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe page 303
) transition type selection Adjust >Pattern Select
5 button (standard type)) ¢ PGM/PST >DSKT1, 2, 3, 4 >Transition >Wipe
3 Adjust >Pattern Select
% DME (Independent key e M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >5DME Wipe | page 345
- transition type selection Adjust >1ch Pattern Select
button (standard type)) * PGM/PST >DSK1, 2, 3, 4 >Transition >5DME Wipe
Adjust >1ch Pattern Select
K-SS STORE Snapshot >Key Snapshot >XX Chapter 14
(Volume 2)
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a) Including the key delegation buttons of the transition control block (standard type).

Independent key transition control block (simple type) a)

Buttons Menus See
WIPE ¢ M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe page 303
Adjust >Pattern Select
¢ PGM/PST >DSKT1, 2, 3, 4 >Transition >Wipe
Adjust >Pattern Select
DME ¢ M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >5DME Wipe | page 345

Adjust >1ch Pattern Select
¢ PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe
Adjust >1ch Pattern Select
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Independent key transition control block (simple type) a)

Buttons Menus See
SHIFT ¢ M/E-1, 2, 3 >Key1, 2, 3, 4 >XX page 204
¢ PGM/PST >DSK1, 2, 3, 4 >XX
a) The menu to be recalled depends on the setup of the key assignment.
Flexi Pad control block (standard type)
Buttons Menus See
WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 277
DME M/E-1, 2, 3, PGM/PST >DME Wipe >XX page 334
SNAPSHOT Snapshot >Snapshot >XX Chapter 14
(Volume 2) fe—
EFF Effect >Effect 1-99 >XX Chapter 13 —
(Volume 2) e
SHOTBOX Shotbox >Register >Store/Recall Chapter 15 Q
(Volume 2) 1
(0]
MCRO Macro >Register >XX Chapter 16 o
(Volume 2)
<
@
2
Key control block @ °
>
Buttons Menus See ES
KEY1 o M/E-1, 2, 3 >Key1 >XX page 204 g—
¢ PGM/PST >DSK1 >XX -
KEY2 ¢ M/E-1, 2, 3 > Key2 > XX %
* PGM/PST >DSK2 >XX -
KEY3 e M/E-1, 2, 3 >Key3 >XX
* PGM/PST >DSK3 >XX
KEY4 ¢ M/E-1, 2, 3 >Key4 >XX
* PGM/PST >DSK4 >XX
LUM e M/E-1, 2, 3 >Key1, 2, 3, 4 >Type page 205
LIN e PGM/PST >DSK1, 2, 3, 4 >Type
CVK
PTN
CRK * M/E-1, 2, 3 >Key1, 2, 3, 4 >Type >Chroma Adjust | page 210

PGM/PST >DSK1, 2, 3, 4 >Type >Chroma Adjust

a) The menu recalled depends on which of the M/E delegation buttons and key delegation buttons

are selected in the key control block.

Basic Menu Operations
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Numeric keypad control block

Buttons Menus See
EFF * Effect >Effect 1-99 >XX ?) Chapter 13
* Effect >Master Timeline >Store © (Volume 2)
SNAPSHOT * Snapshot >Snapshot >XX ?) Chapter 14
¢ Snapshot >Master Snapshot >Store c) (Volume 2)
SHOTBOX Shotbox >Register >Store/Recall Chapter 15
(Volume 2)
MCRO Macro >Register >XX Chapter 16
(Volume 2)
TRANS RATE @ Misc >Transition page 166
STORE RCALL Key Frame >Region Select 9 Chapter 13
(Volume 2)
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a) The menu recalled depends on which of the M/E-1 to M/E-3 banks and PGM/PST bank the
numeric control block is delegated to.

b) When other than [MASTR] is selected with the region selection buttons.

¢) When [MASTR] is selected with the region selection buttons.

d) When the [SNAPSHOT] button or [EFF] button is set to On, or lit green.

Downstream key control block a)

Buttons

Menus

See

DSK1

e M/E-1, 2, 3 >Key1 >XX
* PGM/PST >DSK1 >XX

DSK2

e M/E-1, 2, 3 >Key2 >XX
* PGM/PST >DSK2 >XX

DSK3

¢ M/E-1, 2, 3 >Key3 >XX
¢ PGM/PST >DSK3 >XX

DSK4

¢ M/E-1, 2, 3 >Key4 >XX
¢ PGM/PST >DSK4 >XX

page 204

WIPE

¢ M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe
Adjust >Pattern Select

¢ PGM/PST >DSK1, 2, 3, 4 >Transition >Wipe
Adjust >Pattern Select

page 303

DME

¢ M/E-1, 2, 3 >Key1, 2, 3, 4 >Transition >Wipe
Adjust >Pattern Select

¢ PGM/PST >DSK1, 2, 3, 4 >Transition >DME Wipe
Adjust >Pattern Select

page 345

K-SS STORE D)

Snapshot >Key Snapshot >XX

Chapter 14
(Volume 2)

a) The menu recalled depends on which of keyers 1 to 4 the downstream key control block is

delegated to.
b) Recalling is possible only when the [K-SS] button is On.
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Auxiliary bus control block

Buttons Menus See
FMS1, FMS2 Frame Memory >Still >Freeze/Store page 376
FM1 to 8 signals assigned Frame Memory >Still >Recall page 379
buttons
Color Bkgd1 signal assigned | Color Bkgd >Color Bkgd1 page 422
button
Color Bkgd2 signal assigned | Color Bkgd >Color Bkgd2
button
CCR1 signal assigned button | CCR >CCR1 >XX Chapter 19
CCR2 signal assigned button | CCR >CCR2 >XX (Volume 3)
Device control block (trackball or joystick)
Buttons Menus See
DME1 to DME8 @ DME >XX Chapter 11 Q
(Volume 2) s
DEV1 to DEV12 assigned « Device >DDR/VTR >Cueup & Play ® Chapter 12 %
buttons « Device >DDR/VTR >Timeline © (Volume 2) =
@
FM1CLIP to FM8CLIP Frame Memory >Clip >Recall page 396 2
assigned buttons -
>
K1to K49 e M/E-1, 2, 3>Key1, 2, 3, 4 >Processed Key page 255 ?‘)
¢ PGM/PST >DSK1, 2, 3, 4 >Processed Key S
a) When the three-dimensional transformation operation mode is enabled. S
b) When the [MENU] button is Off. g
¢) When the [MENU] button is On. ©
d) For the MVS-8000G in resizer control mode
Device control block (search dial)
Buttons Menus See
DEV1 to DEV12 + Device >DDR/VTR >Cueup & Play @ Chapter 12
« Device >DDR/VTR >Timeline ©) (Volume 2)
FM1CLIP to FM8CLIP Frame Memory >Clip >Recall page 396
assigned buttons
a) When the [TIMELINE] button is Off.
b) When the [TIMELINE] button is On.
Downstream key/fade-to-black control block
Buttons Menus See
DSK1, DSK2 « PGM/PST >DSK1, 2 >XX @ page 204

a) When a key other than DSK1 or DSK2 is assigned, the menu for the corresponding key appears.
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Transition control block and Flexi Pad control block (simple type)

Buttons Menus See
KEY1 (DSK1) o M/E-1, 2, 3 >Key1 >XX page 204
¢ PGM/PST >DSK1 >XX
KEY2 (DSK?2) o M/E-1, 2, 3 >Key2 >XX
* PGM/PST >DSK2 >XX
WIPE ¢ M/E-1, 2, 3 >Wipe >Main Pattern page 277
* PGM/PST >Wipe >Main Pattern
DME ¢ M/E-1, 2, 3 >DME Wipe >XX page 334
¢ PGM/PST >DME Wipe >XX
SNAPSHOT Snapshot >Snapshot >XX Chapter 14
(Volume 2)
MCRO @ Macro >Register >XX Chapter 16
(Volume 2)
a) When the button is assigned to macro function in the Setup menu.
Multifunction Flexi Pad conrol block
Buttons Menus See
WIPE M/E-1, 2, 3, PGM/PST >Wipe >Main Pattern page 277
DME WIPE M/E-1, 2, 3, PGM/PST>DME Wipe>xxx 2 page 334
SNAPSHOT When the [MSTR] button is On. Chapter 14
Snapshot>Master Snapshot>Store (Volume 2)
When the [MSTR] button is Off
Snapshot>Snapshot>xxx @
EFF When the [MSTR] button is On Chapter 13
Effect>Master Timeline>Store (Volume 2)
When the [MSTR] button is Off
Effect>Effect 1-99>xxx )
SHOTBOX Shotbox>Register>Store/Recall Chapter 15
(Volume 2)
MCRO Macro>Register>xxx ) Chapter 16
(Volume 2)
TRANS RATE Misc>Transition page 436
KEY SS Snapshot>Key Snapshot>xxx 2 Chapter 14
(Volume 2)
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Multifunction Flexi Pad conrol block

Buttons Menus See
KEY ADJ > KEY1 M/E1, 2, 3 >Key1 >xxx a) page 204
PGM/PST >DSK1 >xxx 2
KEY2 M/ET, 2, 3 >Key2 >xxx @
PGM/PST >DSK2 >xxx 2
KEY3 M/E1, 2, 3 >Key3 >xxx 2)
PGM/PST >DSK3 >xxx
KEY4 M/E1, 2, 3 >Key4 >xxx )
PGM/PST >DSK4 >xxx 2
LUM M/E-1 >Key1, 2, 3, 4 >Type page 205
LIN
WIPE PTN M/E-1 >Key1, 2, 3, 4 >Type
M/E-2 >Key1, 2, 3, 4 >Type
M/E-3 >Key1, 2, 3, 4 >Type
PGM/PST >DSK1, 2, 3, 4 >Type
CRK M/E-1 >Key1, 2, 3, 4 >Type >Chroma Adjust page 207
M/E-2 >Key1, 2, 3, 4 >Type >Chroma Adjust
M/E-3 >Key1, 2, 3, 4 >Type >Chroma Adjust
PGM/PST >DSK1, 2, 3, 4 >Type >Chroma Adjust
KEY SS KEY1 M/ET, 2, 3 >Key1 >xxx @ page 204
PGM/PST >DSK1 >xxx 2
KEY2 M/E1, 2, 3 >Key2 >xxx @
PGM/PST >DSK2 >xxx
KEY3 M/ET, 2, 3 >Key3 >xxx @
PGM/PST >DSK3 >xxx 2
KEY4 M/E1, 2, 3 >Key4 >xxx @)
PGM/PST >DSK4 >xxx 2

a) “xxx” represents the last accessed page of the relevant menu.
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Displaying a Menu

To display, for example, the M/E-1 >Key]1

>Type menu, use either of the following

operations.

¢ Press the top menu selection button [M/E
1], then press the VF1 ‘Key1’ button and
the HF1 “Type’ button in that order.

* Press the menu page number button in the
upper left corner of the menu screen to
display the top menu window, then enter

the page number of the M/E-1 >Keyl
>Type menu, which is 1111, and press
the [Enter] button. (For details of the
menu page numbers, see “Menu Tree”

(page 519).)

The M/E-1 >Key15 >Type menu appears in
the menu display as follows.

© Status area

@ Menu page number button

© Menu title
button

@® <« (previous) button and » (next)
button

O Function button area —————
@ Parameter group button

@ Keyframe status

| Edge Main Mask

Matte

8H Drop

[Source Proc Key On Trans

WHIT of

Key Type

Luminance Linear Chroma

—_—
Ke!

| Key Invert
Y Puglllnn

DME Wipe

Self

Edge Main Mask = Sub Mask

Default
Recall

@ el
3 = Key2

Key Sour

Processed

Sub Mask Video Proc

Off Trans Priority

1 = Key4

| Key Wipe

Wipe
Pattern Patlern

Ke:
Frls:mly
I

= 0.00

/Density

Transition Videa

Process

Default recall button

© VF buttons

$ HF buttons

O Knob
parameter
buttons

© Previous page button

M/E-1 >Key1 >Type menu
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Interpreting the Menu
Screen

The menu screen consists of the following
principal parts.

When buttons on the screen are lit or
represented in a depressed state, this
indicates that the corresponding item or
function is selected (set on).

© Menu title button

This shows the title of the menu screen.
You can set different colors for the main
menu site and subsidiary menu site (see
page 127).

© Menu page number button

This shows the menu screen page number.
When you press this button, the top menu
window (see page 124) appears. You can
enter the page number for the desired menu,
or press one of the top menu selection
buttons in the window, to display that
menu.

While the system is accessing the hard disk,
the indicator lights red.

Indicator for frame
l memory external hard disk
o——— Indicator forinternal hard

disk

When the indicator is lit, do not power off
the switcher, or disconnect the IEEE1394
cable V.

1) When an external hard disk drive is connected

© VF buttons
These indicate the larger subdivisions of
this menu.

Depending on the selected item, the menu
screen contents including the HF button
indications change.

O HF buttons

These indicate the items within the menu.

Depending on the selected item, the menu

indications change.

Depending on the function, if any one is on,
the status is shown by an orange bar, as in
the following figure.

Input
Process

© Status area

This shows the status of the settings items
controlled by the selected menu.

An orange frame appears around the
parameter area relating to the displayed
menu. For each of the twelve areas,
pressing the display jumps to the related
menu.

® Function button area

This shows the functions which can be
operated in the currently selected menu by
means of buttons.

Each function button corresponds to a
function which can be set in the currently
selected menu. Press it to enable the
function, to display a parameter group and
adjust the parameters with the knobs, or to
execute the function.

These buttons are in groups by function. In
the screen example shown on the previous
page, the [Key Bus] and [Matte] function
buttons constitute the <Key Fill> group.

@ Parameter group button

This displays parameter group names for
which the knobs can make adjustments, the
current parameter setting page number, and

Basic Menu Operations
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the total number of the parameter setting
pages. (Example: Color Vector 1/2)

When there are more than five parameters
within the same parameter group, press this
button to display the sixth and subsequent
parameters, which can then be controlled
by the knobs.

© Knob parameter buttons

These show the parameters currently
controlled by the knobs and their values.
Pressing one of these buttons displays the
numeric keypad window (see page 121),
and you can then enter a new value for the
corresponding parameter with the numeric
keypad.

© Previous page button

This shows the page number of the
previously displayed menu screen. Press it
to go back to that page. When the indication
[Parent] appears, this displays the parent
directory.

@ Keyframe status

This shows the keyframe status of the

reference region. Pressing this button

switches the menu screen as follows.

When a menu other than the Key Frame
menu is currently shown: The menu
screen switches to the Key Frame
menu.

When the Key Frame menu is currently
shown: The menu screen switches to
the menu that was on the screen
immediately before the Key Frame
menu.

In some parts of menus such as the File

menu, this functions as a “Region selection

area,” for selecting the region to which
operations apply.

@ Default recall button

This only appears in those menus for which
the default recall function is available. (See

Basic Menu Operations

“Menus allowing a return to default

settings” (page 117).)

Press this button, turning it on, then press a

VF button or knob parameter button to

return the settings to their default values, in

the following groupings.

* Function grouping: the functions within
an HF menu under the VF button

* Knob parameters (parameters currently
controlled by the knobs)

® <« (previous) button and » (next)
button

The <« button returns to the previous menu.

Press the P button to continue to the next

menu.

Menu Operations

The method of menu operation is basically
the same when using a mouse with an
external monitor, but with mouse clicks in
place of button presses. There is no
difference in the menu control block
operation described here.

However, since the monitor has no knobs
for adjusting the parameters in the menu
control block, for details of operations
corresponding to these knob operations, see
the section below, “Operation With a
Mouse” (page 121).

Selecting an item

1 Press the VF button (1 to 7) for the
desired group of items.

The HF button (1 to 7) indications
change to show the items within the
selected group.

2 Press the HF button for the desired
item.



The indications in the status area and
function button area change, and you
can now make various changes to the
selected item.

Selecting a function
Press the appropriate function button within
the function button area.

Shape and color of the button
Pressing the button turns it on, and it lights,
showing the state.

Luminance

Lit pale blue: The function is enabled, and
the parameters can currently be
adjusted with the knobs.

Lit orange: The function is enabled.

Lit purple: Execution button. Pressing the
button immediately executes the
function. (Example: [Auto Start]
button in the Chroma Adjust menu)

Chroma
Adjust

Pressing a button of this type displays a
further menu, allowing more detailed
settings. (Example: [Chroma Adjust]
button in the Type menu)

Setting parameters

]
C—mml N |
]

This marking on a function button indicates
that there are parameters which can be
adjusted with the knobs.

Pressing this function button assigns

parameters to the knobs.

You can set the parameter values by either

of the following methods.

* Turn the knob (1 to 5) corresponding to
the parameter, to adjust the value.

* Press the knob parameter buttons (1 to 5)
corresponding to the parameter. This
displays the numeric keypad window
allowing you to enter the desired value.

In the description of specific setting
procedures, the knob adjustment is
described, as follows.

Example: When wipe pattern key is selected

Knob Parameter Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
Soft Edge softness 0.00 to 100.00
Density Key density 0.00 to 100.00

When the [MENU] button in the device

control block is lit, you can use the trackball

and Z-ring to control the parameters.

¢ Move the trackball on the x-axis to
control the parameter for knob 1 or on the
y-axis to control the parameter for knob
2. Moving up or to the right increases the

parameter value, and moving down or to
the left decreases the parameter value.

* Use the Z-ring to adjust the parameter for
knob 3. Turning clockwise increases the
parameter value, and turning
counterclockwise decreases the
parameter value.
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Going back to the previous menu
To return to the last displayed menu, press
the previous page button.

Returning to default state in function
groupings

1 Press the [Default Recall] button,
turning it on.

This enters the menu default recall
mode.

2 Press the VF button you want to return
to the default state.

This returns the settings within the
function grouping to the default state,
and the [Default Recall] button goes
off.

The default state of the settings depends on
the setting of the initial status mode, set in

the Setup menu of system setup, as follows.

User: The state when [Initial Status Define]
is executed.
Factory: Factory default settings

Returning knob parameters to
default state

1 Press the [Default Recall] button,
turning it on.

This enters the menu default recall
mode.

2 Press the knob parameter button you
want to return to the default state.

This returns the knob parameter value
to the default state, and the [Default
Recall] button goes off.

Basic Menu Operations

* Inthe following table, “Menus allowing a
return to default settings,” the default
recall function does not apply to some
knob parameters.

For details, see the table, “Knob
parameters to which default recall does
not apply” on page 118.

The default recall function does not
return the horizontal (H) and vertical (V)
position settings to their default state
individually. Returning the horizontal
(H) position to its default state also
returns the vertical (V) position to its
default state automatically, and vice
versa. For details, see the table, “Knob
parameters subject to restriction on
default recall” on page 120.



Menus allowing a return to default settings

Top menu selection button | VF nhumber Menu number Menu name
name (HF number)
M/E1 VF1 1110-series Key1 @
VF2 1120-series Key2 @
VF3 1130-series Key3 @
VF4 1140-series Key4 @
VF5 1150-series Wipe @
VF6 1160-series DME Wipe @
VF7 1170-series Misc &
M/E2 VFA1 1210-series Key1 @ —
VF2 1220-series Key2 2 —
VF3 1230-series Key3 @ ;3?
VF4 1240-series Key4 @ %
VF5 1250-series Wipe @ ;
VF6 1260-series DME Wipe @ éb
VF7 1270-series Misc & %
M/E3 VF1 1310-series Key1? §
VF2 1320-series Key2 @ ;3;;
VF3 1330-series Key3 @ 3
VF4 1340-series Key4 @
VF5 1350-series Wipe @
VF6 1360-series DME Wipe @
VF7 1370-series Misc &
P/P VF1 1410-series DSK1 @
VF2 1420-series DSK2 @
VF3 1430-series DSK3 3
VF4 1440-series DSK4 @
VF5 1450-series Wipe @
VF6 1460-series DME Wipe @
VF7 1470-series Misc &
COLOR BKGD VF1 2210 Color Bkgd 13
VF2 2220

Color Bkgd 2@

Basic Menu Operations

117



|oued |0J1U0D pue shusy g Jeideyn

Top menu selection button | VF nhumber Menu number Menu name
name (HF number)
CCR VF1 2410-series CCR12
VF2 2420-series CCR2?
FRAME MEM VF1 2510-series Sill P
VF2 2520-series Clip?
VF3 2530-series Reposition/Lock P
VF4 2540-series File ®)
VF5 2550-series Folder P
AUX/MON VF1 2311 Aux Bus ?)
DME VF1 4110-series Edge?
VF2 4120-series Video Modify )
VF3 4131 Freeze ®)
VF4 4141 Non-Linear ?)
VF5 4150-series Light/Trail ®
VF6 4160-series Input/Output ®
VF7 4170-series Enhanced Video
Modify ®)
GLB EFF VF1 4210-series Ch1—Ch4 b
VF2 4220-series Chs-Chg
KEY FRAME (HF3) 6113 Path ®

a) Menu to return to the default settings for particular functions or for particular knob parameters
(for the relevant knob parameters, see page 118)

b) Menu to return to the default settings for particular knob parameters (for the relevant knob
parameters, see page 118)

Knob parameters to which default recall does not apply

Menu number @ | Menu name Button name Knob Parameter
1111 Type [Luminance] and [Linear] in 4 Filter
<Key Type> group
[Color Vector] in <Key Type> 1 Y Filter,
group 2 C Filter
(Parameter
group [2/2])
1111.1 Type >CRK Adjust | [Key Active] 5 Filter
[Color Cancel] in <Color 5 Filter

Cancel> group
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Knob parameters to which default recall does not apply

Menu number @ | Menu name Button name Knob Parameter
1112.1 Edge >Matte [Mix Color] in <Edge Matte> 5 Pattern
group
[Multi] 3 Invert Type
1113 Main Mask [Pattern] 5 Pattern
[Multi] 3 Invert Type
1116 Transition [Wipe] in <ON Transition Type> |1 Transition
group Rate
5 Pattern
[Wipe] in <OFF Transition Type> | 1 Transition
group Rate
5 Pattern
[Key Blink] and [Edge Blink] in 1 Blink Rate e —
<Blink> group —_—
[Mix] in <Transition Type> group |1 Transition o
Type 5
'9_
[Wipe] in <Transition Type> 1 Transition e
group Rate N
5 Pattern %
1116.1 Transition > [Multi] 3 Invert Type (En
Wipe Adjust [H] and [V] in <Pairing> group 1 Width g
[H], [V], and [Fringe] in 4 Shape 1%
<Modulation> group g—
1154 Edge/Direction [Split] in <Edge> group 1 Split No §
1154.1 Edge/Direction > | [Mix Color] in <Edge Matte> 3 Pattern 3
Matte Adjust group
[Multi] 3 Invert Type
1155 Main Modify [H] and [V] in <Pairing> group 1 Width
[H], [V], and [Fringe] in 4 Shape
<Modulation> group
1164 Edge/Direction [Independent Trans Rate] in 1 Transition
<Pattern Limit Release> group Rate
1171 Transition [Mix], [Nam], [Super Mix], 1 Transition
[Preset Color Mix], [Wipe], [DME Rate
Wipe], and [FTB] in <Transition
Type> group

a) The menu numbers shown by way of example are those for M/E-1: the same applies for M/E-2,

M/E-3, and P/P. Also, content applying to Key1 applies equally to Key2, Key3, and Key4.
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Knob parameters subject to restriction on default recall

Menu number | Menu name Button name Knob | Parameter
11111 @ Type >CRK Adjust | [Sample Mark] in the <Auto> group | 1 Position H
2 Position V
11121 @ Edge >Matte [Position]
Adjust
11139 Main Mask [Position]
1116.1 @ Transition >Wipe | [Position]
Adjust
1116.3 @ Transition >5DME | [Position] 1 H
Wipe Adjust 2 \Y
1154.1 @ Edge Direction [Position] 1 Position H
>Matte Adjust 2 Position V
—— 1155 @ Main Modify [Position] in the <Position> group
— 1155.1 @ Main Modify [Position]
o >Multi Adjust
>
S 1156 @ Sub Modify [Position] in the <Position> group
[0]
N 1156.1 @ Sub Modify >Multi | [Position]
=z Adjust
[0]
2 2122.2 Composite [Position] 1 Position H
- >Pattern Adjust 2 Position V
3
g 2131 Reposition [Normal]
s [Black&White]
; 2210 Color Bkgd1 ® | [Position]
2 2412.1©) Primary CCR [Position]
>Mask1 Adjust 9
4116 DME >Edge [Position/Size] 5 Pattern
>Wipe Crop
4127 DME >Video [Position/Size]
Modify >Mask

a) The menu numbers shown by way of example are those for M/E-1: the same applies to M/E-2,
M/E-3, and P/P. Equally, content applying to Key1 applies equally to Key2, Key3, and Key4.

b) The same applies to Color Bkgd?2.

¢) The menu numbers shown by way of example are those for CCR1: the same applies to CCR2.

d) The sample applies to Mask2 Adjust.
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Operation With a Mouse

If you display the menus in an external
monitor, operated with a mouse, then you
click the mouse instead of pressing a button
as described in the previous section, “Menu
Operations.”

However, in the following cases there are
special operations with a mouse.

To set parameters

To adjust the value of a knob setting

parameter button with the mouse, you can

use either of the following three methods.

* Position the cursor over the knob setting
parameter button for which you want to
adjust the value, and turn the mouse
wheel.

* Position the cursor over the knob setting
parameter button for which you want to
adjust the value, then hold down the right
mouse button, and drag the bar showing
the setting to the desired value.

¢ Position the cursor over the knob setting
parameter button for which you want to
adjust the value, then click the left mouse
button to open the numeric keypad
window by whick you can input the
desired value.

To scroll a list
Position the cursor over the list you want to
scroll, and turn the mouse wheel.

In the setup menus you can select the
direction of mouse wheel rotation that
increases the setting value. And you can
also switch the functions of the right and
left mouse buttons.

For details, see Chapter 19 “Control Panel
Setup (Panel)” (Volume 3).

Numeric keypad window

© ltem display
@ Max./min. value indication
Input value

© Item display
This is the name of the parameter being set
in the numeric keypad window.

@ Max./min. (maximum/minimum)
value indication

This shows the maximum and minimum

settings of the parameter.

©® Input value
This is the value being input into the
numeric keypad window.

O Close button
This closes the numeric keypad window.

© TC (timecode) button

When the numeric keypad window is
opened for a setting requiring a timecode
value to be entered, this button appears in a
depressed state.

You can enter a timecode value in the range
that depends on the signal format (see
“Setting the Signal Format (Format

Basic Menu Operations
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Menu)” in Chapter 18 (Volume 3)) as
follows:
00:00:00:00 to 23:59:59:nn,
where nn = (number of frames per
second) — 1.

O - (minus) button
This toggles the sign of the entered value.
When it is pressed, the value is negative.

© Clear button
This clears the input. It does not change the
parameter setting.

Keyboard window

Except when changing source names, the
following characters cannot be used. The
same applies to macro file editing.
space, \, /, 3, ;, , (comma), . (dot), <, >,
k 9 on |

ERRE I

Basic Menu Operations

©® Trim button

After entering the difference from the
current value, press this button to confirm
the numeric input.

© Enter button

This confirms the entered value.

If correctly set, the numeric keypad
window closes.

If not correctly set, the input display
changes color.



O BS button
@ Input string

© ltem display © Close button

Shift button

“—@ Caps Lock button

Space button

® Right button /
® Enter button J

button

Lefl High

Clear Del

@ Left button

© Del button
© Clear button

© Item display
This is the name of the parameter being set
in the keyboard window.

© Input string
This is the character string being input in
the keyboard window.

©® Close button
This closes the keyboard window.

O BS button
This clears the character immediately
before the cursor in the input string.

© Caps Lock button
This enables input of capital letters only.

You can enter items to be displayed on the
control panel LCD using lowercase letters,
but these will be converted to capitals for
display.

MS-DOS does not distinguish case in
filenames, and therefore you are
recommended to enter filenames in capital
letters.

0O Shift button
This selects the characters on the shift side
of the keys. The shift is released when you
enter a character.

@ Space button
This enters a space character.

Basic Menu Operations
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© Clear button
This clears all of the characters in the input
string.

© Del button
This clears the character immediately after
the cursor in the input string.

@ Left button
This moves the cursor one character to the
left in the input string.

@® Right button
This moves the cursor one character to the
right in the input string.

Function of the top menu window

@ Enter button

This sets the input string as a parameter
value, and closes the keyboard window if
the value has been entered correctly. If the
value has not been entered correctly, the
display color changes.

@® Line feed button
After pressing the Shift button, press this
button to feed a line. The input string shows

“|7’

© Top menu selection buttons

ME = ME ’
2 3 P

COLOR  AUX
BKGD CCR

/MON

GLB
DME EFF

SNAP | SHOT

KEY
EFF ' ShoT | BOX

FRAME

ENG
setup  DIAG

@ Shut down button

D Add Favorite button

Sle—O Close button

B Numeric entry section

e=——@ Clear button

Clear

—— @ Enter button

© Top menu selection buttons

These are the same as the top menu
selection buttons in the menu control block.
Pressing one of these buttons closes the top

Basic Menu Operations

menu window and displays the selected
menu in the menu display.




© Input display
This shows the page number entered with
the numeric entry section.

© Numeric entry section
Enter a page number.

O Clear button
Press this to clear the input display.

© Enter button

Pressing this button without entering a page
number closes the top menu window with
the current menu remaining in the menu
display.

If you enter a page number then press this
button, this confirms the value in the input
display. If it is a correct page number, the
top menu window closes, and the menu
display shows the new menu. If it is not
correctly set, the input display changes
color.

0O Close button
Press this to close the top menu window.

© Shut down button
Shuts down the menus.

Be sure to shut down the menus before
powering off the control panel.

Shutting down the menus

1 In the menu screen, press the menu
page number button to open the top
menu window.

Fordetails of the top menu window, see
“Function of the top menu window”
(page 124).

2 Press [Shut down].

A confirmation message appears.

3 Press [Yes].

This shuts down the menu system after
a while, and the menu display changes
to black. Now power off the system.

To restart menu operations
Power on the control panel once more.

© Add Favorite button

Pressing this button allows the currently
displayed menu to be registered to the
Shortcut menu.

Registering a menu to the
Shortcut menu

1 In the Home >Favorites >Shortcut
menu, select the desired group.

2 Display the menu you want to register,
and then press the [Add Favorite]
button.

The currently displayed menu is
automatically registered to a blank
button.
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Use of the color palette window

When a parameter is assigned to the knobs
as a combination of luminance, saturation,

and hue, pressing a knob parameter button
displays a color palette window.

Color Palette

©Color palette
buttons

@Operation
buttons

©Color display

Luminance

Close

0.00 ... 100.00

6 Clear

Cancel

ONumeric
keypad

© Color palette buttons

Press one of these to enter the
corresponding color in the display.

By default the following settings are
available.

First row: white, yellow, cyan, green
Second row: magenta, red, blue, black
Third row: all black

© Operation buttons

Set: If you press any color palette button
with this button held down, the color
shown in the color display is assigned
to the color palette button.

Copy: If you press a color palette button
with this button held down, the color is
used as the source for copying. Next
press a different color palette button to
copy to that button.

Basic Menu Operations

Swap: If you press two color palette
buttons in sequence with this button
held down, the two colors are swapped.

Default: If you press any color palette
button with this button held down, the
color palette button is set to the default
color.

©® Color display

This shows the setting color, and the

parameters (LUM, SAT, and HUE).

By adjusting the parameters with the knobs,

you can create any color.

If a parameter value is outside the permitted

range for RGB (0 to 255), the indication

“Illegal Color” appears, and this is adjusted

to a value in range.

Cancel: Pressing this button returns to the
state when the color palette window
was opened.



O Numeric keypad
Use this to enter numeric values for
parameters.

For details of use, see page 121.

Switching Between the
Main Menu Site and
Subsidiary Menu Site

For menu transitions, you can store two
separate versions in the main and subsidiary
menu sites.

By switching sites, and pressing the «
button and the P button you can trace the
history in each menu.

To switch the subsidiary menu
site on and off

Assign [SUB MENU SITE] to a menu
control block top menu selection button or
user preference button. To switch to the
subsidiary menu site, press this button,
turning it on.

For details of the assignment operation, see
“Assigning Functions to the Menu Control
Block Top Menu and User Preference
buttons” in Chapter 19 (Volume 3).

Shortcut Menu

Recalling a menu using the
shortcut menu

1 In the Home menu, select VF2
‘Favorites’ and HF1 ‘Shortcut.’

The following menu appears.

2 In the [Group Select] box, select the
group.

The group buttons appear.
3 Press the button for the desired menu.

Creating a shortcut menu

Assign frequently used menus to buttons, to
create a “Favorites” menu.

To create a menu group

1 In the Home menu, select VF2
‘Favorites’ and HF1 ‘Shortcut.’

The following menu appears.

2 Press [Group Edit].

The following menu appears.
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3 With the cursor, select the group name
(in this case a blank button) for the
operation.

4 Press [Rename].

A keyboard window appears.

5 Enter a group name (maximum 24
characters), and press Enter.

This confirms the group name.
To copy a menu group

1 In the Home >Favorites >Group Edit
menu, press the button for the copy
source group.

2 Press [Copy].

3 Press the button for the copy
destination group.

4 Press [Paste].

This copies the menu group settings.
To delete menu group settings

1 In the Home >Favorites >Group Edit
menu, select the group to be deleted.

2 Press [Clear].

A confirmation message appears.

Basic Menu Operations

3 Press [Yes].

This deletes the settings.

To register a menu on a button
You can register 15 buttons in one group.

1 In the Home >Favorites >Shortcut
menu, press [Button Edit].

osition

1265

Position

Button name Pattern

Select

2 Move the cursor to the position where
you want to display the button. To
change the content of an already
displayed button, press the button to
select it.

3 Press [Page Set].

A page number input window appears.

4 Enter the page number for the menu
you want to register.

5 Press [Rename].

A keyboard window appears.

6 Enter the button name (maximum 24
characters).



7 To change the button color, press
[Color Set].

Button color samples appear.

8 Press the desired color.

This completes the assignment of the
menu to the button.

9 Repeat steps 2 to 8 to complete the
“Favorites” menu.

To copy button settings

1 In the Home >Favorites >Button Edit
menu, press the copy source button to
select it.

2 Press [Copy].

3 Press the copy destination button to
select it.

4 Press [Paste].

This copies the button settings.

To delete button settings

In the Home >Favorites >Button Edit
menu, press [Clear].

This deletes the button settings.

The shortcut menu settings are handled as
part of the control panel setup. You can
recall and save them in the same way as
setup data.

Basic Menu Operations
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Chapter 3 Signal Selection and
Transitions

Video Processing Flow
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Video Processing Flow

The switch from the current video stream (appearing on the corresponding
program monitor) to a new video stream is referred to as a transition.

The following illustration shows the flow of operations for carrying out a
transition on an M/E bank or the PGM/PST bank.

Video Processing Flow
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Select current background video

(page 135)

Select next transition (page 145)

i '—t

Background

Keys 1to 4

i '—t_'

Select new background video (page 135)

4

Make key settings (page 195)

4

4

Select transition type (page 145)

\ 4 4 \ 4

4

4

mix mix

Super Preset color Wipe DME wipe

1]

!

Make wipe settings
(page 277)

(page 334)

Make DME wipe settings

2

Preview the effect of transition (page 175)

4

Execute the transition (page 161)

Video Processing Flow




Signal Selection

You carry out signal selection with the cross-point buttons in the cross-point
control block of each M/E bank or the PGM/PST bank, and the buttons in the
auxiliary bus control block.

The number of buttons in each cross-point row may be 16, 24, or 32, but here
the description is of the 32-button case as an example.

Source name displays
KEY4 button —

Key 2 row
KEY3 button

Key 1 row Reentry buttons

Cross-point buttons

HISSsess uoo
OO0 a0E

UTIL button

Reentry buttons

SHIFT button

Background B row

Background A row

Cross-point control block

Signal Selection 135

suopisuel] pue uonosies [eubis ¢ Jeideyn



suolIsuel| pue uoios|es [eubls € Jeydeyn

136

Basics of Signal Selection

Each of the M/E banks, PGM/PST bank and auxiliary bus control block has 32
cross-point buttons and three reentry buttons (four in the case of the auxiliary
bus control block).

These buttons are identified by numbers common to all of the banks and block,
and a signal is assigned to each number.

The basis of signal selection is to select, in a cross-point button row, the cross-
point button to which is assigned the desired signal.

Reentry buttons

To use the output of one M/E bank as background input to another bank, use
the reentry buttons [M/E1], [M/E2], and [M/E3] (on the auxiliary bus control
block, [M/E1], [M/E2], [M/E3], and [PGM)]) in the cross-point control block
of the destination bank.

For example, to feed the output from the M/E-1 bank as the background B input
to M/E-2, in the M/E-2 cross-point control block, press the [M/E1] button in
the background B row.

Bus Selection

Each row of 32 cross-point buttons is shared by multiple buses.
For example, in the M/E-1 bank, the key 1 row of buttons can be assigned either
to the key 1 bus or to the key 3 bus. The [KEY3] button switches between these

two assignments.
To assign a bus to the cross-point buttons in the auxiliary bus control block,
press one of the AUX delegation buttons to select the bus.

When using the CCP-6224/6324, buses may be assigned with the cross-point
button rows for keys 1 and 2 as the auxiliary bus control block.

The following table illustrates the correspondence between buses and cross-
point button rows, and the delegation operations.

Signal Selection



Bank Bus name Cross-point Delegation operation
button row
M/E-1, Background A bus 2 Background A -
M/E-2, row
M/E-3
Background B bus 2 BackgroundB |-
row
Key 1 bus Key 1 row Turn off the [KEY3] button
Key 2 bus Key 2 row Turn off the [KEY4] button
Key 3 bus Key 1 row Turn on the [KEY3] button
Key 4 bus Key 2 row Turn on the [KEY4] button
PGM/PST | program bus @ Program row -
Preset bus & Preset row -
DSK 1 bus DSK1 row Turn off the [DSK3] button
DSK 2 bus DSK2 row Turn off the [DSK4] button
DSK 3 bus DSK1 row Turn on the [DSK3] button
DSK 4 bus DSK2 row Turn on the [DSK4] button
M/E-1, Utility 1 bus Background A When [UTIL] button mode
M/E-2, row is Hold, hold down the
';’/I(/EEI\;I?I’DST Utility 2 bus Background B | LU TIL] button
row
DME external video bus | Key 1 row Hold down the [UTIL]
button
DME utility 1 bus Key 2 row Hold down the [UTIL]

DME utility 2 bus

button, and press the
[KEY4] button, turning it
off

Hold down the [UTIL]
button, and press the
[KEY4] button, turning it
on
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Bank

Bus name

Cross-point
button row

Delegation operation

Auxiliary
bus control
block

AUX1 to AUX48 buses

MONITOR 1 to
MONITOR 8 buses

Frame memory source 1
and frame memory
source 2 buses

DME 1 to DME 8 video
buses

DME 1 to DME 8 key
buses

Edit preview bus

M/E-1 UTILITY 1 and
M/E-1 UTILITY 2 buses

M/E-2 UTILITY 1 and
M/E-2 UTILITY 2 buses

M/E-3 UTILITY 1 and
M/E-3 UTILITY 2 buses

P/P UTILITY 1 and P/P
UTILITY 2 buses

M/E-1 Key 1 fill to M/E-1
Key 4 fill buses

M/E-1 Key 1 source to M/
E-1 Key 4 source buses

M/E-2 Key 1 fill to M/E-2
Key 4 fill buses

M/E-2 Key 1 source to M/
E-2 Key 4 source buses

M/E-3 Key 1 fill to M/E-3
Key 4 fill buses

M/E-3 Key 1 source to
M/E-3 Key 4 source
buses

DSK 1 fill to DSK 4 fill
buses

DSK 1 source to DSK 4
source buses

M/E-1 external DME bus

M/E-2 external DME bus

M/E-3 external DME bus

P/P external DME bus

DME UTILITY 1 and
DME UTILITY 2 buses

1st row, 2nd row

Turn on the appropriate
buttons in accordance with
the signal assignment
made in the Setup menu.

Signal Selection




a) Dual background bus mode (see below) can be selected.

Dual background bus mode

In this mode, the shifted signal on the background A row can be selected on the
key 1 row, and the shifted signal on the background B row can be selected on
the key 2 row.

To switch this mode on and off, it is necessary to assign this function to the
[PRE MCROY] button in the cross-point control block.

For details of the assignment operation, see “Overall Control Panel Settings
(Config Menu)” in Chapter 19 (Volume 3).

For the following switcher banks, dual background bus mode is not available.
e When set to “Dual M/E Assign”
¢ When M/E Config is set to “DSK”

AUX Panel-less Function

When using 24-column cross-point control blocks for the CCP-6224/CCP-
6324 Control Panel, you can use the key 1 and key 2 rows as the auxiliary bus
control block. This is called the panel-less function.

Preparations

Assign the function for switching to the AUX control mode to the [PRE
MCRO] and [POST MCROY] buttons. Hereafter this button is called the [AUX
CTRL] button.

In the source name display you can display either the source name or the bus
name.

For details of how to make the assignment, see Chapter 19 “Control Panel
Setup (Panel)” (Volume 3).

Selecting the AUX bus

1 Switch the operation mode with the [AUX CTRL] button.
2 In the key 1 row, select the AUX bus for the operation.

3 In the key 2 row, select the desired signal.
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Signal Assignment and Selection

Assigning signals to buttons

Each of the 32 cross-point buttons and reentry buttons has a corresponding
button number, to which you assign a signal.

In addition to the signals input to the PRIMARY INPUTS 1 to 80 connectors
(1 to 34 connectors for the MVS-8000SF/8000ASF/8000GSF) on the rear
panel of the switcher, you can also select signals generated within the switcher.
Each button has assigned to it a video signal and a key signal, forming a pair.
You can set these video and key combinations in a Setup menu.

For details of Setup menu operations, see “Cross-Point Settings (Xpt Assign
Menu)” in Chapter 19 (Volume 3).

Cross-point button control block button nhumbers

Shift button
0|0
O %
= A5 & G
0000000 RO
1, 2, 3, 4, ....... (f|rst button numbers) ....... 29, 30, 31 121 123
32, 33, 34, 35, ....... (Second button numbers) ....... 60, 61, 62 | 125 127
Shift button

On each M/E bank and the PGM/PST bank, each cross-point button and reentry
button has two button numbers, and you use the shift button to switch between
these numbers.

In the case of a 32-button layout, the button numbers are as follows.

Cross-point control block button numbers

Button Number when the shift Number when the shift
button is not pressed button is pressed

From the left end to the 31st | 1 to 31 32 to 62

button

Reentry buttons 121to 123 125 to 127

Signal Selection



On the MVS-8000A/8000G, you can use the rightmost button (number 32) as
a [SIDE FLAG] button. In this case, the shift button moves one to the left, to
number 31, and the button numbers are offset by one.

For details of the [SIDE FLAG] button, see “Cross-Point Settings (Xpt Assign

Menu)” in Chapter 19 (Volume 3).

Switching button humbers

The rightmost (32nd) button functions as a shift button.
(The shift button function can be disabled in a Setup menu.)
When selecting the signals of button numbers 1 to 31, press the cross-point

button for the desired signal.

To select button numbers 32 to 62, hold down the shift button, and press the

cross-point button for the desired signal.

Button numbers in the auxiliary bus control

block

....... (1st row)

2ND button

29,30,31 121 124

3 (PE
4]]

[iE

1]

00000000000
neee

5
= = 10
0O000000000000000000a GBBO
CO000000[8MAa PABn

32, 33, 34, 35, ....... 2ndrow) .

60,61,62 125 128

When the [2ND] button is unlit

The cross-point buttons and reentry buttons in the auxiliary bus control block

have separate upper (1st row) and lower (2nd row) numbers.
In the case of a 32-button layout, the button numbers are as follows.

Auxiliary bus control block button numbers ([2ND] button unlit)

Button Button Button numbers
1st row From the left end to the 31st button 1to 31

Reentry buttons 121 to 124
2nd row From the left end to the 31st button 32 to 62

Reentry buttons 12510 128

Signal Selection
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When the [2ND] button is lit

Different buses can be assigned to the 1st-row buttons and 2nd-row buttons.
When the 32nd button is set as a shift button, the 1st-row buttons and 2nd-row
buttons both have the following button numbers.

Auxiliary bus control block button numbers ([2ND] button lit)

Button Number when the shift Number when the shift
button is not pressed button is pressed

From the left end to the 31st | 1 to 31 32 to 62

button

Reentry buttons 121 to0 124 125 t0 128

Inhibiting cross-point button operations

For each cross-point button, you can temporarily inhibit operations.

This setting is cleared when you reset the control panel.

Assigning a button to the function of disabling cross-point button
operation

You can assign the button to be used for the operation to the [PRE MCRO]
button, in setup. (See “Overall Control Panel Settings (Config Menu)” in
Chapter 19 (Volume 3).)

You can also use the [Inhibit Set] and [Inhibit All Clear] functions, assigned to
user preference buttons. (See “Setting Button Assignments (Prefs/Utility
Menu)” in Chapter 19 (Volume 3).)

Buses for which operations can be inhibited

This setting applies to the auxiliary bus control block (when using the CCP-
8000) and the cross-point buttons in each switcher bank. However, when using
the CCP-6224/6324, buses may be assigned with the cross-point button rows
for keys 1 and 2 as the auxiliary bus control block.

For example, if you make the setting for one cross-point button in a switcher
bank, this inhibits operation of all cross-point buttons with the same number in
the following buses.

The corresponding name also disappears from the source name display.

* Background A, background B

* Keys 1to4

« Utility 1, Utility 2

e DME utility 1, DME utility 2

* External DME

Signal Selection




To inhibit operation of a cross-point button

Hold down the button which “Inhibit Set” is assigned, and press the cross-point
button whose operation you want to inhibit.

The button you pressed flashes amber, and this makes the operation inhibited.

Even when you inhibit operation of a cross-point button, macro attachment
settings are still possible (see “Setting and Canceling a Macro Attachment” in
Chapter 16 (Volume 2)).

To clear a cross-point button operation inhibit setting

Hold down the button to which “Inhibit Set” is assigned, and press the button
whose operation is inhibited (flashing amber).

This clears the operation inhibit setting for the button you pressed.

To clear all operation inhibit settings
Press the button to which “Inhibit Set” is assigned and the button to which
“Inhibit All Clear” is assigned simultaneously.

Selection of signals linked with the audio mixer

When you select a signal in a switcher bank background A, key 1 or key 2 row
(of the CCP-6224/6324 control panel in AUX control mode) or AUX bus
control block (of the CCP-8000), and the bank and signal are set to be linked
to the audio mixer, then the program output of the audio mixer follows the
signal selection.

For details of the setting, see “Cross-Point Settings (Xpt Assign menu)” in
Chapter 19 (Volume 3).

* For details of audio mixers that can be connected, contact your Sony service
or sales representative.

* When the signal is switched with a snapshot, keyframe, and so on, the audio
mixer is not linked.

¢ When bus fixed mode is selected in setup (see page 173), the audio mixer
program output is linked to the bus output as the background.

Signal Name Display

You can attach a name (source name) to each signal assigned to a cross-point
button, with a maximum of 16 characters.

Signal Selection
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¢ The source name displays in the cross-point control block and auxiliary bus
control block show the source names of the video signals assigned to
numbers 1 to 31.

 To display the source names for numbers 32 to 62, press the [SHIFT] button

to the right of the source name displays.

To display the source names of the key signals assigned to buttons, hold

down the [SPLIT] button in the key control block or the [KEY] button in the

auxiliary bus control block.

When using the AUX panel-less function (see page 139) with the CCP-6224/

6324 Control Panel, you can use the cross-point control block as an AUX bus

control block with the [AUX CTRL] button.

In this case, use the key 1 row as AUX delegation buttons, and the key 2 row

as AUX bus cross-point selection buttons; the source name displays show the

bus names and source names.

Colors of lit cross-point buttons

In a particular row of cross-point buttons, only the last pressed button is
effective, and lights amber or red. The amber indicates the “low tally” state,
and the red indicates the “high tally” state, to indicate whether or not the
selected signal appears in the final output video.

Significance of colors of lit cross-point buttons

Color State Significance
Amber Low tally Does not appear in final output video
Red High tally Appears in final output video

Signal Selection



Transitions

Selecting the Next Transition

To execute a transition, it is first necessary to decide how the image will be
changed as a result of the transition. This selection is carried out using the next
transition selection buttons (see page 50) in the transition control block of each
M/E or PGM/PST bank.

For details of operations, see “Procedure for Basic Transition Operation”
(page 148).

Transition Types

Mix

Selecting the transition type determines the way in which the transition occurs.
Carry out the type selection with the transition type selection buttons in the
transition control block of each M/E or PGM/PST bank.

For details of this operation, see “Procedure for Basic Transition Operation”
(page 148).

The following are the transition types.

This is a dissolve, in which the new video progressively fades in over the
current video, with the sum of the two video outputs maintained constant. At
the mid-point of the transition (when the fader lever is in the center position),
the output of each is 50%.

This transition type can also be selected for an independent key transition. In
this case, the key either dissolves in or dissolves out similarly, with the
progress of the transition.

NAM (non-additive mix)

In this dissolve, the current video and new video signals are compared, and the
signal with the higher luminance level is given priority in the output. The
current video is maintained at 100% output for the first half of the transition as
the new video increases progressively to 100%, then the current video is
progressively reduced from 100% to zero in the second half with the new video
maintained at 100% output.

Transitions
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This transition type is not available for an independent key transition.

Super mix

In this dissolve, the current video is maintained at 100% output for the first half
of the transition as the new video is mixed while increasing progressively to
100%, then the current video is progressively reduced from 100% to zero in the
second half with the new video maintained at 100% output.

For details on super mix settings, see page 157.

This transition type is not available for an independent key transition.

Preset color mix

Wipe

This is a two-stage dissolve, comprising two transitions, the first a dissolve to
a color matte, and the second from the color matte to the new video.

In the first transition, the current video is replaced by the color matte in a mix
(dissolve), then in the second transition the color matte is replaced by the new
video also in a mix (dissolve).

For details on color matte settings, see page 158.

This transition type is not available for an independent key transition.

A wipe replaces the current video by the new video according to a
predetermined pattern. This transition type can also be selected for an
independent key transition.

For details, see “Wipes” (page 26) and Chapter 5 “Wipes” (page 275).

DME wipe

Transitions

Using a DME effect, it is possible to obtain a transition to a new image from
the current image, as in a wipe. You can also use this transition type as an
independent key transition.

For details, see “DME Wipes” (page 27) and Chapter 6 “DME Wipes” (page
321).



Clip transitions

Linked to a mix (dissolve) or wipe transition, a frame memory clip (movie) is
played back.

The clip transition function is only supported on the MVS-8000A/8000G.

Cut

A cut switches instantaneously from the current video to the new video. When
the next transition is a key transition, the key cuts in or out instantaneously.

Transitions
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Procedure for Basic Transition Operation

The positions of the principal buttons used for basic transition operation are as
follows.

ON ON ON ON ( a
1234123412341234

Next transition
selection buttons

Transition type
selection buttons

Transition execution —
section

1
2

Transition control block (for standard transitions)

In the cross-point control block, select the background video with the
background A row of cross-point buttons.

Select the way in which the transition will affect the image, using the next
transition selection buttons in the transition control block.

For an overview, see “Selecting the Next Transition” (page 145).

To change the background: Press the [BKGD] button, turning it on.

To insert or delete a key: Press one of the [KEY 1] to [KEY4] buttons (or
[DSK1] to [DSK4] buttons in the PGM/PST bank), turning it on.

To enable the key priority setting, which determines the key overlay
order after the transition: Press the [KEY PRIOR] button, turning it
on.

You can press more than one button at the same time.

To change the keys and background presets in Setup menus
simultaneously: Press the [ALL] button.

To allocate a particular next transition button to the [ALL] button
function, see “Operation Settings (Operation Menu)” in Chapter 19
(Volume 3).

Procedure for Basic Transition Operation



3 For the transition to change the key priority, set the priority for after the
transition.

For details of the key priority setting operation, see “Key Priority Setting”
(page 151).

Select the new video used for the transition.

¢ In the background B row of cross-point buttons, select the new
background video.

e When inserting a key, select the key signal, and make any required
settings.

For details of key settings, see Chapter 4 “Keys” (page 195).
To carry out a cut transition, skip to step 7; otherwise continue to step 5.

Select one of the transition type selection buttons in the transition control
block.

To carry out a dissolve to the new video: Press one of the [MIX],
[NAM], [SUPER MIX], and [PST COLOR MIX] buttons, turning it
on.

To carry out a wipe: Press the [WIPE] or [DME] button, turning it on.

To carry out a transition while playing back a frame memory clip:
Press one of the buttons corresponding to the clip to be used
(FM1&2CLIP, FM3&4CLIP, FM5&6CLIP, and FM7&8CLIP).

You can also use the Misc >Transition menu to select a desired transition
type for the M/E or PGM/PST bank. (See “Selecting the Transition Type
by a Menu Operation” (page 156).)

For an overview of the transition types, see “Transition Types” (page
145).

The transition type selection buttons in the transition control block can be
interchanged in the setup menu.

For details, see “Overall Control Panel Settings (Config Menu)” in
Chapter 19 (Volume 3).

Make the required settings, according to the selected transition type.

For details of the settings, see the relevant section.

Super mix: “Super Mix Settings” (page 157)
Preset color mix: “Color Matte Settings” (page 158)

Procedure for Basic Transition Operation
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Wipe: “Basic Procedure for Wipe Settings” (page 277)

DME Wipe: “Basic Procedure for DME Wipe Settings” (page 334)
Clip transition: “Clip Transition Operations” (page 408)

Using the transition preview function (page 175), you can check the
transition on the preview monitor.

7 Carry out the transition in the transition execution section.

For a gradual transition such as a mix (dissolve) or wipe: Press the
[AUTO TRANS] button, or operate the fader lever.
To execute a transition by pressing the [AUTO TRANS] button, first
set the transition rate (specified as the duration of the transition).
(See “Setting the Transition Rate” (page 162).)
When you have selected a wipe or DME wipe as the transition type,
you can also set the transition range. (See “Pattern Limit” (page 167).)
For an instantaneous transition: Press the [CUT] button.

For details, see “Executing a Transition” (page 161).

Transition linked to the audio mixer

If the video signal selected in the background B row is linked to the audio mixer
in setup, then the audio mixer sound changes with the transition. That is,
pressing the [AUTO TRANS] button gives a cross fade, and pressing the
[CUT] button gives an instantaneous sound switch.

For details of setup, see “Cross-Point Settings (Xpt Assign Menu)” in Chapter
19 (Volume 3).

* The audio mixer is not linked to a snapshot or key frame transition.

e The audio mixer is not linked to a transition using the fader lever.

* If the bus-fixed mode (see page 173) is selected in the setup menu, and the
fader lever is in the lowest position, there is a cross fade from the audio
selected on the B row to the audio selected on the A row.

¢ The audio mixer is not linked to a key transition.

In the following cases, the audio and video may be out of sync.

— When carrying out a cross fade in some DME wipes (for example, “picture
in picture”)

— When executing a preset color mix in two-stroke mode

For details of audio mixers that can be used, Sony service or sales

representative.

Procedure for Basic Transition Operation



Key Priority Setting

Selecting the key priority

If a number of keys are already inserted in the current video, you can check or
change the key priority, that is to say, the order in which the keys are overlaid.
When a key priority ((KEY PRIOR]) is selected as the next transition, you can
also change the key priority in the new video.

The key priority values go from 1 to 4, with a higher priority key being “in
front” as seen on the screen.

Priority sequence on the screen

There are two ways of setting the priority: either using the [PRIOR SET] button
in the transition control block, or using the Misc menu to access the Key
Priority menu for the M/E or PGM/PST bank.

When the operating mode is set to multi program, the key priority setting
cannot be made.

Setting the Key Priority in the Transition Control Block

The positions of the buttons used for the operation are as follows.

Key Priority Setting 151
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Next transition

ON ON ON ON
1234123412341234

J

selection buttons

KEY PRIOR button

~
ekaD || || kevt Kevz || || keva || || kevs

PRIOR SET button—

=

om || [
il

Transition control block (standard type)

Changing the currently inserted key priority

1 If the next transition selection button [KEY PRIOR] is on, press another
next transition selection button to turn the [KEY PRIOR] button off.

Key Priority Setting

(When the [KEY PRIOR] button is on, the transition control block
switches to the mode for changing the key priority for after the transition.)

Holding down the [PRIOR SET] button, press the one of the next transition
selection buttons [KEY1] to [KEY4] ([DSK1] to [DSK4] buttons in the

PGM/PST bank) for the

key to appear on top.

The selected key now appears on top, on the program monitor.
The priority of keys other than the selected one does not change.

1

L5

Key 1 selected.

Key priority: 3, 1, 4, 2

Key priority: 1, 3, 4, 2

To change the priority of more than one key, repeat this operation as

required.




Changing the key priority for after the transition

When executing a transition, turning on the next transition selection button
[KEY PRIOR] causes the keys to be rearranged based on the set priority.
To set the key priority for after the transition, use the following procedure.

1 In the transition control block, hold down the [PRIOR SET] button and
press the [KEY PRIOR] button to turn it on. Do not release the [PRIOR
SET] button before advancing to step 2.

The [KEY PRIOR] button lights green, and it becomes possible to change
the key priority setting for after the transition.

2 Hold down the [PRIOR SET] button, and press the one of the next
transition selection buttons [KEY 1] to [KEY4] ([DSK1] to [DSK4]
buttons in the PGM/PST bank) for the key you want to bring to the front
after the transition.

To set the priority to be the same as before the transition, press the [BKGD]
button.

The [BKGD] button is only effective when in the mode for changing the
key priority for after the transition.

When the next transition selection button [KEY PRIOR] is on, the selected
key appears on top on the preview monitor. The priority of keys other than
the selected one does not change.

3 To change the priority of more than one key, repeat the previous operation
as required.

4 Execute the transition.

The keys are rearranged based on the set priority.

Setting the Key Priority by a Menu Operation

Changing the priority of the currently inserted keys

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,” then HF3 ‘Key
Priority.’

The Key Priority menu appears.
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2 For each of <Priority 1>, <Priority2>, <Priority3>, and <Priority4>, select
a key, to determine the key priority sequence.

The keys are inserted in the key priority sequence with priority 1 at the
front.

Priority 1

Priority 3

Priority 2 l 1
j

Priority 4

It is not possible to select the same key for two or more priority numbers.

The keys appear in the set order on the program monitor.

Changing the key priority for after the transition

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,” then HF4 ‘Next
Key Priority.’

The Next Key Priority menu appears.

2 For each of <Priority 1>, <Priority2>, <Priority3>, and <Priority4>, select
a key, to determine the key priority sequence.

For details of the key priority sequence, see the figure shown for step 2 in
the previous item (see page 154).

The keys appear in the set order on the preview monitor.

3 Execute the transition.

The keys are rearranged in the set order on the program monitor.

Key Priority Setting



Display of the Key Output Status and Key Priority

You can check whether keys are currently output, and the key priority setting,
using the key status display in the transition control block of the M/E or PGM/
PST bank.

The display is above the next transition selection buttons [KEY 1] to [KEY4]
([DSK1] to [DSK4] buttons in the PGM/PST bank).

Display of the key output status

When a key is included in the output from the M/E or PGM/PST bank, the
corresponding ON indicator lights.

Key priority display

The key priority is indicated by numerals 1 to 4 lighting.

The topmost key as seen on the program monitor is priority 1, and the keys
underneath are numbered 2, 3, 4 away from the viewer (see page 154).

To display the key priority for after the transition, press the [KEY PRIOR]
button in the transition control block, turning it on. For keys for which the
priority after the transition is different from the current priority, the
corresponding numerals 1 to 4 flash. For a key with the same priority, the
indication remains on.

Example key status display given when the [KEY PRIOR] button is pressed:
Current key priority: 1, 2, 3, 4

Key priority after the transition: 3,2, 1, 4

Indicators: 1, 3 (flashing), 2, 1 (flashing), 3, 4

Lit Lit Lit

\_F‘Iashmg Flashln’ﬂ Lit

[EMIRE maéa ]
(=)= (=] =] o]

Example key status display (showing the key priority after the transition)
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Selecting the Transition Type by a Menu
Operation

You can also select the required transition type by a menu operation.

1 In the M/E or PGM/PST menu, select first VE7 ‘Misc,” then HF1

‘Transition.’

The Transition menu appears.

Select the required transition type in the <Transition Type> group.

The parameter settings can now be adjusted with the knobs according to
the selected transition type.

For details, see the following.

* “Super Mix Settings” (page 157)

* “Color Matte Settings” (page 158)

o “Setting the Transition Rate” (page 162)

When multi-program mode is selected in the Setup menu (see “Settings for
Switcher Configuration (Config Menu)” in Chapter 20 (Volume 3)), there
may be cases in which two or more transition types have been selected.

Selecting the Transition Type by a Menu Operation



Super Mix Settings

You can set the output levels of the current and new video signals at the mid-
point of the transition, in the range 0 to 100%.

This transition type is not available for an independent key transition.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,” then HF1
‘Transition.’

The Transition menu appears.
2 Select [Super Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the output levels.

Knob | Parameter |Adjustment Setting values
2 A Gain Background A output level 0.00 to 100.00% N
3 B Gain Background B output level 0.00 to 100.00% e
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Color Matte Settings

You can specify the color matte by luminance, saturation, and hue values.
Also, in place of a color matte you can use an image selected on the utility 2
bus.

* This transition type is not available for an independent key transition.
¢ In the multi-program mode, you can use a preset color mix only when
selecting the background for the next transition.

One-stroke mode and one-time mode

* You can make a setting such that a preset color mix is carried out in a single
transition. This is called “one-stroke mode.”
When the bus fixed mode is selected with a Setup menu setting, a preset color
mix is always carried out in the one-stroke mode.

* You can also make a setting such that when a preset color mix is completed,
the next transition switches to the previous transition type automatically.

This is called “one-time mode.”

When only the background is changed

R

Current video Color matte New video

Preset color mix (changing background only)

Color Matte Settings



When a key is inserted

Key fades out When a key is
selected as the next
transition

v

Key fades in

Preset color mix (transition including key)

By means of a Setup menu setting, it is possible to preserve the key state while
carrying out the color matte mix.

When, with a key inserted, a key is selected in the next transition

Key state preserved

VIDEO
-

Key gradually
removed

Preset color mix (when set to preserve key state)

Setting the color matte

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ then HF1
‘Transition.’

The Transition menu appears.
2 Select [Preset Color Mix] in the <Transition Type> group.

3 In the <Preset Color Mix Fill> group, select one of the following.

Flat Color: monochrome color matte
Utility 2 Bus: signal selected on the utility 2 bus

The utility 2 bus cannot be selected on the MV S-8000.

Color Matte Settings
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4 When “Flat Color” is selected, turn the knobs to adjust the color matte.

Knob | Parameter Adjustment Setting values
2 Luminance Luminance 0.00 to 100.00
3 Saturation Saturation 0.00 to 100.00
4 Hue Hue 359.99 to 0.00

Color Matte Settings




Executing a Transition

There are two modes of executing a transition: an auto transition by button
operation or a manual transition using the fader lever.

It is also possible to combine both methods, taking control with the fader lever
of an auto transition which has partly completed, or complete a transition
started with the fader lever as an auto transition.

By combining common transitions with independent key transitions, different
transition types can be applied to the background and keys, for example
allowing a key wipe combined with a background dissolve.

When the audio mixer is linked in setup, you can carry out an auto transition,
and also switch the sound with the audio mixer. (See “Transition linked to the
audio mixer” (page 150).)

Transition Indicator Function

In each of the M/E banks and PGM/PST bank, to the left of the fader lever is a
transition indicator composed of multiple LEDs. This indicator shows the state
of the transition, whether auto or manual, by which LEDs are lit.

]

Lit

G

OO N AN AN NN

C

Transition indicator
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For example, in the previous illustration, it can be seen that the transition is
more than half completed.
When the transition is completed, all of the LEDs go off.

Setting the Transition Rate

There are three ways of setting the transition rate: using the Flexi Pad control
block, Multifunction Flexi Pad control block or numeric keypad control block
to enter a numeric value, or using the Misc menu to access the Transition menu
for the M/E or PGM/PST bank.

You can also display the transition rate, independent key transition rate, and
fade-to-black transition rate for each of the M/E and PGM/PST banks, and
change the settings. (See “Displaying a List of Transition Rates and Changing
the Settings” (page 436).)

When a clip transition is selected as the transition type, it is not possible to set
the transition rate.

Frame input mode and timecode input mode

For numeric input of the transition rate value, there are two modes: frame input
mode and timecode input mode. You select one of these modes using either the
Flexi Pad control block (page 164), Multifunction Flexi Pad control block or
the numeric keypad control block (page 164).
Frame input mode: The entered value is a number of frames.

Example: Entering 123 constitutes an entry of 123 frames
Timecode input mode: The entered value is a timecode value.

Example: Entering 123 constitutes an entry of 1 second 23 frames.

Whereas you can enter a value of up to 999 in frame input mode, a value not
smaller than 10 seconds cannot be entered in timecode input mode.

Frame display mode and timecode display mode

For the transition rate display in the transition control block, there are two
modes: frame display mode and timecode display mode. You can select one of
these modes in setup. (See “Operation Settings (Operation Menu)” in Chapter
19 (Volume 3).)

Executing a Transition



The setting is common to all banks of the switcher.

Frame display mode: Values are shown as from 0 to 999 frames. In this
display mode, a value entered in timecode input mode is converted for
display as a number of frames.

Timecode display mode: Values are shown as timecode values, consisting of
seconds and frames. In this display mode, a value entered in frame input
mode is converted for display as a timecode value. If the value consists of
four or more digits, the last digit is not shown.

Example: A value of 9 seconds 23 frames appears as “9.23” and a value
of 10 seconds 1 frame appears as “10.0.”

Setting the transition rate in the Flexi Pad control block

In the PGM/PST bank or when using a simple-type transition control block,
you cannot use the Flexi Pad control block to set the transition rate.

1 In the M/E bank Flexi Pad control block, press the [TRANS RATE]
button.

The memory recall section display is now ready to accept the entered
transition rate.
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BANK
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BANK
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S EEE

TC button ENTR button

Memory recall section

Flexi Pad control block (standard type)
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2 Enter the desired transition rate with the numeric keypad.
If required, press the [TC] button to toggle the input mode (frame input or
timecode input).

* Enter a value of up to three digits.
* To cancel the entry, press any of the six buttons in the leftmost column
([WIPE], [DME], ...) or the [TRANS RATE] button.

3 Press the [ENTR] button.

This confirms the entry, and the new setting appears in the transition
control block display.

Setting the transition rate in the numeric keypad control block

TRANS RATE button Display Numeric keypad

[ 0ooooooooooo ]
M
p -

I
.

n
)G

Ry
\\

Region selection buttons  TC button ENTER button

Numeric keypad control block

1 In the numeric keypad control block, press the [TRANS RATE] button.

2 Press the region selection button for the M/E or PGM/PST bank for which
you want to set the transition rate, turning it on.

The numeric keypad control block display now shows the selected region
name and the current transition rate setting for the region.

3 With the numeric keypad, enter the transition rate.
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If required, press the [TC] button to toggle the input mode (frame input or
timecode input).

* Enter a value of up to three digits.
* To clear the entry, press the [CLR] button.

4 Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition
rate appear in the numeric keypad control block display.

The transition control block display of the same bank (M/E or PGM/PST)
also shows the setting.

To enter a difference from the current value

After pressing the [+/-] button, enter the difference and press the [TRIM]
button.

To change the sign (+ or —), press the [+/—] button.

Setting the transition rate in the Multifunction Flexi Pad control
block

1 In the Multifunction Flexi Pad control block, press the [TRANS RATE]
button.

The button displays in the memory recall section change as shown in the
following illustration, and the Multifunction Flexi Pad control block
switches to the transition rate setting mode.
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2 In the region selection buttons, select the switcher bank.

3 Press the [TRANS SEL] button in the memory recall section.

Executing a Transition
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4

5

The button displays in the memory recall section change as shown in the
following illustration, and you can select the type of transition for which
to set the rate.
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Press the [KEY 1] button.

You can now set the M/E-1 block background transition rate.

Watching the alphanumeric display, enter the transition rate you want to
set with the memory recall section button.

If required, press the [TC] button to switch the input mode (frame count
input or timecode input).

* Enter a value of up to three digits.

* To cancel the input, press any of the mode selection buttons.

6 Press the [ENTR] button.

Setting the transition rate by a menu operation

1

In the switcher bank, select first VF7 ‘Misc’, then HF1 ‘Transition.’

The Transition menu appears.
Select any transition type in the <Transition Type> group.

Turn the knob to set the transition rate.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition Rate 0 to 999 (frame count)

Executing a Transition



Displaying the transition rates in a menu and changing the

settings

For each of the M/E and PGM/PST banks, you can display the transition rate,
independent key transition rate and fade-to-black transition rate, and change
the settings.

For more details, see “Displaying a List of Transition Rates and Changing the
Settings” (page 436).

Pattern Limit

When a wipe or DME wipe pattern is selected for the transition, you can

specify the range of movement of the wipe pattern through the course of the

transition, for each bank independently.

When the pattern limit function is enabled, carrying out a transition results in

the following effect for example settings.

¢ When the limit value is set to 50%, the effect at the end of the transition is
the same as when the fader lever is at the center position in the normal case

(with the pattern limit function disabled); the wipe pattern does not complete.

¢ When the limit value is set to 0%, the wipe effect is completely disabled, and
carrying out the transition produces no change in the image.

e When the limit value is set to the maximum 100%, the image changes in
exactly the same way as when the pattern limit function is off, but when the
transition is completed, the cross-point selections on the background A and
B buses do not interchange.

There are two ways of setting a pattern limit: either by operating the fader lever
to save the fader position, or by using the Wipe menu or DME Wipe menu to
access the Edge/Direction menu for the M/E or PGM/PST bank.

* A pattern limit only applies when a wipe or DME wipe is selected as the
transition type.

A pattern limit cannot be applied to an independent key transition (see page
177).

Executing a Transition
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TRANS PVW button

PTN LIMIT button

LIMIT SET button

Transition control block (standard type)

Setting the pattern limit with the fader lever

1

Move the fader lever to the position corresponding to a particular pattern
size.

¢ First make sure that the [PTN LIMIT] button is off.
* To check the pattern size on the preview monitor, first press the [TRANS
PVW] button, to select the transition preview mode (see page 175).

Press the [LIMIT SET] button.

This sets the current fader lever position as the pattern limit.

Setting the pattern limit by a menu operation

1 When a wipe is selected as the transition type, in the M/E or PGM/PST

menu, select first VF5 “Wipe,” then HF4 ‘Edge/Direction.’

When a DME wipe is selected as the transition type, in the M/E or PGM/
PST menu, select first VF6 ‘DME Wipe,’ then HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 Press the [Pattern Limit] button, turning it on.

Executing a Transition



3 Turn the knobs to adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Pattern Limit Pattern limit 0.00 @ to 100.00% ©)

a) 0.00%: Executing the transition does not change the video output at all.

b) 100.00%: The transition is the same as when no pattern limit is set, but the cross-point
button selections of the background A and B buses do not interchange when the transition
completes.

Executing a pattern limit transition

1

Press the [PTN LIMIT] button, turning it on.

The button you pressed lights amber.

Carry out the transition.

The transition progresses as far as the set pattern limit. Even if the
transition completes, the cross-point button assignments of the background
A and B buses do not interchange.

Carry out the transition once again.

The status before the previous transition is restored.

To cancel the pattern limit

To cancel the pattern limit after completion of step 3 in the previous procedure,
press the [PTN LIMIT] button, turning it off.

If after carrying out step 2 in the previous procedure, the pattern limit has been
reached, carry out the following procedure.

1

2

Press the [PTN LIMIT] button.

The button you pressed lights green.

Carry out the transition.

The [PTN LIMIT] button goes off, and the pattern limit state is released.
Depending on the way in which the transition was executed, the action will
be as follows.

¢ When you press the [CUT] button, the pattern limit is immediately
released, and the image switches instantaneously.

* When you press the [AUTO TRANS] button, until the state of the next
transition, the transition is carried out over the duration given by the
transition rate.

* When you move the fader lever, the transition is carried out from the
pattern limit state to the state before the pattern limit transition was

Executing a Transition
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carried out.
Moving the fader lever even a little synchronizes the fader lever position
with the transition state, and you can move the fader lever either in the
forward direction or in the reverse direction.

Depending on the Setup settings, the transition may be executed at the
instant you press the [PTN LIMIT] button, and the button goes off. In this
case, execution continues for the time specified by the dedicated transition
rate in the menu setting, as far as the state of the next transition.

For details of the setting, see “Settings Relating to Keys, Wipes, Frame
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20
(Volume 3).

To set the transition rate when the pattern limit is released

1 In the <Pattern Limit Release> group of the Edge/Direction menu, select
one of the following.

Auto Trans Rate: Use the transition rate set in the transition rate control

block

Independ Trans Rate: Independent transition rate

2 If you selected “Independ Trans Rate” in step 1, adjust the following

parameter.

Knob

Parameter

Adjustment

Setting values

1

Transition Rate

Independent transition rate

0 to 999 (frames)

Executing an Auto Transition

The following two modes can be used for auto transition.

Cut

A cut switches instantaneously from the current video to the new video. When
the next transition is a key transition, the key cuts in or out instantaneously.

Auto transition
The transition from the current video to the new video is carried out
automatically at a constant rate, using the transition effect selected as the

transition type

You can set the transition rate in advance. (See “Setting the Transition Rate”

(page 162).)

Executing a Transition
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CUT button

Transition control block (standard type)

To execute a transition on the M/E or PGM/PST bank by a button operation,
use the following procedure in the transition control block.

To carry out an instantaneous cut transition: Press the [CUT] button.

To carry out a gradual transition: Press the [AUTO TRANS] button.
This executes the transition at the preset transition rate (see page 162).
While the transition is executing, the [AUTO TRANS] button lights
amber. When it completes the button goes off.

To complete a partially executed transition instantaneously: Press the
[CUT] button.
The [AUTO TRANS] button goes off.

Executing a Transition With the Fader Lever (Manual
Transition)

Using the fader lever, you can manually control the progress of the transition.
Moving the fader lever from one end of its travel to the other completes the
transition.

To execute a manual transition with the transition control block fader lever, use
the following procedure.

To carry out the transition completely: Move the lever over the full range of
its travel.

Executing a Transition
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To pause a partly executed transition: Stop moving the fader lever.
To resume a paused transition: Resume moving the fader lever.

Combinations of Auto and Manual Transitions

Using the [AUTO TRANS] button, the [CUT] button, and the fader lever, use
the following procedures.

Moving the fader lever during an auto transition

During an auto transition started by pressing the [AUTO TRANS] button,
operating the fader lever immediately enables the fader lever, and the [AUTO
TRANS] button goes off. Thereafter, the fader lever controls the progress of
the transition.

Executing an auto transition after partly moving the fader lever

* Press the [CUT] button to instantaneously complete the transition.

* Press the [AUTO TRANS] button to complete the rest of the transition at the
preset transition rate.
If the transition rate is set to 100 frames, and the fader lever has moved
through !/ 4 of the transition, then the remaining 3/4 of the transition is carried
out in 100 frames.

Non-Sync State

If the fader lever is in an intermediate position when a transition is completed
as an auto transition, then the lever position no longer agrees with the transition
state. This is termed a non-sync state.

In a non-sync state, two lit LEDs indicate the position from which a normal
transition can be carried out. This is either at one end position or both end
positions of the fader lever travel.

Moving the fader lever toward the position of the lit LEDs does not carry out a
transition, but when the fader lever reaches the end position the non-sync state
is released, and it is now possible to carry out the next transition.

Executing a Transition



Once the fader lever is moved

4——to this position, the non-sync
state ends, and the next
transition (direction shown by
the arrow) is possible.
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= \

E -&
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= 1 \
Manual transition completed as auto Manual transition completed as
transition when moving the fader auto transition when moving the
lever upward: Top two LEDs light. fader lever downward: Bottom two

LEDs light.

« If the fader lever is moved in the direction away from the lit LEDs, this
carries out the next transition, over the remaining part of the fader lever
travel.

* Even in a non-sync state, you can carry out an auto transition by pressing the
[AUTO TRANS] button. During the auto transition, the indicators show the
transition progress in the usual way, but when the transition completes, they
once again indicate the non-sync state.

Fader Lever Operation in Bus Fixed Mode

Flip-flop mode and bus fixed mode

The following describes the difference between flip-flop mode and bus fixed
mode, taking an M/E bank as an example; the functionality is the same,
however, on the PGM/PST bank.

Normally, when a background transition is carried out on an M/E bank, the
signals selected on the A and B rows of cross-point buttons are interchanged at
the end of the transition. That is to say, except during a transition, the
background output is always from the background A bus. This is called “flip-
flop mode.”

The alternative is known as “bus fixed mode,” in which there is no bus
interchange. In this mode, when the fader lever is at the top of its travel the
output from the A bus is always 100%, and when the fader lever is at the bottom
of its travel the output from the B bus is 100%.

Executing a Transition 173
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Flip-flop mode and bus fixed mode

In the bus fixed mode there is a fixed relationship between the position of the
fader lever and the signal output on each bus. Depending on the direction of the
transition, the fader lever must therefore always be moved in a particular
direction, as shown in the following table. This does not affect an auto
transition, which is executed regardless of the fader lever direction.

Fader lever operating direction in bus fixed mode

Next transition Transition direction Fader lever movement
Background A—B Downward

B—A Upward
Keys 1,2, 3,and 4 | On — Off (deletion) Downward

Off — On (insertion) Upward

e When a transition applies to a combination of more than one of the
background and keys 1, 2, 3, and 4, then the transition for all of these must
be in the same direction complying with the above table.

* If as a result of an auto transition, for example, the fader lever position does
not agree with the signal output, this is a non-sync state (see page 172) and
LEDs light at both end positions of the fader lever travel. Moving the fader
lever does not carry out a transition, but when the fader lever reaches the end
position the non-sync state is released, and it is now possible to carry out the
next transition. If the fader lever is moved in the direction away from the lit
LEDs, this carries out the next transition, over the remaining part of the fader

lever travel.

Executing a Transition




Transition Preview

With the preview output of the M/E banks and PGM/PST bank, you can check
the effect of a transition in advance. To carry out a transition preview, press the
[TRANS PVW] button in the transition control block.

In multi-program mode, DSK mode or bus fixed mode (page 173), it is not
possible to carry out a transition preview.

Carrying out a transition preview

1 In the M/E or PGM/PST bank transition control block, press the [TRANS
PVW] button.

The [TRANS PVW] button lights green, and the switcher is now in the
transition preview mode. At this point, the preview output is the same as
the program output before the [TRANS PVW] button was pressed.

2 Operate the fader lever, or press the [AUTO TRANS] button or [CUT]
button.

On the preview monitor, you can check the effect of the transition.

To terminate a transition preview

There are three modes for a transition preview. To terminate a transition

preview, carry out the operation which depends on the mode, and press the

[TRANS PVW] button, turning it off.

Lock: Toggling the [TRANS PVW] button on and off switches between the
transition preview mode and the normal mode.

Hold: The preview mode obtains only while the [TRANS PV W] button is held
down.

One Time: Each time a transition ends, it reverts to the normal mode.

Set the transition preview mode in the following combinations.

For details, see Chapter 19 “Control Panel Setup (Panel)” (Volume 3).

Transition Preview | Switcher setup Panel setup

mode (Transition menu) (Operation >Custom Button
<Transition Preview> group | menu)

<Trans Pvw> group

Lock Normal Lock

Transition Preview
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Transition Preview | Switcher setup Panel setup
mode (Transition menu) (Operation >Custom Button
<Transition Preview> group | menu)
<Trans Pvw> group
Hold Normal Hold
One Time One Time -

* During a transition, whether executed with the [AUTO TRANS] button or
the fader lever, it is not possible to press the [TRANS PVW] button.

¢ In bus fixed mode (see page 173), transition previews are not available.

* When using the simple-type transition control block (see page 189),
transition previews are not available.

Transition Preview




Independent Key Transitions

What is an independent key transition?

In addition to common transitions, it is possible to carry out independent
transitions on the keyers of the M/E banks and PGM/PST bank. These are
called “independent key transitions.”

By carrying out an independent key transition in combination with a common
transition, different transition types can be used for the background and keys.
It is also possible to use different transition types for key insertion and key
deletion by means of a Setup menu setting.

For details of this operation, see “Basic Independent Key Transition
Operations” (page 180).

Combining other transitions with independent key transitions

When you set a common transition and a key independent transition for the
same key, you can apply two different effects such as a wipe and mix (dissolve)
(see page 145) to the key simultaneously.

When carrying out such a combination of transitions simultaneously on a key
as auto transitions (see page 170), the result depends on the timing of pressing
the respective [AUTO TRANS] buttons.

Simultaneous execution

If the [AUTO TRANS] buttons for the two transitions are pressed

simultaneously, the following is the result.

Note that in both cases the common transition is a wipe and the independent

key transition is a mix (dissolve).

Deleting a key with simultaneous transitions: With the key inserted, it is
deleted simultaneously with the two transitions.
When the common transition completes, even if the independent key
transition is still not completed, the two end simultaneously.

Independent Key Transitions
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Wipe and mix The key is deleted,

(dissolve) are even if the

carried out independent key

simultaneously.  transition has not
completed.

Deleting a key with simultaneous transitions

Inserting a key with simultaneous transitions: With the key not inserted, it
is inserted simultaneously with the two transitions. If the common
transition or independent key transition ends first, the other continues to

completion.
LA Dk

Wipe and mix The transitions
(dissolve) are continue until both
carried out are completed.

simultaneously.

Inserting a key with simultaneous transitions

Time offset execution

If the [AUTO TRANS] buttons for the two transitions are pressed with a time

offset, the following is the result.

Note that in both cases the common transition is a wipe and the independent

key transition is a mix (dissolve).

Time offset execution with the key inserted: With the key inserted, it is
deleted with the two transitions acting with a time offset.
Whichever button is pressed first, when the common transition completes,
even if the independent key transition is still not completed, the two end
simultaneously.

Independent Key Transitions



Example: When the independent key transition [AUTO TRANS] button
is pressed later

* - e o]

T T The key is deleted,
Common transition Independent key even if the
(wipe) start transition (mix) start ~ independent key
transition has not
completed.

Time offset execution with the key inserted

Time offset execution with the key not inserted: With the key not inserted,
it is inserted with the transition whose [AUTO TRANS] button is pressed
first.

Since the key is then in the inserted state, with the transition whose [AUTO
TRANS] button is pressed later, the key is deleted. When the key is
completely deleted, both transitions complete.

Example 1: When the independent key transition [AUTO TRANS]
button is pressed later

-»1 -»*-»
t I

Common transition Independent key The transition
(wipe) start transition (mix) completes with the
start key deleted.

Example 2: When the common transition [AUTO TRANS] button is
pressed later

- -»k-»

1 t

Independ_e_nt Common The transition
key transition transition (wipe) completes with the
(mix) start start key deleted.

Time offset execution with the key not inserted

Independent Key Transitions
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Basic Independent Key Transition Operations

Key source name display/key @@@@
snapshot buttons ‘

Key delegation buttons

Independent key transition type
selection buttons

Independent key transition
execution section

Independent key transition control block (standard type)

To set independent transitions for the keyers on the M/E or PGM/PST bank,
use the independent key transition control block.

1 Select one or more of the delegation buttons [KEY 1] to [KEY4] ([DSK1]
to [DSK4] in the PGM/PST bank), turning them on.

You can press more than one button at the same time.

2 Select the transition type.

To fade a key in or out: Press the [MIX] button, turning it on.

To insert or delete a key using a dedicated wipe pattern: Press the
[WIPE] button, turning it on.

To insert or delete a key using a dedicated DME wipe pattern: Press
the [DME] button, turning it on.

If, in the Setup menus, you set insertion and deletion as independent
modes, make the settings for the next transition in the independent key
transition control block.

Separate settings are required both when inserting a key and when deleting
it. For example, with the key not inserted, if you select the transition type
and carry out a transition, this will be the setting when inserting a key.

Independent Key Transitions



You can also use the Transition menu to select a desired independent key
transition type for each key (see the next section).

For details of the wipe settings, see “Wipe Settings for Independent Key
Transitions” (page 303). For details of DME wipe settings, see “DME
Wipe Settings for Independent Key Transitions” (page 345).

Execute the transition.

To insert or delete the key gradually with a mix or wipe transition:
Press the [AUTO TRANS] button.

For details of the transition rate, see “Setting the Independent Key
Transition Rate” (page 183).

For details of operation together with a common transition, see
“Combining other transitions with independent key transitions” (page

177).

To cut the Kkey in or out instantaneously: Press the [KEY ON] button on
the keyer.

¢ In an independent key transition, the pattern limit function is not
available.

* When the following DME effects are set, the effects may be applied
during wipe transitions. If the effects are not necessary, cancel the
settings.

— Trail

— Motion Decay

— Wind

When the Keyframe Strobe effect is set, operating keyframes do the
same effect. Cancel the unnecessary settings.

Independent Key Transitions
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Independent key transition operations when using the CCP-6224/
6324 Control Panel

Independent key transition execution section

ON ON ON ON
1234123412341234 )

Transition control block (compact type)

To carry out an independent key transition, press the corresponding button in
the independent key transition execution section of the transition control block.
The color of the button shows the status as follows.

Lit green: transition in progress.

Lit amber: key inserted.

Lit red: key inserted into final program output.

Off: no key inserted.

For details of setting the transition rate, see “Setting the transition rate in the
Flexi Pad control block” (page 163).

Setting the Independent Key Transition Type by a Menu
Operation

You can also select the required independent key transition type by a menu
operation.

1 In the M/E or PGM/PST menu, select first the desired one from VF1
‘Keyl’ to VF4 ‘Key4,” then HF6 ‘Transition.’

The Transition menu for the selected appears.

2 Select the required transition type in the <Transition Type> group.

Independent Key Transitions



If, in the Setup menus, you set insertion/deletion as independent modes,
make the settings for insertion in the <On Transition Type> group, and the
settings for deletion in the <Off Transition Type> group.

Setting the Independent Key Transition Rate

There are two ways of setting the transition rate: using the Flexi Pad control
block, Multifunction Flexi Pad control block or numeric keypad control block
to enter a numeric value, or using the Key menu to access the Transition menu
for the M/E or PGM/PST bank.

You can also display the transition rate, independent key transition rate, and
fade-to-black transition rate for each of the M/E and PGM/PST banks, and
change the settings. (See “Displaying a List of Transition Rates and Changing
the Settings” (page 436).)

When the setup selection is for separate transition rates for inserting or deleting
a key, you can set both rates independently. For example, with the system in
the state with the key not inserted, the transition rate setting applies to key
insertion.

Setting the independent key transition rate in the Flexi Pad
control block

In the PGM/PST bank or when using a simple-type transition control block,
you cannot use the Flexi Pad control block to set the transition rate.

1 In the Flexi Pad control block of the M/E bank, hold down the [TRANS
RATE] button, and in the independent key transition control block, press
the delegation button [KEY 1] to [KEY4] for the key for which you want
to set the transition rate.

The memory recall section display is now ready to accept the entered
independent key transition rate.

2 Enter the desired transition rate with the numeric keypad.

* Enter a value of up to three digits.
* To cancel the entry, press any of the six buttons in the leftmost column
([WIPE], [DME], ...) or the [TRANS RATE] button.

For details of frame input mode and timecode input mode, see page 162.

3 Press the [ENTR] button.
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Setting the independent key transition rate in the numeric
keypad control block

You cannot use the numeric keypad control block to set the transition rate for
a simple transition.

1

In the numeric keypad control block, hold down the [TRANS RATE]
button, and in the independent key transition control block, press the
delegation button [KEY 1] to [KEY4] ([DSK1] to [DSK4] in the PGM/PST
bank) for the key for which you want to set the transition rate.

The numeric keypad control block changes to the mode for inputting the
independent key transition rate, and its display now shows the
corresponding region name and the current transition rate set for the
region.

With the numeric keypad, enter the transition rate.

* Enter a value of up to three digits.
* To clear the entry value, press the [CLR] button.

For details of frame input mode and timecode input mode, see page 162.

Press the [ENTER] button.

This confirms the entry, and the selected region name and the set transition
rate appear in the numeric keypad control block display.

To enter a difference from the current value

After pressing the [+/—] button, enter the difference and press the [TRIM]
button.

To change the sign (+ or —), press the [+/—] button.

Setting the independent key transition rate in the Multifunction
Flexi Pad control block

For example, to set the independent key transition rate for M/E-1 keyl, carry
out the following procedures.

1

In the Multifunction Flexi Pad control block, press the [TRANS RATE]
button.

The Multifunction Flexi Pad control block switches to the transition rate
setting mode.

Independent Key Transitions



2 In the region selection buttons, select the switcher bank.

3 Press the [TRANS SEL] button in the memory recall section.

You can select the type of transition for which to set the rate.

4 Press the [KEY 1] button.

This enables setting of the independent key transition rate for M/E-1 key 1.

5 Watching the alphanumeric display, enter the transition rate you want to
set with the memory recall section button.

If required, press the [TC] button to switch the input mode (frame count
input or timecode input).

* Enter a value of up to three digits.

* To cancel the input, press any of the mode selection buttons.

6 Press the [ENTR] button.

Setting the independent key transition rate by a menu operation

1 In the M/E or PGM/PST menu, select first the desired one from VF1
‘Keyl’ to VF4 ‘Key4,” then HF6 ‘Transition.’

The Transition menu for the selected key appears.

2 Select any transition type in the <Transition Type> group.

If, in the Setup menus, you set insertion/deletion as independent modes,
make the settings for insertion in the <On Transition Type> group, and the
settings for deletion in the <Off Transition Type> group.

3 Turn the knob to set the transition rate.

Knob Parameter Adjustment | Setting values

1 Transition Rate Transition rate | 0 to 999 (frame count)

Independent key transition rate display

To check the set independent key transition rate, press the key source name
display/key snapshot button above the corresponding delegation button when
the [K-SS] button is off.
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Displaying the independent key transition rates in a menu and
changing the settings

For each of the M/E and PGM/PST banks, you can also display the transition
rate, independent key transition rate and fade-to-black transition rate, and
change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the
Settings” (page 436).

Independent Key Transitions



Fade to Black

The PGM/PST bank provides a fade-to-black function, controlled with the
[FTB] button in the fade to black control block.

In multi-program mode or DSK mode, it is possible to carry out a fade-to-black
on a number of programs simultaneously.

You can also make a Setup menu setting such that a fade-to-black does not
apply to particular programs.

For details of the setting, see “Settings Relating to Video Switching (Transition
Menu)” in Chapter 20 (Volume 3).

Fade to Black Operation

—— FTB button

Fade to black control block

Carrying out a fade to black

To carry out a fade to black, press the [FTB] button in the fade to black control
block.

The fade to black is carried out with the transition rate set for the program
output of the PGM/PST bank.

Fade to Black
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During the transition, the [FTB] button lights amber. When the transition
completes (the video is completely black), the button lit color changes to red.

Setting the Fade to Black Transition Rate

Setting the fade to black transition rate

1 In the PGM/PST menu, select first VE7 ‘Misc,’ then HF1 ‘Transition.’

The Transition menu appears.
2 Select [FTB].

3 Turn the knob to set the fade to black transition rate.

Knob Parameter Adjustment Setting values

1 Transition Rate Transition rate 0 to 999 (frame count)

Displaying the transition rates in a menu and changing the
settings

You can also display the transition rate, independent key transition rate, and
fade-to-black transition rate for each of the M/E and PGM/PST banks, and

change the settings.

For more details, see “Displaying a List of Transition Rates and Changing the
Settings” (page 436).

Fade to Black




Simple Transition

The “simple transitions” refer to the transitions carried out using the simple-
type transition control block (or simple-type independent key transition control
block).

Basic Operations for Simple Transitions

Key transition selection buttons

Key status display

Transition type selection buttons

ON ON —
OVER OVER

= j\]]

C

L/

Transition execution section

Transition control block (simple right-hand type)

The simple transition control block cannot be installed in the CCP-6224/6324
Control Panel.

Simple Transition 189
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Carrying out a transition using a simple-type transition control

block
1
2
3
Simple Transition

With the background A row of cross-point buttons in the cross-point
control block, select the background video.

Using one of the following methods, select the way in which the transition
will affect the image.

Use a combination of the transition type selection buttons ([MIX], [NAM],
[WIPE] and [DME]) and the next transition selection buttons ((KEY 1] and
[KEY2)).

For an overview of the mix, NAM, wipe, and DME wipe transition types,
see “Transition Types” (page 145).

To change the background only: Press one of the [MIX], [NAM],
[WIPE], and [DME] buttons.

The [KEY 1] and [KEY2]buttons go off, and the system changes to the
background transition mode.

To insert or delete key 1: Hold down the [KEY 1] button and press one of
the [MIX], [NAM], [WIPE], and [DME] buttons.

To insert or delete key 2: Hold down the [KEY?2] button and press one of
the [MIX], [NAM], [WIPE], and [DME] buttons.

To insert or delete key 1 and key 2 simultaneously: Hold down the
[KEY1] and [KEY?2] buttons, and press one of the [MIX], [NAM],
[WIPE], and [DME] buttons.

To use a super mix or preset color mix: Select [Super Mix] or [Preset
Color Mix] in the Misc >Transition menu for the M/E or PGM/PST
bank.

To set the key priority, use the Misc >Key Priority menu for the M/E or
PGM/PST bank. For details, see “Setting the Key Priority by a Menu
Operation” (page 153).

The transition type selection buttons ([MIX], [NAM], [WIPE], and
[DME]) can be assigned to other transition types in setup.

For details, see “Overall Control Panel Settings (Config Menu)” in
Chapter 19 (Volume 3).

Select the new background for after the transition.

¢ Select the background video with the background B row of cross-point
buttons.



» To insert a key, select the key signal, and make various settings as
required.

For details of key settings, see Chapter 4 “Keys” (page 195).

4 Depending on the transition type selected in step 2, make the required
settings.

For details of the settings, see the following sections:

Super mix: “Super Mix Settings” (page 157)

Preset color mix: “Color Matte Settings” (page 158)

Wipe: “Basic Procedure for Wipe Settings” (page 277)

DME Wipe: “Basic Procedure for DME Wipe Settings” (page 334)
Clip transition: “Clip Transition Operations” (page 408)

5 Carry out the transition in the transition execution section.

For a gradual transition such as a mix or wipe: Press the [TAKE]
button, or operate the fader lever.

See “Setting the Transition Rate” (page 162) and “Pattern Limit” (page
167) as required.

Display of the Key Output Status and Key Priority

You can check the output status of keys 1 and 2 and the key priority setting, in
the key status display in the transition control block.

The key status display includes two ON indicators corresponding to keys 1 and
2.

Display of the key output status
When the key is inserted in the output from the M/E or PGM/PST bank, the
indication “ON” lights, and when it is not inserted, the indication goes off.

Key priority display
The key lying in front on the program monitor has an indication “OVER” lit.

To set the key priority, use the Misc >Key Priority menu for the M/E or PGM/
PST bank. For details, see “Setting the Key Priority by a Menu Operation”
(page 153).

Simple Transition
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Split Fader

What does “split fader” mean?

The term “split fader” refers to the function of carrying out a transition with the

fader lever split into left and right halves, so that the background A and

background B buses can be manipulated separately.

To use the split fader, the following conditions must be met.

* The fader lever is in bus fixed mode. (See “Settings Relating to Video
Switching (Transition Menu)” in Chapter 20 (Volume 3).)

» The necessary settings have been made in a Setup menu to enable the split
fader (See “Settings Relating to Video Switching (Transition Menu)” in
Chapter 20 (Volume 3).)

* A background is selected for the next transition.

* For the transition type, [MIX] or [NAM] is selected.

Split fader operation

The two halves of the split fader lever correspond to the buses as follows.
Right fader lever: Background A bus

Left fader lever: Background B bus

The relationship between the positions of the two fader levers and the image
output in a mix is as follows.

Left lever position | Right lever A bus output B bus output
position

Top Top 100% 0%

Bottom Top 100% 100%

Top Bottom 0% 0%

Bottom Bottom 0% 100%

Center Center 50% 50%

* When the transition type is NAM, the outputs of the A bus and B bus in the
above table are the outputs subjected to NAM.

¢ The transition indicators always show the progress of the background A bus.

 The operation of the left lever and that of the right lever can be swapped. (See
“Operation Settings (Operation Menu)” in Chapter 19 (Volume 3).)

Independent Key Transitions With a Simple Transition

Module

You carry out independent key transition operations using the independent key
transition control block (simple type). This controls only keys 3 and 4.
However, each key button can be assigned to any key in setup (see “Overall
Control Panel Settings (Config Menu)” in Chapter 19 (Volume 3)).

Simple Transition



Key 3 control block  Key 4 control block

Independent key transition
execution section

Independent key transition type
selection buttons

The functions of the key 3 control block and key 4 control block are the same.

Independent key transition control block (simple type)

Carrying out a transition using a simple-type independent key
transition control block

1 Select the transition type for key 3 or key 4 using the independent key
transition type selection buttons.

To fade a key in or out: Press the [MIX] button, turning it on.

To insert or delete a key using a dedicated wipe pattern: Press the
[WIPE] button, turning it on.

To insert or delete a key using a dedicated DME wipe pattern: Press
the [DME] button, turning it on.

For details of wipe settings, see “Wipe Settings for Independent Key
Transitions” (page 303). For details of DME wipe settings, see “DME
Wipe Settings for Independent Key Transitions” (page 345).

To cut the key instantaneously in or out: Press the [CUT] button, turning
it on.

Simple Transition
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Simple Transition

If, in the Setup menus, you set insertion and deletion as independent
modes, make the settings for the next transition in the independent key
transition control block.

Separate settings are required both when inserting a key and when deleting
it. For example, with the key not inserted, if you select the transition type
and carry out a transition, this will be the setting when inserting a key.

Carry out the transition in the independent key transition execution
section.

To insert or delete the key gradually with a mix or wipe transition:
Press the [TAKE] button.

To set the independent key transition rate using a simple-type transition
control block, use the key 3 and key 4 Transition menus. For details, see
“Setting the Independent Key Transition Rate” (page 183).

To cut the key in or out instantaneously: Press the [KEY 3 ON] button
or [KEY 4 ON] button.

In an independent key transition, the pattern limit function is not available.
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Overview

A key is an effect in which a part of the background image is replaced by an
image or superimposed text. The signal determining how the background is cut
out is termed “key source,” and the signal that replaces the cut-out part is
termed “key fill.”

The system component responsible for processing a key is referred to as a
keyer.

Each M/E bank and the PGM/PST bank has four keyers, and all of these keyers
provide the same functions.

Key Types

The key type indicates the manner in which the key source signal is used to cut
out the background. In each bank, you can use the following key types. You
can select the key type using the key type selection buttons in the key control
block or Multi function Flexi Pad control block, or by a setting in the Type
menu for the keyer. (See “Key Type Setting” (page 205).)

Luminance key

The background is cut out according to the luminance (Y) of the key source
signal, and at the same time the key fill signal is cut out and then added to the
background signal.

Linear key

This is a type of luminance key, but there is a reduced variability in gain,
allowing more precise adjustment.

Color vector key

The key signal is created from a combination of the luminance and
chrominance components of the key source signal. When perfect keying is not
possible with a luminance key, this allows a key signal to be created even if the
luminance level is low, provided that the colors have high saturation.

Clean mode

In a luminance key, linear key or color vector key, you can enable the clean
mode. When the clean mode is on, the key source does not affect the key fill,
which is added unchanged to the background. This improves the keyed image

Overview
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quality, but means that the part of the key fill signal which is not to be inserted
must be completely black, or it will color the background. You set the clean
mode with the Type menu of the respective keyer. (See “Setting the key type in
amenu” (page 205).)

Note that in the following situations, the clean mode goes off, and cannot be
turned on.

* When the key type is a pattern key

* When key inversion is on

¢ When the key fill is a matte

e When the key edge is an outline

* When the key edge is normal with soft edge being on

* When fine key is on

* When the key positioner is on

Chroma key
A key signal based on a particular color is used to cut out the background, and
the key fill is then inserted. The inserted signal is also referred to as the
foreground, and the composite image is called a chroma key image.

Foreground Background

Chroma key image

For details of chroma key composition, see “Chroma Key Composition” (page
207). For details of video adjustment operations and the adjustment items, see
“Chroma Key Adjustments” (page 208).

Wipe pattern key

This uses the wipe pattern selected for a transition as the key source.
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Key wipe pattern key

This uses the wipe pattern selected for an independent key transition as the key
source.

Note on wipe pattern modifiers

In a wipe pattern key or key wipe pattern key, you can apply various
modifications, depending on the pattern used, and the modifiers in common
with a wipe.

However, modifiers which relate to the wipe direction and edge are not
reflected.

Key Modifiers

Edge modifiers

You can apply borders and other effects to the edge of the key. (See “Key Edge
Modifications” (pages 217 and 238).)

Name Effect Image

Normal | This is the state with no key edge modifiers
applied.

Border | This applies a uniform width border to the
edge of the key. You can adjust the border
width and density. You can also enable the
separate edge function, and adjust the top,
bottom, left, and right border widths
separately.

Overview
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Name Effect Image

Drop This applies a border below and to the right
border | for example, of the key. You can adjust the
border width, position, and density.

Shadow | This applies a shadow below and to the right
for example, of the key. You can adjust the
shadow width, position, and density.

Outline | This uses the outline of the original key as
the key. You can adjust the width and density
of the outline. You can also enable the
separate edge function, and adjust the top,
bottom, left, and right outline widths
separately.

Emboss | This applies an embossing effect to the -
outline of the key. You can adjust the width
and position of the embossing, and the
density. You can adjust the density
separately for key fill and key edge. When
embossing is on, the Fine Key and zabton
functions go off.

Soft This softens the edge of the key. -
edge

Zabton | This inserts a translucent pattern behind a -
key. You can adjust the pattern size,
softness, density and color.

Edge type and key fill’key source position

The key edge modification function has two modes: a mode (“key drop ON
mode”) in which the key fill/key source position moves downward, and a mode
(“key drop OFF mode”) in which it does not move downward.
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Edge fill

Masks

Key drop ON mode: The key fill’key source position moves downward by
eight scan lines or four scan lines. When a drop border or shadow is
selected, it is possible to apply a border to the top edge of the key.

Key drop OFF mode: The key fill/key source position does not move. When
a drop border or shadow is selected, it is not possible to apply a border to
the top edge of the key.

In the key drop ON mode, a menu setting selects between the mode (“4H

mode”) in which the key fill/key source position is lowered by four scan lines,

and the mode (“8H mode”) in which the key fill/key source position is lowered
by eight scan lines.

When Fine Key is on, the edge width is forced to the range 0.00 to 4.00.

Note that in the following situations, the key drop mode is forcibly turned on.
* When the edge type is border, outline, or emboss

* When the edge type is normal with soft edge being on

* When Fine Key is on

To fix key fill / key source in key drop off mode

In the Edge menu, switch frame delay mode on (see page 221).

Regardless of the fine key and edge type settings, key fill and key source are
fixed in key drop off mode. In this mode key image has a one-frame delay.

[Notes
¢ This function is only valid on the MVS-8000G/8000GSF.

* This function uses the resizer, and therefore the normal effect of the setting
is not obtained while using DME wipe or other effect that uses the resizer.

When a border, drop border, or shadow modifier is selected, you can select a
signal to fill these edge effects.

The edge fill may be either the signal from the dedicated color matte generator,
or the signal currently selected on the utility 1 bus.

In the case of an outline, there is no edge fill signal selection, because the key

fill signal fills the outline, and the rest of the image remains as the background.

For the emboss effect, in place of the edge fill signal, the emboss fill matte 1
and emboss fill matte 2 signals are used.

A mask is used to inhibit the effect of a key over a part of the image. This
allows parts of the background which would otherwise be keyed to be
protected, or to correct the key if it is not of the desired shape.

For details of masking operations, see “Masks” (pages 225 and 242).
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Key mask and background mask

There are two types of mask: a key mask and a background mask.

Key mask: This masks out a part of the key, which will result in the
background appearing.

Background mask: This masks out a part of the background, which will result
in the key fill appearing.

Masked area (box) ‘A4
— ~l =@
A4

Background mask

Key mask

Main mask and subsidiary (“sub”) mask

Each keyer allows two masks to be used simultaneously, and these are referred

to as the main mask and the sub mask. The signal that determines the mask

shape and size is termed the mask source, and different sources are used for the
main mask and sub mask.

Main mask: This uses the signal from the dedicated box generator provided
on each keyer, or the signal from the dedicated pattern generator as the
mask source.

When the box generator is selected, a rectangular mask is formed. You can
adjust the positions of the four sides of the box separately.

When the pattern generator is selected, you can select the pattern and apply
modifiers.

Sub mask: This uses the wipe generator signal or the signal selected on the
utility 1 bus, as the mask source.

When the wipe generator is selected, the patterns and the pattern modifiers
are the same as in a wipe transition.

Key Memory

Overview

The key memory function allows the keyer settings on each cross-point button

to be automatically stored, so that the next time the same cross-point button is

selected these settings are recalled automatically.

There are two modes for key memory: simple mode and full mode.

The parameters stored in each mode are as follows.

Simple mode: key type, clean mode (including the plane setting for chroma
keying), key position, key inversion, and adjustment values for the



particular key type (Clip, Gain, Density, Filter, etc. This includes color
vector key, wipe pattern key, key wipe pattern key, and chroma key.
However, in the case of a chroma key, it excludes color cancel, Y balance,
foreground CCR, window, and shadow.)

Full mode: All settings except transition (the same parameters as simple mode,
Fine Key, key modifiers, main and sub mask settings, chroma key detailed
settings, and so on)

For the settings for these modes, see “Settings Relating to Keys, Wipes, Frame
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20
(Volume 3).

Key Default

With a simple operation you can return the key adjustment values to their

defaults.

The adjustment values which can be returned to their default values are as

follows.

* Adjustment values for the particular key type (Clip, Gain, Density, Filter,
etc.)
In the case of chroma keying, all adjustment values return to their default
values.

» Key position

* Key inversion

* Clean mode

For details, see “Returning the key adjustment values to their defaults” (page
247).

For the menu operation to return the key adjustment values to their defaults,
see “Returning to default state in function groupings” (page 116).
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Key Setting Operations Using Menus

There are two ways of making key settings: either using menus, or using the
key control block or the Multifunction Flexi Pad control block.

This section describes basic procedures for making key settings using the
menus, taking the M/E-1 >Key1 menu as an example.

Operations in the Key menus are the same for all banks (M/E-1 to M/E-3 and
PGM/PST).

For details of the method of using the key control block, see “Key Setting
Operations With the Key Control Block” (page 234).

Key Setting Menus

The key setting menus for each bank (M/E-1 to M/E-3 and PGM/PST) are as
follows.

Bank Keys set Menus

M/E-1 Keys 1to 4 M/E-1 >Key1 to 4
M/E-2 Keys 1to 4 M/E-2 >Key1 to 4
M/E-3 Keys 1to 4 M/E-3 >Key1 to 4
PGM/PST Downstream keys 1 to 4 PGM/PST >DSK1 to 4

Accessing a key setting menu

For example, to access the M/E-1 >Key1 menu, carry out any of the following

procedures.

* In the menu control block, select the top menu selection button [M/E 1], then
press VF1 ‘Keyl.

¢ In the M/E-1 bank transition control block, press the KEY 1 next transition
selection button twice in rapid succession.

* In the M/E-1 bank independent key transition control block, press the key
delegation button [KEY 1] twice in rapid succession.

* In the key control block, press the M/E delegation button [M/E1], then press
the key delegation button [KEY1] twice in rapid succession.

Any of the above operations displays the M/E1 >Key1 menu.

Note that you can access the DSK menus by pressing the button for the

corresponding key in the downstream key control block twice in rapid

succession.

Key Setting Operations Using Menus




Key Type Setting

Setting the key type in a menu

1

2

4

In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

In the <Key Type> group, select the key type.

Luminance: luminance key

Linear: linear key

Chroma: chroma key

Color Vector: color vector key

Wipe Pattern: wipe pattern key

Key Wipe Pattern: key wipe pattern key

For the selected key type, you can now set the parameters.

For an overview of the key types, see “Key Types” (page 197).

Carry out the following settings as required, depending on the key type
selected in step 2.

To enable clean mode (see page 197) for a luminance key, linear key or
color vector key: Select [Clean Mode] so that it is set on.
When clean mode is enabled, key fill is added to the background
without cutting out with key source.

When chroma Kkey is selected: Select [Chroma Adjust] to access the

Chroma Adjust menu (see page 210), and make the required settings.

When a wipe pattern key is selected: In the M/E-1 >Wipe menu (see
page 277), select the pattern and set any modifiers, then return to the
M/E-1 >Key1 menu.

When a key wipe pattern key is selected: In the M/E-1 >Keyl >
Transition >Wipe Adjust menu (see page 303), carry out pattern
selection and modifier setting, then return to the M/E-1 >Key1 >Type
menu.

For a wipe pattern selected for a wipe pattern key or key wipe pattern key,
the [Edge] and [Direction] modifier settings are not available.

Set the parameters.
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* When a luminance key or linear Key is selected

Knob | Parameter |Adjustment Setting values
1 Clip Reference level for generating the | +109.59 to —7.31
key signal
Gain Key sensitivity —100.00 to +100.00
Density Key density 0.00 to 100.00
Filter Filter coefficient 1t092

a) Setting this value to 1, produces the “through” state in which no filter is applied. The larger
the value, the more strongly the filter applies.

* When a chroma key is selected

Knob |Parameter |Adjustment Setting values
3 Density Key density 0.00 to 100.00

* When a color vector key is selected

Parameter group [1/2]

Knob | Parameter |Adjustment Setting values
1 Y Clip Reference level for creating +109.59 to —7.31
luminance signal
Y Gain Luminance signal sensitivity —100.00 to +100.00
C Clip Reference level for creating 100.00 to 0.00
chrominance signal
4 C Gain Chrominance signal sensitivity —100.00 to +100.00
Density Key density 0.00 to 100.00

Parameter group [2/2]

Knob | Parameter |Adjustment Setting values
1 Y Filter Luminance signal filter coefficient | 1to 9
2 C Filter Chrominance signal filter 1to9
coefficient
* When a wipe pattern key or key wipe pattern key is selected
Knob | Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
Soft Degree of edge softness 0.00 to 100.00
Density Key density 0.00 to 100.00

5 Make the following settings as required.
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To invert the black and white sense of the key source: Press [Key
Invert], turning it on.

To adjust the horizontal position or key source width for a luminance
key, linear key, or chroma key: Press [Key Position], turning it on,
and set the parameters.

Knob | Parameter |Adjustment Setting values
1 H Phase Key horizontal position —4.00 to +4.00
Left Key left edge position —4.00 to +4.00
Right Key right edge position —4.00 to +4.00

To set the key priority: Press [Key Priority] or select VF7 ‘Misc’ and
HF3 ‘Key Priority’ to access the Key Priority menu.
For details, see “Setting the Key Priority by a Menu Operation” (page
153).

Chroma Key Composition

Normal mix and additive mix

In creating a chroma key image, either a normal mix or an additive mix can be

used. To select which, use the Type >Chroma Adjust menu for the keyer.

Normal mix: The foreground is cut out with the key signal, and then combined
with the background, which has also been cut out with the key signal.

Additive mix: The background, which has been cut out with the key signal, is
combined with the unshaped foreground. This is effective for a natural-
looking composite when the scene includes glass or other translucent
objects.

Plane function

In an additive mix, the foreground is not shaped by the key signal, and
variations in the (blue) background appear in the composite image. To prevent
this, it is possible to set a particular luminance level for the background, and
any parts below this level are cut forcibly.

Composing an image by chroma keying

There are two types of composition for chroma keying: normal mix, and
additive mix.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

2 Select [Chroma] in the <Key Type> group.
It becomes possible to adjust the key density (see page 206).
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3 Select [Chroma Adjust].

The Chroma Adjust menu appears.

4 Carry out auto chroma key adjustments.
Also carry out manual adjustments if necessary to obtain an optimum

chroma key image.

For the adjustment procedures, see page 208.

5 In the <Mix Mode> group, select [Normal Mix] or [Additive Mix]
depending on the desired type of chroma key composition.

When using an additive mix for chroma keying, the (typically blue)
background parts of the foreground video must be converted to black. For this,
use the color cancel function (see page 211).

Using the plane function

In an additive mix, since no key is applied to the foreground, any variations in
the (typically blue) background may appear in the composite image. To avoid
this, a particular luminance level can be set for the (blue) background, and
regions of lower luminance forcibly cut.

1 In the Chroma Adjust menu, set [Plane] on.

2 Adjust the following parameter.

Knob |Parameter |Adjustment Setting values

1 Luminance | Luminance level 0.00 to 100.00

Chroma Key Adjustments

Methods of adjusting the composite obtained from chroma keying include
automatic adjustment with the auto chroma key function, and manual
adjustment carrying out the necessary processing separately. The optimum
results will be obtained by first carrying out adjustments with the auto chroma
key function, then making any fine adjustments as required.

The following manual adjustments are possible.

Key active
When this function is off, only the foreground is output and you can make

adjustments of color cancel (see the next paragraph).

Key Setting Operations Using Menus




Color cancel
If the foreground image includes shades of the background color, turn this
function on to remove the color from the foreground image.

Chroma key window
You can adjust the range over which the key signal is determined as matching
the specified hue. When this adjustment is off the default ranges are used.

Chroma keying generates a key signal based on a particular color (reference
color) in the foreground (typically a plain blue background), and the “window”
refers to the range of colors which are regarded as matching this specified
reference color to create the key signal.

As seen on a vectorscope (that is, in the hue-saturation color space), the range
for this matching corresponds to a truncated sector. This range is specified by
two parameters: the “Angle” parameter, which determines the range of the hue
parameter, and the “Crop” parameter, which determines the degree of
truncation (see the following figure).

Angle
B St
| ‘,'
I -
; S » Reference color
i RIS specified by Hue
N SRR setting
Crop @
Range of colors remaining Range of colors creating the key signal
as foreground (to be replaced by background signal)

a) The Crop and Angle values do not change even if
you use the auto chroma key function.

Window adjustment

Y balance

In normal chroma keying, the key signal is based on the chrominance
component only, and all elements of the foreground with the same hue are
replaced by the background. Using the Y balance function, you can specify a
luminance level range within which the key is active, and replace the specified
part by the background.
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You can use the Y balance function independently on the key signal for the
composition and the key signal for the color cancel function. When applied to
the key signal for the composition, this produces the foreground with the color
cancel effect applied. This can therefore be used to provide an impression of
smoke, for example.

When the Y balance function is applied to the color cancel key, the relevant
part is output in its original color without canceling, and therefore it is possible
to combine colors which are the same color as the background (i.e. typically
blue) in the foreground.

Chroma key shadow

This function provides a more realistic treatment when the shadow of an object
in the field of view falls on the blue background. Since parts of the blue
background darker than a specified intensity are treated as shadows, there is no
effect on cutting out of the foreground.

Video signal adjustment
You can vary the foreground signal gain, or change the hue. There are separate
adjustments for the gain of the overall video signal, and Y and C components.

Making auto chroma key adjustments

Auto chroma key is an automatic adjustment function which allows you to
specify a part of the foreground video (for example, the blue background color)
and use it as a reference for creating the chroma key image.

1 In the M/E-1 >Key1 menu, select HF1 “Type,’ then select [Chroma] in the
<Key Type> group.

2 Select [Chroma Adjust].

The Chroma Adjust menu appears.

3 Select [Sample Mark] in the <Auto> group.

The foreground video only appears on the monitor, with a white box-
shaped sample selector.

4 Adjust the position and size of the sample selector, to specify the color to
be used as the basis of chroma keying (typically a blue background).

Knob |Parameter |Adjustment Setting values
1 Position H Horizontal position —100.00 to +100.00 &
2 Position V Vertical position —~100.00 to +100.00 @
3 Size Size 1.00 to 100.00

Key Setting Operations Using Menus



a) The setting ranges depend on the signal format, screen aspect ratio, and size settings.

5 Select [Auto Start] in the <Auto> group.

This executes an auto chroma key based on the color specified by the
sample selector, and displays the composite image on the monitor.

Making key active adjustments

When the key active function is on, the composite image is output to the
monitor, and you can watch the monitor while manually adjusting the keying.
When the key active function is off, only the foreground image appears. Set
this off when manually adjusting color cancel (see the next section).

1 In the Chroma Adjust menu, set [Key Active] on.

2 Adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Clip Chroma key reference level 0.00 to 100.00

2 Gain Key gain —100.00 to +100.00
3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

5 Filter Filter coefficient 1t09

Making color cancel adjustments

If the background color is leaking into the foreground video, turning the color
cancel function on allows you to eliminate this leakage.

1 In the Chroma Adjust menu, turn [Key Active] off.

Only the foreground image appears on the monitor.
2 In the <Color Cancel> group, set [Color Cancel] on.

3 Adjust the following parameters.

Knob |Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00
5 Filter Filter coefficient 1t09
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4 Set [Key Active] on.

Making key signal adjustments for color cancel

When the color cancel function is set on, you can adjust the key signal for color
cancel.

1
2

The chroma key composite image now appears in the monitor.

In the <Color Cancel> group of the Chroma Adjust menu, set [Color

Cancel] on.

In the <Color Cancel> group, set [Cancel Key] on.

The cancel key is now on, and you can now adjust the key signal for color

cancel.
Knob | Parameter |Adjustment Setting values
1 Clip Color cancel key reference level | 0.00 to 100.00
2 Gain Color cancel key gain —100.00 to +100.00

Make the following settings, as required, in the <Color Cancel> group.

* When setting [Key Position] on and adjusting the color cancel key

edge position

Knob | Parameter |Adjustment Setting values

1 H Phase Move left and right edges of the Left edge position
color cancel key simultaneously value shown

2 Left Move left edge of the color cancel |-3.00 to +3.00
key

3 Right Move right edge of the color —-3.00 to +3.00
cancel key

* When setting [Window] on and adjusting the detection range of the

color cancel key

Knob |Parameter |Adjustment Setting values
1 Crop Crop value 100.00 to 0.00
2 Angle Angle value 180.00 to 0.00

For details of the crop and angle parameters, see “Chroma key window”

(page 209).
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* When setting [Y Balance] on and adjusting the ratio in which Y
balance is added to the color cancel key

Knob | Parameter |Adjustment Setting values
1 Mixture Ratio of Y balance key 0.00 to 100.00

Adjusting the window

Setting the window function on allows you to adjust the detection range used
to determine the key signal. When this function is off, the default range is used
for the key.

For an overview of the window, see “Chroma key window” (page 209).

After making sure that the values of Clip, Gain, and Hue are adjusted
appropriately, use the following procedure to make the window adjustment.

1 In the Chroma Adjust menu, set [Window] on.

2 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values
1 Crop Crop value 100.00 to 0.00
2 Angle Angle value 180.00 to 0.00

Adjusting the Y balance

Setting the Y balance on allows you to specify that, even if the hue is the same,
only portions of a particular luminance will be replaced by the background.

For an overview of the Y balance, see “Y balance” (page 209).
1 In the Chroma Adjust menu, set [Y Balance] on.

2 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 Clip Luminance range 0.00 to 100.00
Gain Key gain —100.00 to +100.00
Luminance |Luminance 0.00 to 100.00

Adjusting the chroma key shadow

This function allows a shadow falling on the (typically blue) background color
to be rendered more realistically. Since portions of the (blue) background of
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less than a certain luminance are treated as shadows, there is no effect on
cutting out of the foreground.

1 In the Chroma Adjust menu, set [Shadow] on.

2 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values
1 Luminance | Reference luminance for shadows | 0.00 to 100.00
2 Gain Shadow key gain —100.00 to +100.00
3 Density Shadow opacity 0.00 to 100.00
4 Soft Shadow softness 0.00 to 100.00

When chroma key shadow is on, key edge is changed to normal, and soft edge
is switched off.

Adjusting the video signal

You can change the gain of the foreground signal, or vary the Hue. There are
separate adjustments for the gain of the whole video signal, or Y and C
individually.

1 In the Chroma Adjust menu, set [FRGD CCR] on.

2 Adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Video Gain | Overall gain of video signal —100.00 to +100.00
2 Y Gain Y signal gain —100.00 to +100.00
3 C Gain C signal gain —100.00 to +100.00
4 Hue Hue offset amount —180.00 to +180.00

Selecting Key Fill and Key Source

Selecting key fill and key source

To select key fill and key source for key 1 on the M/E-1 bank, use the following
procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’
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The Type menu appears.

In the <Key Fill> group, select either of the following for use as key fill.

Key Bus: signal selected on the key 1 fill bus
Matte: signal from the dedicated color matte generator

If you selected [Key Bus] in step 2, select the key fill signal on the key 1
row in the cross-point control block.

To select key fill for key 3 or key 4 in the cross-point control block, press
the [KEY3] button or [KEY4] button to the right of the key bus buttons,
turning it on, to allocate the key 1 row or key 2 row to the key 3 fill or key
4 fill, then press the desired cross-point button.

For the CCP-6224/6324 Control Panel, it is necessary to set the [AUX
CTRL] button to Off in order to exit the AUX panel-less function (see page
139).

If you selected [Matte] in step 2, in the same Type menu, press the [Matte
Adjust] button to display the Matte Adjust menu, then adjust the single-
color or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Fill Matte> group.

Flat Color: Adjust color 1 with the following parameters.

Knob | Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

Mix Color: Carry out a color mix. Adjust color 1 and color 2, and select a
mix pattern (see the next section).

In the <Key Source> group, specify the key source selection mode.

Self: The key fill bus signal is automatically selected as the key source.
When the key type is selected as chroma key, select [Self].

Auto Select: The signal allocated, being paired with the key fill bus signal,
to a cross-point button is automatically selected as the key source. The
setting of key fill and key source pairs is carried out in the Setup menu.
(See “Cross-Point Settings (Xpt Assign Menu)” in Chapter 19
(Volume 3).)

Split: You can select a key source signal independently of the key source
automatically selected in Auto Select mode.

When [Split] was selected in step 5, hold down the [SPLIT] button in the
key control block or the Multifunction Flexi Pad Control block, then in the
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cross-point control block key 1 row, select the key source signal.
Alternatively, hold down the key delegation button in the transition control
block and press a cross-point button in the key 1 row to select the key
source signal.

* Inthe above-stated key 1 row operation, you can only select a key signal
assigned to a cross-point button. For the method of selecting a video
signal, see “To select a video signal assigned to a cross-point button”
below.

* On the MVS-8000, the video signal selection operation is not supported.

e When [Split] is selected, the key memory function (see page 202) is
disabled.

To select a video signal assigned to a cross-point button

By selecting the key source bus with an auxiliary bus control block AUX
delegation button, and pressing the cross-point button, it is possible to select
the video signal assigned to the cross-point button.

(If you press the cross-point button with holding down [KEY], the key signal
assigned to the cross-point button.)

In the above operation, the following settings must have been made.
» Assigning the key source bus to an AUX delegation button

For details, see “Auxiliary Bus Control Block Settings (Aux Assign Menu)”
in Chapter 19 (Volume 3).

* Setting the [KEY] button operating mode
For details, see “Operation Settings (Operation Menu)” in Chapter 19
(Volume 3).

This operation is not supported on the MVS-8000.

Carrying out a color mix for key fill

When [Matte] is selected for key fill, you can combine color 1 and color 2. For
the combination, you can use not only a key wipe generator pattern, but also
the dedicated pattern for key edge color mix.

1 In the <Key Fill> group of the Type menu, select [Matte] and press [Matte
Adjust].

The Matte Adjust menu appears.
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2 Select [Mix Color] in the <Fill Matte> group.

3 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of the edge of the 0.00 to 100.00
pattern

4 Select the combining pattern in the <Mix Pattern> group.

Key Wipe: The wipe pattern selected for an independent key transition is
used for combination. You can change this pattern by pressing [Pattern
Select] to open the menu for key wipe pattern selection (Pattern Select
menu), and make adjustments by pressing [Pattern Adjust] to open the
menu for pattern adjustment (Wipe Adjust menu).

Key Edge Pattern: Combine using the dedicated pattern selected for the
color mix in the key edge fill. You can change this pattern by pressing
[Pattern Select] to open the menu for edge color mix dedicated wipe
pattern selection (Mix Pattern Select menu), and make adjustments by
pressing [Pattern Adjust] to open the menu for pattern adjustment
(Matte Adjust menu).

For details, see “Carrying out a color mix for the key edge fill matte”
(page 222).

5 In the Type menu, adjust color 1 and color 2.

To adjust color 1, select [Colorl1], and to adjust color 2, select [Color2],
then adjust the following parameters.

Knob |Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00 P —
2 Saturation Saturation 0.00 to 100.00 —
3 Hue Hue 359.99 to 0.00 Q
1
[0}
6 To interchange color 1 and color 2, press the [Color Invert] button, turning N
it on. %
2
(2]
Key Edge Modifications
To modify the key edge of key 1 on the M/E-1 bank, use the following
procedure.
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1

2

In the M/E-1 >Key1 menu, select HF2 ‘Edge.’

The Edge menu appears.

Select the edge type in the <Edge> group.

For an overview of the key edge modifications, see “Edge modifiers”
(page 199).

Normal: unadorned edge

Border: edge with border applied

Drop Border: edge with drop border applied
Shadow: edge with shadow applied
Outline: edge used as outline

Emboss: embossing effect applied to edge

If you select [Normal], skip to step 7.

Set the border width and other parameters.

When border or outline is selected: The setting parameters depend on
the key type and whether the separate edge function is enabled or not.
To enable the separate edge function, press [Separate Edge], setting it
on.

* Separate edge off

Knob Parameter | Adjustment Setting values

1 Width Width 0.00 to 8.00 @
(0.00 to 100.00) ©)

3 Density Density 0.00 to 100.00

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0.00
to 4.00.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

* Separate edge on
The left, right, top, and bottom border or outline widths can be adjusted
independently. The separate edge function is only valid when a
luminance key, linear key, or chroma key is selected as the key type.

Knob | Parameter |Adjustment Setting values
1 Top Top edge width 0.00 to 8.00 @
2 Left Left edge width 0.00 to 8.00 @
3 Right Right edge width 0.00 to 8.00 @
4 Bottom Bottom edge width 0.00 to 8.00 @
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Knob |Parameter |Adjustment

Setting values

5 Density Density

0.00 to 100.00

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0.00

to 4.00.

When drop border or shadow is selected: The setting parameter values
depend on the on/off setting of key drop and the selection of 4H mode/

8H mode (see page 200).

* “Key drop OFF” mode

Knob |Parameter |Adjustment Setting values

1 Width Width 0.00 to 8.00

2 Position Position 359.99 to 180.00
3 Density Density 0.00 to 100.00

* “Key drop ON” mode

Knob | Parameter |Adjustment Setting values
1 Width Width 0.00 to 8.00 @
2 Position Position 359.99 to 0.00
3 Density Density 0.00 to 100.00

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0.00

to 4.00.

‘When emboss is selected:

Knob |Parameter |Adjustment Setting values
1 Width Width 0.00 to 4.00

2 Position Position 359.99 to 0.00
3 Density 2 Density 0.00 to 100.00

a) The Density adjustment only affects the key edge. This can be adjusted separately from
Key Density, and if Key Density is set to 0.00, the embossed edge effect only can be
applied.

To make edge fill adjustments, carry out the settings in step 6.

Select the edge fill signal in the <Edge Fill> group.

Utility 1 Bus: signal selected on the utility 1 bus
Matte: signal from dedicated color matte generator.
It becomes possible to adjust color 1.
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Knob |Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

When the edge type is outline, in place of the edge fill signal, the selected
key fill signal fills the outline, and elsewhere remains as the background.

Carry out the following operation, depending on the selection in step 4.

When [Utility 1 Bus] is selected: Hold down the [UTIL] button in the
cross-point control block, and select the signal in the background A

bus row.
While the [UTIL] button is held down, the background A bus changes
to the utility 1 bus.

To enable the [UTIL] button, its operation mode must be set to [Hold]
beforehand. (See “Operation Settings (Operation Menu)” in Chapter
19 (Volume 3).)

When [Matte] is selected: Press [Matte Adjust] in the same EDGE menu,
to display the Matte Adjust menu, and adjust a single color or two-
color combination color matte.

You can select whether to use a single color matte or a two-color
combination color matte in the <Edge Matte> group.

For the color mix operation, see “Carrying out a color mix for the key edge
fill matte” (page 222).

When emboss is selected for the edge type, adjust the color in the <Emboss
Fill> group.

To adjust matte 1 press [Mattel], and to adjust matte 2 press [Matte2], then
adjust the following parameters.

Knob |Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

7 To make the edge soft, press [Soft Edge] to set it on,

softness.
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Knob

Parameter

Adjustment

Setting values

1

Soft

Edge softness

0.00 to 100.00

For a normal edge, when [Soft Edge] is enabled, [Key Drop] is kept on.

8 To make separate fine adjustments to the positions of the left, right, top,
and bottom of the source edge, press [Fine Key], to set it on, and adjust the

following parameters.

Parameter group [1/2]

Knob |Parameter |Adjustment Setting values

1 Top Key top edge position —2.00 to +2.00

2 Left Key left edge position —2.00 to +2.00

3 Right Key right edge position —2.00 to +2.00

4 Bottom Key bottom edge position —2.00 to +2.00

Parameter group [2/2]

Knob |Parameter |Adjustment Setting values

1 H Phase Key horizontal position Left edge position
value shown

2 V Phase Key vertical position Top edge position
value shown

In the emboss function it is not possible to set [Fine Key] on.

* When the edge type is normal, drop border or shadow, enabling the [Fine

Key] function keeps [Key Drop] on.
e When applying a border to the key edge, enabling the [Fine Key]

function halves the border width setting range.

To fix key fill and key source in key drop off mode

1 In the Edge menu, press [Key Delay Mode].

The Key Delay Mode menu appears.

This function is only supported on the MVS-8000G.

2 Press [Frame Delay], setting it to On.
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This function uses the resizer, and therefore the expected result of the
setting may not be obtained if conditions do not allow the resizer to be
used.

Carrying out a color mix for the key edge fill matte

When you select ‘Matte’ for the edge fill of a border, drop border, or shadow,
you can create a combination of color 1 and color 2 using a wipe pattern
generated by the dedicated pattern generator.

1 In the <Edge Fill> group of the Edge menu, select [Matte], then press
[Matte Adjust].

The edge fill Matte Adjust menu appears.
2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 Size Pattern size 0.00 to 100.00
Soft Softness of pattern edge 0.00 to 100.00
Pattern Pattern number 1t024 9

a) The patterns are the same as standard wipes. (For details, see “Wipe Pattern List” in (page
497).)

To select the pattern, display the Mix Pattern Select menu by pressing

[Mix Pattern] in the edge fill Matte Adjust menu. After selecting one of the

patterns (standard wipe patterns 1 to 24) displayed in the Mix Pattern

Select menu, you can adjust the following parameters.

Knob |Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Softness of pattern edge 0.00 to 100.00

4 Adjust color 1 and color 2.

To adjust color 1 press [Color 1], and to adjust color 2 press [Color 2],
turning it on respectively, and adjust the following parameters.

Knob |Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
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Knob |Parameter |Adjustment Setting values
3 Hue Hue 359.99 to 0.00

If required, set the pattern modifiers.

* When turning [Position] on and setting the pattern position

Knob |Parameter |Adjustment Setting values
1 Position H Horizontal position —200.00 to +200.00 @
2 Position V Vertical position —200.00 to +200.00 @

a) See page 290.

* When turning [Multi] on and replicating the pattern

Knob | Parameter |Adjustment Setting values

1 H Multi Number of repetitions of pattern 1to 63
horizontally

2 V Multi Number of repetitions of pattern 1to0 63
vertically

3 Invert Type | Replication layout 1t04 2

a) See page 295.

* When turning [Aspect] on and setting the aspect ratio of the pattern

Knob |Parameter |Adjustment Setting values

1 Aspect Aspect ratio ~100.00 to +100.00 @

a) See page 294.

* When turning [Angle] on in the <Rotation> group and inclining the
pattern

Knob |Parameter |Adjustment Setting values

1 Angle Angle of pattern rotation ~100.00 to +100.00 @

a) See page 292.

* When turning [Speed] on in the <Rotation> group and rotating the
pattern at a constant speed

Knob |Parameter |Adjustment Setting values

1 Speed Rotation rate of pattern ~100.00 to +100.00 @

a) See page 293.
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6 To interchange color 1 and color 2, press [Color Invert], turning it on.

Applying the zabton effects
1 In the Edge menu, press [Zabton], turning it on.

2 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
Soft Pattern edge softness 0.00 to 100.00
Density Density 0.00 to 100.00

If in the pattern selection described below you select “Mask Pattern,” and
“Box” for the main mask, the “Size” parameter here cannot be adjusted.
Set “Size” in the Main Mask menu.

3 To adjust the pattern and color, press [Zabton Adjust].

The Zabton Adjust menu appears.

4 In the <Zabton Pattern> group, select the pattern.

Key Wipe: Use a key wipe.
You can change this pattern by pressing [Pattern Select] to open the
menu for key wipe pattern selection (Pattern Select menu), and make
adjustments by pressing [Pattern Adjust] to open the menu for pattern
adjustment (Wipe Adjust menu).

Key Edge Pattern: Use a color mixing pattern for key edge.
You can change this pattern by pressing [Pattern Select] to open the
menu for edge color mix dedicated wipe pattern selection (Mix Pattern
Select menu), and make adjustments by pressing [Pattern Adjust] to
open the menu for pattern adjustment (Matte Adjust menu).

Mask Pattern: Use the main mask Box or Pattern.

You can also press [Pattern Select], and in the corresponding pattern

adjustment menu, change the pattern.

5 To adjust the color, press [Zabton Color] and adjust the following

parameters.
Knob | Parameter | Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
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Knob | Parameter | Adjustment Setting values

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

Masks

There are two masks, which can be used to mask off unneeded parts of a key
or background, or to remove defects, and these are known as the main mask and
subsidiary mask. You can either use the main mask and subsidiary mask
independently, or at the same time.

Using the main mask

For example, to use the main mask for key 1 on the M/E-1 bank, use the
following procedure.

1 In the M/E-1 >Key1 menu, select HF3 ‘Main Mask.’

The Main Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Box: signal from the dedicated box generator
Pattern: signal from the dedicated pattern generator

4 Set the mask source parameters.

¢ When a box is selected

Knob | Parameter |Adjustment Setting values

1 Top Top position —100.00 to +100.00
2 Left Left position —100.00 to +100.00
3 Right Right position —100.00 to +100.00
4 Bottom Bottom position —100.00 to +100.00
5 Soft Box softness 0.00 to 100.00
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* When a pattern is selected

Knob | Parameter

Adjustment

Setting values

1 Size Pattern size 0.00 to 100.00
Soft Edge softness 0.00 to 100.00
Pattern Pattern number 1t024 @

a) The pattern is the same as a standard wipe. (See “Wipe Pattern List” in Appendix (Volume

1) (page 497).)

To select the pattern, display the Mask Ptn Select menu by pressing the
[Mask Ptn Select] button in the Main Mask menu.
After selecting one of the patterns (standard wipe patterns 1 to 24)

displayed in the Mask Ptn Select menu, you can adjust the following

parameters.

Knob | Parameter

Adjustment

Setting values

1 Size

Pattern size

0.00 to 100.00

2 Soft

Edge softness

0.00 to 100.00

To invert the black and white sense of the mask source, press the [Mask
Invert] button, turning it on.

When a pattern is selected as the mask source, set the pattern modifiers as

required.

* When turning [Position] on and setting the pattern position

Knob |Parameter |Adjustment Setting values
1 Position H Horizontal position —200.00 to +200.00 @
2 Position V Vertical position —200.00 to +200.00 @

a) See page 290.

* When turning [Multi] on and replicating the pattern

Knob | Parameter |Adjustment Setting values

1 H Multi Number of repetitions of pattern 1to 63
horizontally

2 V Multi Number of repetitions of pattern 1to 63
vertically

3 Invert Type | Replication layout 1t04 9

a) See page 295.
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* When turning [Aspect] on and setting the aspect ratio of the pattern

Knob | Parameter |Adjustment Setting values
1 Aspect Aspect ratio ~100.00 to +100.00 @

a) See page 294.

* When turning [Angle] on in the <Rotation> group and setting the
angle of the pattern rotation

Knob | Parameter |Adjustment Setting values

1 Angle Pattern angle —100.00 to +100.00 &

a) See page 292.

* When turning [Speed] on in the <Rotation> group and setting the
rate of pattern rotation

Knob | Parameter |Adjustment Setting values

1 Speed Rate of pattern rotation —100.00 to +100.00 @

a) See page 293.

Using the subsidiary mask

For example, to use the subsidiary mask for key 1 on the M/E-1 bank, use the
following procedure.

1

2

In the M/E-1 >Key1 menu, select HF4 ‘Sub Mask.’

The Sub Mask menu appears.

In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

In the <Mask Source> group, select the mask source.

Wipe: wipe pattern selected for a transition
If you select [Wipe], select the pattern and make modifier settings in
the M/E-1 >Wipe menu (see page 277), then return to this M/E-1
>Keyl menu.
In the case of a wipe pattern selected for a mask, the modifier [Edge]
and [Direction] settings are not available.

Utility 1 Bus: signal selected on the utility 1 bus
When you selected [Utility 1 Bus], hold down the [UTIL] button in the
M/E-1 bank cross-point control block, and select the signal with the
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background A bus buttons. While the [UTIL] button is pressed, the
background A bus switches to the utility 1 bus.

To enable the [UTIL] button, its operation mode must be set to [Hold]
beforehand. (See “Operation Settings (Operation Menu)” in Chapter 19
(Volume 3).)

4 Set the mask source parameters.

* When wipe is selected

Knob |Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Edge softness 0.00 to 100.00

* When utility 1 bus is selected

Knob |Parameter |Adjustment Setting values

1 Clip Reference level for creating mask | +109.59 to —7.31
signal

2 Gain Gain —100.00 to +100.00

5 To invert the black and white sense of the mask source, press the [Mask
Invert] button, turning it on.

Applying a DME Effect to a Key
Note

For one M/E bank, DME effects (including DME wipes) can be used in up to
two places on the dedicated interface and in only one place on the SDI interface

simultaneously.
When combining the SDI interface with the dedicated interface, you can apply
DME effects to a maximum of three keys. (Requires a setting in setup.)

For details, see “Interfacing With External Devices (Device Interface Menu)”
in Chapter 19 (Volume 3).

Assigning a DME to a key

1 In the M/E-1 >Key1 menu, select HFS ‘Processed Key.’

The Processed Key menu appears.
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2 In the <DME Select> group, select the DME channel (DME1 to DMES) to

be used.

The lit colors of [DME1] to [DMES] indicate the DME assignment.

Lit green: Shows the DME assigned to the currently selected key.

Lit amber: Shows the DME assigned to a key other than the currently
selected key.

Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.
The later selection is valid, and the button lights green.

Using two or three DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

1

Select the DME for the first channel (see the previous item, “Assigning a
DME to akey”), then select the successive channel for the second channel.
For the third channel select the channel after that.

To select the video signal for the second channel, hold down the [UTIL]
button in the cross-point control block, and select the signal in the Key1
row (DME external video bus).

To select the video signal for the third channel, hold down the [UTIL]
button in the cross-point control block, and carry out the following
operation.

e If the selected DME is channel 3 or channel 4, turn off the [KEY4]
button in the key 2 row, then select the signal in the key 2 row (DME
utility 1 bus).

¢ If the selected DME is channel 7 or channel 8, turn on the [KEY4] button
in the key 2 row, then select the signal in the key 4 row (DME utility 2
bus).

Using four DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

1

Select the DME channel 1 (or channel 5) for the first channel (see
“Assigning a DME to akey” (page 228)). In the same way, select the DME
channel 2 (channel 6) for the second channel, the DME channel 3 (channel
7) for the third channel, and the DME channel 4 (channel 8) for the fourth
channel.
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2 To select the video signal for the second channel, hold down the [UTIL]
button in the cross-point control block, and select the signal in the Keyl
row (DME external video bus).

3 To select the video signal for the third channel, hold down the [UTIL]
button in the cross-point control block, and carry out the following
operation.

o If the selected DME is channel 3, turn off the [KEY4] button in the key
2 row, then select the signal in the key 2 row (DME utility 1 bus).

* If the selected DME is channel 7, turn on the [KEY4] button in the key
2 row, then select the signal in the key 4 row (DME utility 2 bus).

4 To select the video signal for the fourth channel, hold down the [UTIL]
button in the cross-point control block, and carry out the following
operation.

* If the selected DME is channel 4, turn on the [KEY4] button in the key
2 row, then select the signal in the key 4 row (DME utility 2 bus).

* If the selected DME is channel 8, turn off the [KEY4] button in the key
2 row, then select the signal in the key 2 row (DME utility 1 bus).

When using the SDI interface

The operations to select the video signals for the third and fourth channels
differ from those in the previous procedure: select the video signals on the
AUX bus allocated in a Setup menu (Engineering Setup >Switcher >Device
Interface >DME Type Setting >5DME SDI Interface menu).

In setup (Engineering Setup >Switcher >Device Interface menu), if “Up to
3Keys” is selected, the second channel video signal is also selected on the AUX
bus.

For details, see “Interfacing With External Devices (Device Interface Menu)”
in Chapter 19 (Volume 3).

You can check the DME operating status in the Status menu (see page 439).

Assigning a DME output signal as a monitor signal

1 In the Processed Key menu, press [Monitor].

The Monitor menu appears.

2 Press [Monitor Set], turning it on.
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3 In the <DME Select> group, select the DME channel (DME1 to DMES) to
be used.

This assigns the selected DME output to DME MON V and DME MON K.
The colors with which [DME1] to [DMES] are lit show the key assignment
status.

Lit green: DME currently being monitored

Lit amber: DME that can be monitored

Off: Unassigned DME

Specifying the Key Output Destination

Using the key processed keyer signals (external processed key)

To select the key processed keyer key fill and key source signals on the AUX
bus or edit preview bus, press [Ext Proc Key] turning it on, in the Processed
Key menu.

This assigns the key fill and key source signals for M/E-1 key 1 to reentry
signals PROC V and PROC K.

When a DME is selected on the keyer, the key fill and key source signals to
which a DME effect is applied are assigned.

You cannot select the PROC V and PROC K signals using the cross-point
selection buttons of the M/E or PGM/PST bank.

Using the key processed keyer signals or signals to which a DME
effect is applied in frame memory (frame memory feed)

To use the key processed keyer key fill and key source signals on the frame
memory source buses, in the Processed Key menu, press [FM Feed]. [Ext Proc
Key] turns on, and the key fill and key source signals processed on the
currently selected keyer are automatically assigned to frame memory source
buses 1 and 2. When a DME is selected on the keyer, the key fill and key source
signals to which a DME effect is applied are assigned.

Key Modify Clear

A simple button operation or a menu operation returns the key settings to the
initial status settings.
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Press [Default Recall] at the lower left of the menu display, turning it on, then
press the corresponding VF button (VF1 to VF4) to return the key settings to
their initial status.

For details of the initial status, see “Selecting the State After Powering On
(Start Up Menu)” in Chapter 18 (Volume 3).

For the menu operation to return the key state to that set in initial status, see
“Returning to default state in function groupings” (page 116).

Blink Function

With the blink function, you can obtain the following effects.

Key blink: The key is alternately inserted and deleted at regular intervals. You
can set the period of blinking, and the proportion of each cycle for which
the key is inserted.

Edge blink: The key fill and key edge fill signals are interchanged at regular
intervals. You can set the period of blinking, and the proportion of each
cycle for which the original state holds.

The blink settings are in the Transition menu for each key.

Using the blink function

For example, to make the required settings for key 1 on the M/E-1 bank, use
the following procedure.

1 In the M/E-1 >Key1 menu, select HF6 ‘Transition.’

The Transition menu appears.
2 In the <Blink> group, select [Key Blink] or [Edge Blink] to set it on.
3 Set the blink parameters.

* When key blink is selected

Knob | Parameter |Adjustment Setting values

1 Blink Rate Length of blink cycle 1to 100

2 Duty Proportion of cycle for which key | 0.00 to 100.00
inserted

* When edge blink is selected

Knob |Parameter |Adjustment Setting values

1 Blink Rate Length of blink cycle 1to 100
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Knob

Parameter

Adjustment

Setting values

Duty

Proportion of cycle for which
original state holds

0.00 to 100.00

Video Processing

You can adjust the luminance and hue of the selected key fill signal.
For example, to apply video processing to the signal selected on the M/E-1
bank key 1 fill bus, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF7 ‘Video Process.’

The Video Process menu appears.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Video Gain | Video gain —200.00 to +200.00
2 Y Gain Luminance gain —200.00 to +200.00
3 C Gain Chrominance gain —200.00 to +200.00
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level | Luminance black level —7.31to +109.59

To return adjustment values to their defaults
Press [Unity].
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Key Setting Operations With the Key
Control Block

This section describes the basic procedures for key settings using the key
control block.

Key delegation buttons

M/E delegation buttons Displays

Key type selection buttons Knobs

ooaoo

ooaoo
ooaoo

ooaoo

© O O Op—

Key fill’/key source selection buttons Edge type selection buttons

MORE button
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Key control block

Operations in the Key Control Block

Parameter adjustment with the knobs
When the button for a function requiring parameter settings is pressed (that is,
on), you can set the parameters with the four knobs. If there are more than four
values to be assigned to the knobs, the [MORE] button lights amber. At this
point, press the [MORE] button, which turns green, to assign the fifth and
subsequent parameters to the knobs, so that the parameter settings can be made.
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Selecting the bank and keyer

To make key settings, first select the bank (from M/E-1 to M/E-3 and PGM/
PST) and keyer, then assign them to the key control block.

For example, to set key 1 on M/E-1 with the key control block, use the
following procedure.

1 Using the M/E delegation buttons in the key control block, press the [M/
E1] button, setting it on.

2 Using the key delegation buttons in the key control block, press the
[KEY1] button, setting it on.

This assigns the key control block to M/E-1 key 1.

Selecting the key type

To select the key type, press one of the key type selection buttons in the key

control block.

[LUM] button: luminance key

[LIN] button: linear key

[CRK] button: chroma key

[CVK] button: color vector key

[PTN] button: key wipe pattern key
When using a wipe pattern key as the key type, in the <Key Type> group
of the Type menu for the keyer, select [Wipe Pattern] and make the
settings.

For an overview of the key types, see “Key Types” (page 197).

The button you pressed lights green, and you can now adjust the parameters
with the knobs. The display beside each knob shows the first letter of the
parameter name and the three-digit setting value.

* When the [LUM] or [LIN] button is lit green

Knob | Parameter Adjustment Setting values
1 Clip Reference level for generating the +109 to -7
key signal
2 Gain Key sensitivity —100 (shown as —00)
to +100
Density Key density 0to 100
Filter Filter coefficient 1t09
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* When the [CRK] button is lit green

Knob | Parameter Adjustment Setting values
1 Clip Chroma key reference level 0to 100
2 Gain Key sensitivity —100 (shown as —00)
to +100
Hue Hue 0 to 359
Density Key density 0to 100

* When [Key Active] is off, only the parameters Hue and Density are
displayed.
* When both [Key Active] and [Color Cancel] are off, only the parameter

Density is displayed.

* When the [CVK] button is lit green

Parameter group [1/2]

Knob | Parameter Adjustment Setting values
1 Y Clip Reference level for Y signal +109 to -7
2 Y Gain Y signal sensitivity —100 (shown as —00)
to +100
3 C Clip Reference level for chrominance 100to O
signal
4 C Gain Chrominance signal sensitivity —100 (shown as —00)
to +100
Parameter group [2/2]
Knob | Parameter Adjustment Setting values
1 Y Filter Y signal filter coefficient 1t09
2 C Filter Chrominance signal filter coefficient | 1 to 9
Density Key density 0to 100
* When the [PTN] button is lit green
Knob | Parameter Adjustment Setting values
1 Size Pattern size 0 to 100
Soft Edge softness 0to 100
Density Key density 0to 100
Selecting key fill
Select whether to use a color matte as key fill, or the signal on the key fill bus.
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When using a color matte: Press the [MATTE FILL] button, setting it on. The
button lights green, and you can now set the parameters with the knobs.

Knob | Parameter |Adjustment Setting values
1 Luminance | Color 1 luminance 0to 100
Saturation Color 1 saturation 0to 100
Hue Color 1 hue 359100

When [Mix Color] is selected in the key fill Matte Adjust menu, you can

further adjust color 2.

When [Mix Color] is on, and the [MORE] button is lit amber

Knob |Parameter |Adjustment Setting values
1 Luminance | Color 1 luminance 0to 100
2 Saturation Color 1 saturation 0to 100
3 Hue Color 1 hue 359100
4 Size Pattern size 0to 100
When [Mix Color] is on, and the [MORE] button is lit green
Knob |Parameter |Adjustment Setting values
1 Luminance | Color 2 luminance 0to 100
2 Saturation Color 2 saturation 0to 100
3 Hue Color 2 hue 359100
4 Soft Edge softness 0to 100

When using the key fill bus signal: Press the [MATTE FILL] button, turning

it off.

To select the key fill signal, use the key 1 or key 2 bus buttons in the cross-

point control block.

To select the key fill signal for key 3 or key 4 in the cross-point control
block, press the [KEY 3] button or [KEY4] button to the right of the key
bus buttons, turning it on, to allocate the key 1 bus row or key 2 bus row
to the key 3 fill bus or key 4 fill bus, then press the desired cross-point

button.

For the CCP-6224/6324 Control Panel, it is necessary to set the [AUX
CTRL] button to Off in order to exit the AUX panel-less function (see page

139).

Selecting key source

* To use the key source paired with the key fill signal selected on the key fill
bus, press the [AUTO SEL] button, turning it on. The pairing of the cross-
point buttons for key fill and key source is carried out in the Setup menu. (See
“Cross-Point Settings (Xpt Assign Menu)” in Chapter 19 (Volume 3).)
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* To select key source independently of the key fill signal selected on the key
fill bus and paired with key source, hold down the [SPLIT] button, turning it
on, then press the desired Key 1 or Key 2 button in the cross-point control
block.

* To use as key source the same signal as the key fill signal selected on the key
fill bus, select the SELF mode by pressing the [AUTO SEL] button and
[SPLIT] button simultaneously so that both are off. When chroma key is
selected as the key type, select the SELF mode.

Key Edge Modifications

To apply a modification to the key edge, press one of the edge type selection
buttons in the key control block.

[BDR] button: border

[DROP BDR] button: drop border
[SHDW] button: shadow
[OUTLINE] button: outline
[EMBOS] button: emboss

For an overview of the edge modifications, see “Edge modifiers” (page 199).
The pressed button lights green, and you can now adjust the parameters with

the knobs. The display beside each knob shows the first letter of the parameter
name and the three-digit setting value.

Setting the border parameters

When the [BDR] button is lit green, the parameter settings depend on the key
type and whether the separate edge function is active. To activate the separate
edge function, press [Separate Edge], setting it on, in the Edge menu for the
key.

* Separate edge off

Knob Parameter Adjustment Setting values
1 Width Border width Oto8?

(0to 100) P
4 Density Border density 0to 100

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type
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¢ Separate edge on
The border width settings can be made independently for left, right, top, and

bottom sides. The separate edge function is only available when luminance
key, linear key, or chroma key is selected as the key type.

Knob | Parameter Adjustment Setting values
1 Top Top edge width Oto83
2 Left Left edge width Oto8?d
3 Right Right edge width Oto83
4 Bottom Bottom edge width Oto8?d

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0 to 4.

To adjust the edge fill color
When [BDR] is selected, the [MORE] button lights amber. Pressing the

[MORE] button to turn it green then allows you to adjust the edge fill color
parameters with the knobs.

Knob | Parameter Adjustment Setting values
1 Luminance Luminance 0to 100
2 Saturation Saturation 0 to 100
3 Hue Hue 359100
4 Density Density 0to 100

Setting the drop border or shadow parameters

When the [DROP BDR] or [SHDW] button is lit green, the parameter settings
differ between the “key drop OFF” and “key drop ON” modes (see page 200)
as shown below. Switching between these two modes is made by turning the
[KEY DROP] button on or off.

* “Key drop OFF” mode

Knob | Parameter Adjustment Setting values
1 Width Width 0to8

2 Position Position 359 to 180

4 Density Density 0to 100

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0 to 4.

* “Key drop ON” mode

Knob

Parameter

Adjustment

Setting values

1

Width

Width

0to8?d
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Knob | Parameter Adjustment Setting values

2 Position Position 359100

4 Density Density 0to 100

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0 to 4.

To adjust the edge fill color

When [DROP BDR] or [SHDW] is selected, the [MORE] button lights amber.
Pressing the [MORE] button to turn it green then allows you to adjust the edge
fill color parameters with the knobs.

Knob | Parameter Adjustment Setting values
1 Luminance Luminance 0to 100
2 Saturation Saturation 0to 100
3 Hue Hue 359100
4 Density Density 0to 100

Setting the outline parameters

When the [OUTLINE] button is lit green, the parameter settings depend on the
key type and whether the separate edge function is active. To activate the
separate edge function, press [Separate Edge], setting it on, in the Edge menu
for the key.

* Separate edge off

Knob Parameter Adjustment Setting values
1 Width Outline width Oto8?d

(0to 100) ®
4 Density Outline density 0to 100

a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0 to 4.
b) When a wipe pattern key or key wipe pattern key is selected as the key type

¢ Separate edge on
The outline width settings can be made independently for left, right, top, and
bottom sides. The separate edge function is only available when luminance
key, linear key, or chroma key is selected as the key type.

Knob | Parameter Adjustment Setting values
1 Top Top edge width Oto83
2 Left Left edge width Oto8?
3 Right Right edge width 0to8?
4 Bottom Bottom edge width Oto83
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a) In the “4H mode” and when [Fine Key] (page 221) is on, the setting value range is 0 to 4.

When [Outline] is selected with separate edge on, the [MORE] button lights
amber. Pressing the [MORE] button to turn it green then allows you to adjust
the key fill density parameter with a knob.

Knob | Parameter Adjustment Setting values

4 Density Outline density 0to 100

Setting the embossing parameters
When the [EMBOS] button is lit green, adjust the following parameters.

Knob Parameter Setting values
1 Width Oto4

2 Position 359100

4 Density 0to 100

Selecting a normal edge

When all five edge type selection buttons are off, a normal edge is selected. If
one of the buttons is lit, press it, turning it off.

Softening the edge

Press the [SOFT EDGE] button, turning it on. The button lights green, and you
can now adjust the softness with the knob.

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0to 100

* For a normal edge, when [SOFT EDGE] is enabled, “Key Drop” mode turns
on.

* When a luminance key or linear key is selected as the key type, and clean
mode is enabled, enabling [SOFT EDGE] ends the clean mode.

Applying the zabton effects

When the [ZABTN] button is lit green, adjust the following parameters.

Knob Parameter Adjustment Setting values
1 Size Pattern size 0to 100
2 Soft Pattern edge softness 0to 100

Press the [MORE] button lit amber, changing it to green, then adjust the
following parameters.
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Knob Parameter Adjustment Setting values
1 Luminance Luminance 0to 100
2 Saturation Saturation 0to 100
3 Hue Hue 359100
4 Density Density 0to 100

Masks

Using the main mask

In the key control block, press the [MAIN MASK] button, turning it on.
The parameter settings depend on the mask source selected as [Box] or
[Pattern] in the <Mask Source> group of the Main Mask menu for the key.

¢ When box is selected

Knob | Parameter Adjustment Setting values

1 Top Top position —100 (shown as -00) to +100
2 Left Left position —100 (shown as —-00) to +100
3 Right Right position —100 (shown as —-00) to +100
4 Bottom Bottom position —100 (shown as -00) to +100

When box is selected and the [MORE] button is lit amber, there are more
settings. Press the [MORE] button, so that it changes from amber to green to
make the extra setting.

Knob | Parameter Adjustment Setting values
1 Soft Box softness 0to 100
* When pattern is selected
Knob | Parameter Adjustment Setting values
1 Size Pattern size 0to 100
Soft Edge softness 0to 100
Pattern Pattern number 1t024 9

a) The pattern is the same as a standard wipe. (See “Wipe Pattern List” (page 497).)
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Using the subsidiary mask

In the key control block, press the [SUB MASK] button, turning it on. The
parameter settings depend on the mask source selected as [Wipe] or [Utility 1
Bus] in the <Mask Source> group of the Sub Mask menu for the key.

* When wipe is selected

Knob | Parameter Adjustment Setting values
1 Size Pattern size 0to 100
2 Soft Edge softness 0to 100

* When utility 1 bus is selected

Knob | Parameter Adjustment Setting values
1 Clip Reference level for +109 to -7
creating mask signal
2 Gain Gain —100 (shown as -00) to +100

Applying a DME Effect to a Key
Note

For one M/E bank, DME effects (including DME wipes) can be used in up to
two places on the dedicated interface and in only one place on the SDI interface
simultaneously.

When combining the SDI interface with the dedicated interface, you can apply
DME effects to a maximum of three keys. (Requires a setting in setup.)

Assigning a DME to a key
1 In the key control block, press the delegation buttons [M/E1] and [KEY1].

2 Using the DME channel selection buttons, select the DME channel (DME1
to DMES) for applying the effect.

The lit colors of the [DME1] to [DMES] buttons indicate the DME

assignment.

Lit green: Shows the DME assigned to the currently selected key.

Lit amber: Shows the DME assigned to a key other than the currently
selected key.

Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME channel.

Key Setting Operations With the Key Control Block 243

shoy ¢ Jerdeyn



shey ¢ Jeideyn

244

The later selection is valid, and the button lights green.

Using two or three DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

1

Select the DME for the first channel (see the previous item, “Assigning a
DME to akey”), then select the successive channel for the second channel.
For the third channel select the channel after that.

To select the video signal for the second channel, hold down the [UTIL]
button in the cross-point control block, and select the signal in the Keyl
row (DME external video bus).

To select the video signal for the third channel, hold down the [UTIL]
button in the cross-point control block, and carry out the following
operation.

¢ If the selected DME is channel 3 or channel 4, turn off the [KEY4]
button in the key 2 row, then select the signal in the key 2 row (DME
utility 1 bus).

¢ Ifthe selected DME is channel 7 or channel 8, turn on the [KEY4] button
in the key 2 row, then select the signal in the key 4 row (DME utility 2
bus).

Using four DME channels on one keyer
When using the DME dedicated interface, proceed as follows.

1

Select the DME channel 1 (or channel 5) for the first channel (see
“Assigning a DME to akey” (page 243)). In the same way, select the DME
channel 2 (channel 6) for the second channel, the DME channel 3 (channel
7) for the third channel, and the DME channel 4 (channel 8) for the fourth
channel.

To select the video signal for the second channel, hold down the [UTIL]
button in the cross-point control block, and select the signal in the Keyl
row (DME external video bus).

To select the video signal for the third channel, hold down the [UTIL]
button in the cross-point control block, and carry out the following
operation.

* If the selected DME is channel 3, turn off the [KEY4] button in the key
2 row, then select the signal in the key 2 row (DME utility 1 bus).

* If the selected DME is channel 7, turn on the [KEY4] button in the key
2 row, then select the signal in the key 4 row (DME utility 2 bus).
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4 To select the video signal for the fourth channel, hold down the [UTIL]
button in the cross-point control block, and carry out the following
operation.

* If the selected DME is channel 4, turn on the [KEY4] button in the key
2 row, then select the signal in the key 4 row (DME utility 2 bus).

* If the selected DME is channel 8, turn off the [KEY4] button in the key
2 row, then select the signal in the key 2 row (DME utility 1 bus).

When using the SDI interface

The operations to select the video signals for the third and fourth channels
differ from those in the previous procedure: select the video signals on the
AUX bus allocated in a Setup menu (Engineering Setup >Switcher >Device
Interface >DME Setting >DME SDI Interface menu).

When using a second key in combination with a dedicated interface, select the
signal to be used on the AUX bus.

You can check the DME operating status in the Status menu (see page 439).

Assigning the DME output signal to a monitor signal

1 Holding down the output destination specification button [MON] in the
key control block, use the DME channel selection buttons to select the
DME channel (DME1 to DMES) you want to use.

The selected DME output is assigned to DME MON V and DME MON K.

2 To check the DME assignment status, hold down just the [MON] button.

While it is held down, the lit color of the [DME1] to [DMES] buttons
shows the key assignment status.

Lit green: Shows the DME currently being monitored.

Lit amber: Shows a DME which can be monitored.

Off: DME is not assigned.

Other Key Setting Operations
Using an external processed key

You can select and use the key processed keyer key fill and key source signals
on the AUX buses.

Key Setting Operations With the Key Control Block
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1 Select the keyer to be allocated.

In the key control block, press [PROC KEY], turning it on.

The button lights amber, and on the currently selected keyer, the key fill
and key source are assigned to reentry signals PROC V and PROC K.

When a DME is selected on the currently selected keyer, the key fill and
key source signals to which the DME effect is applied are assigned to
PROC V and PROC K.

You cannot select the PROC V and PROC K signals using the cross-point
selection buttons of the M/E or PGM/PST bank.

Using a frame memory feed

When you press the [FM FEED] button in the key control block, it lights
momentarily amber, then the key fill and key source signals processed in the
currently selected keyer are assigned to frame memory sources 1 and 2.

If a DME is selected on the currently selected keyer, then the key fill and key
source signals to which a DME effect is applied are assigned to frame memory
sources 1 and 2.

Carrying out a frame memory feed causes the [PROC KEY] button to light
amber.

Using the show key function

While the [SHOW KEY] button is held down, the key-processed key source
signal appears on the specified output. (Show key mode)

Even when the [SHOW KEY] button is released, for a preset time the show key
mode is maintained. You can specify the output to which the show key function
is applied and set the time for which the show key mode is maintained after
releasing the button in a Setup menu.

For details see “Settings Relating to Keys, Wipes, Frame Memory and Color
Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20 (Volume 3).

Using the auto delegation function

To couple the selection in the key delegation buttons of the independent key
transition control block so that the key control block delegation selection is

automatically switched, in the key control block press the [AUTO DELEG]

button, turning it on.
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Returning the key adjustment values to their defaults

Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [PTN])
recalls the key default values (page 203).

Key modify clear

When an M/E delegation button is held down, holding down a key delegation
button together returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On
(Start Up Menu)” in Chapter 18 (Volume 3).
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Key Adjustment Operations With the
Multifunction Flexi Pad Control Block

This section describes basic key adjustment operations when using the
Multifunction Flexi Pad control block.

EDIT ENBL button Alphanumeric display

Mode selection buttons Adjustment knobs

C N
SNAP SHOT
[ | Hoo
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\ EDIT TRANS KEY
NBL RATE ADJ
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DME DME
ME ME
KN
& J

ENTR

O 0O O Of—

III gooo
3 TRIM
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. . o .

. . i .
5 i

\

Region selection buttons Adjustment knob displays

Memory recall section

Selecting the switcher bank and keyer

Before carrying out key adjustment, first select the key adjust mode, then select
the switcher bank and keyer.
For example, to adjust key 1 on M/E-1, proceed as follows.

1 In the Multifunction Flexi Pad control block mode selection buttons press
[KEYADIJ].

2 Press the [M/E1] region selection button.

3 In the memory recall section, press the [KEY 1] button.
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The button displays in the memory recall section now appear as shown in
the following illustration.

Pressing the [PAGE 1/3] >[PAGE 2/3] buttons further changes the display
as follows, then pressing [PAGE 3/3] returns to the original display shown
in the illustration.
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With these buttons in the memory recall section, you can carry out the
following key adjustment.
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Selecting the key type

[LUM] button: Selects a luminance key.

[LIN] button: Selects a linear key.

[CRK] button: Selects a chroma key.

[WIPE PTN] button: Selects a key wipe pattern key.

Adjust the parameters for each type with the adjustment knobs. For details of
the parameters, see the following sections.

Luminance key: “When the [LUM] or [LIN] button is lit green” (page 235)
Linear key: “When the [LUM] or [LIN] button is lit green” (page 235)
Chroma key: “When the [CRK] button is lit green” (page 236)

Key wipe pattern key: “When the [PTN] button is lit green” (page 236)

Selecting the key source

[AUTO SEL] button: The signal assigned as a pair with the key fill bus signal
for the key row button in the cross-point control block is automatically
selected.

[SPLT] button: Select a different signal manually. To make the selection, hold
down this button, and press the button assigned to the signal you want as
key source in the cross-point control block.

You can also use the same signal as the key fill selected on the key fill bus as

key source (SELF). Press the [AUTO SEL] button and [SPLT] button

simultaneously so that both are off, to select the SELF mode.

Setting auto chroma key

[SMPL MARK] button: Toggles the sample mark display on and off. When
on, the monitor screen shows the foreground video and a white box sample
mark.

[AUTO STRT] button: Automatically adjusts the chroma key. When the
[SMPL MARK] button is off, pressing this does not carry out automatic
chroma key adjustment.

You can adjust the display position and size of the sample mark with the

adjustment knobs.

For details of these parameters, see “Making auto chroma key adjustments”
(page 210).

Setting the show key function

[SHOW KEY] button: When this is pressed, the key source signal to which
key processing has been applied is output from the specified output port
(show key mode).

For details, see “Using the show key function” (page 246).

Key Adjustment Operations With the Multifunction Flexi Pad Control Block
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Setting the resizer function

[RE SIZR] button: Enables and disables the resizer function.

The parameters that can be adjusted with the adjustment knobs are on two
pages; to access the second page, press the [KNOB 1/2] button. For details of
the parameters, see “Menu operations for key shrinking, magnification and

movement” (page 256).
If you press this button at the same time as any of the [KEY1] to [KEY4]
buttons, you can switch the trackball and joystick to the resizer setting mode.

Inverting the sense of the key source

[KEY INV] button: When this is set to On, the sense of the key source is
inverted.

Selecting the key fill signal

[FILL MAT] button: When this is On, the signal generated by the dedicated
color matte generator is selected, and when it is Off, the signal selected on
the key 1 fill bus is selected.

For parameters that can be adjusted with the adjustment knobs, see “Selecting
key fill and key source” (page 214).

Selecting the key edge signal

[EDGE MAT] button: When this is On, the signal generated by the dedicated
color matte generator is selected, and when it is Off, the signal selected on

the utility bus is selected.

For parameters that can be adjusted with the adjustment knobs, see step 4 in
“Key Edge Modifications” (page 219).

Selecting the mask source

[MASK] button: Selects the mask source (box generated by dedicated
generator or pattern) to be selected in the Main Mask menu for each M/E

bank.
The parameters that can be adjusted with the adjustment knobs are different for

a box or a pattern.
The box parameters are on two pages; to access the second page, press the

[KNOB1/2] button.
For details, see step 4in “Using the main mask” (page 225).

Applying modifiers to the key edge
[BDR] button: Applies a border to the edge.

Key Adjustment Operations With the Multifunction Flexi Pad Control Block



[DROP BDR] button: Applies a drop border to the edge.
[SHDW] button: Applies a shadow to the edge.

For parameters that can be adjusted with the adjustment knobs, see “Key Edge
Modifications” (page 217).

Setting the degree of edge softening
[SOFT EDGE] button: Softens the key edge.

For parameters that can be adjusted with the adjustment knobs, see step 7 in
“Key Edge Modications” (page 220).

Enabling the set key to be used on the AUX bus

[PROC KEY] button: This enables the keyer key fill/key source signal to be
subjected to key processing, then used as a reentry signal by selection on
the AUX bus.

For details, see “Using an external processed key” (page 245).

Sending a signal subjected to key processing to frame memory

[FM FEED] button: Press this to assign the key fill/key source signal
processed on the currently selected keyer to frame memory source 1 or 2.

For details, see “Using a frame memory feed” (page 246).

Using a DME currently used on another keyer

[OVER RIDE] button: When one DME channel is in use, holding down this
button and pressing a DME channel button ((DME1] to [DMES]) allows
you to forcibly select this channel. The button for the selected DME
channel lights green.

Recalling the keyer using the DME channel

[TRCE] button: Holding down this button, press the selection button for the
DME channel already assigned to another keyer or transition, to switch the
keyer or transition to which the DME channel is assigned to the currently
selected state.

Monitoring DME output

[DME MON] button: Holding down this button and pressing the selection
button for a DME channel ((DME1] to [DMES&]) allows you to monitor the
signal for this channel as a reentry signal to DME MON V/K.

Key Adjustment Operations With the Multifunction Flexi Pad Control Block
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However, it is first necessary to assign this channel on the DME to the
delegation (keyer or transition) to be monitored.

Selecting the DME channel
[DME1] to [DMES] buttons: Press one of these to select the corresponding
DME channel. The number of valid buttons depends on the number of

DME channels in use.
[DME MORE] button: If there are more than four DME channels in use, use

this to change the DME channel selection buttons displayed.

Returning the key adjustment values to their defaults

Holding down a key type button ([LUM], [LIN], [CRK], [CVK], or [PTN])
recalls the key default values.

Key modify clear
When the [KEY ADJ] button is held down, holding down the region selection
button for the selected region together returns all the key settings of the region

to the initial status settings.
When the [KEY ADIJ] button is held down, holding down the button for the
selected key together returns the key settings to the initial status settings.

For details of the initial status, see “Selecting the State After Powering On
(Start Up Menu)” in Chapter 18 (Volume 3).
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Resizer

Resizer allows you to apply DME-like effects such as image shrinking,
magnification and movement, as well as change of the aspect ratio, to the
processed key.
The following functions are available.
¢ Two-dimensional transformations of keys
* Resizer interpolation settings
* Resizer crop/border settings
* Resizer effect settings
(wide key border, drop shadow, edge enhance, mosaic, defocus, mask)

 The resizer function is supported on the MVS-8000G only.

* The image of the key manipulated by resizer has a one-frame delay.

* Some effects of resizer are different from what you would expect of DME
effects.

Restrictions on the use of effects

There are restrictions on combined use of resizer effects themselves and that
with DME wipes.

For details, see “Impossibility of simultaneous use within the same keyer”
(page 268).

Relation between resizer and other effects

You cannot apply DME effects to a key for which the resizer function is
enabled. When one of the three functions — resizer, DME wipe and DME
effects — is enabled, the other two are disabled.

Two-Dimensional Transformations of Keys

When the screen aspect ratio is 4:3 in HD format, when the resizer is used to
shrink a video image, this is applied to the 16:9 screen including the added
video on the left and right sides. Use the crop function as required to extract the
4:3 image.

Resizer
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Menu operations for key shrinking, magnification and movement

For example, to shrink, magnify or move keyl of the M/E-1 bank, use the
following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

2 Adjust the following parameters with the knobs.

Parameter group [1/2]

Knob | Parameter Adjustment Setting values
1 Location X Move key HD —99.9999 to
horizontally +99.9999
SD 4:3 —33.3333 to
+33.3333
SD 16:9 —24.9999 to
+24.9999
2 Location Y Move key vertically | HD —99.9999 to
+99.9999
SD 4:3 —33.3333 to
+33.3333
SD 16:9 —24.9999 to
+24.9999
3 Size Magnify or shrink | 0.0000 to 99.9999
key

Parameter group [2/2]

Knob | Parameter Adjustment Setting values

1 Aspect X Change aspect 0.0000 to 99.9999
ratio horizontally

2 Aspect Y Change aspect 0.0000 to 99.9999
ratio vertically

3 Aspect Ratio Change aspect 0.0000 to 2.0000

ratio horizontally
and vertically at a
time

256 | Resizer



Key control block operations for key shrinking, magnification

and movement

Delegation buttons

RESIZER button

o

®
e [0
10

O

MORE button

1 Use the delegation buttons to select the key to which you want to apply a

resizer function.

2 Press the [RESIZER] button, turning it on.

3 Adjust the following parameters with the knobs.
(To switch between displaying parameter group 1/2 and 2/2, press the
[MORE] button.)

Parameter group [1/2]

Knob | Parameter Adjustment Setting values
1 X Move key HD —99 to +99
horizontally SD 4:3 ~33 10 +33
SD 16:9 —24 to +24
2 Y Move key vertically | HD —99 to +99
SD 4:3 -33 to +33
SD 16:9 —24 to +24

Resizer
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Parameter group [1/2]

Knob | Parameter Adjustment Setting values
3 S Magnify or shrink | 0.0 to 99
key

Parameter group [2/2]

Knob | Parameter Adjustment Setting values

1 X Change aspect 0.0to 99
ratio horizontally

2 Y Change aspect 0.0to 99
ratio vertically

3 R Change aspect 0.0t0 2.0
ratio horizontally
and vertically at a
time

Device control block operations for key shrinking, magnification
and movement

RSZR CTRL button

Delegation buttons Trackball

JC

RSZR button Z-ring

LOC button

ASP button

1 Press the [RSZR CTRL] button, turning it on.
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2 Press the delegation button to select the key.

w

Press the [RSZR] button, turning it on.

4 * To change the aspect ratio, turn on the [LOC SIZE(ASP)].

 To shrink, magnify, or move the key, turn on the [LOC XYZ(LOC)].
Hold these buttons down while carrying out the operation of step 5 to
enable fine adjustment (fine mode).

5 Use the trackball and joystick for the operation.

For details of parameters, see step 3 of “Key control block operations for key
shrinking, magnification and movement” (page 257).

Entering parameters
This operation is the same as DME three-dimensional parameter input.

For details, see “Entering Three-Dimensional Parameter Values” in Chapter
11 (Volume 2).

Resetting parameters

This operation is the same as DME three-dimensional parameter resetting.

For details, see “Entering Three-Dimensional Parameter Values” in Chapter
11 (Volume 2).

Clearing resizer effects

To clear two-dimensional transform parameters only and set the
initial state

In the device control block, press the [CLR WORK BUFR] button in the
operation buttons.

To clear all resizer parameters, and set the initial state

In the device control block, press the [CLR WORK BUFR] button in the
operation buttons, twice in rapid succession.

For the initial state, you can select either the factory default settings or user
settings.

For details of how to make this selection, see “Selecting the State After
Powering On (Start Up Menu)” in Chapter 18 (Volume 3).
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Resizer Interpolation Settings

For example, to make the interpolation settings for key 1 of the M/E-1 bank,
use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Resizer Process].

The Resizer Process menu appears.

3 In the <Video Field/Frame Mode> and other groups, make the
interpolation settings.

Resizer Crop/Border Settings

Making a crop setting for a key for which resizer is on

For example, to make the crop settings for key 1 of the M/E-1 bank, use the
following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Border/Crop].

The Border/Crop menu appears.

3 Press [Crop], turning it on.

This enables the adjustment of crop.

4 Set the parameters.

These settings are the same as those for crop of DME. For details, see
“Crop Settings” in Chapter 11 (Volume 2).

If mosaic or defocus is enabled, and in the <Mosaic/Defocus Mode> group you
select Video/Key, then the crop is disabled.
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Applying a border to a key for which resizer is on

For example, to add the border for key 1 of the M/E-1 bank, use the following

procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

Press [Border/Crop].

The Border/Crop menu appears.

Press [Border], turning it on.

This enables the adjustment of crop.

Set the parameters.

The valid ranges of the parameter values depend on the combination of

signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system,

as follows.
e SD format
Knob | Parameter | Adjustment Setting Values
1 H Simultaneously adjust width of left | 0.00 to 4.00
and right borders
2 \Y Simultaneously adjust width of top | 0.00 to 3.00 (4:3)
and bottom borders 0.00 to 2.25 (16:9)
3 All Simultaneously adjust width of all | Value of H shown
four borders
5 Density Density of the borders 0.00 to 100.00
e HD format
Knob | Parameter | Adjustment Setting Values
1 H Simultaneously adjust width of left | 0.00 to 12.00 (4:3)
and right borders 0.00 to 16.00 (16:9)
2 \' Simultaneously adjust width of top | 0.00 to 9.00
and bottom borders
3 All Simultaneously adjust width of all | Value of H shown
four borders
5 Density Density of the borders 0.00 to 100.00

To apply color to a border

1 In the <Border Mode> group of the Border/Crop menu, press [Flat Color].

Resizer
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Resizer

2 Adjust the following parameters.

Knob | Parameter | Adjustment Setting Values

1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

To soften the inner edge of a border
1 In the Border/Crop menu, press [Border Soft].

2 Adjust the following parameters.

Knob | Parameter | Adjustment Setting Values

1 Inner Soft Border inner softness 0.00 to 100.00

To apply a beveled light edge

1 In the <Border Mode> group of the Border/Crop menu, press [Beveled
Light Edge].

2 Adjust the following parameters.

Knob | Parameter | Adjustment Setting Values

1 Top Top edge —100.00 to +100.00
2 Left Left edge —100.00 to +100.00
3 Right Right edge —100.00 to +100.00
4 Bottom Bottom edge —100.00 to +100.00
5 All Four edges Value of Left shown

3 Press [Border Soft].

4 Adjust the following parameters.

Knob | Parameter | Adjustment Setting Values
1 Inner Soft Border inner softness 0.00 to 100.00
2 Bound Soft | Border boundary softness 0.00 to 100.00




To apply a beveled color edge

1 In the <Border Mode> group of the Border/Crop menu, press [Beveled
Color Edge].

2 In the <Color Adjust> group, select the edges for adjustment among the
[Top], [Left], [Right], and [Bottom] edges. To select all the four edges,
press [All].

3 Set the color parameters.

For details, see “To apply color to a border” (page 261)

4 Press [Border Soft].

5 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values
1 Inner Soft Border inner softness 0.00 to 100.00
2 Bound Soft | Border boundary softness 0.00 to 100.00

Applying Resizer Effects

For example, to apply effects to key 1 of the M/E-1 bank, use the following

procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press [Resizer], turning it on.

This enables the resizer function.

2 Press [Enhanced Effect].

The Enhanced Effect menu appears.

Defocus.

Resizer
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Applying a wide key border

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press [Dual
Rszr Effect], turning it on.

2 Press [Wide Key Border], turning it on.

3 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 H Simultaneously adjust border 0.00 to +100.00
width of left and right edges

2 \'% Simultaneously adjust border 0.00 to +100.00
width of upper and lower edges

3 All Simultaneously adjust border Value of H shown
width of all four edges

4 Soft @ Softness of border 0.00 to +100.00

5 Density Density of border 0.00 to +100.00

a) Shared with the drop shadow “Soft” value.

4 To add an outline, press [Out Line], turning it on.

(8]

To adjust the border color, press [Border Color].

6 Set the color parameters.

For details, see “To apply color to a border” (page 261)

Applying a drop shadow

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press [Dual
Rszr Effect], turning it on.

2 Press [Drop Shadow], turning it on.

3 Set the parameters.

The valid ranges of the parameter values depend on the combination of
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system,
as follows.
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¢ SD format

Knob | Parameter |Adjustment Setting values
1 H Horizontal position of shadow —8.00 to +8.00
2 \Y Vertical position of shadow —6.00 to +6.00 (4:3)
—4.50 to +4.50 (16:9)
Size Shadow size 0.00 to 2.00
Soft @ Softness of shadow 0.00 to 100.00
5 Density Density of shadow 0.00 to 100.00

a) Shared with the wide key border “Soft” value.

* HD format
Knob | Parameter |Adjustment Setting values
1 H Horizontal position of shadow —24.00 to +24.00
(4:3)-32.00 to +32.00
(16:9)
2 \Y Vertical position of shadow —18.00 to +18.00
3 Size Shadow size 0.00 to 2.00
4 Soft @ Softness of shadow 0.00 to 100.00
5 Density Density of shadow 0.00 to 100.00

a) Shared with the wide key border “Soft” value.

Edge enhancement
Adjusting the gain sharpens the image.

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press [Edge

Enhance], turning it on.

2 Adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 H Horizontal gain adjustment 0.00 to 100.00

2 \Y Vertical gain adjustment 0.00 to 100.00

3 All Both horizontal and vertical H value is displayed
adjustment

Applying a mosaic

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press
[Mosaic], turning it on.

Resizer
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2 Set the parameters.

This operation is the same as the DME mosaic setting. For more details,

see “Mosaic Settings” in Chapter 11 (Volume 2).

3 In the < Mosaic/Defocus Mode > group, select the signal to which to apply

the mosaic effect.

Video/Key: Video signal and key signal
Video: Video signal only

If mosaic is enabled, and in the <Mosaic/Defocus Mode> group you select

Video/Key, then the crop and mask are disabled.

4 Set the parameters.

Knob | Parameter |Adjustment Setting values
1 H Horizontal defocusing 0.00 to 100.00
\Y Vertical defocusing 0.00 to 100.00
All Horizontal and vertical defocusing | H value shown

To make the mosaic like a relief pattern

1 With [Mosaic] on, press [Relief], turning it on.

2 In addition to the mosaic parameters, set the following parameters.

Knob | Parameter |Adjustment Setting values
3 Gain Relief depth of mosaic cells 0.00 to 100.00
4 Angle Light source direction -8.00 to +8.00

Defocusing

Resizer

1 In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press
[Defocus], turning it on.




2 Set the parameters.

This operation is the same as the defocusing setting when using the DME
with the DME dedicated interface.

However, <Mosaic/Defocus Mode> appears in place of <Defocus
Mode>.

For more details, see “Defocus Settings” in Chapter 11 (Volume 2).

If defocus is enabled, and in the <Mosaic/Defocus Mode> group you select
Video/Key, then the crop and mask are disabled.

Applying a mask to mosaic or defocus

1
2

In the M/E-1 >Key1 >Processed Key >Enhanced Effect menu, press [Dual
Rszr Effect], turning it on.

Press [Mask], turning it on.

This enables the mask function.
To make the mask settings, continue with steps 3 and following.

Press [Mask Menu].

The Mask menu appears.

In the <Mask Source> group, select either of [Box] and [Circle].

Box: Use a box pattern as the mask signal.
Circle: Use a circle pattern as the mask signal.

Set the parameters.

The valid ranges of the parameter values depend on the combination of
signal format (SD/HD) and aspect ratio (4:3/16:9) selected in the system,
as follows.

The parameters are the same as for drop shadow. For more details, see
“Applying a drop shadow” (page 264), except that knobs 3 and 5 are as
follows.

Knob |Parameter |Adjustment Setting values

3 Size Size 0.00 to 100.00

5 Aspect Aspect ratio —100.00 to +100.00
Resizer
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The rotation and inversion operations are the same as for a DME mask
setting. For more details, see Chapter 11 “Mask Settings” (Volume 2).

e When a mask effect is applied to a border, the boundary becomes
discontinuous, giving an unnatural effect. Avoid applying a mask to a
border.

¢ If mosaic or defocus is enabled, and in the <Mosaic/Defocus Mode>
group you select Video/Key, then the mask is disabled.

Restrictions on resizer effects

Resizer

Restrictions on the use of effects

Of the resizer effects, using mask, drop shadow, or wide key border requires
two units of hardware for the resizer function.

These are called “dual resizer effects”.

In a dual resizer effect, predetermined combinations, key 1 and key 2, or key 3
and key 4 are used.

For example, if either of key 1 and key 2 has resizer set to On, the other key
cannot be used for a dual resizer effect.

The same restriction applies when using a resizer DME wipe in place of resizer.

Impossibility of simultaneous use within the same keyer

The following combinations of resizer effects cannot be simultaneously on.
* Mosaic and edge enhance

* Defocus and wide key border

* Mask and drop shadow

* Mask and wide key border



Key Snapshots

Key settings other than the key on/off status and the key priority can all be
instantaneously saved in a dedicated register, for recall when required. A key
snapshot comprises three values: a cross-point button number, key memory full
mode, and independent key transition, and can be called in any combination.
There are four key snapshot registers for each keyer.

Key Snapshot Operations

Key snapshot operations are carried out in the independent key transition
control block downstream key control block or Multifunction Flexi Pad control
block. Each keyer is provided with four dedicated key snapshot registers.

Key source name display/key snapshot buttonsﬁ

'a R
=)
Key delegation buttons 5
o
Key snapshot setting %
buttons —

Independent key transition control block (standard type)

Saving a key snapshot

For example, the following procedure saves the state of the M/E-1 key 1
settings.

1 In the M/E-1 independent key transition control block, press the key
delegation button [KEY 1], turning it on.

2 Press the [K-SS] button, turning it on.

Key Snapshots
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The system switches to key snapshot mode, and the key source name
display/key snapshot buttons show the status of registers 1 to 4 for key 1.
Off: Nothing is saved in the register.

Lit orange: Settings are saved in the register.

For a register holding a snapshot, the register name is shown as up to eight
characters.

Hold down the [K-SS STORE] button, and press the key source name
display/key snapshot button corresponding to the register in which you
want to save the snapshot.

The key source name display/key snapshot button which you pressed lights
yellow.

If you save a key snapshot in a register for which the button is lit orange or
yellow, the existing contents of the register are overwritten.

Recalling a key shapshot

For example, the following procedure recalls the state of the M/E-1 key 1
settings.

1
2

Key Snapshots

In the M/E-1 independent key transition control block, press the key
delegation button [KEY 1], turning it on.

Press the [K-SS] button, turning it on.

Set the following buttons on or off, depending on the information you want
to recall.
(These buttons are not provided in the downstream key control block.)

[K-MOD ENBL] button: When this is on, the key settings and key
modifiers are recalled. When this is off, they are not recalled.

[K-TR ENBL] button: When this is on, the independent key transition
settings are recalled. When this is off, they are not recalled.

If both buttons are off, the key memory function is enabled and only the

saved selection of key fill and key source signals is recalled.

Press the key source name display/key snapshot button corresponding to
the register you want to recall.

The button you pressed lights yellow, and this recalls the key snapshot.

To cancel a recall carried out in the downstream key control block, press
the [UNDO] button in the downstream key control block.



Key snapshot operation on the Multifunction Flexi Pad control

block

By default, the [KEY SS] key snapshot mode selection button does not appear
in the Multifunction Flexi Pad control block. To carry out key snapshot saving
and recall in this control block, it is first necessary in the Engineering Setup
>Panel >Config >Link/ProgramButton >Multi Function >Mode Sel Assign
menu to assign the Key Snapshot mode to a mode selection button.

To save a key shapshot
For example, to save a key snapshot for key 1 of M/E-1, select M/E1 and key 1,
then use the following procedure.

1 Press the [K SS] button.

The button displays in the memory recall section change as shown in the
following illustration.

swap || || sHor
DME
MCR wipg
KEvt KEv2 KEYS KEva
TRANS KEY DO
RATE ADJ B
oME oME
MOD TRNS
ENBL ENBL
K
AUTO KEY
- -

HREE
]

Sile

2 In the memory recall section, hold down the [STOR] button, and press the
button (any of [1] to [4]) for the register in which you want to save the key
snapshot.

To recall a key snapshot
For example, to recall a key snapshot for M/E1 key 1 saved in register 1, with
the M/E1 region and key 1 selected, proceed as follows.

1 Press the [KEY SS] button.

2 According to the information you want to recall, set the following buttons
On/Off.

[MOD ENBL] button: Recall the key adjustment values and key modifier
settings.

Key Snapshots
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[TRNS ENBL] button: Recall independent key transition settings.
If both are Off, then key memory is enabled, and just the saved key fill
and key source signal selections are recalled.

3 Press button [1] for the register you want to recall.

The [1] button lights yellow, and the key snapshot is recalled.
To cancel the recall operation, press the [UNDO] button.

To delete a key shapshot
For example, to delete a key snapshot for M/E1 key 1 saved in register 1, with

the M/E1 and key 1 region selected, proceed as follows.
1 Press the [KEY SS] button.

2 Holding down the [DEL] button, press the button [1] for the register in
which is saved the key snapshot you want to delete.

To carry out an auto transition execution during key snapshot

operation
Press the [AUTO TRNS] button.

Instant key insertion/removal
Press the [KEY ON] button.
To remove the key, while the key is inserted press the [KEY ON] button.

Key Snapshot Operations Using a Simple Transition

When using a simple transition module, the key snapshots hold the settings for
key 3 and key 4. However, each key control block can be assigned to any key
in setup (see “Overall Control Panel Settings (Config Menu)” in Chapter 19
(Volume 3)).

You can carry out key snapshot operations in the independent key transition
control block (simple type) and Flexi Pad control block (simple type).

There are two dedicated key snapshot registers for each of keys 3 and 4.

Key Snapshots



Key 3 control block Key 4 control block

Key source name display/key —
snapshot buttons

Ol

K-SS button

The functions of the key 3 control block and key 4 control block are the same.

Independent key transition control block (simple type)

Saving a key snapshot

For example, to save the settings of M/E-1 key 3, use the following procedure.

1 In the M/E-1 independent key transition control block, press the [K-SS]

button in the key 3 control block, turning it on.

This switches to key snapshot mode, and the key source name display/key
snapshot button shows the state of registers 1 and 2 for key 3.

Off: Nothing is saved in the register.

Lit orange: Settings are saved in the register.

For a register holding a snapshot, the register name is shown as up to eight
characters.

In the Flexi Pad control block, hold down the [SNAPSHOT] button and
press the key source name display/key snapshot button corresponding to
the register in which you want to save the snapshot.

The key source name display/key snapshot button which you pressed lights
yellow.

If you save a key snapshot in a register for which the button is lit orange or
yellow, the existing contents of the register are overwritten.

Key Snapshots
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Recalling a key snapshot
For example, the following procedure recalls the state of the M/E-1 key 3
settings.

1 In the M/E-1 independent key transition control block, press the [K-SS]
button in the key 3 control block, turning it on.

2 Press the key source name display/key snapshot button corresponding to
the register you want to recall.

The button you pressed lights yellow, and this recalls the key settings
(excluding the key insertion state (on/off) and key priority).

274 Key Snapshots
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Overview

A wipe is a transition from the current video stream to a new video stream,
using a wipe pattern.

Changing the background by means of a wipe is referred to as a “background
wipe,” and inserting or deleting a key with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in a common transition,
and those that can be selected in an independent key transition.

For details of independent key transitions, see page 177.

Types of Wipe Pattern

Overview

The patterns that can be used for a wipe are divided into a number of groups,
as follows. Note that only the standard wipe patterns can be used for an
independent key transition.

For wipe patterns, see “Wipe Pattern List” in Appendix (Volume 1) (page
497).

Standard wipe patterns
Patterns consisting of straight lines vertically, horizontally, or diagonally, and
circular patterns.

Enhanced wipes
More complex shapes such as hearts, stars, and round corners.

Rotary wipes
These patterns involve rotation of the image about a point.

Mosaic wipe pattern
This divides the image into small tiles.

Random and diamond dust wipe patterns
These patterns consist of small random tiles, or fine particles.



Basic Procedure for Wipe Settings

You carry out wipe setting operations principally using the Wipe menu for each
of the M/E-1 to M/E-3 and PGM/PST banks.

This section describes the basic procedures for wipe settings, taking the M/E-
1 >Wipe menu as an example.

For details of independent key transition wipe settings, see “Wipe Settings for
Independent Key Transitions” (page 303).

Wipe Settings Menu

Accessing the wipe settings menu

To access the M/E-1 >Wipe menu, use either of the following operations.

¢ In the menu control block, select the top menu selection button [M/E 1], and
press VF5 ‘Wipe.’

¢ In the transition control block of the M/E-1 bank, press the transition type
selection button [WIPE] twice in rapid succession.

Any of the above operations displays the M/E-1 >Wipe menu.

Wipe Pattern Selection

Selecting a wipe pattern by a menu operation

1 In the M/E-1 >Wipe menu, select HF1 ‘Main Pattern.’

The Main Pattern menu appears.

2 Select the wipe pattern group with the pattern group selection button.

Standard: standard wipes

Enhanced: enhanced wipes

Rotary: rotary wipes

Mosaicl to Mosaic3: mosaic wipes
Random/Dust: random/diamond dust wipes

The patterns from the selected pattern group appear on the screen.

For details of wipe patterns, see “Types of Wipe Pattern” (page 276) and
“Wipe Pattern List” (page 497).
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3 Press the button to select the desired pattern.

4 The parameters change according to the selected pattern, and you can

adjust the pattern.

* When a polygon wipe is selected (pattern number 49)

Knob | Parameter |Adjustment Setting values
1 No Number of points 3to 64
2 Star Rate Angularity of star —100.00 to +100.00 &

a) A value of —100.00 completely removes the star “rays,” leaving a circle; at +100.00 the
“rays” are at their sharpest.

* When a mosaic wipe is selected (pattern numbers 200 to 203, 206 to
213, 224 to 247, 250 to 257, 260 to 269)

Knob | Parameter |Adjustment Setting values
1 H Tile No Number of tiles horizontally 21to 36
2 V Tile No Number of tiles vertically 2t0 18

* When a karaoke wipe is selected (pattern numbers 220 to 223)

Knob | Parameter

Adjustment

Setting values

1 Start Position of start tile ~100.00 to +100.00 @
Row No Number of rows of tiles 1to 36
Phase Delay for next row —~100.00 to +100.00 ©)

a) At —100.00 tiles appear from the top (or left edge) of the screen; at +100.00 from the
bottom (or right edge) of the screen.
b) At—100.00 all rows appear simultaneously; at +100.00 until one row of tiles is completely

displayed, the next row

does not start to appear.

* When a random wipe is selected (pattern number 273)

Knob |Parameter |Adjustment Setting values
1 H Size Tile width 0.00 to 100.00
2 V Size Tile height 0.00 to 100.00
3 Volatility Rate of tile generation 0.00 to 100.00

¢ When a diamond

dust wipe is selected (pattern number 274)

Knob | Parameter

Adjustment

Setting values

1 H Size Particle width 0.00 to 100.00
V Size Particle height 0.00 to 100.00
Flash Rate | Rate of generation of particles 0.00 to 100.00

Basic Procedure for Wipe Settings




When Flash Rate is set to 0.00, you cannot change the pattern. In this state,
adjusting H Size or V Size has no effect on the pattern.

For details of a pattern mix, see the next section.
For details of applying pattern modifiers, see “Setting Wipe Modifiers”
(page 284).

Pattern Mix

You can create a new pattern by combining two selected patterns (main and
“Sub”).

It is not possible to apply a pattern mix to an independent key transition.

Types of pattern mix

There are four ways in which patterns can be combined in a pattern mix, as

follows.

Mix: The effect of the sub pattern is applied to the main pattern, modifying the
outline or nature of the main pattern.

Positive NAM (+Nam): Creates a pattern with an outline which contains all

points within the outlines of either of the main pattern and the sub pattern.

Negative NAM (-Nam): Creates a pattern with an outline which contains all
points within the outlines of both of the main pattern and the sub pattern.

Basic Procedure for Wipe Settings
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Mix Positive NAM Negative NAM

Morphing: As the transition progresses, the pattern morphs from the main
pattern, through the “mix” combination, to the sub pattern.

Basic Procedure for Wipe Settings



Dust mix

. Parameter settings
* Main pattern at 100%  Start: Point in the course of the
transition at which the main pattern
@ Sub pattern at 100% is at 100%
End: Point in the course of the transition
at which the sub pattern is at 100%

0.00 N 100.00
| ! Transition (0.00 - 100.00) !
| \ H
: i Mix ends during i >
St?” | i m;ﬁg:g'::gon of transition, which i Enld
value | l ends with sub | value
| | patterns already ttern at 100% |
| | begun pattern a o 1
B -
-10.00 - ] 90.00
I
.
: i Begins with main Ends with sub
| | pattern at 100% pattern at 100%
B - @
)
0.00 : ! Transition ends ! 100.00
| ! with main and !
I ! Mix begins after sub patterns i
: ! transition starts still in mix i
| * * * combination ‘
| —>
10.001 I T "I 110.00

* A value of 0.00 corresponds to the beginning of the transition, and a value of
100.00 to the end of the transition.

* A negative Start value signifies that the main and sub patterns are already
combined when the transition starts.

* An End value of 100.00 or more signifies that the main and sub patterns are
still combined when the transition complete.

o If the Start and End values are the same, the main and sub patterns are
interchanged instantaneously at the corresponding point in the transition.
 If End is less than Start, as the transition proceeds, it changes from the sub

pattern to the main pattern.

You can apply the effect of a diamond dust wipe to a selected pattern. You can
also apply the diamond dust wipe effect to the pattern resulting from a pattern
mix. (See “Pattern Mix” (page 279).)

When the pattern mix function is off, turning dust mix on results in the main

pattern and the diamond dust pattern being mixed. This state is the same as a

pattern mix when the diamond dust pattern is selected for the sub pattern.
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Main and sub modifier link function

When carrying out a pattern mix, it is possible to link the modifier settings for
the main pattern and sub pattern. There are two modes for this function.

FULL LINK (fully linked) mode

In this mode, all modifier settings are the same for the main pattern and sub
pattern.

Changing the modifier settings for one pattern automatically changes the
settings for the other.

SEMI LINK (semi-linked) mode

Only the parameter settings of the modifiers are linked. The modifier on/off
settings are not linked. When the parameter values for the modifiers of the main
pattern and sub pattern are different, then after this link mode is selected,
changing the value of a parameter for one pattern changes the value of the
parameter for the other pattern to maintain the same difference between the
two.

When carrying out a wipe transition using a pattern mix, it is recommended that
you set the modifier link function to “FULL LINK” mode.

If the link function is off, or SEMI LINK mode is selected, the desired effect
may not be obtained at the start or end of the transition.

Combining two patterns

You can combine two selected patterns (referred to as main and “sub”) to form
a new pattern. Select a main pattern in the Main Pattern menu, then use the
following procedure.

1 In the M/E-1 >Wipe menu, select HF3 ‘Sub Pattern.’

The Sub Pattern menu appears.

2 In the same way as for the main pattern, select the sub pattern.

The patterns that can be selected for the sub pattern depend on the pattern
selected for the main pattern (see the following table).

Basic Procedure for Wipe Settings



Possible combinations of main pattern and sub pattern
Yes: Combination possible No: Combination not possible

3 Select HF2 ‘Pattern Mix.’

4

The Pattern Mix menu appears.

In the <Pattern Mix> group, select the type of pattern mix.

Mix: mix

+Nam: positive Nam
—Nam: negative Nam
Morphing: morphing

For an overview of types of pattern mix, see “Types of pattern mix” (page

279).

Depending on the selection in step 4, set the following parameters.

* When mix, positive Nam, or negative Nam is selected

Knob

Parameter

Adjustment

Setting values

1

Mix Ratio

Proportion of sub pattern to the
main pattern

0.00 to 100.00

* When morphing (see page 280) is selected

pattern is at 100%

Knob | Parameter |Adjustment Setting values

2 Start Point in transition at which main —50.00 to +150.00
pattern is at 100%

3 End Point in transition at which sub —50.00 to +150.00

In the <Main/Sub Link> group, make the main/sub modifier link function
settings. (See “Main and sub modifier link function” (page 282).)

Full: fully linked mode

Basic Procedure for Wipe Settings

Main Sub pattern
pattern -
Standard Enhanced |Rotary Mosaic Random/
diamond
dust —
Standard Yes Yes No Yes Yes —
Enhanced | Yes Yes No Yes Yes o
0
Rotary No No No No No S
Mosaic Yes Yes No No Yes 3
Random/ | Yes Yes No Yes No s
diamond ]
dust @
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Semi: semi-linked mode

Applying the effect of a diamond dust wipe to the selected
pattern (Dust mix)

1 In the Pattern Mix menu, press [Dust Mix], turning it on.

2 Set the following parameters as required.

Knob |Parameter |Adjustment Setting values

1 Mix Ratio Proportion of diamond dust 0.00 to 100.00
pattern in mix

H Size Particle width 0.00 to 100.00

V Size Particle height 0.00 to 100.00

Flash Rate | Rate of generation of particles 0.00 to 100.00

You can also apply the dust mix function to the pattern generated by a
pattern mix.

Note
When a random/diamond dust wipe (pattern numbers 270-274) is selected,
the dust mix function is not available.

Setting Wipe Modifiers

You can apply various modifiers to the wipe pattern: setting the wipe direction,
pattern position, and so on.

Note that the available modifiers may depend on the pattern you are using. For
details, see “Possible combinations of wipe patterns and modifiers” (page

301).

Main pattern and sub pattern modifiers

You can make independent settings of the modifiers for the main pattern and

sub pattern.

* To set the modifiers for the main pattern, in the M/E-1 >Wipe menu, select
HF5 ‘Main Modify,” and make the settings in the Main Modify menu.

* To set the modifiers for the sub pattern, select HF6 ‘Sub Modify,” and make
the settings in the Sub Modify menu.

Operations in the Main Modify menu and Sub Modify menu are the same.
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Independently set modifiers for the main pattern and sub pattern
Positioner

Rotation

Aspect ratio

Pattern replication (MULTI)

Pairing

Modulation

Spring

Spiral

The following sections show examples of modifying the main pattern.

Specifying the wipe direction (Direction)

You can specify the direction of the wipe: the regular direction is referred to as
“normal,” and the other direction as “reverse.” You can also select alternating
directions each time the transition is completed (normal/reverse mode).

N__/ N/

N\ 7N

Normal Reverse

To specify the wipe direction in a menu

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal

To specify the wipe direction with a button in the transition control
block

In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST
banks, press the following direction selection buttons.

NORM: Normal

NORM/REV: Normal/reverse

REV: Reverse

Basic Procedure for Wipe Settings
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Splitting the wipe pattern (Split)
This splits the pattern, making the parts of the wipe move in opposite
directions.

H —

Split off Split on

The parameter Split No specifies the number of splits.
The parameter Spacing specifies the spacing between adjacent patterns.

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.
2 Press [Split], turning it on.

3 Set the following parameters.

Knob | Parameter |Adjustment Setting values

1 Split No Number of splits 1 to 4 (integer)

2 Spacing Spacing between adjacent 0.00 to 100.00
patterns

Modifying the wipe pattern edge (Edge)
You can apply a border to the pattern, soften the edges, or soften the applied
border.

Border Soft Soft border

Border: You can adjust the border width.
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Soft: You can adjust the edge softness.
Soft border: You can adjust the border width, and the softness of the inner and

outer edges of the border.

When a border or soft border is selected, the signal filling the border is called
edge fill. For the edge fill, you can use a matte generated by the dedicated color
matte generator, or the signal selected on the utility 2 bus. A matte can include
color 1 and color 2, and a combination of the two colors (a “color mix™).

1

In the M/E-1 >Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

In the <Edge> group, select the edge type.

Border: border
Soft: soft edge
Soft Border: soft border

Set the parameters according to the selection in step 2.

¢ When border is selected

Knob | Parameter |Adjustment Setting values

1 Width Border width 0.00 to 100.00
* When soft edge is selected

Knob | Parameter |Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

¢ When soft border

is selected

Knob | Parameter |Adjustment Setting values
1 Width Border width 0.00 to 100.00
2 Inner Soft Border inner softness 0.00 to 100.00
3 Outer Soft Border outer softness 0.00 to 100.00

When you selected border or soft border, select the edge fill signal in the

<Edge Fill> group.

Utility 2 Bus: signal selected on the utility 2 bus

Matte: signal from the dedicated color matte generator

Depending on the operation in step 4, carry out the following operation.

When ‘Utility 2 Bus’ is selected: Hold down the [UTIL] button in the
cross-point control block, and select the signal on the background B

bus.

Basic Procedure for Wipe Settings

287

sadipy G Jeidey)d



sadipy G Jeideyn

288

While the [UTIL] button is held down, the background B bus changes
to the utility 2 bus.

To enable the [UTIL] button, its operation mode must be set to [Hold]
beforehand. (See “Operation Settings (Operation Menu)” in Chapter

19 (Volume 3).)

When ‘Matte’ is selected: In the same Edge/Direction menu, press [Matte
Adjust] to display the Matte Adjust menu, then adjust the single-color
or two-color combination color matte. Select whether to use a single-
color matte or a two-color combination in the <Edge Matte> group.
Flat Color: Adjust color 1 with the following parameters.

Knob | Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

When you select [Mix Color] for a two-color combination, see the next
paragraph.

Carrying out a color mix for the edge fill matte

When you selected [Matte] for the border or soft border edge fill, you can
combine color 1 and color 2.
For the combination, you can use not only a normal wipe generator pattern, but
also the dedicated color mix pattern.

1 In the <Edge Fill> group of the Edge/Direction menu, select [Matte], and

press [Matte Adjust].

The Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], turning it on.

3 In the <Mix Pattern> group, make one of the following selections.

Wipe: Use the wipe pattern selected for the transition.

Pattern: Use the dedicated pattern.

4 Depending on the selection in step 3, set the following parameters.
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* When Wipe is selected

Knob | Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Edge softness 0.00 to 100.00
* When Pattern is selected

Knob |Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Edge softness 0.00 to 100.00
3 Pattern Pattern number 110243

a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” (page 497).

If you selected Pattern, you can also carry out the pattern selection by

pressing the [Mix Ptn Select] button in the Matte Adjust menu, to display

the Mix Ptn Select menu. Select any pattern appearing in the Mix Ptn

Select menu (wipe patterns 1 to 24) by pressing the appropriate button, and

you can then adjust the following parameters.

Knob | Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Edge softness 0.00 to 100.00

If you selected Pattern in step 4, if required, the following modifiers can

be added. After selecting a wipe mix, skip to step 6.

* When turning [Position] on and setting the pattern position

Knob | Parameter |Adjustment Setting values
1 Position H Horizontal position ~200.00 to +200.00 &
2 Position V Vertical position ~200.00 to +200.00 @

a) See page 290.

* When turning [Multi] on and using replications of the same pattern

Knob | Parameter |Adjustment Setting values

1 H Multi Number of repetitions of pattern 1to 63
horizontally

2 V Multi Number of repetitions of pattern 1to 63
vertically

3 Invert Type | Replication layout 1t0 49

a) See page 295.
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* When turning [Aspect] on and setting the aspect ratio of the pattern

Knob

Parameter

Adjustment

Setting values

1

Aspect

Aspect ratio

—~100.00 to +100.00 @

a) See page 294.

* When turning [Angle] on in the <Rotation> group and slanting the

Adjustment

Setting values

pattern
Knob | Parameter
1 Angle

Angle of pattern rotation

—~100.00 to +100.00 @

a) See page 292.

* When turning [Speed] on in the <Rotation> group and rotating the
pattern at a constant rate

Adjustment

Setting values

Rotation rate of pattern

-100.00 to +100.00 2

Knob | Parameter
1 Speed
a) See page 293.

6 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on,
then adjust the parameters.

Knob | Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

7 To interchange color 1 and color 2, press the [Color Invert] button, turning

it on.

Setting the wipe position (Positioner)

When you turn on this function, you can move the wipe pattern to any position.

—

Positioner off

Positioner on

290
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¢ The parameter H Position controls the horizontal position of the pattern.
A negative value moves the pattern to the left, and a positive value moves the
pattern to the right.

» The parameter V Position controls the vertical position of the pattern.
A negative value moves the pattern down, and a positive value moves the
pattern up.

You can set the position independently for the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Position> group, press [Position], turning it on, and set the pattern

position.

Knob | Parameter |Adjustment Setting values

1 Position H Horizontal position —200.00 to +200.00
2 Position V Vertical position —200.00 to +200.00

To return the pattern position to the center of the screen
In the <Position> group, press [Center].

To move the pattern from its current position to the center through
the course of a transition
In the <Position> group, press [Auto Center], turning it on.

To set the wipe position using the trackball or joystick
You can also set the wipe position using the trackball or joystick in the device
control block.

1 In the device control block, press the [M/E1], [M/E2], [M/E3], or [P/P]

button, turning it on.

The buttons in the device control block are assigned to the wipe position
setting as follows.

Table 1: Buttons and assigned settings

Button name Setting
MAIN Wipe position for common transition (main pattern)
SUB Wipe position for common transition (sub pattern)
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Table 2: Buttons assigned to functions

Button name

Function

POS

Toggle Position on or off.

X, Y

Fix the operating direction.

CTR

Return the pattern position to the center of the screen.

2 Press the [MAIN] button or [SUB] button, turning it on.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X]
button, turning it on, you can restrict movement to the horizontal direction,
and by pressing the [ Y] button, turning it on, you can restrict movement to
the vertical direction.

Rotating the wipe pattern (Rotation)

You can rotate the pattern. There are three rotation modes, as follows.

Angle

This carries out a wipe with the pattern in a fixed angle.

B —

Angle off

Angle on

The parameter Angle determines the angle of pattern rotation.
A value of —100.00 of the parameter Angle corresponds to one whole turn
counterclockwise; a value of +100.00 corresponds to one whole turn

clockwise.

With a value of 0.00 there is no rotation.

Basic Procedure for Wipe Settings




Speed
Through the course of the transition the wipe pattern rotates at a fixed specified
speed.

The parameter Speed determines the speed of pattern rotation.
A value of —100.00 of the parameter Speed corresponds to one turn per second

counterclockwise; a value of +100.00 corresponds to one turn per second
clockwise. With a value of 0.00 the pattern is stationary.

Magnitude
Through the course of the transition the wipe pattern rotates through the
specified angle.

\¥/

The parameter Angle determines an angle of pattern inclination at the

beginning of the transition.

e A value of —100.00 corresponds to the angle rotated one whole turn
counterclockwise.

¢ A value of +100.00 corresponds to the angle rotated one whole turn
clockwise.

* With a value of 0.00 the pattern is stationary.

The parameter Magnitude determines an angle of pattern rotation through the

course of the transition.

* A value of —200.00 corresponds to a rotation of two turns counterclockwise.

* A value of +200.00 corresponds to a rotation of two turns clockwise.
e With a value of 0.00 the pattern is stationary.

You can apply rotation independently to the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.
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2 In the <Rotation> group, select the rotation type.

Angle: Incline the pattern through a fixed angle.

Speed: Rotate at a fixed rate.

Magnitude: Rotate through a particular angle during the course of the
transition.

3 According to the selection in step 2, set the following parameters.

* When Angle is selected

Knob | Parameter |Adjustment Setting values

1 Angle Angle of pattern rotation ~100.00 to +100.00

* When Speed is selected

Knob |Parameter |Adjustment Setting values

1 Speed Rotation rate of pattern ~100.00 to +100.00

* When Magnitude is selected

Knob |Parameter |Adjustment Setting values

1 Angle Angle of pattern rotation at start of | _100.00 to +100.00
transition

2 Magnitude | Angle of rotation through course | _200.00 to +200.00

of transition

Setting the wipe pattern aspect ratio (Aspect ratio)

You can freely change the aspect ratio of the pattern.

H — I

Aspect off Aspect on

A negative value of the parameter Aspect stretches the pattern vertically; a
positive value stretches the pattern horizontally.

You can set the aspect ratio independently for the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’
The Main Modify menu appears.
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2 Press [Aspect], turning it on.

3 Set the following parameter.

Knob | Parameter |Adjustment Setting values

1 Aspect Aspect ratio —100.00 to +100.00

Setting the wipe pattern replication (Multi)

The same pattern can be repeated horizontally and vertically or both, up to 63
times. You can also change the orientation of alternate copies, or change the
position.

* % k
* % %

“Multi” off “Multi” on

e The parameter H Multi determines the number of pattern replications
horizontally, and the parameter V Multi determines the number of pattern
replications vertically.

* The parameter Shift determines the manner of replication.

At a value of —100.00, the pattern of the adjacent odd-numbered column on
the left lines up with the central coordinate horizontally.

At a value of +100.00, the pattern of the adjacent odd-numbered column on
the right lines up with the central coordinate horizontally.

For an independent key transition wipe, you can use the “Invert Type”
parameter to select from the following four types of replication pattern.

1 2 3 4

A A A A
A A A ANA

r
4N
A
V'
A

1: All replications in the same orientation

2: Even-numbered rows staggered

3: Even-numbered columns and rows inverted

4: Even-numbered columns and rows inverted, and even-numbered rows
staggered
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You can set pattern replication independently for the main pattern and sub

pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press the [Multi] button, turning it on.

3 Set the following parameters.

Knob |Parameter |Adjustment Setting values
1 H Multi Number of repetitions of pattern 1to 63
horizontally
2 V Multi Number of repetitions of pattern 1to 63
vertically
3 Shift Replication layout —100.00 to +100.00

4 To make more adjustments, press the [Multi Adjust] button.

The Multi Adjust menu appears.

5 Make the following settings, as required.

H Invert: When this is on, alternate tiles are inverted left-to-right.

V Invert: When this is on, alternate tiles are inverted top-to-bottom.

Non-Mask: When this is on, even if the positioner function is used to
move the pattern position, the pattern is always present on the screen.

Position: By adjusting the following parameters, move the pattern position
within the divisions determined in step 3.

Knob |Parameter |Adjustment Setting values

1 Position H Horizontal position of pattern —200.00 to +200.00 @
2 Position V Vertical position of pattern —200.00 to +200.00 @
a) See page 290.
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Making a wipe pattern like a Venetian blind (Pairing)

This slits the pattern into multiple strips, making it like a venetian blind.

Mg

Pairing off Pairing on

H: Create slits in the horizontal direction.

V: Create slits in the vertical direction.

¢ The parameter Width determines the width of the slits.

¢ The parameter H Offset determines the spacing in the horizontal direction.
If a negative value is set, the even-numbered pairs of strip and slit move to
the left, and the odd-numbered pairs move to the right. (The value —100.00
represents the maximum movement.)
If a positive value is set, the even-numbered pairs of strip and slit move to
the right, and the odd-numbered pairs move to the left. (The value +100.00
represents the maximum movement.)

¢ The parameter V Offset determines the spacing in the vertical direction.
If a negative value is set, the even-numbered pairs of strip and slit move
upward, and the odd-numbered pairs move downward. (The value —100.00
represents the maximum movement.)
If a positive value is set, the even-numbered pairs of strip and slit move
downward, and the odd-numbered pairs move upward. (The value +100.00
represents the maximum movement.)

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Pairing> group, select the slit direction.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.

3 Set the following parameters.

Knob | Parameter |Adjustment Setting values

1 Width Width of the slits 1 to 128 (integer)

2 H Offset Spacing in the horizontal direction | _100.00 to +100.00
3 V Offset Spacing in the vertical direction | _100.00 to +100.00
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Applying modulation to the wipe pattern (Modulation)

The pattern signal can be modulated, giving waves on the horizontal or vertical
edges, or radially.

The parameter Shape determines the form of the modulation.

1: sine wave, 2: triangular wave, 3: rectangular wave

Note |
When using 1080PsF mode in an HD system, the modulation function is not
available.

Horizontal modulation
This modulates the pattern, applying waviness in the horizontal direction to
edges.

The parameter Speed determines the speed of waves.
A value of —100.00 generates the maximum downward speed of waves, and a
value of +100.00 the maximum upward speed.

Vertical modulation
This modulates the pattern, applying waviness in the vertical direction to
edges.

The parameter Speed determines the speed of waves.
A value of —100.00 generates the maximum leftward speed of waves, and a
value of +100.00 the maximum rightward speed.
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Fringe

This modulates the pattern, applying waviness in the radial direction to edges.

The parameter Speed determines the speed of waves.
A value of —100.00 generates the maximum counterclockwise speed of waves,
and a value of +100.00 the maximum clockwise speed.

You can apply modulation independently to the main pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Depending on the desired effect, in the <Modulation> group select one of
the following.

H (Horizontal modulation): Modulate the pattern, applying waviness in
the horizontal direction to edges.
V (Vertical modulation): Modulate the pattern, applying waviness in the
vertical direction to edges.
Fringe (Radial modulation): Modulate the pattern, applying waviness in
the radial direction to edges.

3 Set the following parameters.

Knob |Parameter |Adjustment Setting values

1 Amplitude Amplitude of modulation 0.00 to 100.00

2 Frequency Frequency of modulation 0.00 to 100.00

3 Speed Speed of waves -100.00 to +100.00
4 Shape Form of the modulation 1t03
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Applying barrel or pincushion distortion to the edge of the wipe
pattern (Spring)
As the transition progresses, the edge of the pattern is subjected to barrel or
pincushion distortion.

H — BN

Spring off Spring on

A negative parameter value produces pincushion distortion, and a positive
value produces barrel distortion.

You can set the spring function independently for the main and sub patterns.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’
The Main Modify menu appears.

2 Press [Spring], turning it on.

3 Set the following parameters.

Knob |Parameter |Adjustment Setting values

1 Gain Degree of barrel distortion ~100.00 to +100.00

Applying a spiral effect to the wipe pattern (Spiral)
This deforms the pattern spirally.

—-

Spiral off Spiral on
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¢ The parameter Magnitude determines the size and direction of the spiral.
A value of —100.00 represents the maximum movement in the
counterclockwise direction, and a value of +100.00 represents the maximum
movement in the clockwise direction.

¢ The parameter Wave Speed determines the speed of the lateral waves.
A value of —100.00 represents the maximum speed to the left, and a value of
+100.00 represents the maximum speed to the right.

You can set the spiral function independently for the main and sub patterns.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.
2 Press [Spiral], turning it on.

3 Set the following parameters.

Knob |Parameter |Adjustment Setting values
1 Magnitude | Size and direction of the spiral ~100.00 to +100.00
2 Wave Speed | Speed of the lateral waves ~100.00 to +100.00

Possible combinations of wipe patterns and modifiers

Yes: Can be used No: Cannot be used

Modifiers Type of wipe

Standard Enhanced | Rotary Mosaic | Random/

diamond dust

Direction Yes Yes Yes Yes Yes
Split Yes Yes No Yes No
Edge Yes Yes Yes Yes Yes
Positioner Yes @ Yes ) Yes © No No
Rotation Yes Yes Yes © No No
Aspect ratio Yes 9 Yes No No No
Pattern Yes Yes Yes Yes® |No
replication
Pairing Yes Yes No No No
Modulation Yes Yes Yes No No
(HNV)
Modulation No 9 Yes No No No
(Fringe)
Spring No 9 Yes No No No
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Modifiers Type of wipe
Standard Enhanced | Rotary Mosaic | Random/
diamond dust
Spiral No P Yes No No No

a) Not patterns 1 to 16, 19, and 20
b) Not patterns 300 to 303

¢) Not patterns 100 to 103, 150, 151, 516, 518, 604, and 606
d) Not patterns 1 to 8, 17, and 18
e) Not patterns 220 to 223

f) Not patterns 19 and 20

g) But patterns 21, 23 and 24 are possible
h) But patterns 21 and 23 are possible

302

Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then
press VES ‘Wipe’ to return the wipe settings to their initial status.

For details of the menu operation to return the wipe state to that set in initial
status, see “Returning to default state in function groupings” (page 116).
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Wipe Settings for Independent Key
Transitions

You carry out independent key transition wipe setting operations using the
Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see “What is an independent

key transition?” (page 177).

This section describes the independent key transition wipe settings, taking the
M/E-1 >Key1 >Transition >Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition Wipe
Settings

Accessing the independent key transition wipe settings menu

As an example, to access the M/E-1 >Key1 >Transition >Wipe Adjust menu,

carry out either of the following operations.

* In the menu control block, select the top menu selection button [M/E 1] and
select VF1 ‘Keyl’ and HF6 ‘Transition’ to display the Transition menu for
key 1, then press [Wipe Adjust].

¢ In the independent key transition control block of the M/E-1 bank, press the
key delegation button [KEY 1], then press the independent key transition type
selection button [WIPE] twice in rapid succession.

Carrying out the above operation displays the M/E-1 >Key1 >Transition

>Wipe Adjust menu (which will be referred to below as simply the Key1 Wipe

Adjust menu).

Selecting the independent key transition wipe pattern

You select the independent key wipe pattern from the list of patterns displayed
in the menu.

In an independent key transition, you can only use the standard wipe patterns
(pattern numbers 1 to 24).

To select a wipe pattern for independent keyl on the M/E-1 bank, use the
following procedure.
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1 In the Keyl Wipe Adjust menu, select [Pattern Select].

The Pattern Select menu appears.

2 Press the button for the desired pattern.

sadipy G Jeideyn

Setting Independent Key Transition Wipe Modifiers

Available modifiers
You can use the following modifiers with an independent key transition wipe.
Note that the available modifiers may depend on the pattern you are using.
¢ Direction
* Edge
* Positioner
* Rotation
* Aspect ratio
* Pattern replication

Setting the wipe direction (Direction)

In the <Direction> group of the Keyl Wipe Adjust menu, make any of the
following selections.

Normal: regular direction

Normal/Reverse: alternate between regular and reverse for each transition

Reverse: reverse direction to normal

Softening the wipe pattern edge (Soft edge)
1 Press [Soft] in the Keyl Wipe Adjust menu, turning it on.

2 Set the following parameter.

Knob |Parameter |Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Setting the wipe position (Positioner)
There are two methods of setting the wipe position: using the device control
block, or in a menu.
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To set the wipe position using the trackball or joystick
You can also set the wipe position using the trackball or joystick in the device
control block.

1 In the device control block, press the [M/E1], [M/E2], [M/E3], or [P/P]
button, turning it on.

The buttons in the device control block are assigned to the wipe position
setting as follows.

Table 1: Buttons and assigned settings

Button name

Setting

K1 CB1 Wipe position for independent key 1 transition
K2 Wipe position for independent key 2 transition
CB2

K3 Wipe position for independent key 3 transition
K4 Wipe position for independent key 4 transition

Table 2: Buttons assigned to functions

Button name

Function

POS Toggle Position on or off.
X, Y Fix the operating direction.
CTR Return the pattern position to the center of the screen.

2 Press one of the buttons in Table 1 above, to select the wipe position to
which the operation applies. Multiple selection is possible.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. By pressing the [X]
button, turning it on, you can restrict movement to the horizontal direction,
and by pressing the [ Y] button, turning it on, you can restrict movement to
the vertical direction.

To set the wipe position by a menu operation

1 Press [Position] in the Keyl Wipe Adjust menu, turning it on.

2 Set the following parameters.

Knob | Parameter |Adjustment Setting values
1 Position H Horizontal position ~200.00 to +200.00 @
2 Position V Vertical position ~200.00 to +200.00 @
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a) See page 290.

To move the pattern from its current position to the center through

the course of a transition

Press [Auto Center] in the <Position> group, turning it on.

Rotating the wipe pattern (Rotation)

1 In the <Rotation> group of the Keyl Wipe Adjust menu, select the rotation

type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a speed rate.

Magnitude: Rotate the pattern through a fixed angle during the course of

the transition.

2 According to the selection in step 1, set the following parameters.

* When Angle is selected

Knob | Parameter |Adjustment

Setting values

1 Angle Angle of pattern rotation

—100.00 to +100.00 @

a) See page 292.

* When Speed is selected

Knob |Parameter |Adjustment

Setting values

1 Speed Rotation rate of pattern

-100.00 to +100.00 2

a) See page 293.

* When Magnitude is selected

Knob |Parameter |Adjustment

Setting values

of transition

1 Angle Angle of pattern rotation at start of | _100.00 to +100.00 @
transition
2 Magnitude | Angle of rotation through course | _200.00 to +200.00 &

a) See page 293.

Setting the wipe pattern aspect ratio (Aspect ratio)

1 Press [Aspect] in the Keyl Wipe Adjust menu, turning it on.

2 Set the following parameter.
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Knob | Parameter

Adjustment

Setting values

1 Aspect

Aspect ratio

—~100.00 to +100.00 @

a) See page 294.

Replicating the wipe pattern (Multi)

1 Press [Multi] in the Keyl Wipe Adjust menu, turning it on.

2 Set the following parameters.

Knob |Parameter |Adjustment Setting values

1 H Multi Number of repetitions of pattern 1to0 63
horizontally

2 V Multi Number of repetitions of pattern 1to 63
vertically

3 Invert Type | Replication layout 1t042

a) See page 295.
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Wipe Snapshots

You can snapshot and save a wipe pattern together with the current settings of
its modifiers and pattern limit in a dedicated register for recall when required.
There are 10 wipe snapshot registers on each M/E bank and the PGM/PST
bank.

Use the Flexi Pad control block, the Multifunction Flexi Pad block in each
switcher bank or the Menu control block to save and recall wipe snapshots.
For simple transitions (see page 189), there are eight wipe snapshot registers
on each M/E bank and the PGM/PST bank.

Wipe Snapshot Operations With the Flexi Pad

Numeric display

UNDO button

WIPE button STORE STATS button

XPT HOLD
ABUU:1234

WIPE UNDO

Ny
D
]
2

) —)

3 ]
2 3
H S
é Gl

STATS

SNAP

SHOT RATE

BNAK
0

SHOT

BANK
BOX 1

PTN
NQ

DEEE
OEBE

ENTR BANK

SEL

DEDEBGE—
BB RE

Memory recall buttons

Flexi Pad control block (standard type)
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WIPE button

Numeric display

XPT HOLD ]
ABUL1234/| LI
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]

Memory recall buttons

UNDO button

Flexi Pad control block (simple type)

Selecting a wipe pattern in the Flexi Pad control block

To select a pattern with a standard type Flexi Pad control block, use the
following procedure. (It is not possible to select a wipe pattern with a simple
type Flexi Pad control block.)

1 In the M/E-1 Flexi Pad control block, press the [WIPE] button.

This switches the Flexi Pad control block to wipe snapshot mode.

2 In the memory recall section, press the [PTN NO] button.

This switches the Flexi Pad control block to wipe pattern number recall
mode.

3 Use the buttons in the memory recall section to enter the pattern number
consisting of up to three digits, and press the [ENTR] button.

Wipe Snapshots
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The entry is confirmed, and now the numeric display shows the pattern
number.

For the pattern numbers, see “Wipe Pattern List” (page 497).

Saving a wipe snapshot

1

Make the wipe settings that you want to save.
Make any modifier settings required.

For details, see “Setting Wipe Modifiers” (page 284).

In the Flexi Pad control block, hold down the [WIPE] button, and press the
memory recall button corresponding to the register in which you want to
save.

* If you press a button which is lit orange or yellow, the existing contents

of the register are overwritten.
* If you carry out a pattern mix, and both the main pattern and sub pattern
are selected, then the memory recall button shows the main pattern.

The pattern appears on the button you pressed, which lights yellow.
The numeric display shows the number of the corresponding pattern.
It is also possible to display the register name using a Setup menu (see
“Operation Settings (Operation Menu)” in Chapter 19 (Volume 3)).

Meaning of the state of buttons

Off: Nothing is saved in the register.

Lit orange: Settings are saved in the register.
Lit yellow: The most recently recalled register.

Canceling the saving of a wipe snapshot

To cancel the saving of a wipe snapshot immediately after performing it, hold
down the [STORE STATS] button, and press the [UNDO] button. The
[STORE STATS] button changes from amber to green.

On a simple type Flexi Pad control block, it is not possible to cancel the saving
of a wipe snapshot.

Wipe Snapshots



Recalling a wipe snhapshot

1 In the Flexi Pad control block, press the [WIPE] button.

This switches the Flexi Pad control block to the wipe snapshot mode.

2 Press the memory recall button for the register from which you want to
recall the wipe snapshot.

The button lights, and the saved wipe snapshot is recalled. At this point,
the numeric display shows the pattern number or register name.

Canceling the recall of a wipe snhapshot
To cancel the recall of a wipe snapshot, press the [UNDO] button.

Deleting a wipe snapshot

When the [WIPE] button is lit in the Flexi Pad control block, hold down the
[STORE STATS] button and press the memory recall button for the register in
which you want to delete the wipe snapshot.

The indication of the memory recall button reverts from the wipe pattern or
register name to the register number.

In a simple type Flexi Pad control block, it is not possible to delete a wipe
snapshot.

Wipe Snapshot Operations With the Menus

Menus used

As an example, when operating on M/E-1, select M/E-1 >Wipe >Wipe
Snapshot.

The Wipe Snapshot menu appears.

Wipe Snapshots
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Current Patlern No

——
DME Wipe

Snapshol

Memory recall buttons

Button displays
In setup you can select whether the memory recall buttons show the pattern

number or register name.

See “Operation Settings (Operation Menu)” in Chapter 19 (Volume 3).
Saving a wipe snapshot from the menu

1 Set up the wipe you want to save.

2 In the Wipe Snapshot menu, press [Store], lighting it amber.

3 Press the memory recall button for the register in which you want to save.

* If you press a button which is already lit, this overwrites the contents of

the register.
* When both the main pattern and sub pattern are selected for a pattern

mix, the button in the memory recall section shows only the main
pattern.

Recalling a wipe snapshot from the menu

In the Wipe Snapshot menu, press the memory recall button for the wipe
snapshot you want to recall.

This recalls the wipe snapshot, and the button you pressed lights amber.
In the upper left is shown the currently recalled register name or number.
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The Flexi Pad and menu settings are linked.
A setting in setup determines whether register names or pattern numbers
appear.

Deleting a wipe snapshot from the menu

1 In the Wipe Snapshot menu, press [Delete].

2 Press the memory recall button for the wipe snapshot you want to delete.

This deletes the wipe snapshot.

Wipe Snapshots
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Recalling a Wipe Snapshot

You can recall a wipe snapshot in the Multifunction Flexi Pad control block.
To recall a wipe snapshot, use the operations shown in the following
illustration.

1 In the Multifunction Flexi Pad control block, press the [WIPE] button.

This sets the Multifunction Flexi Pad control block to wipe snapshot mode,
and the button indications appear as follows.

WIPE button Alphanumeric display knobs
f_lﬁ
OEE | | =
SEEC LT
oooo O
EEE
)
O
1 2 3 UNDO
M‘/E MZ/E PP
PTN STOR
D ERE S
\ J | —

Region selection buttons Memory recall section

You can change the indications for buttons [0] to [9] in the memory recall
section to pattern images, using the Engineering Setup >Panel >Operation
>Flexi Pad Mode menu.

2 Select the region for the wipe snapshot to be recalled with the region
selection buttons.
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3

Press the numeric button (lit orange) in the memory recall section

corresponding to the register in which the desired wipe snapshot is stored.

The button you pressed lights yellow, and this recalls the saved wipe
snapshot.

At this point the numeric display shows the register name or pattern
number for the pattern.

Selecting the Wipe Pattern

1
2

Press the [WIPE] button, and select the region with the region selection
buttons.

Press the [PTN NO.] button in the memory recall section.

The [PTN No.] button lights green.

With the buttons in the memory recall section, enter the pattern number of
up to three digits, and press the [ENTR] button.

This confirms the input, and the pattern number appears in the
alphanumeric display.

The [PTN NO.] button lights orange, and the system returns to wipe
snapshot mode.

For pattern numbers, see “Wipe Pattern List” (page 497).

Editing the Wipe Pattern

By pressing the [EDIT ENBL] button to switch the memory recall section to
editing mode as shown in the following illustration, you can edit the selected
wipe pattern with the following buttons.

To exit from the editing mode, press the [EDIT ENBL] button once more, or
press the [EXIT] button.

Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Wipe pattern edge setting buttons

BDR (border): Applies a border to the wipe pattern.

SOFT BDR (soft border): Softens the applied border.

SOFT (soft edge): Softens the edge.

EDGE MAT (edge matte): Selects whether to fill the edge with a color matte,
or insert an image from the utility bus. By default a color matte is selected.

You can adjust the parameters selected with these buttons using the control

knobs, when the button is lit green.

¢ When border is selected

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 w Border width 0to 100
Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0to 100

2 S Saturation 0to 100

3 H Hue 359100

¢ When soft border is selected

Parameter group [1/2]

Knob Parameter Adjustment Setting values
1 W Border width 0to 100
2 | Degree of softening of 0to 100

inside of border

316
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Parameter group [1/2]

Knob Parameter Adjustment Setting values
3 o} Degree of softening of 0 to100
outside of border
Parameter group [2/2]
Knob Parameter Adjustment Setting values
1 L Luminance 0to 100
2 S Saturation 0to 100
3 H Hue 359100

* When soft edge is selected

Knob

Parameter

Adjustment

Setting values

1

S

Degree of softening of
edge

0to 100

* When edge matte is selected

Knob Parameter Adjustment Setting values
1 L Luminance 0to 100
2 S Saturation 0to 100
3 H Hue 359100

Buttons for positioning the wipe pattern

POS (position): Adjusts the position of the wipe pattern.
CNTR (center): Returns the wipe pattern position to the center.

When you press the [POS] button, the alphanumeric display first shows the
name of the parameter, “H” or “V,” and then the value of the parameter.

When the [POS] button is lit green, you can adjust the position of the wipe
pattern with the control knobs.

Knob Parameter Adjustment Setting values
1 H Horizontal position —200 to +200
2 \% Vertical position —200 to +200

Buttons for setting the wipe direction

NORM (normal): Sets wipe to normal (forward) direction.

NORM/REYV (normal/reverse): Sets the wipe direction to alternate between

normal and reverse for each transition.
REYV (reverse): Sets wipe to reverse direction to normal.

Wipe Pattern Operations in the Multifunction Flexi Pad Control Block

sadipy G Jeidey)d



sadipy G Jeideyn

318

Buttons for setting the wipe pattern limit

PTN LIMT (pattern limit): Enables the following settings for the pattern
limit using the control knobs.

LIMT SET (limit set): If you change the pattern size with the fader lever then
press this button, this sets the current size as the pattern limit.

Knob Parameter Adjustment Setting values

1 P Pattern limit range 03 to +100D (%)

a) At 0%, executing the transition has no effect at all.
b) At 100%, the transition can be executed with the same effect as with no pattern limit set, but
when the transition completes, background buses A and B are not interchanged.

Other buttons
EXIT: Exits the editing mode, and returns the memory recall section to wipe

snapshot mode.
KNOB 1/2: When the control knob adjustments are on two pages, this switches

between parameter group [1/2] and parameter group [2/2].

Wipe modify clear

Press [Default Recall] at the lower left of the menu display, turning it on, then
press VES ‘Wipe’ to return the wipe settings to their initial status.

For details of menu operations, see “Menu Operations” (page 114).

Saving, Canceling, and Deleting Edited Wipe Patterns

Saving the edited wipe pattern as a snapshot

Holding down the [WIPE] button, press the button in the memory recall section
for the register in which you want to save.

The button you pressed lights yellow.
Buttons for registers in which wipe snapshots are already saved light orange.

Canceling a saved wipe snapshot

To cancel a wipe snapshot
Immediately after saving, hold down the [STOR STAT] button and press the

[UNDO] button.
At other times, hold down the [STOR STAT] button, and press the button for

the register in which the wipe snapshot you want to cancel is saved.

Wipe Pattern Operations in the Multifunction Flexi Pad Control Block



Buttons for registers in which wipe snapshots are already saved light orange.

Canceling recall of a wipe shapshot

To cancel the operation of recalling a wipe snapshot, press the [UNDO] button.

Deleting the date of a saved wipe snapshot

Holding down the [DEL] button, press the button for the register in which the
wipe snapshot you want to delete is saved.
The register button you pressed goes off.

Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Overview

A DME wipe is a wipe transition that uses a DME effect to change from one

video image to the next.
There are two types of DME wipe: those which can be selected for a normal
transition, and those which can be selected for an independent key transition.

For details of independent key transitions, see page 177.

On the MVS-8000G, it is also possible to carry out a DME wipe on a key using
the resizer (see page 349).

Types of DME Wipe Pattern

The patterns used for a DME wipe fall into two broad classes.

Preset patterns: predetermined fixed patterns

User programmable DME patterns: patterns which you can create using
keyframe effects

DME wipe execution mode and pattern numbers that can be used

There are three DME wipe execution modes, depending on the number of
DME channels available: one-channel mode, two-channel mode and three-
channel mode. The pattern numbers that can be used in these modes are as

follows.

Execution mode Preset pattern numbers | User programmable DME pattern
that can be used numbers that can be used

One-channel mode 1000 series 1901 to 1999

Two-channel mode 2000 series 2901 to 2999

Three-channel mode | 3000 series 3901 to 3999

DME wipe pattern groups

Overview

The patterns used in DME wipes fall into the following groups.

For each group (excluding user programmable DMEs), for schematic patterns
and numbers, see “DME Wipe Pattern List” in Appendix (Volume 1) (page
503). The black part of the pattern represents the old video, and the white part
the new video, with the wipe taking place in the direction of the arrow.



Slide: The new video slides in over the old video.

(Pattern numbers: 1001 to 1008 (one-channel mode), 2601 to 2608 (two-
channel mode))

Squeeze: The new video appears squeezed over the old video, and
progressively expands to cover it.

(Pattern numbers: 1021 to 1031 (one-channel mode), 2621 to 2628 (two-
channel mode))

Split: The old video splits, and the new video appears in the gap.

(Pattern numbers: 1011 to 1013 (one-channel mode))

Door: The new video moves like a door closing, and progressively covers the
old video.

(Pattern numbers: 1041 to 1048 (one-channel mode))

Flip tumble: The old video rotates about an axis and is replaced by the new
video. During the transition, the signal from the utility 2 bus of the M/E
bank appears as the background.

(Pattern numbers: 1101 to 1104, 1109, 1110, 1121, 1122, 1124, 1131 to
1133, 1135 (one-channel mode))

Mirror: The new video appears over the old video as a mirror effect slides in
all four directions.

(Pattern numbers: 1355 to 1358 (one-channel mode))

Sphere: The new video appears wrapped around a sphere over the old video,
then returns to the original video while unwrapping.
(Pattern number: 1365 (one-channel mode))

Character trail: The new video appears with a trail over the old video. Next
this gradually returns to the original from the periphery.
(Pattern numbers: 1371, 1372 (one-channel mode))

Wave: The new video appears with a wave-like effect over the old video. Next
this returns to the original video as the effect reduces.
(Pattern numbers: 1378, 1379 (one-channel mode))

Ripple: The new video appears over the old video like outwardly moving
ripples.

(Pattern number: 1381 (one-channel mode))

Page turn: The old video moves like a page turning, and the new video appears
behind it.

(Pattern numbers: 1301 to 1313, 1315 to 1318, 1341 to 1345 (one-channel
mode), 2701 to 2713, 2715 to 2718, 2741 to 2745 (two-channel mode))

Page roll: The new video unrolls like a scroll over the old video. This is a type
of page turn.

(Pattern numbers: 1321 to 1333, 1335 to 1338, 1346 to 1350 (one-channel
mode), 2721 to 2733, 2735 to 2738, 2746 to 2750 (two-channel mode))

Frame in-out: Completed in two transitions. In the first transition, the new
video appears, then on the second transition the new video goes out and the
old video returns.

(Pattern numbers: 1201 to 1208, 1221 to 1224 (one-channel mode), 2851
to 2854, 2861 to 2864 (two-channel mode))

Overview
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Overview

Picture-in-picture: The one-channel mode and two-channel mode differ as
follows.
In one-channel mode, this completes in two transitions. In the first
transition, the old video shrinks, and the new video appears behind it.
In the second transition, the old video expands again until it is its original
size.
(Pattern number: 1251 (one-channel mode))
In two-channel mode, in the first half of the transition, the old video
shrinks, and the new video appears. In the second half of the transition, the
new video expands, and the old video disappears. You can move the
pattern from the current position by a relative amount. During the
transition, the signal from the utility 2 bus of the M/E bank appears as the
background.
(Pattern numbers: 2651 and 2652 (two-channel mode))

2D trans: The new video appears over the old video, while undergoing
expansion, two-dimensional rotation and translation.

(Pattern numbers: 1051 to 1058, 1061 to 1064, 1068 (one-channel mode))
3D trans: In one-channel mode, the new video appears over the old video,

while undergoing expansion, three-dimensional rotation and translation.

(Pattern numbers: 1071, 1072, 1074, 1076, 1077, 1088, 1091 to 1094 (one-

channel mode))

In two-channel mode, the old video changes to the new video while both

undergo expansion, three-dimensional rotation and translation.

(Pattern numbers: 2631 to 2634, 2642, 2644 (two-channel mode))

Sparkle: The new video appears over the old video with a nonlinear effect
applied, such as broken glass, explosion, or melt. Next this returns to the
original video as the effect gradually reduces.

(Pattern numbers: 1391, 1393, 1394, 1396, 1398, 1399 (one-channel
mode))

Split slide: The new video appears in strip form while sliding interleaved in the
opposite direction over the old video.

(Pattern numbers: 1384 to 1389 (one-channel mode))

Mosaic: In the first half of the transition, a mosaic is gradually applied to the
old video, then at the 50% point the inner image changes to the new video.
In the second half, the mosaic effect on the new video is gradually reduced,
returning to the original image at 100%.

(Pattern number: 1701 (one-channel mode))

Defocus: In the first half of the transition, the old video is gradually defocused,
then at the 50% point the inner image changes to the new video. In the
second half, the defocusing effect on the new video is gradually reduced,
returning to the original image at 100%.

(Pattern number: 1702 (one-channel mode))

Brick: In two-channel mode, a brick such that the side surface is visible slides
in over the old video, then rotates so that the new video can be seen.
(Pattern numbers: 2801 to 2804, 2811 to 2814 (two-channel mode))



In three-channel mode, a brick appears over the old video as the image is
expanding and rotating, and switches to the new video.
(Pattern number: 3601 (three-channel mode))

User programmable DME: Using a DME keyframe effect created with a

keyframe operation, this executes a DME wipe.
(Pattern numbers: 1901 to 1999 (one-channel mode), 2901 to 2999 (two-
channel mode), 3901 to 3999 (three-channel mode))

For details of creating keyframe effects, see “Creating User
Programmable DME Patterns” (page 353).

To use the Split, Page Turn, and Page Roll effects on the MVE-8000 requires
the optional MKS-8830M Nonlinear Effect Board.
In an independent key transition, the following patterns can be used.

Execution mode DME wipe patterns that can be used

One-channel mode Slide, split, squeeze, door, 2D trans, 3D trans, frame in-out,

page turn, page roll, mirror, sphere, character trail, wave, ripple,
split slide, sparkle, user programmable DME

Two-channel mode Page turn, page roll

User programmable DME in transition mode

For the transition mode set when creating a keyframe effect for a user
programmable DME pattern, the following can be used.

Single: single transition mode

Flip tumble (Flip Tumble): flip tumble transition mode

Dual: dual transition mode

Picture-in-picture (PinP): one-channel and two-channel picture-in-picture
transition mode

Compress: a type of picture-in-picture, in which the new image is the
background, and the currently visible image shrinks, and then expands to its
original size. (See example in the next item.)

Frame in-out (Frame I/0): frame in-out transition mode. When the first
transition completes, if you move the position of the image, you can move it
both horizontally and vertically.

Frame in-out H (Frame I/0 H): a type of frame in-out mode, which is
specified when creating a transition effect in the horizontal direction.

The image movement is reflected at both the transition start point and end
point. (See page 327.)

The operation is carried out according to DME wipe patterns 1202, 1203, or
1204.

Frame in-out V (Frame I/O V): a type of frame in-out mode, which is
specified when creating a transition effect in the vertical direction.

Overview
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The image movement is reflected at both the transition start point and end
point. (See page 328.)

Transition mode “Compress”

The change in the image when the transition mode is set to “Compress” is as

follows, in comparison to the case of “Picture-in-picture.”

* Example of the image change in the transition mode “Picture-in-
picture” (one-channel mode)

A A A A A
A
L4
First stroke Second stroke

A 4

* Example of the image change in the transition mode “Compress”

A4
A 4

First stroke Second stroke

Transition mode “frame in-out”
In this mode, when the first transition has completed, you can move the image
with the positioner in both horizontal and vertical directions, but the image
position at the transition start point and end point does not change.

The description is of an example of creating an effect such as the following.



First transition
Transition start completion point Transition end

A A A

"""" Image created
by interpolation

A Background A
B  Background B

Effect execution

At the first transition completion point, if you move the image with the
positioner, the transition appears as in the following figure.

First transition
Transition start completion point Transition end

A A A

A .------ . 7=----7 Image created

by interpolation

/. -
- """ j' -- A Background A
B

Effect execution Background B

State before
modification

Transition mode “frame in-out H”

This mode is specified when creating a transition effect in the horizontal
direction.

In this mode, when the first transition has completed, you can move the image
with the positioner in both horizontal and vertical directions. The image at the
transition start point and end point also moves.

The description is of an example of creating an effect such as the following.

Overview
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First transition
Transition start completion point Transition end

A A A

[ ]

A 7—--1 Image created

> > i _____i1 by interpolation

| B | : | B | :“ | B | A Background A
e

Effect execution B Background B

At the first transition completion point, if you move the image with the
positioner, the transition appears as in the following figure.

First transition
Transition start completion point Transition end

A AI A
| * |

— —
A ... T Image created

| f| | |Bf| --i- “| 2 by interpolation

A Background A
B Background B
B

Effect execution
State before

modification

Transition mode “frame in-out V”

This mode is specified when creating a transition effect in the vertical
direction.

In this mode, in the state at completion of the first transition, you can move the
image with the positioner in both horizontal and vertical directions. The image
at the transition start point and end point also moves.

The description is of an example of creating an effect such as the following.



First transition
Transition start completion point Transition end

L | ]
v
B
‘ 7771 Image created
Eo--o3 A {_____1 by interpolation
Effect execution B A Background A
l B  Background B

At the first transition completion point, if you move the image with the
positioner, the transition appears as in the following figure.

First transition
Transition start completion point Transition end

A A A

—

| * |

B’ { B
l """" i Image created

A 1 by interpolation

Effect execution [[B™ 1 B A Background A

B Background B
- B’ State before
B { B modification
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Signals forming part of the background for a DME wipe

For a two-channel mode page turn, page roll, brick, frame in-out, and so on, the
part of the pattern shown in gray (see page 511) is filled with the signal selected
on the DME external video bus.

For three-channel mode brick, the part of the pattern shown in dark gray is
filled with the DME external video signal, and the light gray portion with the
signal selected as follows.

For a DME dedicated interface
When the DME channel used is 3 or 4, the signal selected on the DME utility
1 bus. For channel 7 or 8, the signal selected on the DME utility 2 bus.

For an MVE-8000A or MVE-9000 SDI interface

Signal selected on the AUX bus assigned in the Engineering Setup >Switcher
>Device Interface >DME Type Setting >DME SDI interface menu. (The AUX
bus is determined by which DME channel is being used.)

Note|
For the SDI interface on the MVE-8000A or MVE-9000, in some cases the
AUX bus is used in place of the DME external bus.

For details, see “Interfacing With External Devices (Device Interface Menu)”
in Chapter 19 (Volume 3).

DME Wipe Pattern Variation and Modifiers

Overview

You can modify the selected DME wipe pattern in the same way as an ordinary
wipe pattern, as follows.

For the setting operations, see “Setting DME Wipe Modifiers” (page 337).

Direction: You can set the DME wipe direction to normal, reverse, or
alternating normal/reverse (see page 337), except for a key transition,
which is always in normal/reverse mode. However, a key transition can
only be specified when the following patterns are selected, and when other
patterns are selected, this is fixed, as normal/reverse.

Patterns: 1204, 1207, 1221 to 1224

Edge: You can apply a border or soft border (see page 338).

In the case of those user programmable DME patterns for keys in which an

edge has already been applied to the effect, the behavior is as follows.

* When the DME wipe edge setting is on, only part of the edge applied in
the effect is enabled, and that portion can be adjusted (page 338).

* When the DME wipe edge setting is off, the edge applied in the effect is
enabled as is.



In an MVS-8000 system, edge cannot be used for a key DME wipe.

Positioner: You can move the DME wipe pattern or center of the effect to an
arbitrary position. Using the position select function, you can also
instantaneously move the pattern.

* 1031
When this pattern number is selected, with the progress of the transition
the pattern center automatically moves initially from the set position
toward the center of the screen (see page 339). In other words, the effect
obtained is the same as in a normal wipe with the positioner set to
“AUTO CENTER”.

* 1201 to 1208, 1221 to 1224, 1251
‘When these pattern numbers are selected, you can set the pattern position
when the first transition completes.

» 1381, 1391, 1393, 1394, 1396
When these pattern numbers are selected, you can set the center of the
transition effect.

e 2651, 2652
When these pattern numbers are selected, you can move the pattern for
each channel, or with values relative to the current position the two
channels simultaneously.

e 2801 to 2804, 2811 to 2814
When the these pattern numbers are selected, you can set the vertical
position as the brick slides in.

e 2851 to 2854, 2861 to 2864
When these pattern numbers are selected, you can set the pattern position
for each channel setting when the first transition completes.

Pattern limit: You can restrict the range of the transition as desired. However,
this is not available for a DME wipe in the independent key transition
control block.

For more details, see “Pattern Limit” (page 167).

Size: This can only be used when one of the following pattern numbers is

selected.

e 1201 to 1208, 1221 to 1224, 1251

* 2651, 2652, 2851 to 2854, 2861 to 2864
You can set the size of the image.

Crop: You can crop the image. It is also possible in 16:9 mode to crop both
sides, to convert the image to a 4:3 aspect ratio. For the execution of a
DME wipe crop transition, you can select from the following three
possibilities.

e Cut
* Last 5%
* Linear
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When [Last 5%] is selected, you can set the [Release Transition] as
follows.

e Last 30%

e Last 5%

e Off

* When pattern numbers 1701 and 1702 are selected, crop cannot be used.
e The MVS-8000 does not support the [Last 5%] setting for [Release
Transition].

Relation Between DME Wipes and Other Effects

The relations between DME wipes and other effects are as follows.

Relation to ordinary wipes

* DME wipes do not use the wipe generator built into the switcher. Therefore,
during the execution of a DME wipe, you can still use a pattern produced by
the wipe generator as the source for a pattern key or mask.

* A DME wipe pattern cannot be used as the source for a pattern key or mask.

Relation to processed keys

When using the DME for a processed key, if you select a DME wipe, an
available DME is automatically allocated to the DME wipe. If all of the DME
channels are in use, then it is not possible to select a DME wipe.

If in a Setup menu a setting has been made for DME allocation, that Setup
menu setting takes precedence (see “Setting the assignments of DME channels
to use on the individual M/E banks” in Chapter 20 (Volume 3).

Relation to resizer (for MVS-8000G only)

When resizer is enabled, it is not possible to select a DME wipe.
For the key 1 and key 2, or key 3 and key 4 combinations, if one is used for a
dual resizer effect, the other key cannot be used for a DME wipe.

Number of DME wipes that can be used simultaneously on a
single M/E bank

DME wipes can be used in five places, including the four independent key
transitions.

Overview



When the DME dedicated interface is used, a maximum of two DME wipes can
be used simultaneously, and when the SDI interface is used, only one DME
wipe can be used at one time.

When combining the SDI interface with the dedicated interface, it may be
possible to use up to three wipes simultaneously.

For details, see “Interfacing With External Devices (Device Interface Menu)”
in Chapter 19 (Volume 3).

Overview
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Basic Procedure for DME Wipe Settings

You carry out DME wipe setting operations principally using the DME Wipe
menu for each bank.

This section describes the basic procedures for DME wipe settings, taking the
M/E-1 >DME Wipe menu as an example.

For details of independent key transition DME wipe settings, see “DME Wipe
Settings for Independent Key Transitions” (page 345).

For details of resizer DME wipe (for MVS-8000G only), see page 349.

For one M/E bank, DME effects (including external processed keys) can be
used in up to two places on the DME dedicated interface and in only one place
on the SDI interface simultaneously.

When combining the SDI interface with the dedicated interface, you can apply
DME effects to a maximum of three keys. (Requires a setting in setup.)

DME Wipe Settings Menu

Accessing the DME Wipe menu

To access the M/E-1 >DME Wipe menu, use either of the following operations.

¢ In the menu control block, select the top menu selection button [M/E 1], and
press VF6 ‘DME Wipe.’

¢ In the transition control block of the M/E-1 bank, press the transition type
selection button [DME] twice in rapid succession.

Either of the above operations displays the M/E-1 >DME Wipe menu.

DME Wipe Pattern Selection

Selecting a DME wipe pattern by a menu operation

1 In the M/E-1 >DME Wipe menu, select HF1 ‘1ch’ for one-channel mode,
HF2 “2ch’ for two-channel mode or HF3 ‘3ch’ for three-channel mode.
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2 Select the desired DME wipe pattern group with one of the following

buttons.

Slide/Squeeze: slide and squeeze
Split/Door: split and door

Flip Tumble: flip tumble

Mirror/Sphere: mirror and sphere
Character Trail: character trail
Wave/Ripple: wave and ripple

Page Turn/Roll: page turn and page roll
Frame I/O/P in P: frame in/out and picture-in-picture
2D Trans/3D Trans: 2D trans and 3D trans
Sparkle/Split Slide: sparkle and split slide
Mosaic/Defocus: mosaic and defocus
Brick: brick

User Program: user programmable DME

Selectable DME wipe pattern groups in one-channel mode: All of the
above groups except for Brick.

Selectable DME wipe pattern groups in two-channel mode: Slide/
Squeeze, Page Turn/Roll, Frame I/O, PinP, 3D Trans, Brick and User
Program.

Selectable DME wipe pattern groups in three-channel mode: User
Program and Brick.

For details of DME wipe patterns, see “Types of DME Wipe Pattern”
(page 322) and “DME Wipe Pattern List” (page 503).

The patterns from the selected pattern group appear on the screen.

Press the button to select the desired pattern.

For a key transition, the page turn, page roll and picture-in-picture cannot
be used.

Adjusting DME wipe pattern parameters

Of the DME wipe patterns, the following have parameters that can be adjusted.

When Brick (for two channels) is selected (pattern numbers 2801

to 2804, 2811 to 2814)

Knob Parameter Adjustment Setting values
1 Side V Size X Horizontal magnification 0.01 to 8.00
2 Side V Size Y Vertical magnification 0.01 t0 8.00
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Knob Parameter Adjustment Setting values
3 Height Height of brick 0.01 to 100.00
4 Center X Horizontal center position | _100.00 to +100.00 @
5 Center Y Vertical center position —100.00 to +100.00 ®

a) The horizontal center position of the video pasted on Side V. At -100.00 the center is at the left
edge of the screen, and at +100.00 the center is at the right edge of the screen.

b) The vertical center position of the video pasted on Side V. At—100.00 the center is at the bottom
edge of the screen, and at +100.00 the center is at the top edge of the screen.

When Frame in-out (for two channels) is selected
e Pattern numbers 2851 to 2854

Knob

Parameter

Adjustment

Setting values

5

Delay

Timing for video selected on
a utility bus to appear on the
screen

—100.00 to +100.00

e Pattern numbers 2861 to 2864

Knob Parameter Adjustment Setting values
1 Rot X Rotation about the Y axis —100.00 to +100.00
(horizontal direction)
2 Rot Y Rotation about the X axis —100.00 to +100.00
(vertical direction)
Rot Z Rotation about the Z axis —100.00 to +100.00
Delay Timing for video selected on | -100.00 to +100.00

a utility bus to appear on the
screen

When Brick (for three channels) is selected (pattern number 3601)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Side V Size X Side V horizontal 0.01 t0 8.00
magnification

2 Side V Size Y Side V vertical 0.01 10 8.00
magnification

3 Height Height of brick 0.01 to 100.00 @

4 Side V Center X | Side V horizontal center —~100.00 to +100.00 ®
position

5 Side V Center Y | Side V vertical center —100.00 to +100.00 ©
position

a) Shared with knob 3 for parameter group 2
b) The horizontal center position of the video pasted on Side V. At—100.00 the center is at the left
edge of the screen, and at +100.00 the center is at the right edge of the screen.
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¢) The vertical center position of the video pasted on Side V. At—100.00 the center is at the bottom
edge of the screen, and at +100.00 the center is at the top edge of the screen.

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Side H Size X Side H horizontal 0.01 10 8.00
magnification

2 Side H Size Y Side H vertical 0.01 10 8.00
magnification

3 Height Height of brick 0.01 to 100.00 @

4 Side H Center X | Side H horizontal center —~100.00 to +100.00 ®
position

5 Side H Center Y | Side H vertical center ~100.00 to +100.00 ©
position

a) Shared with knob 3 for parameter group 1

b) The horizontal center position of the video pasted on Side H. At—100.00 the center is at the left
edge of the screen, and at +100.00 the center is at the right edge of the screen.

c) The vertical center position of the video pasted on Side H. At—100.00 the center is at the bottom
edge of the screen, and at +100.00 the center is at the top edge of the screen.

Setting DME Wipe Modifiers

sedim NG 9 Jeidey)

You can apply various modifiers to the DME wipe pattern: setting the DME
wipe direction, pattern position, and so on.

For an overview of the DME wipe modifiers, see “DME Wipe Pattern
Variation and Modifiers” (page 330).

Specifying the DME wipe direction (Direction)
You can specify the DME wipe direction (normal/reverse).
To specify the DME wipe direction in a menu
1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

The Edge/Direction menu appears.

2 In the <Direction>group, specify the DME wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and reverse for each transition
Reverse: reverse direction to normal
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To specify the DME wipe direction with a button in the transition
control block
In the transition control block of each of the M/E-1 to M/E-3 and PGM/PST

banks, press the following direction selection buttons.
NORM: Normal

NORM/REV: Normal/Reverse
REV: Reverse

Modifying the DME wipe pattern edge

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/Direction.’

2

The Edge/Direction menu appears.

Depending on whether the selected pattern is in one-channel mode or two-

channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select
the corresponding channel. You can select more than one channel at

the same time.

In the <Edge> group, select the edge type.

Border: border

Soft Border: soft border

Set the parameters according to the selection in step 3.

¢ When border is selected

Knob |Parameter |Adjustment Setting values
1 Width Border width 0.00 to 100.00
3 Luminance |Luminance 0.00 to 100.00
4 Saturation Saturation 0.00 to 100.00
5 Hue Hue 359.99 to 0.00

¢ When soft border

is selected

Knob |Parameter |Adjustment Setting values
1 Width Border width 0.00 to 100.00
2 Inner Soft Border inner softness 0.00 to 100.00
3 Luminance | Luminance 0.00 to 100.00
4 Saturation Saturation 0.00 to 100.00
5 Hue Hue 359.99 to 0.00
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Display indications when multiple channels are selected at the same
time

The indications on the knobs show the settings of the lowest-numbered
channel. When you turn the knobs to adjust the settings, this changes the
settings on the other channels by the same amount.

Setting the DME wipe position (Positioner)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the DME wipe pattern is in one-channel mode or
two-channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select
the corresponding channel. You can select more than one channel at
the same time.

w

In the <Position> group, press [Position], turning it on.

4 Set the following parameters.

Knob | Parameter |Adjustment Setting values
1 H Horizontal position —200.00 to +200.00
2 \Y Vertical position —200.00 to +200.00

Display indications when multiple channels are selected at the same
time

The indications on the knobs show the settings of the lowest-numbered
channel. When you turn the knobs to adjust the settings, this changes the
settings on the other channels by the same amount.

To return the DME wipe pattern position to the center of the screen
In the <Position> group, press [Center].

Displaying and moving the position of the DME wipe pattern
(position select)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.
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In the <Position Select> group, the one of the [Top Left], [Top Right],
[Bottom Left], and [Bottom Right] buttons that is on indicates the current
display position of the DME wipe pattern.

2 In the <Position> group, press [Position], turning it on.

3 Depending on whether the DME wipe pattern is in one-channel mode or
two-channel mode, proceed as follows.

In one-channel mode: press [1st Ch], turning it on.
In two-channel mode: from the <Ch Select> group, select the
corresponding channel. You can select more than one channel at the

same time.

4 To move the position of the DME wipe pattern, press the button where you
want to move to, turning it on.

The DME wipe pattern displayed on the screen moves to the position of
the specified button.

Setting relative positions to move the DME wipe pattern
In two-channel mode, use the following procedure.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.
2 In the <Ch Select> group, select the target channels.
3 Press [Position] in the <Position> group, turning it on.

4 Set the following parameters.

Knob |Parameter |Adjustment Setting values

4 Relative H Relative movement in the —400.00 to +400.00
horizontal direction

5 Relative V Relative movement in the vertical | —-400.00 to +400.00
direction

For details of the method of DME wipe pattern selection, see “DME Wipe
Pattern Selection” (page 334).

Setting the DME wipe pattern size (Size)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’
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The Modify menu appears.

Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select
the corresponding channel. You can select more than one channel at
the same time.

Press [Size], turning it on.

Set the following parameters.

Knob |Parameter |Adjustment Setting values

1 Size Set size of effect 0.00 to 200.00 @

a) The effect size when [Size] is off is taken as 100.00%.

Display indications when multiple channels are selected at the same
time

The indications on the knobs show the settings of the lowest-numbered
channel. When you turn the knobs to adjust the settings, this changes the
settings on the other channels by the same amount.

Adjusting the DME wipe pattern cropping

When pattern numbers 1701 and 1702 are selected, crop cannot be used.

1

2

In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: press [1st Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select
the corresponding channel. You can select more than one channel at
the same time. Some patterns need no selection which is fixed in the
<Ch Select> group.

In the <Crop Mode> group, press [Crop], turning it on.

Set the following parameters.

Basic Procedure for DME Wipe Settings

341

sedim NG 9 Jeidey)



sedim ANG 9 Jeideyd

342

Knob |Parameter |Adjustment Setting values

1 Top Crop the top of the image —100.00 to +100.00
2 Left Crop the left of the image —100.00 to +100.00
3 Right Crop the right of the image —100.00 to +100.00
4 Bottom Crop the bottom of the image | —100.00 to +100.00

Display indications when multiple channels are selected at the same
time

The indications on the knobs show the settings of the lowest-numbered
channel. When you turn the knobs to adjust the settings, this changes the
settings on the other channels by the same amount.

In 16:9 mode, to crop to 4:3 aspect ratio
In the <Crop Mode> group, press [4:3], turning it on.

To set the action when a DME wipe crop transition is executed

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-channel mode or two-
channel mode, proceed as follows.

For a pattern in one-channel mode: in the <Ch Select> group, press [1st
Ch], turning it on.

For a pattern in two-channel mode: from the <Ch Select> group, select
the corresponding channels. You can select more than one channel at
the same time.

3 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop from 16:9
to 4:3 aspect ratio), turning it on.

4 In the <Crop Mode> group, press [Remove From Begin].
The Remove From Begin menu appears.

5 In the <Crop Transition> group, select the execution mode for the DME
wipe crop transition.

Cut: Cut mode. The cropping does not change during the transition, but at
the end point of the transition the cropping is removed (enlarges).

Last 5%: The cropping is maintained for the first 95% of the transition,
and is progressively removed during the last 5% of the transition
(enlarges).
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Linear: The cropping is removed linearly through the whole course of the

transition (enlarges).
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Setting the timing of transition completion
When the execution mode for a DME wipe crop transition is set to [Last 5%],
you can select the timing of transition completion from 70% ([Last 30%]), 95%
([Last 5%]), and 100% ([Off]).

1 In the M/E 1 >DME Wipe menu, select HF5 ‘Modify’.

The Modify menu appears.

2 In the <Crop Mode> group select [Remove From Begin].

The Remove From Begin menu appears.

3 In the <Release Transition> group, select the timing of transition

completion.

Last 30%: The transition completes at the end of 70% of the transition

execution time. The transition has a dead zone from 70% to 95% of the
transition time.

Last 5%: The transition completes at the end of 95% of the transition

execution time. When the transition completes, the cropping is
removed during the last 5%.

Off: The transition completes at the end of the transition execution time.

During the last 5% of the transition, the transition and cropping
removal proceed together.
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DME Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, turning it on, then
press VF6 ‘DME Wipe’ to return the DME wipe settings to their initial status.

For details of the menu operation to return the DME wipe state to that set in
initial status, see “Returning to default state in function groupings” (page

116).
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DME Wipe Settings for Independent Key
Transitions

You carry out independent key transition DME wipe setting operations using
the DME Wipe Adjust menu for each keyer.

For an overview of independent key transitions, see page 177.

This section describes the independent key transition DME wipe settings,
taking the M/E-1 >Key1 >Transition >SDME Wipe Adjust menu as an example.

Basic Procedure for Independent Key Transition DME
Wipe Settings

Accessing the independent key transition DME wipe settings

menu

As an example, to access the M/E-1 >Keyl >Transition >SDME Wipe Adjust

menu, carry out the following operation.

* In the menu control block, select the top menu selection button [M/E 1], and
select VF1 ‘Keyl’ and HF6 ‘Transition’ to display the Transition menu for
key 1. Next, press [DME Wipe Adjust].

* Press the key delegation button [Key1] in the independent key transition
control block of the M/E-1 bank, then press the independent key transition
type [DME] twice in quick succession.

Carrying out the above operation displays the M/E-1 >Key1 >Transition

>DME Wipe Adjust menu (which will be referred to below as simply the Key1

DME Wipe Adjust menu).

Selecting the independent key transition DME wipe pattern

You select the independent key DME wipe pattern from the list of patterns
displayed in the menu.

To select a DME wipe pattern for independent key1 on the M/E-1 bank, use the
following procedure.

1 In the <Pattern Select> group of the Keyl DME Wipe Adjust menu, press
[1ch] for one-channel mode or [2ch] for two-channel mode.

The Pattern Select menu appears.

DME Wipe Settings for Independent Key Transitions
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2 Select the desired DME wipe pattern group with one of the following
buttons.

In two-channel mode, only Page Turn and Page Roll are selectable.
Slide/Squeeze: slide and squeeze
Split/Door: split and door

Mirror/Sphere: mirror and sphere
Character Trail: character trail
Wave/Ripple: wave and ripple

Page Turn/Roll: page turn and page roll
Frame I/O: frame in/out

2D Trans/3D Trans: 2D Trans and 3D Trans
Sparkle/Split Slide: sparkle and split slide
User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME Wipe Pattern”
(page 322) and “DME Wipe Pattern List” (page 503).

The patterns from the selected pattern group appear on the screen.

3 Press the button to select the desired pattern.

Setting Independent Key Transition DME Wipe
Modifiers
You can add modifiers such as pattern position and size for an independent key
transition DME wipe.

For introductory information, see “Setting the DME wipe position
(Positioner)” (page 339) and “Setting the DME wipe pattern size (Size)” (page
340).

Setting the DME wipe position (Positioner)
For applicable pattern numbers, see page 331.

1 In the <Position> group of the Keyl DME Wipe Adjust menu, press
[Position], turning it on.

2 Set the following parameters.

Knob | Parameter |Adjustment Setting values
1 H Horizontal position —200.00 to +200.00
2 \Y Vertical position —200.00 to +200.00
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To return the DME wipe pattern position to the center of the screen

In the <Position> group, press [Center].

Setting the DME wipe pattern size (Size)
For applicable pattern numbers, see page 331.

1 In the Key 1 DME Wipe Adjust menu, press [Size], turning it on.

2 Set the following parameter.

Knob

Parameter

Adjustment

Setting values

1

Size

Set size of effect

0.00 to 200.00 @

a) The effect size when [Size] is off is taken as 100.00%.

Cropping a key DME wipe

1 In the <Crop Mode> group of the Keyl DME Wipe Adjust menu, press

[Crop], turning it on.

2 Set the following parameters.

Knob |Parameter |Adjustment Setting values

1 Top Cropping of the top of the image |—-100.00 to +100.00

2 Left Cropping of the left of the image | —100.00 to +100.00

3 Right Cropping of the right of the image | —100.00 to +100.00

4 Bottom _Cropping of the bottom of the —100.00 to +100.00
image

To crop to 4:3 in 16:9 mode
In the <Crop Mode> group, press [4:3 Crop], turning it on.

To set the operation for DME wipe crop transition execution

1 In the <Crop Mode> group of the Keyl DME Wipe Adjust menu, press

[Crop], turning it on.

2 In the <Crop Mode> group, press [Crop] or [4:3 Crop] (to crop to 4:3 in
16:9 mode), turning it on.

3 In the <Crop Mode> group, press [Remove From Begin].
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The Remove From Begin menu appears.
For subsequent operations, see step 5 of “To set the action when a DME
wipe crop transition is executed” (page 342).

To set the timing of transition completion

1 In the <Crop Mode> group of the Keyl DME Wipe Adjust menu, press
[Crop], turning it on.

2 In the <Crop Mode> group, press [Remove From Begin].

For subsequent operations, see “Setting the timing of transition
completion” (page 343).

Applying a border to a key DME wipe

In the <Edge> group of the Keyl DME Wipe Adjust menu, press [Border],
turning it on.

For subsequent operations, use the same process as in step 4 of “Modifying the
DME wipe pattern edge” (page 338).
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Resizer DME Wipe Setting

You can carry out a DME wipe on a key using the resizer.

[Notes|

¢ This function is supported by the MVS-8000G.

* When the screen aspect ratio is 4:3 in HD format, when the resizer DME
wipe is used to shrink a video image, this is applied to the 16:9 screen
including the added video on the left and right sides. Use the crop function
as required to extract the 4:3 image.

DME wipe patterns available for resizer DME wipe

You can use the following patterns of the DME wipe pattern one-channel mode
that can be used in a resizer DME wipe. (7000-series numbers)

* Slide (pattern numbers: 7001 to 7008)

* Squeeze (pattern numbers: 7021 to 7031)

 frame in-out (pattern numbers: 7201 to 7208, 7221 to 7224)

Relation between DME wipes and other effects

The following relations hold between a resizer DME wipe and other effects.

Relation to processed keys
It is not possible to select a resizer DME wipe for a key with processed key
enabled.

Relation to resizer

It is not possible to use a resizer DME wipe for a key with resizer enabled.

It is not possible to use a resizer DME wipe for a key forming a pair with a key
with the dual resizer effect enabled. The key combinations forming pairs are
keys 1 and 2, and keys 3 and 4. For example, when a dual resizer effect is
enabled for key 1, it is not possible to use a resizer DME wipe on key 2.

Making resizer DME wipe settings

1 In the <Pattern Select> group of the Keyl DME Wipe Adjust menu, press
[1ch].

The 1ch Pattern Select menu appears.

2 Select [Resizer Slide/Squeeze] or [Resizer Frame 1/0].

The patterns of the selected group appear.
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The wipe patterns that can be used for a resizer DME wipe are as follows.

* Slide (pattern numbers: 7001 to 7008)
* Squeeze (pattern numbers: 7021 to 7031)
* Frame in-out (pattern numbers: 7201 to 7208, 7221 to 7224)

3 Press the desired pattern to select it.

For more about resizer DME wipe modifiers, see “Setting Independent
Key Transition DME Wipe Modifiers” (page 346).
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DME Wipe Snapshots

You can snapshot and save a DME wipe pattern together with the current
settings of its modifiers and pattern limit in a dedicated register for recall when
required.

There are 10 DME wipe snapshot registers for each of the M/E and P/P banks.
To save and recall these registers, use the Flexi Pad control block, the
Multifunction Flexi Pad block in each switcher bank or the Menu control
block.

In the case of a simple transition system, there are eight DME wipe snapshot
registers for each switcher bank.

DME Wipe Snapshot Operations With the Flexi Pad

To carry out DME wipe snapshot operations, use the Flexi Pad control block.
You can save, recall and delete DME wipe snapshots using the procedures
similar to the procedures for wipe snapshot operations. In DME wipe snapshot
operations, use the [DME] button instead of the [WIPE] button used in wipe
snapshot operations.

Selecting a DME wipe pattern in the Flexi Pad control block

In the standard type Flexi Pad control block, enter a four-digit pattern number,
using the [DME] button.

For details, see “Flexi Pad Control Block (Standard Type)” (page 54).

* You cannot select a DME wipe pattern in the simple type Flexi Pad control
block.

* A button in the memory recall section in which a DME wipe snapshot is
saved shows the pattern, and lights yellow.
For a user-programmable DME, the register number (see page 353) appears.
Depending on the setting of the Setup menu (see “Operation Settings
(Operation Menu)” in Chapter 19 (Volume 3)), you can also display a
register name.

¢ In a simple type Flexi Pad control block, it is not possible to delete a DME
wipe snapshot.

For details of the operating procedures, see “Wipe Snapshots” (page 308).
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DME Snapshot Operations With the Menus

In the same way as for wipe snapshots, you can save, recall, and delete DME
snapshots.

For details of the operating procedures, see “Wipe Snapshot Operations With
the Menus” (page 311).
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Creating User Programmable DME Patterns

With a user programmable DME, you can use DME effects created through the
use of keyframes for a transition on the switcher system.

Note the following points when creating a keyframe effect for use as a user
programmable DME pattern.

Register numbers and pattern numbers

When saving a keyframe effect as a user programmable DME pattern, specify
the register number that corresponds to the pattern number as shown in the
following table.

Execution mode

Register number

Pattern number

One-channel mode 101 to 199 1901 to 1999
Two-channel mode 201 to 299 2901 to 2999
Three-channel mode 301 to 399 3901 to 3999

For details of registers and keyframe effects, see Chapter 13 “Keyframe
Effects” (Volume 2), respectively.

Keyframe effects in the global channel

When the effect with the same number as the reference channel is present on

the DME global (GLBL) channel, executing the user programmable DME will
also execute the effect on the global channel simultaneously.

When executing a user programmable DME, take note of whether the effect is
present on the global channel.

User Programmable DME Transition Mode

To create a user programmable DME, it is necessary to set the transition mode
(the way in which the effect moves). To set the transition mode, use the Key
Frame >DME User PGM menu.

For details of the operating procedures, see “Transition Mode Settings for
User Programmable DME” in Chapter 13 (Volume 2).
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The following transition modes are available.

Channels Transition mode Effect group

One-channel mode | Single transition mode Slide, Split, Door, Page turn,
Page roll, Squeeze, Mirror,
Sphere, Character Trail, Wave,
Ripple, 2D Trans, 3D Trans,
Sparkle, Split Slide

Flip Tumble Flip Tumble, Mosaic, Defocus
Frame in-out Frame in-out
Frame in-out H 2 Frame in-out
Frame in-out V Frame in-out

Picture-in-picture °) Picture-in-picture

Compress ©) Picture-in-picture

Two-channel mode | Dual transition mode Slide, Squeeze, 3D Trans

Two-channel picture-in-picture | Picture-in-picture

a) Transition according to DME wipe patterns 1202, 1203, or 1204
b) Transition according to DME wipe pattern 1201
¢) Transition according to DME wipe pattern 1251

For details, see “Overview” (page 322).

For the following group of effects available in two-channel mode, no user
programmable DME wipe patterns can be created.
Page turn, Page roll, Frame in-out, Brick

Notes on creating keyframe effects

When creating a keyframe effect to be used as a user programmable DME
pattern, note the following, depending on the transition mode used.

Notes on single transition mode (one-channel mode)

* Either create the first keyframe image outside the screen area, or set the
image size to zero so that it cannot be seen within the screen.

* Create the last keyframe to be a full-size image.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [Single].

Notes on flip tumble (one-channel mode)

¢ Create the first keyframe image at full size. In the <Back> group of the DME
>Input/Output >Video/Key menu, depending on the direction of the rotation
you want during the transition, press [H Invert] or [V Invert], turning it on.
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¢ Create the last keyframe with the image inverted so the back side is visible,
and with the size at full size.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [Flip Tumble].

Notes on frame in-out (one-channel mode)

Create a minimum of three keyframes.

* Either create the first keyframe image outside the screen area, or set the
image size to zero so that it cannot be seen within the screen.

* Create the first transition to end such that the image can be seen within the
screen. At this point, press the [PAUSE] button in the keyframe control
block, turning it on, to set a pause for the keyframe.

* Either create the last keyframe image outside the screen area, or set the image
size to zero so that it cannot be seen within the screen.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [FRAME 1/0O].

Notes on Frame in-out H (one-channel mode)

Create a minimum of three keyframe points.

* FEither create the first keyframe image outside the screen area, or set the
image size to zero so that it cannot be seen within the screen.

* As the state after completion of the first transition, move the image
horizontally to make it visible within the screen. At this time, press the
[PAUSE] button in the keyframe control block, turning it on, to set a pause
for the keyframe.

¢ For the last keyframe move the image horizontally to place it outside the
screen area or set the image size to zero, so that the image is not visible
within the screen.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [FRAME 1/O H].

Notes on frame in-out V (one-channel mode)

Create a minimum of three keyframe points.

« Either create the first keyframe image outside the screen area, or set the
image size to zero so that it cannot be seen within the screen.

* As the state after completion of the first transition, move the image vertically
to make it visible within the screen. At this time, press the [PAUSE] button

in the keyframe control block, turning it on, to set a pause for the keyframe.

¢ For the last keyframe move the image vertically to place it outside the screen
area or set the image size to zero, so that the image is not visible within the
screen.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [FRAME I/O V].

Notes on picture-in-picture (one-channel mode)
Create a minimum of three keyframes.

Creating User Programmable DME Patterns
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* Either create the first keyframe image outside the screen area, or set the
image size to zero so that it cannot be seen within the screen.

* Create the first transition to end such that the image can be seen within the
screen. At this point, press the [PAUSE] button in the keyframe control
block, turning it on, to set a pause for the keyframe.

* Either create the last keyframe image outside the screen area, or set the image
size to zero so that it cannot be seen within the screen.

* In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [P In P].

Notes on compress (one-channel mode)

Create a minimum of three keyframe points.

¢ Create the first keyframe with the image at full size.

* In the state at completion of the first transition, create the image to be visible
within the screen. At this time, press the [PAUSE] button in the keyframe
control block, turning it on, to set a pause for the keyframe.

* For the last keyframe, once again set the image size to full size.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [Compress].

Notes on dual transition mode (two-channel mode)

¢ Create the first keyframe for each channel as follows.
Channel 1: create the image full-size.
Channel 2: either create the image outside the screen area, or set the image
size to zero so that it cannot be seen within the screen.

¢ Create the last keyframe for each channel as follows.
Channel 1: either create the image outside the screen area, or set the image
size to zero so that it cannot be seen within the screen.
Channel 2: create the image full-size.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [Dual].

Notes on picture-in-picture (two-channel mode)

Create a minimum of three keyframes.

* Create the first keyframe for each channel as follows.
Channel 1: create the image full-size.
Channel 2: since the priority is low, it will not be visible on the screen, so
no particular restrictions apply.
In the Global Effect >Ch1 to Ch4 >Combiner menu, when setting the priority
of channel 1 and channel 2, set the channel 1 priority higher.

¢ In the intermediate part of the transition, create the two images so that both
are visible within the screen. In the Global Effect >Ch1 to Ch4 >Combiner
menu, when setting the priority of channel 1 and channel 2, set the channel 2
priority higher.

Creating User Programmable DME Patterns



It is recommended to make the priority settings at a keyframe point at which
the two images are not overlapping.
* During the course of a transition, there is a “dead zone” corresponding to the
intermediate point of the whole effect (see following figure), during which
the image does not change. Therefore, it is necessary to create the effect so
that the image in the intermediate part of the transition is the keyframe for
the mid-point of the whole effect. The range of this “dead zone” corresponds
to the central one-third of the range of the transition indicator. This also
applies to an auto transition.

Keyframe effect

A

B

C

s

First keyframe

h
Last keyframe

Mid-point of effect

Change in image through transition

Image at point C—»

appears

Image at point B
appears
(dead zone)

Image at point A——»

appears

A

1

T
T

Transition indicator

Fader lever

¢ Create the last keyframe for each channel as follows.
Channel 1: since the priority is low, it will not be visible on the screen, so
no particular restrictions apply.
Channel 2: create the image full-size.

¢ In the <Transition Mode> group of the Key Frame >DME User PGM menu,
select [P In P].

Creating User Programmable DME Patterns

357

sedim NG 9 Jeidey)



sedi NG 9 Jerdeyd

DME Wipe Pattern Operations in the
Multifunction Flexi Pad Control Block

Recalling a DME Wipe Snapshot

The operation of recalling a DME wipe snapshot in the Multifunction Flexi Pad
control block is the same as the operation of recalling a wipe snapshot, except
for pressing the [DME WIPE] button to select DME wipe snapshot mode.

See “Recalling a Wipe Snapshot” (page 314).

You can change the indications for buttons [0] to [9] in the memory recall
section to pattern images, using the Engineering Setup >Panel >Operation
>Flexi Pad Mode menu.

SNAP SHOT
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.
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ENB F{ATE ADJ

MORE

[DDDD]O
0ooo O
DEL
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UNDO
STOR
STAT gooo O

D

H8EE

PTN
NO.

EJ
EJ
= L]

Selecting the DME Wipe Pattern

The operation of selecting the DME wipe pattern in the Multifunction Flexi
Pad control block is the same as the operation of selecting a wipe pattern,
except for pressing the [DME WIPE] button to select DME wipe snapshot
mode.

See “Selecting the Wipe Pattern” (page 315).

Note, however, that the pattern numbers for DME wipe patterns have four
digits.

358 | pmE Wipe Pattern Operations in the Multifunction Flexi Pad Control Block



For pattern numbers, see “DME Wipe Pattern List” (page 503).

Editing the DME Wipe Pattern

By pressing the [EDIT ENBL] button to switch the memory recall section to
editing mode as shown in the following illustration, you can edit the selected
DME wipe pattern with the following buttons.

To exit from the editing mode, press the [EDIT ENBL] button once more, or
press the [EXIT] button.

SNAP

1T
CH

2ND
CH

PTN

LMT
L 14 (::::)

LIMT
SET

e
43

CROP

NORM REV KNOB

IREV 112 H349

Note that the operation of the following buttons is the same as when editing a
wipe pattern.

EXIT

SOFT

1ZE
BDR S

|IIII |IIII |IIII |IIII

fol CNTR CROP

ME ME
IIIIII IIIIII llliill
NORM
USES v
4

(—)
B ©
5}
2 3

[EXIT] button

[PTN LIMT], [LIMT SET] buttons
[NORM], [NORM/REV], [REV] buttons
[KNOB 1/2] button

For the method of operation of these buttons, see “Editing the Wipe Pattern”
(page 315).

Channel selection buttons

1ST CH (channel 1): Selects channel 1.
2ND CH (channel 2): Selects channel 2.
You can also select two channels by pressing the buttons simultaneously.

DME wipe pattern edge setting buttons

BDR (border): Applies a border to the DME wipe pattern.
SOFT BDR (soft border): Softens the applied border.

DME Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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You can adjust the parameters selected with these buttons using the control
knobs, when the button is lit green.

¢ When border is selected

Knob Parameter Adjustment Setting values
1 w Border width 0to 100
2 L Luminance 0to 100
3 S Saturation 0to 100
4 H Hue 0 to 359

¢ When soft border is selected
Parameter group [1/2]

Knob Parameter Adjustment Setting values
1 W Border width 0to 100
2 | Degree of softening of 0to 100
inside of border
Parameter group [2/2]

Knob Parameter Adjustment Setting values
1 L Luminance 0to 100

S Saturation 0to 100

H Hue 0 to 359

Buttons for positioning the DME wipe pattern

POS (position): Adjusts the position of the DME wipe pattern.
CNTR (center): Returns the DME wipe pattern position to the center.

When you press the [POS] button, the alphanumeric display first shows the
name of the parameter, “H” or “V,” and then the value of the parameter.
When the [POS] button is lit green, you can adjust the position of the pattern
with the control knobs.

Knob Parameter Adjustment Setting values

1 H Horizontal position —200 to +200

2 \Y Vertical position —200 to +200

3 H (R) Relative horizontal —400 to +400
movement

4 V (R) Relative vertical movement |—-400 to +400
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Buttons for setting DME wipe pattern cropping

CROP: Adjusts the DME wipe pattern cropping.
4:3 CROP: Crops a 16:9 image to 4:3.

When the [CROP] button is lit green, you can set the cropping ratio of the DME
wipe pattern, with the control knobs.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Cropping ratio of the image |-100 to +100
from left and right sides

2 \Y Cropping ratio of the image |-100 to +100
from top and bottom sides

3 A Cropping ratio of the image |—-100 to +100
from all four sides

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 T Cropping ratio of the image |-100 to +100
from the top

2 L Cropping ratio of the image |-100 to +100
from the left

3 R Cropping ratio of the image |-100 to +100
from the right

4 B Cropping ratio of the image |—-100 to +100
from the bottom

Button for specifying effect size

SIZE: Specifies the effect size. When the [SIZE] button is lit green, you can
specify the effect size, with the control knobs.

Knob

Parameter

Adjustment

Setting values

1

S

Effect sizes

0102002

a) The effect size when [Size] is off is taken as 100.00.

DME wipe modify clear

With the [DME WIPE] button held down, pressing and holding down the
region selection button for the selected region returns the DME wipe settings
to their initial status.

For details of the initial status, see “Selecting the State After Powering On
(Start Up Menu)” in Chapter 18 (Volume 3).
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Saving, Canceling, and Deleting DME Wipe Snapshots

362

The operations of saving, canceling, and deleting a DME wipe pattern snapshot
you have created are the same as the operations of saving, canceling, and
deleting a wipe snapshot.

For the operations for wipe snapshots, see “Saving, Canceling, and Deleting
Edited Wipe Patterns” (page 318).
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Overview

Frame memory is a function whereby a frame of input video can be frozen and
written to memory, for further use as material for editing.
You can also play recorded frame memory clips (movies).

Frame capacity

The maximum number of images that can be written to memory is as follows.

MVS-8000 system

HD system: 58 frames (88 frames in 720P/59.94 format)
SD system: 222 frames

MVS-8000A system and MVS-8000G system

HD system:

(Without ancillary data)

Video format

Memory capacity

1080i/50

1080i/59.94

1080i/60

1080PsF/24

1080PsF/25

1080PsF/29.97

1080PsF/30

Approx. 1000 frames

720P/50

720P/59.94

Approx. 2300 frames

(With ancillary data)

Video format

Memory capacity

1080i/50 Approx. 700 frames
1080i/59.94 Approx. 800 frames
1080i/60

1080PsF/23.976 Approx. 600 frames
1080PsF/24

1080PsF/25 Approx. 700 frames

1080PsF/29.97

Approx. 800 frames

Overview
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Video format Memory capacity
1080PsF/30 Approx. 800 frames
720P/50 Approx. 1400 frames
720P/59.94 Approx. 1700 frames
SD system:

(Without ancillary data)

Video format Memory capacity
480i/59.94 Approx. 5600 frames
576i/50 Approx. 4800 frames

(With ancillary data)

Video format Memory capacity
480i/59.94 Approx. 4700 frames
576i/50 Approx. 3900 frames

For the MVS-8000A and MV S-8000G, up to two frame memory boards can be
installed (MKS-8440A for the MVS-8000A, MKS-8442G for the MVS-
8000G). The above-stated maximum number applies when one frame memory
board is installed.

When two boards are installed, the figures are doubled, but of the two boards

only one can be used for frame memory clips.
Note that for the MVS-8000/8000SF, MVS-8000ASF and MVS-8000GSF, it
is not possible to install two frame memory boards.

For details of operating procedures, see “Still Image Operations” (page 369).

Types of image and terminology used

Overview

The following types of image are handled in frame memory.

Freeze image: An input image that has been frozen, but not saved to memory.

Still image: A freeze frame that has been saved to memory as a file. Each file
(still file) holds just one still image.

Frame memory clip: A clip consists of a sequence of still images, which
appears as a movie on playback. In this manual this is also referred to
simply as a “clip.” The files (still files) constituting clips are referred to as
a “clip file.”

When the above distinctions are not being made, an image is simply referred

to as an “image.”




About extended clips

When two frame memory boards (MKS-8440A for the MVS-8000A, MKS-
8442G for the MVS-8000G) are installed, one is dedicated to clips. Such clips
held in a frame memory board are called “extended clips.”

Use of frame memory

There are eight frame memory channels, FM1 to FMS, and each channel
independently allows a freeze image to be saved or recalled.

By allocating FM1 to FMS to cross-point buttons you can use the still image
output or clip output from each channel as input material.

On the MV S-8000A, an extended clip can only be recalled from FM1 or FM2.
It is not possible to recall from FM3 to FM8. Note that this restriction does not
apply to the MVS-8000G.

Correspondence between input and output

There are two buses for capturing frame memory material: the frame memory
source 1 bus and the frame memory source 2 bus.

These input buses are used by allocation to one of the pairs of output, FM1&2,
FM3&4, FM5&6, and FM7&8. You can freeze a frame in each channel
separately, or freeze in the two channels simultaneously.

The source buses allocated to FM1 to FM8 are as follows.

Input Frame memory source bus 1 | Frame memory source bus 2
Output FMA FM2

FM3 FM4

FM5 FM6

FM7 FM8

Pair mode

By enabling the pair mode, you can link FM1 and FM2, FM3 and FM4, FM5
and FM6, and FM7 and FMS. For example, when a freeze or image processing
is carried out on FM1, the same operation is carried out on FM2. The same
applies to the other pairs. When a pair of images are captured in pair mode, the
image frozen in FM1 (3, 5, or 7) is referred to as the main file and the other
frozen in FM2 (4, 6, or 8) is referred to as the sub file.
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Pair files and single files

A file that can be recalled in pair mode is termed a “pair file.” A pair file can
be created by setting pair mode and capturing an image, or by using the
coupling function (see page 411) to combine two single files.

A file other than a pair file is termed a “single file.” A single file can be created
by switching off pair mode and capturing an image, or by using the separation
function (see page 412) to split a pair file.

Operation modes

The frame memory has the following operation mode.
V/K mode: When the pair mode is active, the key signal is automatically

selected on frame memory source bus 2. This is convenient for handling
the video and key signals together in frame memory. For example, when
you select a video signal on frame memory source bus 1, the key signal
assigned to it is automatically selected on frame memory source bus 2. You
can also use the signal automatically selected on frame memory source bus
2 as a key signal when processing keyframe memory 1.

To change the pair mode or operation mode, use the Frame Memory menu.

Frame memory folders

Still images and clips can be managed in a maximum of twelve groups.
Such a group is called a “frame memory folder.” Folders can be added or
deleted, and can be given a name of up to 8§ characters.

Overview

This function is not supported on the MVS-8000.
When the system is powered off, the folder names are deleted. The folder
names need to be saved on media.
The following names cannot be used for folders.
Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2, COM3,
COM4, COMS5, COM6, COM7, COMS8, COM9
LPTO, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, LPT9
A folder named “Default” is provided, and this folder cannot be renamed or
deleted.
Still images and clips in different frame memory folders cannot have the
same name.



Still Image Operations

The frame memory functions provides the following still image file functions.

Freezing an input image

Saving a still image

Recalling a still image

Processing an image

Image output

Continuously capturing images (record)

Recalling a continuous sequence of images (animation)

For an overview of frame memory concepts, see “Overview” (page 365).

* During playback of a frame memory clip of the pair assigned to either of the
target FM selection buttons (see page 398), frame memory operations may
not be performed properly. Carry out frame memory operations after
stopping clip playback.

 The following sections describe the operations available in the MVS-8000A
system and MVS-8000G system.

The MVS-8000 system uses the same menus as those of Version 5.30. For
its operating procedures, see the User’s Guide of Version 6.00 or earlier.

Preparations

Allocating the frame memory outputs (FM1 to FM8) to cross-
point buttons

To output a frame memory image to a monitor, for example, the output signal
from the frame memory (FM1 to FMS8) must be allocated to a cross-point
button. Carry out this allocation in the Setup menu.

Accessing the Frame Memory menu

Most frame memory operations are carried out using the Frame Memory menu.

To access the Frame Memory menu, use either of the following procedures.

* In the menu control block, select the top menu selection button [FRAME
MEM].

* Press the cross-point button to which the frame memory output is allocated
twice in rapid succession.

Still Image Operations
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Interpreting the Frame Memory Menu

The menu screen consists of the following principal parts.

The frame memory selection area display is the same for all except the Pattern
Adjust/Pattern Select/Field Invert/File (excluding Pair Recombination menu)/
Folder/External HDD menus.

© Auto store status display
@ Display of available image capacity
O Pair selection button
Frame memory
selection area © Target FM Pair button
selection @ Frame
buttons memory
folder
(Effect) Free KF: 497 selection
2511 > Still[} Recall / 01:00: 00: 00 area
Reposition cilpooot
! 00:00:10
Name Pair Ext Duration
image001 P Still
Folder
| Direct
Recall
External
HDD
E::ﬁ;fl“ !F;Ir:f:e' Compaosite a;\::rgraltnn -ﬁéeym;mme Field Invert =
2551
File selection area O Direct
Recall
button

Frame Memory menu

© Auto store status display
Depending on the setup settings, this appears when the auto store function is
enabled.
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@ Display of available image capacity

This shows the remaining number of frames. When no more frames can be
stored, in pair mode “1” or “0” appears in red, and in single mode “0” appears
in red.

The lower figure shows the remaining number of frames that can be used as
extended clips.

© Target FM selection buttons

Ancillary data-attached clip display
Extended clip display

Status display

Clip001

Czmn

|
Still/duration dis;!lay Reposition/Lock status display

The border color shows the status as follows:
Blue: selected as the reference channel

Amber: selected, but not the reference channel
Black: not selected

Press one of these to select which of the selected outputs (FM1 and FM2 in the
example shown) the operation applies to.
The following information appears on the button.

Status display

File name (e.g. image001) and thumbnail: when a file is output
Black: when a black signal is output

Through: when the input image is output

Freeze: when a freeze is output

Composite: when a composite image is processed

Record: when continuously capturing images (record)

Still/duration display

When a still image is selected, “Still” is shown. When a clip is selected, a
duration indication such as “00:00:10” is shown.

Still Image Operations
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Reposition/Lock status display
This shows “R” when the reposition function (see page 387) is on, and shows
“L” when the lock function (see page 388) is on.

Extended clip display
For an extended clip, an “E” appears.

Ancillary data-attached clip display
For an ancillary data attached clip, an “A” appears.

O Pair selection button
Select the pair to be displayed in the target FM selection buttons.
(in the following figure, the pair of FM1 and FM2 is selected.)

Status display

Black 4

Black @& |7 Black 8

The border color shows the status as follows:
Blue: selected as the reference channel

Amber: selected, but not the reference channel
Black: not selected

The following information appears on the button.

Status display

For a pair, shows the status for the reference.
Thumbnail: when a file is output

Black: when a black signal is output

Through: when the input image is output

Freeze: when a freeze is output

Compos: when a composite image is processed
Record: when continuously capturing images (record)

© Pair button
Press this button, turning it on, to enable pair mode.

O File selection area
You can select from the displayed still image files or clip files.
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File information detail display
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Selected file.
When a pair file is selected each press switches the front and the back.

Thumbnail indications

Still image files and clip files: Still image files are displayed as gray buttons
and clip files are displayed as yellow buttons.

Single files and pair files: Single files are displayed with shadow and pair files
are displayed with no shadow.

Selected file: Pale blue border. When more than one file is selected, only the
first is pale blue, and the remainders are amber. If the pair file was selected,
each press switches the front and the back.

File information detail display
For the selected file, this shows the file name, “P” if a pair file, “E” if an
extended clip, “A” if an ancillary data attached clip, and the duration.

@ Frame memory folder selection area
Select the frame memory folder to be displayed.

© Direct Recall button
Toggle on and off the direct recall mode in which pressing a thumbnail
immediately recalls the file.

Selecting an Input Image

For the input image to frame memory, you can use either the signal selected on
one of the two frame memory source buses or a dedicated color matte signal.
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When using the signal on frame memory source bus 1 or 2 for the input image,
select the signal as described below.

For the method of using a color matte signal, see “Freezing an image and
writing it to memory” (page 376).

Selecting the signal on a frame memory source bus

As an example, to select a signal on frame memory source bus 1, use the
following procedure.

1 In the auxiliary bus control block, press the AUX delegation button to
which frame memory source bus 1 is allocated, turning it on.

For allocation of buses to the AUX delegation buttons, see “Assigning a
Bus to an AUX Delegation Button” in Chapter 19 (Volume 3).

On a CCP-6224/6324 control panel, you switch the cross-point control
block for use as an AUX bus control block. For details of the switching,
refer to the Setup menu ( “Auxiliary Bus Control Block Settings (Aux
Assign Menu)” in Chapter 19 (Volume 3)).

2 In the auxiliary bus control block cross-point buttons, select the signal to
be used for the input image.

To select a signal with a key or DME effect applied on the frame
memory source bus

In the key control block, press the [FM FEED] button, turning it on.

This automatically assigns the key fill and key source signals being keyed by
the currently selected keyer to frame memory source buses 1 and 2.

When DME is selected on the keyer, the key fill and key source signals to
which a DME effect is applied are assigned.

Selecting Outputs and Target Frame Memory

Selecting outputs (FM) and target frame memory

The following description applies to the case of settings for FM1&2, but the
procedures are similar for the other cases.

1 In the Frame Memory menu, press one of VF1 to VF4, and select the
required HF menu.

The current status of frame memory appears. (See page 370).
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2 From the pair selection buttons, press the buttons corresponding to FM 1
and FM2.

This assigns the signals to FM1 and FM2.
To the right of the target FM selection buttons, the FM1 and FM2 output
status appears (see page 371).

3 If required, press [Pair], to select the FM operation mode (pair mode).

On: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) as a pair.
Off: Operate on FM1(3, 5, 7) and FM2(4, 6, 8) individually.

For more details, see “Pair mode” (page 367).

In the Pair Recombination menu, the [Pair] operation is not possible.

4 Press the target FM selection button [FM1] or [FM2] (see page 371) to
select the FM operations apply to.

When [Pair] is On: Whichever of FM1 and FM2 you press, the pair is
selected.

When [Pair] is Off: One of the targets must be selected. However, in the
Clip >Play menu you can also select both FM1 and FM2.

Selecting a frame memory folder

Press a button in the frame memory folder selection area (see page 373).

By pressing [More] to switch the display, you can select from a maximum of
12 folders.

Thumbnails of the files within the selected folder appear.

Capturing and Saving an Input Image

As the input material for the frame memory, you can use the signal selected on
the frame memory source bus. For this signal you can use video processing
(video levels or hue value adjustment) or masking.

Allocating a frame memory source bus signal to one of FM1 to FMS, then
carrying out a freeze captures a still image in the corresponding frame memory
output image, and saves it in temporary memory.

For a freeze, an image can be captured either as video frame (a “frame freeze”)
or a video field (“field freeze”).

Still Image Operations

375

Klowsy swelq 7 Jeydeyn



Aows\ swelq 7 Jaydeyn

376

When the system is powered off, any freeze images written to temporary
memory are lost.

Freezing an image and writing it to memory

To freeze the signal selected as input material, and write it to memory, use the
following procedure.

1

2

w

In the Frame Memory menu, select VF1 ‘Still’ and HF2 ‘Freeze/Store.’

The Freeze/Store menu appears.

Select the target frame memory.

For the procedure, see “Selecting outputs (FM) and target frame
memory” (page 374).

To enable V/K mode, press [V/K Mode] turning it on.

Press a button in the frame memory folder selection area, to select the
folder to hold the freeze image.

For details of the selection method, see page 375.

The folder selected here is the destination folder for writing the freeze
image.

It is not possible to change the selection of this folder after the following
step 5.

An orange bar appears on the selection button for the destination folder.

Press [Freeze Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair
of FMs selected in step 2, a freeze is now possible.

If necessary, make the video process settings (see page 378) or mask
settings (see page 379) for application to the selected signal.

In the state in which you want to freeze, press one of the following in the
<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.
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After carrying out the freeze, to return to the state immediately before the

freeze, press [Undo] in the <Freeze> group.

* All freeze images written to temporary memory are lost when the system

is powered off.

« If you change the frame memory to use as in step 2 before saving the
freeze images written to temporary memory, all the freeze images in
temporary memory are lost, unless the auto store function has been

enabled in setup. With the auto store function enabled, the freeze images

written to temporary memory are saved automatically when the frame
memory selection is changed.
* For the following signal formats, a field freeze is not possible.
1080PsF/23.976, 1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/
50, 720P/59.94

Saving a freeze image (Store)

You can save an image in temporary memory which has been placed with the
freeze function as a file in memory. You can save a single image in a single file

and apply a name of up to eight characters to the file.

When the system is powered off, all the files saved in memory are erased.

To save a captured still image in a file, use the following procedure in the Still

>Freeze/Store menu.

1

Press [Store].

The keyboard window (see page 122) appears.

In the keyboard window, enter the file name (maximum 8 characters).

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, COM2,
COM3, COM4, COM5, COM6, COM7, COM8, COM9
LPTO, LPT1, LPT2, LPT3, LPT4, LPTS, LPT6, LPT7, LPTS,
LPT9

In the keyboard window, press the [Enter] button.

This saves the still image file in memory.
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The destination folder is the folder selected in step 4 of “Freezing an image
and writing it to memory.”

If the entered folder name already exists, a message to confirm overwriting
appears.

When the system is powered off, the file saved in memory is erased.
When the system is powered off, the file saved in memory is erased.
However, you can recall a backed up file in the Frame Memory menu.
For details, see “File Backups” (page 415), and “Restoring backed up
files” (page 415).

To carry out a freeze and store simultaneously (Freeze and Store)
Press [Freeze & Store], turning it on.

In this state, if you press [Frame] or [Field], this carries out a freeze, and
simultaneously stores in a still image file.

This function is not supported on the MVS-8000.

Setting video processing

To set video processing for the signal selected on a frame memory source bus,
use the following procedure in the Still >Freeze/Store menu.

1 In the <Video Process> group, press [Video Process], turning it on.

2 Use the knobs to adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Video Gain | Overall gain of the video signal —200.00 to +200.00
2 Y Gain Y signal gain —200.00 to +200.00
3 C Gain Chrominance signal gain —200.00 to +200.00
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level |Y signal black level —7.31to +109.59

To return the settings to the default values, press [Unity] in the <Video
Process> group.

When a pair setting is active, it is coupled to the video process on/off
setting, but the above parameter settings are only valid for frame memory
source bus 1. The pair setting cannot be used to set the frame memory
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source bus 2. If you want to set video process for frame memory source bus
1 only with the pair setting when old settings for frame memory source bus
2 remain, return the frame memory source bus 2 settings to their default
values. When setting video process for the frame memory source bus 2,
disable the pair setting.

Setting a mask

Masks can be set separately for frame memory source buses 1 and 2. To apply
a mask to the signal selected on frame memory source bus 1, for example, use
the following procedure in the Still >Freeze/Store menu.

1 Press [Box Mask] turning it on.

2 Use the knobs to adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 Top Top position —100.00 to +100.00
2 Left Left position —100.00 to +100.00
3 Right Right position —100.00 to +100.00
4 Bottom Bottom position —100.00 to +100.00

3 To link the masks on frame memory source buses 1 and 2, press [Mask
Link], turning it on.

Recalling Still Images

You can recall an image file saved in memory, and allocate to any of the FM1
to FMS outputs.

Recalling a still image

To recall a still image file saved in memory using the thumbnails, and assign it
to an FM output, use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still” and HF1 ‘Recall.’

The Recall menu appears.

* When [Pair] is on, only pair files (pairs of main file and sub file) are
displayed.
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image001 image001 5) image002 image002

sy image005 image005

Sub file

Main file

e When [Pair] is off, both single files and pair files appear.

image001 image001 8 image002 image002 (s)

image003 image004 image004

Single file

In the frame memory selection area, select the FM to be assigned. (See
page 375.)

If [Direct Recall] is on, press and turn it off.
Select the desired folder in the folder selection area.

By pressing [More] to switch the display, you can select from a maximum
of 12 folders.

Thumbnails of the files within the selected folder appear.

Using the arrow keys or turning the knob, scroll the file thumbnail display.

Knob Parameter Adjustment Setting values
1 Scroll Thumbnail display 1 and upwards
scrolling
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6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

This recalls the still image file, which is assigned to the FM you selected
in step 2.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press [Direct Recall].

2 Press the thumbnail for the file you want to recall.

This immediately recalls the file.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], turning it on.

Inverting the Field Polarity of a Saved Still Image (Field
Invert Function)

This function is valid when the signal format is HD (excluding 720P).
However, it is not valid if the frame memory saving mode is set to “save with
ancillary data.”

To invert the field polarity of a saved still image

1 In the Frame Memory >Still menu, press HF7 ‘Field Invert.’

The Field Invert menu appears.
This automatically switches pair mode off, and the status area shows
thumbnails of all images currently saved in frame memory.

2 Press the arrow keys or turn the knob to scroll the thumbnail display.

Knob | Parameter Adjustment Setting values

1 Scroll Scroll thumbnail display 1 and upwards
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3 Select the thumbnail of the still image on which you want to carry out field
inversion. You can also select more than one image.
To select all still images, press [Select All].

The file names for the selected still images appear in reverse video.

To cancel the selection, press once more, returning to the normal display.
The last still image selected is automatically recalled, and a pale blue
border appears around the thumbnail.

You can now select thumbnails while checking the still images.

4 To carry out field inversion, press [Field Invert].

Field inversion starts, and a popup window shows the progress of the
operation.

When the system is powered off, files held in memory are lost, but backed-up
files can be recalled in the Frame Memory menu.

For details, see “File Backups” on page 415 and “Restoring Files” on page
415.

Image Processing

You can combine the background image (a still image file allocated to any of
FM1 to FMS, a freeze image written to temporary memory, or a black signal)
and the input signal.

The following types of processing are available.

Pattern key: Using the signal from a dedicated pattern generator, you can cut
out the background image and insert the signal selected on the frame
memory source bus or a color matte signal. You can adjust the size and
position of the pattern, and add modifiers.

External key: When processing an image in FM1 (3, 5, 7), you can use the
signal selected on the frame memory source bus 2 to cut out the
background image, and fill with the signal selected on the frame memory
source bus 1, or a color matte signal.

When processing an image in FM2 (4, 6, 8), you can use the signal selected
on the frame memory source bus 2 to cut out the background image, and
fill with a color matte signal (always white).

An external key can only be used when the pair mode is enabled (see page
367).
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MIX: Mix the background image with the signal selected on the frame memory

source bus or color matte signal. The mix ratio can be set.

NAM: Non-additive mix the background image with the signal selected on the

frame memory source bus or color matte signal.

Combining the background image and input signal

1

In the Frame Memory menu, select VF1 ‘Still” and HF3 ‘Composite.’

The Composite menu appears.

In the frame memory selection area, select the FM to be assigned. (See
page 375.)

To select V/K mode, press [V/K Mode], turning it on.

Press a button in the frame memory folder selection area, to select the
folder to hold the freeze image.

For details of the selection method, see page 375.

The folder selected here is the destination folder for writing the freeze
image.

It is not possible to change the selection of this folder after the following
step 5.

An orange bar appears on the selection button for the destination folder.

Press [Edit Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair
of FMs selected in step 2, and the combining of the background signal (the
signal providing the background for combination) and the input signal (the
signal providing the foreground for combination) is now possible.

The input signal is lowered by one line, but when you apply a freeze, the
freeze image is returned to the correct position.

To use a color matte signal for the input signal, press [Frgd Color], turning
it on.

Even when pair mode is enabled, you can make separate settings for each
FM.
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Turn the knobs to adjust the following parameters.

Knob Parameter Adjustment Setting values
1 Luminance Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00

If you turned [Frgd Color] off in step 6, if required press [Input Adjust] to
display the Input Adjust menu, and make the video process (see page 378)
and mask (see page 379) settings for the input signal.

To set the background signal to black, press [Bkgd Black], turning it on.

* When the background signal is originally black, [Bkgd Black] remains
on.

* When the background signal is a freeze image (an image frozen, but not
saved), turning [Bkgd Black] on erases the unsaved freeze image and, as
a result, [Bkgd Black] remains on.

1 OIn the <Type> group, set the type of combination (see page 385).

1 1 In the state in which you want to freeze, press one of the following in the

<Freeze> group, to write the freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze image.

After carrying out the freeze, to return to the state immediately before the
freeze, press [Undo] in the <Freeze> group.

» All freeze images written to temporary memory are lost when the system
is powered off.

* If you change the frame memory to use as in step 2 before saving the
freeze images written to temporary memory, all the freeze images in
temporary memory are lost, unless the auto store function has been
enabled in setup. With the auto store function enabled, the freeze images
written to temporary memory are saved automatically when the frame
memory selection is changed.

¢ For the following signal formats, a field freeze is not possible.

1080PsF/23.976, 1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/50,
720P/59.94
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Saving a processed freeze image

To save a processed freeze image as a file, in the Still >Composite menu use

the following procedure.

1

2

Press [Store].

The keyboard window appears.

In the keyboard window, enter the file name (maximum eight characters).

In the keyboard window press [Enter].

This saves the freeze image as a still image file in memory.
The destination folder is the folder selected in step 4 of “Combining the
background image and input signal” (page 383).

If the entered folder name already exists, a message to confirm overwriting

appears.

Selecting the way in which images are combined

To select the way in which the background image and input signal are
combined (see page 382), use the following procedure.

1

In the <Type> group of the Still >Composite menu, select one of the
following methods of combination.

* Pattern Key: pattern key
* Ext Key: external key
(This can only be selected when the pair mode is enabled. The signal
selected on the frame memory source 2 bus is used as the key signal.)
e Mix: mix
e Nam: non-additive mix
If none of the above is selected, image combination is not carried out.

Depending on the selection in step 1, set the following parameters.

* When [Pattern Key] is selected

Knob | Parameter |Adjustment Setting values

1 Size Size of pattern 0.00 to 100.00
Soft Edge softness of pattern 0.00 to 100.00
Pattern Pattern number 1to24 3

a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” in Appendix
(Volume 1) (page 497).
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* When [Ext Key] is selected

Knob | Parameter

Adjustment

Setting values

1 Clip Reference level for key +109.59 to -7.31
signal generation
2 Gain Key sensitivity —100.00 to +100.00

* When [Mix] is selected

Knob | Parameter

Adjustment

Setting values

1 Mix Rate

Mix proportion

0.00 to 100.00

3 When you selected a pattern key, press [Pattern Adjust].

The Pattern Adjust menu appears. In the menu, set the pattern modifiers as

required.

* When turning [Position] on and setting the pattern position

Knob | Parameter

Adjustment

Setting values

1 Position H

Horizontal position

-100.00 to +100.00 2

2 Position V

Vertical position

-100.00 to +100.00 2

a) See page 290.

* When turning [Multi] on and replicating the pattern

Knob | Parameter |Adjustment Setting values
1 H Multi Number of repetitions of 1to 63
pattern horizontally
2 V Multi Number of repetitions of 1to 63
pattern vertically
3 Invert Type | Replication layout 1t049

a) See page 295.

* When turning [Aspect] on and setting the aspect ratio of the pattern

Knob | Parameter

Adjustment

Setting values

1 Aspect

Aspect ratio

-100.00 to +100.00 @

a) See page 294.

* When turning [Rotation Angle] on and inclining the pattern

Knob | Parameter

Adjustment

Setting values

1 Angle

Angle of pattern rotation

-100.00 to +100.00 @

a) See page 292.
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To select the pattern, display the Pattern Select menu by pressing [Pattern
Select] in the Pattern Adjust menu. You can change the pattern selected in
step 2 here. After selecting one of the patterns (wipe patterns 1 to 24)
displayed in the Pattern Select menu, you can adjust the following

parameters.
Knob | Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Edge softness 0.00 to 100.00

4 When you selected a pattern key or external key, if required press [Key
Invert] in the Still >Composite menu to invert the key.

Image Output

There are two functions related to image output: the reposition function for
moving the output image, and the lock function for fixing the output image.

Moving the output image (reposition function)

For up to two channels of FM1 to FMS (one from FM1, FM3, FM5 and FM7

and the other from FM2, FM4, FM6 and FMS), you can move the output image

with respect to the screen. The area of the screen around the image that has

been moved is filled with black. There are two ways of carrying out this

repositioning.

Normal mode: Movement in the horizontal direction is in two-pixel
increments.

Black and white mode: Movement in the horizontal direction is in one-pixel
increments, and for each pixel moved the color is inverted.

It is not possible to save an image moved with the reposition function directly
to frame memory.

1 In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF1
‘Reposition.’

The Reposition menu appears. In this menu, you can also enable the V/K
mode (see page 376).

2 In the frame memory selection area, select the FM output (see page 375).

3 In the <Reposition> group, select the movement mode.
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5

Normal: Move in normal mode.
Black&White: Move in black & white mode.

With the knobs, adjust the parameters to move the image.

Knob | Parameter |Adjustment Setting values
1 Position H Move in horizontal direction | _200.00 to +200.00 @
2 Position V Move in vertical direction —200.00 to +200.00 &

a) See page 290.

The surroundings of the moved image on the screen are filled with black.

To return the image moved by the reposition function to the center
position, in the <Reposition> group press [Center].

Fixing the output image selection (lock function)

For the output of each of FM1 to FMS, this fixes the image at the current
output. When this lock is enabled, even if the output is recalled in a snapshot
or keyframe, the images output to FM1 to FMS are preserved.

1

In the Frame Memory menu, select VF3 ‘Reposition/Lock’ and HF2
‘Lock.’

The Lock menu appears.
In the frame memory selection area, select the FM output. (See page 375.)

Press [Lock], turning it on.

This fixes the currently selected frame memory output image.
To release the lock, set [Lock] to off.

Continuously Capturing Still Images (Record)

You can continuously capture (freeze) a sequence of input video frames and
store the sequence of the still images over a specified time interval.

The name of each image recorded in this way consists of a first character string
followed by a second string.

First character string: A common part of name assigned to all the still images

captured in one record operation. This string includes a maximum of four
characters, which can be specified using a menu before carrying out the
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capture. The first string is automatically used as the clip name when the
images are treated as a frame memory clip.

Second character string: A four-digit number (0000 or greater), which is

incremented each time a still image is captured.

When using the record function to continuously capture frames, it is not
possible to use the mask function.

On the MVS-8000, the image file name is “anmxxyyy” (‘“anm” is constant,
“xx” is a two-digit number from 00 to 99 incremented by 1 for ever recording
operation, and “yyy” is a three-digit number from 000 to 999, incremented
by 1 for each captured image).

Continuously freezing input images and writing to memory

1

w

In the Frame Memory menu, select VF1 ‘Still” and HF4 ‘Animation
Record.’

The Animation Record menu appears.

Select the desired frame memory.

For details of the operating procedures, see “Selecting outputs (FM) and
target frame memory” (page 374).

To use V/K mode, press [V/K Mode], turning it on.

Press a button in the frame memory folder selection area, to select the
folder to hold the freeze image.

For details of the selection method, see page 375.

The folder selected here is the destination folder for writing the freeze
image.

It is not possible to change the selection of this folder after the following
step 5.

An orange bar appears on the selection button for the destination folder.

Press [Record Enable], turning it on.

The signals of frame memory source buses 1 and 2 are assigned to the pair
of FMs selected in step 2, the recording function is now possible.

Input the file name if required.
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9

1

Pressing [File Name] displays the keyboard window and you can enter the
first character string (up to four characters) of the file name.

Set the recording time if required.

Pressing [Duration] displays the numeric keypad window, in which you
can enter the recording time in the form of timecode.

If you set the recording time to zero, this uses all frame memory in which
storing is possible for recording.

If required, set video processing for the selected signal.

For details of the operating procedures, see “Setting video processing”
(page 378).

Press [Record], to start recording.

When the recording time is set, recording stops once the time has elapsed.

OPress [Stop] to stop recording.

Even if the recording time is set, you can still stop recording before the set
time has elapsed.

Recalling
(Animatio

a Continuous Sequence of Still Images
n)

You can use a continuous sequence of images captured with the record function

as

keyframes to create an effect. By executing this effect you can recall the

continuous sequence (animation).

For example, to create an effect using FM 1, FM1 must be assigned to a user
region.

To execute the effect, you must assign the user region to which FM1 is
assigned to a region selection button in the numeric keypad control block and
the Multifunction Flexi Pad control block. (For details of assigning to region
selection buttons, see Chapter 19 “Control Panel Setup (Panel)” (Volume

3).)

In the Frame Memory menu, effect creation follows the image file names. Of
the eight characters in the file names, if files have the same characters except
for the last three characters they are treated as an image file group, and the
effect is created with the last three (numeric) characters in sequence.
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When creating the effect in pair mode (see page 367), the files used must be
main files and sub files with the same last three (numeric) characters in the file
name.

To recall a continuous sequence of still images, create an effect in the user
region with the still image files as a keyframe, and run the created effect.

With the 720P format, you can continuously recall images using the frame
memory in units of two frames only.

Creating an effect with still image files as a keyframe

1 In the Frame Memory menu, select VF1 ‘Still’ and HFS5 ‘Create Key
Frame.’

The Create Key Frame menu appears.

* A thumbnail appears for each group of files having the same characters,
except for the last three characters, in the file name.

e When [Pair] is on, only pair files (each pair comprising a main file and
a sub file) appear.

e When [Pair] is off, both single files and pair files all appear.

2 In the frame memory selection area, select the frame memory to be
assigned.

This creates the effect in the user region to which the selected frame
memory is assigned.

For details of the operating procedures, see “Selecting outputs (FM) and
target frame memory” (page 374).

3 Select the desired folder in the folder selection area.

By pressing [More] to switch the display, you can select from a maximum
of 12 folders.

Thumbnails of the files within the selected folder appear.

4 Turn the knob to select the register number in the user region.

Knob Parameter Adjustment Setting values

5 Register Effect register number 1t099

Still Image Operations
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To search for an empty register in the user region, use the numeric keypad
control block or the Multifunction Flexi Pad control block (see step 3 of
“Recalling a Register” in Chapter 13 (Volume 2)).

5 Use the arrow keys or turn the knobs to scroll the thumbnail display of the

files.
Knob Parameter Adjustment Setting values
1 Scroll Thumbnail display 1 and upwards
scrolling

»

Select the thumbnail of the files to be used for the keyframe.

7 If necessary, turn the knob to check the animation effect in the thumbnail

display.
Knob Parameter Adjustment Setting values
3 Viewer Animate thumbnail display | 00:00:00 and upwards
of files

8 Using the region selection buttons in the numeric keypad control block or
the Multifunction Flexi Pad control block, select one of the regions (User1
to User8) to which the frame memory output signals have been assigned.

9 Carry out either of the following.

¢ To clear the effect register selected in step 4, and create a new effect:
press [Create Key Frame].

* To add to the end of the effect register selected in step 4, press [Append
Key Frame].

A confirmation message for creating the effect appears.
If there is an inappropriate condition for creating the effect, an error
message appears.

For details of error messages, see “Error Messages” in the Appendix
(Volume 3).

1 OPress [OK].

This creates the effect in the selected user region register.

To cancel creating the effect
Press [Cancel].

Still Image Operations



* The effect is built with the selected files, in increasing order of the last three
characters of the file name. If you do not want to include some of these files
in the effect, first delete or rename them.

* A maximum of 99 keyframes can be included in a single effect.

Recalling a sequence of still images

Run the effect created by the foregoing procedure.
The procedure for doing this is the same as for any other effect.

For details, see “Executing Effects” in Chapter 13 (Volume 2).

Still Image Operations
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Frame Memory Clip Function

The frame memory clip function is not supported on the MV S-8000.

What is a “frame memory clip”?

Movies can be read into frame memory, and recalled and played back. A movie
held in frame memory is called a “frame memory clip.”

A frame memory clip can be named using up to four characters. (For details of
frame memory clip names, see “Continuously Capturing Still Images
(Record)” (page 388).)

Ancillary data

In a frame memory clip, in addition to the video image, you can also record and
play back ancillary data which can be used as embedded audio (MVS-8000A
and MVS-8000G only).

To record the ancillary data, in the Setup menu the frame memory saving mode
must be set to “save with ancillary data” (see “Saving a Frame Memory Clip
With Ancillary Data” in Chapter 18 (Volume 3)).

* With this setting, the saving mode for still images also changes to “save with
ancillary data,” but when playing back a still image the ancillary data is never
played.

* When you change the saving mode, the frame memory is initialized, and any
existing recorded frame memory data is lost.

Note on transferring ancillary data

Ancillary data is recorded when the frame memory saving mode is set to “save
with ancillary data,” and can be saved to an external storage device such as a
hard disk or memory card, and recalled. However, the ancillary data can only
be saved or recalled;

* When the frame memory saving mode is set to “save with ancillary data.

* When ancillary data is present in the saved or recalled frame memory file.
* When the system signal format is the same as the signal format in the file.

When the frame memory saving mode is set to “save with ancillary data,” the
following ancillary data status information is added to a frame memory clip.
¢ Disable(d):
In this state the ancillary data is not played. This is the status when the
[Ancillary Enable] button in the Frame Memory >Clip menu is set to Off.

Frame Memory Clip Function



¢ Enable(d):
In this state, ancillary data is present, and can be played back. This is the
status when the [Ancillary Enable] button in the Frame Memory >Clip menu
is set to On. This is the status after a clip recording operation.

This status information is saved in a file, and is followed when the file is
recalled.

Frame memory clip settings

For frame memory clips, you can make the following settings using a menu or
device control block (trackball/search dial/joystick).

e Start point

* Stop point

¢ Loop On/Off

The above settings can be saved in a snapshot register as snapshot attributes,
and recalled.

On the MVS-8000A, it is only possible to replay extended clips as output from
FM1 or FM2.

Frame Memory Clip Function
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Frame Memory Clip Operations

For an overview of frame memory clip concepts, see “Frame Memory Clip
Function” (page 394).

* The frame memory clip function is supported on the MVS-8000A/8000G
only.

* During playback of a frame memory clip of the pair assigned to either of the
target FM selection buttons (see page 398), frame memory operations may
not be performed properly. Carry out frame memory operations after
stopping clip playback.

Preparations for Operation

The preparations for using a frame memory clip (hereafter, a “clip”) are the
same as for a still image operation. See “Preparations” (page 369) and
“Selecting Outputs and Target Frame Memory” (page 374).

Recalling Clips

Recalling a clip
You can recall a clip from each of frame memories 1 to 8.
1 In the Frame Memory menu, select VF2 ‘Clip’ and HF1 ‘Recall.’

The Recall menu appears. (See following figure)
e When [Pair] is set to On, only pair files (sets of main file and sub file)

are shown.
e When [Pair] is set to Off, both of single files and pair files are shown.

Frame Memory Clip Operations
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Direct
Recall

Clip file selection area Direct Recall button

2 In the frame memory selection area, select an assigned target FM. (See
page 374)

For the MVS-80004, if other than FM1 and FM2 is selected, extended
clips are not displayed.

w

If [Direct Recall] is on, press the button, turning it off.

4 In the folder selection area, select the desired folder.

By pressing [More] to switch the displays, you can select from a maximum
of 12 folders.
Thumbnails of the files within the selected folder appear.

5 Using the arrow keys or turning the knob, scroll the file thumbnail display.

Knob Parameter Adjustment Setting values
1 Scroll Thumbnail display 1 and upwards
scrolling

Frame Memory Clip Operations
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6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

This recalls the clip file, which is assigned to the FM you selected in step 2.
In pair mode, if a clip is selected, the main file is output to FM1, and the
sub file to FM2. In single mode, when only one of FM1 and FM2 is
selected, the front file on the thumbnail is output.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press [Direct Recall].

2 Press the thumbnail for the file you want to recall.

This immediately recalls the file.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], turning it on.

Aows\ swelq 7 Jaydeyn

Clip Playback

You can play a recalled clip by a menu operation or by using the device control
block.

With a pair file recalled, it is possible to set [Pair] to Off and carry out a single
file operation, but if you then set [Pair] to On again, the output of frame
memory may be black. In such cases it is necessary to recall the pair file once
more.

Playing a clip using the menu

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF2 ‘Play.’

The Play menu appears. The status of the clip shown in the current target
FM selection buttons appears here.
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(pale blue bar)

Playback end point
(yellow bar)

2 When [Pair] is Off, press a target FM selection button to select the target.

3 To set loop playback, press [Loop], turning it on.

4 To start playback, press [Play]. During playback, to stop, press [Stop].

To cue up
Press [Cue].

To play the image at the beginning of the clip (Clip Begin)

Press [Rewind].

To play the image at the end of the clip (Clip End)

Press [FF].
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To specify the playback start point

To set the current position as the playback start point, in the <Start TC> group,
press [Set]. To set a different position, press the [Start] status button, and enter
a timecode value from the numeric keypad window.

To specify the playback stop point

Start playback, and at the desired position press the [STOP] button to stop

playback, then in the <Stop TC> group, press [Set]. To set to any position,
press the [Stop] status button, and enter a timecode value from the numeric
keypad window.

To change the current position
To change the current position, press the [Current] status button, and enter a
timecode value from the numeric keypad window.

Using the device control block (search dial) to play back clips

A frame memory clip must first be recalled with a menu operation.

1 With the device selection buttons, select the frame memory clip to be
played (FM1 CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], [JOG], [CUE],
[REW], [FF], and [ALL STOP] buttons.

For details of the buttons in the device control block (search dial), see
“Device Control Block (Search Dial)” (page 66) in Chapter 2.

To specify the playback start point

To make the current position the playback start point, press the [START TC]
button. To set a different position, press the [SET START TC] button, then
enter the timecode from the numeric keypad control block.

To specify the duration

Press the [SET DUR] button, and enter a timecode from the numeric keypad
control block. If the playback start point is already set, this automatically sets
the playback stop point. If the playback stop point is already set, this
automatically sets the playback start point. (The duration setting is not
displayed in the device control block.)

Frame Memory Clip Operations



To specify the playback stop point

Start playback, and at the desired position press the [STOP] button to stop
playback, then press the [STOP TC] button. To set to any position, press the
[SET STOP TC] button, and enter a timecode from the numeric keypad control
block.

To carry out the variable speed playback
Use the search dial.

For details on using the search dial, see “Controlling the Tape/Disk
Transport” in Chapter 12 (Volume 2).

To apply a loop to a frame memory clip
Press the [LOOP] button.

Using the device control block (trackball) or device control block
(joystick) to play back clips

A frame memory clip must first be recalled with a menu operation.

1 Press the [DEV] button in the region selection buttons, and select the frame
memory clip for playback (FM1 CLIP to FMS8 CLIP).

If the pair mode is on, both main and subsidiary FMs light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], [JOG], [CUE],
[REW], [FF], and [ALL STOP] buttons.

For details of the buttons in the device control block (trackball) or device
control block (joystick), see “Device Control Block (Trackball)” (page 60) in
Chapter 2.

For details of the playback start point, stop point, and duration settings, see the
previous item, “Using the device control block (search dial) to play back clips”
(page 400).

To carry out the variable speed playback

Press any of the [SHTL], [JOG], and [VAR] buttons, then turn the Z-ring or
move the joystick. The image changes in the forward direction when you turn
the Z-ring clockwise, and in the reverse direction when you turn it
counterclockwise. Move the joystick to the right for the forward direction and
to the left for the reverse direction.
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When you pressed the [JOG] button: Playback is at a speed corresponding
to the turning speed of the Z-ring or the movement speed of the joystick.

When you pressed the [SHTL] button: Playback is at a speed corresponding
to the rotation angle of the Z-ring or amount of movement of the joystick.

When you pressed the [VAR] button: Playback is at a speed corresponding
to the rotation angle of the Z-ring or amount of movement of the joystick,
in the range —1 to +3 times normal speed.

Clip Creation

You save a movie as a clip.

If the number of frame memory clips exceed 100 single files (50 pair files), an
error appears.

Using the menu to record clips

1 In the Frame Memory menu, select VF2 ‘Clip’ and HF3 ‘Record.’

The Record menu appears.

Frame Memory Clip Operations
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With [Pair] off, press the operation target selection button, to select the
operation target.

In the folder selection area, select the folder containing the clip to be
recorded.

In the <Record Enable> group, select the clip type.

* To record a normal clip, press [Clip].
* To record an extended clip, press [Ext Clip].

To set the clip name, press [Name].

A keyboard window appears.
Enter the clip name, and press Enter.
To start recording, press [Record Start].

To end recording, press [Record Stop].

Frame Memory Clip Operations
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To set the clip duration

1 Press [Clip Duration].

A numeric keypad window appears.

2 Enter a timecode value or number of frames, and press Enter.

This confirms the clip duration.

Creating and Handling Frame Memory Folders

You can create, rename, and delete frame memory folders.

Creating a new folder

1

In the Frame Memory menu, select VF5 ‘Folder.’

The Folder menu appears. The status area shows a list of the current folder
settings.

Select [New].

A keyboard window appears.

Enter the folder name, and press Enter.

This confirms the folder name.

Changing the folder name

1

In the Frame Memory >Folder menu, select the folder with the arrow keys
or by turning the knobs.

Knob |Parameter |Adjustment Setting values

1 No. Folder selection 1to12

2 Num Number of files to select 1to 12
consecutively from selected file

Press [Rename].

A keyboard window appears.

Enter the new folder name, and press Enter.
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The following names cannot be used for folders:
Default, Flash1, Flash2
CON, PRN, AUX, CLOCKS$, NUL, COMO, COM1, COM2,
COM3, COM4, COM5, COM6, COM7, COMS, COM9
LPTO, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPTS,
LPT9

This changes the folder name.

Deleting a folder

1 In the Frame Memory >Folder menu, select the folder with the arrow keys

or by turning the knobs.

Knob | Parameter |Adjustment Setting values
1 No. Folder selection 1to 12

2 Num Number of files to select 1to 12

consecutively from selected file

To select all folders, select [All].

2 Press [Delete].

A confirmation message appears.

3 To carry out the deletion select [ Yes], and to cancel the deletion select

[No].

It is not possible to delete the default folder (named “Default”).

Clip Output

As for still image operation, you can use the reposition and lock functions.

For details of the operation, see “Image Output” (page 387).

Frame Memory Clip Operations
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Recording and Playback of Ancillary Data

Preparations

To record ancillary data, it is first necessary in the Setup menu to select “save
with ancillary data” as the frame memory saving mode (see “Saving a Frame
Memory Clip With Ancillary Data” in Chapter 18 (Volume 3)).

Recording ancillary data

To record ancillary data in a frame memory clip, use the Frame Memory >Clip
>Record menu.

For details of the operating sequence, see “Clip Creation” (page 402).

To check ancillary data during recording
If the ancillary data to be recorded is embedded audio, by first setting the signal
output to through mode, you can listen while recording.

For the method of setting the signal output to through mode, see “Signal
Output Settings (Output Menu)” in Chapter 20 (Volume 3).

For [Freeze Enable] or [Record Enable], in the <Record Enable> group,
pressing [Clip] or [Ext Clip] to turn them on or off may result in noise. Also,
with these buttons in the On state, selecting the signal on the frame memory
source bus may result in noise.

Playing back ancillary data

You can play ancillary data recorded in a frame memory clip by normal
playback or an auto transition of the clip transition.

To play the ancillary data, you must use the following procedure to enable
playback of the ancillary data. For the subsequent playback operation, see
“Clip Playback” (page 398).

* After recording a frame memory clip, the ancillary data state is enabled for
playback.

* To play back the clip, set the signal output to through mode. For the method

of setting through mode, see “Signal Output Settings (Output Menu)” in

Chapter 20 (Volume 3).

When the reposition function is on, ancillary data cannot be played back.

Switching reposition function between on and off may cause noise.

Only the AUX bus and edit preview bus can output ancillary data.
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On the MVS-8000A playing back ancillary data is only possible for FM1,
FM3, FM5, and FM7. For FM2, FM4, FM6, and FMS, ancillary data cannot
be played back. On the MVS-8000G there are no such restrictions.

For loop playback of clips in the following video formats, the loop playback
range must be at least 5 frames, and set to a multiple of 5 frames.

— 480/59.94i

— 720/59.94P

— 1080/59.94i

— 1080/29.97PsF

Recalling operations of still images or clips can cause noise.

Carrying out file operations on a frame memory clip may result in the
ancillary data being discontinuous, or in noise occurring. However, if the
first or last frame of the clip is deleted, noise will not occur.

The audio sampling frequency is always 48 kHz.

In the case of 480i or 59.94, noise may occur at the beginning of playing back
aclip. This can be avoided by making the first nine or more frames of the clip
soundless.

When you play back the recorded embedded audio, depending on the device
to be used, noises are produced at the playback start point and end point. For
details of devices that are used for playback, contact your Sony service or
sales representative.

1 In the Frame Memory menu, select VF2 “Clip”, HF5 “Ancillary Enable.”

2 Select the frame memory folder and file to be played back.

3 Set the [Ancillary Enable] button to On.
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Clip Transition Operations

A frame memory clip (movie) is played back, linked to a transition using a mix
(dissolve) or wipe.

The following restrictions apply to the use of a clip transition.

» Key frame capture is not possible.

* It is not possible to apply a pattern limit.

* Transitions executed in two strokes, such as a preset color mix with the
stroke mode set to Normal, or a DME wipe with a picture-in-picture pattern,
will not execute correctly.

It is not possible to vary the transition rate of a clip transition.

Transition preview cannot be used.

No instantaneous state of a clip transition can be saved as a snapshot.
When recalling a snapshot including a clip transition during executing
another clip transition, the follow-on transition does not operate properly. Be
sure to complete the transition before recalling a snapshot.

* The clip transition function is only supported by the MV S-8000A/8000G.

* When a clip transition is selected as the transition type, if one of the wipe
direction selection buttons in the transition control block is lit, it indicates the
direction of clip playback.

Setting a clip transition

The following example describes the case of a clip transition using FM 1&2
Clip on the M/E-1 bank.

To use a clip transition effectively, the image from the frame memory clip
being played back during the clip transition should be seen in the M/E-1
program output. For example, inserting a key using frame memory output 1 and
frame memory output 2.

1 Display the M/E-1 >Misc >Transition menu, and in the <Transition Type>
group select “FM1&2 Clip.”

2 Press [Clip Transition].

The Clip Transition menu appears.

Clip Transition Operations
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Press the [Clip] button.

The Clip menu appears, and the status area shows a list of clips.
Select the clip to use in the clip transition.

Return to the Clip Transition menu, and in the <BKGD Transition Type>
group, select the background transition type.

For details of the background transition selected here, see the various
adjustments in the M/E-1 >Misc >Transition menu.

In the <Select> group, press [BKGD Transition].

Use either of the following methods to set the background transition start
point independently of the clip playback timing.

* Move the fader lever to the desired position, and in the <BKGD
Transition Set Timing> group press [Start].

Clip Transition Operations
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e Turn knob 1 to set the number of frames. (The left end of the reference
axis (see following figure) is the position of frame 0.)

Position of frame 0 Reference axis

BKGD Trans

Starl [24] Stop [39]

FM1&2 Clip
Start [0] ' Stop [60]

8 Using either of the following methods, set the end point of the background
transition.

* Move the fader lever to the desired position, and in the <BKGD
Transition Set Timing> group press [Stop].
¢ Turn knob 2 to set the number of frames.

9 If Wipe or DME Wipe is selected in the <BKGD Transition Type> group,
in the <BKGD Transition Direction> group, select the background
transition direction.

1 OIn the <Select> group, press [FM 1&2 Clip].

1 1 Using either of the following methods, set the start point of the clip.

* Move the fader lever to the desired start point, and in the <Clip
Transition Set Timing> group press [Start].

e Turn knob 1 to set the number of frames. (The left end of the reference
axis (see previous figure) is the position of frame 0.)

It is not possible to set the end point.

1 21n the <Clip Transition Direction> group, select the playback direction of
the clip.

To reset the start point and end point

Press [Timing Reset].

The background transition start point and end point, and the clip start point are
all reset.

Clip Transition Operations



Image Data Management

You can carry out the following operations on the files in which images are
saved.

* Pair file processing

* Move

* Delete
* Rename
* Backup
* Restore

* The following sections describe the operations available in the MVS-8000A
system and MVS-8000G system.

The MVS-8000 system uses the same menus as those of Version 5.30. For
its operating procedures, see the User’s Guide of Version 6.00 or earlier.

* During playback of a frame memory clip of the pair assigned to either of the
target FM selection buttons (see page 398), frame memory operations may
not be performed properly. Carry out frame memory operations after
stopping clip playback.

Pair File Processing

You can create a pair file from two single files. In the reverse direction, you

can split a pair file into two single files.

Couple: You can create a pair file from two single still image files or clip files.

Separate: You can also separate a pair file into two single still image files or
clip files.

This function is not supported on the MVS-8000.
Creating a pair file from two single files

Carrying out the following operation automatically switches [Pair] to On.

The following description applies to the case of FM1&2, but the procedures are
similar for the other cases.

Image Data Management 411
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1

2

In the Frame Memory >Still >Recall menu or Frame Memory >Clip
>Recall menu, recall the two single files you want to convert to a pair file,
to FM1 and FM2.

In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair
Recombination.’

The Pair Recombination menu appears.

Press [Couple].

This converts the files output to FM1 and FM?2 to a pair.

Splitting a pair file into two single files

Carrying out the following operation automatically switches [Pair] to Off.

The following description applies to the case of FM1and FM2, but the
procedures are similar for the other cases.

1
2

In the Frame Memory >Still >Recall menu or Frame Memory >Clip
>Recall menu, recall the pair file.

Select the folder in which the file to be moved is stored.

In the Frame Memory menu, select VF4 ‘File’ and HF1 ‘Pair
Recombination.’

The Pair Recombination menu appears.

Press [Separate].

The FM1 and FM2 pair file is split into separate single files.

Moving Files

1

In the Frame Memory menu, select VF4 ‘File’ and HF5 ‘Move.’

The Move menu appears. The status area shows files to be moved in the
upper area, and destination files in the lower area.

Select the folder which contains the file to be moved.

Using any of the following methods, select the file to be moved.

412 Image Data Management
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¢ Press the arrow keys to scroll the display.
* Press directly on the thumbnail in the status area.
e Turn the knobs.

Knob | Parameter |Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of number of files in 1 and upwards
sequence

Select the destination folder and file.
Press [Move].

To confirm the move press [Yes], and to cancel press [No].

Deleting Files

1

In the Frame Memory menu, select VF4 ‘File’ and HFS ‘Delete.’

The Delete menu appears. In the status area, whether pair mode is on or
off, all of the saved files appear as thumbnails.

Select the folder which contains the file to be deleted.

Using either of the following methods, select the file to be deleted. If
necessary, press the arrow keys to scroll the display.

* Press directly on the thumbnail in the status area.
e Turn the knobs.

Knob Parameter | Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of number of files in 1 and upwards
sequence

» To delete all files, press [Select All], turning it on.

* When aclip thumbnail is selected, the still image files making up the clip

are also selected for deletion.

If necessary, turn the knob to check the contents of the frame memory clip
through the thumbnail display.

Knob Parameter Adjustment Setting values

3 Viewer For a movie, the current frame 00:00:00 and
position. For a still image, no effect. | upwards
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Press [Delete].

A message for confirming the deletion appears.

To confirm the deletion press [Yes], and to cancel press [No].

Renaming Files

1

In the Frame Memory menu, select VF4 ‘File’ and HF6 ‘Rename’

The Rename menu appears. In the status area, whether pair mode is on or
off, all of the saved files appear as thumbnails.

Using either of the following methods, select the file to be renamed. If
necessary, press the arrow keys to scroll the display.

¢ Press directly on the thumbnail in the status area.
* Turn the knobs.

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

If necessary, turn the knob check the contents of the frame memory clip
through the thumbnail display.

Knob Parameter | Adjustment Setting values

3 Viewer For a movie, the current frame 00:00:00 and
position. For a still image, no effect. | upwards

Press [Rename].

A keyboard window appears.

Enter the new name, then press [Enter] in the keyboard window.

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COMO, COM1, COM2, COM3,
COM4, COMS5, COM6, COM7, COMS8, COM9
LPTO, LPT1, LPT2, LPT3, LPT4, LPTS, LPT6, LPT7, LPTS8, LPT9

This renames the file.

Image Data Management



File Backups

To back up a file saved in memory to hard disk, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF7 ‘Backup/Restore.’

The Backup/Restore menu appears.

2 Press [Backup].
This backs up the saved file.

Restoring Files

Restoring backed up files

To recall files backed up on the hard disk, use the following procedure.

1 In the Frame Memory menu, select VF4 ‘File’ and HF7 ‘Backup/Restore.’

The Backup/Restore menu appears.

2 Press [Restore].

This recalls the backed up file.

Image Data Management
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External Hard Disk Drive Access

In an MVS-8000A system and MVS-8000G system, you can connect a hard
disk drive to the IEEE1394 port of the switcher processor, to carry out the
following operations.

Format: Format the hard disk.
Backup: Batch saving of files from frame memory to the hard disk.
Restore: Restoring frame memory from files saved on the hard disk.

Since image data saved in memory is lost when the system is powered off,
using an external hard disk drive allows required data to be preserved.

[Notes

* This function is only available on an MVS-8000A/8000G system.

¢ Only one hard disk drive can be connected to a single switcher processor.

* While the hard disk is being accessed, frame memory operations are not
possible.

During playback of a frame memory clip of the pair assigned to either of the
target FM selection buttons (see page 398), frame memory operations may
not be performed properly. Carry out frame memory operations after
stopping clip playback.

Consult your Sony service representative or sales representative about the
hard disk drives that can be connected.

Selecting the switcher

When the system is operating in Dual Simul mode, select the switcher on which
to carry out formatting, file saving, and file recall operations.

For details of Dual Simul mode, see “System Settings (System Config Menu)”
in Chapter 18 (Volume 3).

1 In the Frame Memory menu, select VF6 ‘External HDD’ and HF1
‘Format’ or HF2 ‘Backup/Restore.’

The Format menu or Backup/Restore menu appears.

2 In the region selection area (see page 114), press [SWR].

A popup window for selecting the switcher appears.

3 Press [SWR1] or [SWR2] to select the switcher.

External Hard Disk Drive Access



The button for the selected switcher lights.

You can select two switchers simultaneously. In this case, the last operated
button lights green, and the other lights amber. The menu shows the
information for the switcher lit green.

4 Press [OK].

Hard Disk Formatting

When you connect a hard disk drive for the first time, it is necessary to format
the hard disk. This partitions the disk, creating five logical drives (FMHDD1
to FMHDDS).

1 In the Frame Memory menu, select VF6 ‘External HDD’ and HF1
‘Format.’

The Format menu appears.
If in Dual Simul mode, select the switcher to operate (see page 416).

To get the hard disk drive information

In the button area press [Refresh Status].

The Model Name item shows the product information for the hard disk
drive.

2 Press [Format].

A popup window for confirming formatting appears.

Carrying out formatting erases any existing data on the hard disk.

3 Press [Yes].

This starts the hard disk formatting. A progress bar and numerical
indication appear to show the progress of the operation.

When the operation is completed, a popup window reading “Success!!”
appears.

4 Press [OK].

Saving Files

You can save all of the files from frame memory to the external hard disk drive.

External Hard Disk Drive Access
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Before carrying out this operation for the first time, it is necessary to format the
hard disk (see previous item, “Hard Disk Formatting”).

1 In the Frame Memory menu, select VF6 ‘External HDD’ and HF2
‘Backup/Restore.’

The Backup/Restore menu appears.
If in Dual Simul mode, select the switcher to operate (see page 416).

To get the hard disk drive information

Press [Refresh Status].

The Model Name item shows the product information for the hard disk
drive, and the names of directories within the logical drives.

2 Using any of the following methods, select a logical drive (FMHDD1 to
FMHDDYS).

¢ Press directly on the list to select.
* Press a button in the <Partition> group.
e Turn the knob.

Knob |Parameter |Adjustment Setting values

1 Partition Logical drive selection 1to5

3 Press [Backup].

A popup window for confirming file saving appears.

When you save the files, all of the saved files in the logical drive is erased
immediately before the saving operations.

4 Press [Yes].

This starts the file saving operation. If there is no directory in the logical

drive, a directory is automatically created, and the files are saved within it.
A progress bar and numerical indication appear to show the progress of the
operation.

When the operation is completed, a popup window reading “Completed.”
appears.

5 Press [OK].

To rename a directory
Select a directory in the list, and in the button area press [Rename].

External Hard Disk Drive Access




In the keyboard window that appears, enter the new directory name, and press
[Enter]. The name of a directory is limited to eight characters.

The following names cannot be used:

CON, PRN, AUX, CLOCK$, NUL, COMO, COM1, COM2, COM3,
COM4, COMS5, COM6, COM7, COMS, COM9
LPTO, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPTS, LPT9

Recalling Files

You can recall all of the saved files on the hard disk drive into frame memory.

1

Carry out steps 1 and 2 of the procedure “Saving Files” (page 417).

It is not possible to select a directory (logical drive) on which files are not
saved.

Press [Restore].

A popup window for confirming file recall appears.

When you recall the files, any existing data in frame memory is lost
immediately before the recalling operations.

Press [Yes].

This starts the file recall operation. A progress bar and numerical
indication appear to show the progress of the operation.

When the operation is completed, a popup window reading “Completed.”
appears.

Press [OK].

External Hard Disk Drive Access
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Color Background

The dedicated generators generate color signals, and these can be used as color
backgrounds in video effects.

Color background selection
There are two color backgrounds, color background 1 and color background 2,
which you use by assigning to cross-point buttons.

Color combinations (“color mix”)

The color generators can output the result of combining two colors, which are
color 1 and color 2.

Using a pattern from a dedicated pattern generator, color 1 and color 2 can be
combined in the boundary region, forming a color gradation. This is referred to
in the menu system as “color mix.”

You can also apply modifiers to the selected pattern.

When the “color mix” function is not used, the result is a flat color, and color
1 is always output.

You carry out color background settings in the Color Bkgd menu. This section
describes the settings menu for color background 1 as an example.

Color Background Settings Menu

Accessing the Color Bkgd1 menu

Use either of the following operations.

* In the menu control block, select the top menu selection button [COLOR
BKGD], and press VF1 ‘Color Bkgdl1.’

* Press a cross-point button assigned to color background 1 twice in rapid
succession.

The above operation displays the Color Bkgd1 menu.

Basic Color Background Setting Operations

Making a single-color matte (Flat Color)

If you are not using the “color mix” function to combine two colors, use the
following procedure.

Color Background



1 In the <Matte> group of the Color Bkgd 1 menu, press [Flat Color], turning

it on.

You can now adjust color 1.

2 Set the following parameters.

Knob | Parameter Adjustment Setting values
1 Luminance Luminance 0.00 to 100.00
Saturation Saturation 0.00 to 100.00
Hue Hue 359.99 to 0.00

Making a color combination (color mix)

To combine color 1 and color 2, use the following procedure.

1 In the <Matte> group of the Color Bkgd1 menu, press [Mix Color], turning

it on.

2 Set the following parameters as required.

Knob |Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Degree of softening of edge 0.00 to 100.00
5 Pattern Pattern number 110249

a) The patterns are the same as for a standard wipe. See “Wipe Pattern List” (page 497).

You can also carry out the pattern selection by pressing the [Mix Ptn
Select] button, to display the Mix Ptn Select menu. Select any pattern

appearing in the Mix Ptn Select menu (standard wipe patterns 1 to 24), and

you can then adjust the following parameters.

Knob | Parameter |Adjustment Setting values
1 Size Pattern size 0.00 to 100.00
2 Soft Edge softness 0.00 to 100.00

3 To adjust color 1, set [Color 1] on, and to adjust color 2 set [Color 2] on,

then adjust the parameters.

Knob | Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00

Color Background
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Color Background

Knob | Parameter

Adjustment

Setting values

3 Hue

Hue

359.99 to 0.00

If required, set the pattern modifiers.

* When turning [Position] on and setting the pattern position

Knob | Parameter |Adjustment Setting values
1 Position H Horizontal position ~200.00 to +200.00 &
2 Position V Vertical position ~200.00 to +200.00 &

a) See page 290.

¢ When turning [Multi] on and using replications of the same pattern

Knob |Parameter |Adjustment Setting values

1 H Multi Number of repetitions of pattern 1to 63
horizontally

2 V Multi Number of repetitions of pattern 1to 63
vertically

3 Invert Type | Replication layout 1t04 9

a) See page 295.

* When turning [Aspect] on and setting the aspect ratio of the pattern

Knob | Parameter

Adjustment

Setting values

1 Aspect

Aspect ratio

-100.00 to +100.00 2

a) See page 294.

* When turning [Pairing] on and making a wipe pattern like a

Venetian blind
Knob | Parameter |Adjustment Setting values
1 Width Width of the slits 1 to 128 (integer)

* When turning [Angle] on in the <Rotation> group and slanting the

pattern
Knob |Parameter |Adjustment Setting values
1 Angle Angle of pattern rotation ~100.00 to +100.00 @

a) See page 292.




* When turning [Speed] on in the <Rotation> group and rotating the
pattern at a constant rate

Knob | Parameter |Adjustment Setting values

1 Speed Rotation rate of pattern —100.00 to +100.00 &

a) See page 293.

* When selecting H (horizontal) or V (vertical) in the <Modulation>
group and applying waviness to the pattern
(The modulation is always a sine wave.)

When using 1080PsF mode in an HD system, the modulation function is
not available.

Knob | Parameter |Adjustment Setting values
1 Amplitude Amplitude of modulation 0.00 to 100.00
2 Frequency Frequency of modulation 0.00 to 100.00
3 Speed Speed of waves —100.00 to +100.00

To interchange color 1 and color 2, press the [Color Invert] button, turning
it on.

Color Background
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Copy and Swap

You can copy and swap the settings among the M/E-1 to M/E-3, and PGM/PST
banks or between keyers.

The following settings can be copied or swapped.

e QOpverall settings for the M/E-1 to M/E-3, and PGM/PST banks

* Keyer settings

* Wipe settings in a transition control block

* Wipe settings in an independent key transition control block

* DME wipe settings in a transition control block

DME wipe settings in an independent key transition control block
Matte data (color 1, color 2, and how to compose them)

Color settings

DME channel settings

Format converter input settings (copy only)

Format converter output settings (copy only)

You can carry out copy operations with a simple button operation. Swap
operations, and copy operations on DME data can only be done with a menu
operation.

M/E copy and M/E swap

You can copy and swap the overall bank settings among the M/E-1 to M/E-3,
and PGM/PST banks.

Target bank | Target data

M/E-1 Bank settings excluding the following data items:
M/E-2 ¢ Setup data

M/E-3 Flexi Pad settings

PGM/PST Snapshots

* Keyframe effects
¢ Key snapshots
* Key memory

If a DME is being used on the source M/E bank, then if for example there are
insufficient DME channels, it may not be possible to select the DME.
There are no such restrictions on a swap.

Keyer copy and keyer swap

You can carry out copy and swap operations among the 16 keyers listed in the
following table.

426 Copy and Swap



Target bank

Target keyer

Target data

M/E-1 Keys 1 to 4

M/E-2

M/E-3

PGM/PST Downstream keys 1 to 4

Key settings excluding the following data
items:

¢ Setup data

¢ Key snapshots

* Key memory

If a DME is being used on the source keyer for a copy or either keyer for a

swap, then if for example there are insufficient DME channels, or the limit on
using DME channels within an M/E bank is exceeded, it may not be possible
to select the DME.

Wipe copy and wipe swap

You can copy and swap the wipe settings among the banks listed in the
following table.

Target bank

Target data

M/E-1
M/E-2
M/E-3
PGM/PST

Wipe settings.

It is not, however, possible to carry out copy or swap involving
independent key transition wipe settings.

Wipe copy and wipe swap in the independent key transition
control block

You can copy and swap the wipe settings among the 16 keyers listed in the
following table.

Target bank

Target keyer

Target data

M/E-1 Keys 1 to 4

M/E-2

M/E-3

PGM/PST Downstream keys 1 to 4

Wipe settings in the independent key
transition control block.

DME wipe copy and DME wipe swap

You can copy and swap the DME wipe settings among the banks listed in the
following table.

Target bank

Target data

M/E-1
M/E-2
M/E-3
PGM/PST

DME wipe settings.

It is not, however, possible to carry out copy or swap involving
independent key transition DME wipe settings.

Copy and Swap

427

sBumes J8yi0 pue ‘demg pue Ado) ‘spunoibyoeg Joj0) g Jsideyn



sbumas JayiQ pue ‘demg pue Ado) ‘spunoibyoeg 10j0) g Jsidey)n

DME wipe copy and DME wipe swap in the independent key
transition control block
You can copy and swap the DME wipe settings among the 16 keyers listed in

the following table.

Target bank | Target keyer Target data

M/E-1 Keys 1 to 4 DME wipe settings in the independent
M/E-2 key transition control block.

M/E-3

PGM/PST Downstream keys 1 to 4

Matte data copy and swap

You can copy or swap the matte data among the 38 color generators listed in
the following table.

Target bank Target keyer and data

M/E-1 * Keys1to4 ¢ Matte data for key fill
M/E-2 * Downstream keys 1 to 4 * Matte data for key edge fill
M/E-3

PGM/PST Matte data for wipe border edge

Color background | Matte data for color background 1
* Matte data for color background 2

Color data copy and swap

You can copy or swap the color data among the 152 color generators listed in
the following table.

Target bank Target keyer and data

M/E-1 ¢ Keys1to4 * Colors 1 and 2 for key fill
M/E-2 e Downstream keys 1 to 4 e Colors 1 and 2 for key edge fill
M/E-3 e “Zabton” color data

PGM/PST

Colors 1 and 2 for wipe border

Color data for preset color mix

Colors 1 and 2 for color background 1
¢ Colors 1 and 2 for color background 2

Color background

Frame memory * FM1 color
e FM2 color

DME ch1toch8 | Background

* Border

e Sepia

* Light

* Shade

* Drop shadow (other than DME ch4 and DME ch8)

Trail
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DME channel copy and swap

You can copy and swap the channel data among DME channels 1 to 4 or DME
channels 5 to 8.

It is not possible to copy or swap the channel data between DME channels 1 to
4 and DME channels 5 to 8.

Copying format converter data

On the MVS-8000G, you can copy data from one format converter input to
another or from one output to another.

Copy and Swap
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Copy and Swap Menu Operations

Accessing the Copy/Swap menu

In the menu operation section top menu selection buttons, press the [Copy/
Swap] button, then press VF1 ‘Copy/Swap.” The Copy/Swap menu appears.
Here a copy/swap operation on wipe data is described by way of example,
using the Copy/Swap >Wipe menu, but the same general procedure applies to
all of the following menus.

M/E: Copying and swapping M/E data

Key: Copying and swapping key data

Wipe: Copying and swapping wipe data

DME Wipe: Copying and swapping DME wipe data

Matte: Copying and swapping matte data

Color: Copying and swapping color data

DME: Copying and swapping data by DME channels

Format Converter: Copying format converter data (for MVS-8000G only)

For details, see “Settings Relating to Signal Inputs (Input Menu)” in Chapter
21 (Volume 3).

For an overview of the concepts involved, see “Copy and Swap” (page 426).
For details of color corrector copy and swap, see Chapter 9 “Color
Corrector” (page 445).

Copying and swapping wipe data
As an example, to copy or swap wipe data, use the following procedure.
1 In the Copy/Swap menu, select HF3 “Wipe.’

The Copy/Swap >Wipe menu appears.
The status area shows lists for the copy/swap source on the left, and the
copy/swap destination on the right.

2 In the <Data Select> group, select either of the following.

Wipe: The operation applies to wipes in the transition control block.
Key Wipe: The operation applies to wipes in the independent key
transition control block.

Copy and Swap Operations



3 Using any of the following methods, select the data to be copied or

swapped.

¢ Press directly on the list in the status area.
* Press the arrow keys to scroll the reverse video cursor.
e Turn the knobs to make the setting.

Knob Parameter Adjustment Setting values

1 Left No Select data for copy/swap | 1 g 4 @)
source 11016

2 Right No Select data for copy/swap | 1 to 4 @
destination 11016

a) Transition control block wipe data
b) Independent key transition control block wipe data

For details of the data affected, see “Copy and Swap” (page 426).

4 To copy, press [Copy], and to swap, press [Swap].

This carries out the copy or swap.

To undo a copy or swap

Press [Undo], to return to the state before the copy or swap was carried out.

Copy by Button Operation

You can carry out the following copy operations by a simple button operation.

* M/E copy
* Keyer copy
* Wipe copy

* DME wipe copy

On the CCP-6224/6324, it is not possible to carry out a copy by button

operation.

Basic button operation

The basic button operation is to hold down the copy source button, then press

the destination button.
You can undo the last operation using [Undo] in the menu (see page 431).

Copy and Swap Operations
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M/E copy button operation

In the Flexi Pad control block of each M/E bank, use the [SNAPSHOT] button.

To copy from M/E-1 to M/E-2
In the M/E-1 Flexi Pad control block, hold down the [SNAPSHOT] button,
then press the [SNAPSHOT] button in the M/E-2 Flexi Pad control block.

Keyer copy button operation

To specify the copy source, use the key delegation buttons in the key control
block, and to specify the copy destination, use the key delegation buttons in the
independent key transition control block.

To copy from M/E-1 key 1 to M/E-2 key 2

In the key control block M/E delegation buttons, press [M/E1], turning it on,
then hold down the [KEY 1] button, and in the M/E-2 independent key
transition control block, press the [KEY?2] button.

Wipe copy button operation

Use the [WIPE] button in the Flexi Pad control block of each M/E bank.

To copy the M/E-1 wipe to the M/E-2 wipe
In the M/E-1 Flexi Pad control block, hold down the [WIPE] button, then press
the [WIPE] button in the M/E-2 Flexi Pad control block.

DME wipe copy button operation

Use the [DME] button in the Flexi Pad control block of each M/E bank.

To copy the M/E-1 DME wipe to the M/E-2 DME wipe
In the M/E-1 Flexi Pad control block, hold down the [DME] button, then press
the [DME] button in the M/E-2 Flexi Pad control block.

Copy and Swap Operations



Misc Menu Operations

In the Misc menu, you can carry out the following operations.

* Enabling and disabling operation from an external device, System Manager,
or an editing keyboard.

* Enabling and disabling side flags on the background bus of each of the M/E-
1 to M/E-3 and PGM/PST banks.

For the side flag function, see “Side Flags” (page 468).

» Switching the safe title function on or off for each switcher output.

* Displaying the transition rate, independent key transition rate, and fade-to-
black transition rate for each of the M/E and PGM/PST banks, and changing
the settings.

Port Settings for Control From an External Device

Enabling or disabling control from an external device

1 In the menu control block, press the top menu selection button [MISC],
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears with the status area
showing the settings of the following ports.

» Switcher Remote 1 to Remote 4 ports (RS-422A, D-sub 9-pin)

» Switcher GPI port (parallel, 25-pin)

* DME1/DME2 Editor ports (RS-422A, D-sub 9-pin)
 DME1/DME2 GPI ports (parallel, 25-pin)

2 In the <Switcher> or <DME> group, press on the name of the port for
which you want to disable control from an external device, turning it off.
To re-enable control for the port, press on its name once more.

For the AUX bus operation from the Remote 1 to Remote 4 ports of the
switcher, the setting (Enable/Disable/Manual) in the Setup menu takes
precedence. Only when the setting is “Manual,” the settings made in the
Port Enable menu apply.

For details, see “Interfacing With External Devices (Device Interface
Menu)” in Chapter 19 (Volume 3).
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DME override

1

In the menu control block, press the top menu selection button [MISC],
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

In the <DME Override> group, select the DME override mode.

DME Override: When a switcher snapshot or effect using a DME is
recalled, forcibly select the DME that was used when saving.

On Air Protect: The operation is the same as the DME override function,
except that a DME being used by an M/E bank or P/P bank that is on
air will not be forcibly selected.

If effects using the same DME channel are selected simultaneously in two
or more regions, the DME is selected with the order of precedence P/P >M/
El >M/E2 >M/E3.

Enabling or disabling control from System Manager

By installing the BZPS-8000 System Management Software (System
Manager), you can use a computer connected on a network for management of
some switcher data and control operations.

To enable or disable this function, use the following procedure.

1

In the menu control block, press the top menu selection button [MISC],
then select VF1 ‘Enable’ and HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

Press [System Manager].

Each time you press the button toggles between enable and disable.

Editing Keyboard Settings

The following operations are only possible when a license for the BZS-8050
Editing Control Software is activated. For details of license registration, see
“Installation and Device Setup (Install/Unit Config Menu)” in Chapter 18
(Volume 3).

Misc Menu Operations



Enabling or disabling control from the editing keyboard

1

2

In the menu control block, press the top menu selection button [MISC],
then select VF1 ‘Enable’ and HF2 ‘Plug-In Editor.’

The Misc >Enable >Plug-In Editor menu appears.

In the <Control From Plug-In Editor> group, press [Editor Enable].

Each time you press the button toggles between enable and disable.

To enable control of the preview bus only

When control from the editing keyboard is disabled (when [Editor Enable] is
set to Disable), to enable control of the preview bus only, press [PVW Bus
Enable] in the <Control From Plug-In Editor> group.

Safe Title Settings

Switching the safe title function on or off

1

In the menu control block, press the top menu selection button [MISC] and
select VF2 ‘Safe Title.’

The Misc >Safe Title menu appears.
Using any of the following methods, select the signal to which the settings
apply.

* Directly press the list in the status area.
* Press the arrow keys to scroll the reverse video cursor.
e Turn the knob to make the setting.

Knob | Parameter Adjustment Setting values
1 Output Signal to which the settings 1to 48
apply

« It is not possible to change the setting for the output for which the safe
title is set off in a Setup menu.

* The safe title function cannot be used for output signals for which
through mode is set to Enable in a Setup menu.

For more information about the Setup menu settings referred to above, see
“Signal Input Settings (Input Menu)” and “Signal Output Settings (Output
Menu)” in Chapter 20 (Volume 3).

Misc Menu Operations
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3 Press [Safe Title] to set it on or off.

Displaying a List of Transition Rates and Changing the
Settings

In the Transition menu, for each bank you can display a list of the M/E (or
PGM/PST) transition rates and independent key (or DSK) transition rates, and
change the settings.

These settings are linked to the other transition rate setting operations.

You can also display and set the fade-to-black transition rate.

Displaying the Transition menu

In the menu control block, press the top menu selection button [MISC], then
select VF3 ‘Transition.’
The Misc >Transition menu appears.

About the Transition menu display

The display of the independent key transition rate in the Misc >Transition
menu depends on the selection in the <Key Transition> group of the
Engineering Setup >Switcher >Transition menu for each of the M/E and PGM/
PST banks.

When [Same] (On direction and Off direction settings the same) is selected
in the <Key Transition> group: Only “Key” (or “DSK” in the PGM/PST
bank) appears.

When [Independ] (On direction and Off direction settings independent) is
selected in the <Key Transition> group: “Key(On)” and “Key(Off)”
each appear. In the case of the PGM/PST bank, “DSK(On)” and
“DSK(Off)” appear.

For more details, see “Settings Relating to Video Switching (Transition
Menu)” in Chapter 20 (Volume 3).

Setting the transition rate in the Transition menu

For example, to make the settings for the M/E-1 bank, use the following
procedure.

To set the M/E transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press
[Transition].
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2 Turn the knob to set the number of frames.

Knob

Parameter

Adjustment

Setting values

1

Transition Rate

Transition rate

0 to 999 (frames)

When a clip transition is selected as the transition type, it is not possible to

change the transition rate in this menu.

To set the independent key transition rate

1 In the <M/E-1 Transition Rate> group of the Misc >Transition menu, press

[Key].

To set the key On direction or Off direction independently, press Key(On)

or Key(Off).

2 Turn the knobs to set the number of frames.

Knob

Parameter

Adjustment

Setting values

1

Key1 Trans Rate

Key 1 transition rate

0 to 999 (frames)

Key2 Trans Rate

Key 2 transition rate

0 to 999 (frames)

Key3 Trans Rate

Key 3 transition rate

0 to 999 (frames)

2
3
4

Key4 Trans Rate

Key 4 transition rate

0 to 999 (frames)

To set the fade-to-black transition rate in the Transition menu

1 In the Misc >Transition menu, press [FTB].

2 Turn the knob to set the number of frames.

Knob

Parameter

Adjustment

Setting values

1

Transition Rate

Transition rate

0 to 999 (frames)

Misc Menu Operations
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AUX Bus Settings

Making video process settings for an AUX bus

1 In the Aux/Mon >Aux Bus menu, using any of the following methods,
select the AUX bus to which the settings apply.

* Directly press the list in the status area.
* Press the arrow keys to scroll the reverse video cursor.
e Turn the knob to make the setting.

Knob

Parameter

Adjustment

Setting values

1

AUX Bus

AUX bus selection

1to0 48

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain —200.00 to +200.00
2 Y Gain Luminance signal gain —200.00 to +200.00
3 C Gain Chrominance signal gain | —200.00 to +200.00
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level Black level —7.31 to +109.59

To return adjustment values to their defaults, press [Unity].

AUX Menu Operations




Status Menu

The Status menu shows the following information.
* Operating status of the DME

Viewing the DME operating status

To view the DME operating status, press the top menu selection button
[STATS] in the menu control block.
This selects VF1 ‘DME Status’ and the Status menu appears.

Page Status Effectt: 2 (2) Free KF: 498
3311 > DME Status M/E-1 KF#2/2 01:00: 01: 00

DME Stalus

DME Bank Key Type

DME status display

For each DME channel, you can see how the DME is being used in the
corresponding operation block.

The display background color also indicates the following differences in the
way in which a DME is being used.

Blue: The DME is currently being used in other than the final program output.
Red: The DME is currently being used in the final program output.

Status Menu
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Router Control Menu Operations

Using the Router >Router Control >Router Control menu, you can carry out
router switching operations.

Checking the List of Inputs for Each Destination

You can check the list of signals currently input for each destination.

In the menu control block, press the top menu selection button [RTR], then
select VF1 ‘Router Control’ and HF1 ‘Router Control.’

The following menu appears, and the left side of the status area shows a list for
destination assignments.

Dest Bin # Protect Desl Name Sre Name I A Lvl Bin # Level Assign
10 OuUT|0010 1
11 ouTj0011
12 ouT|0012

OUT[0013

ouT|0014
15 QUT0015
16 OUT|0016
] [ e |
18 OouT|0018

oOuT|0018

QuT|0020

OUT|0021

OuT|0022

OuTj0023

0uUT|0024

Level Butlon No

Change evel 1 Level 2 Level 3 Level 4
Xpl

If in the Assign >RTR Mode Setting menu, [Inhibit] is set to On for a
destination, the corresponding line appears in gray. Also, if [PROT] (protect)
is set to ON for a source, using a BKSR3xxx or R1xxx series Router remote
control, a padlock icon appears.

The right side of the status area shows the level assignment status to the Level
1 to Level 4 buttons.

Selecting the level

In the Level Button No group at the lower right in the above illustration, press
the selected level for switching.
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Switching the Source for Each Destination

You can switch the source for each destination with a menu operation.

For the assignment of destinations and sources to buttons, use the Setup
>Panel >Aux Assign >RTR Mode Setting menu. For details, refer to “Using

the Auxiliary Bus Control Block for Router Control” in Chapter 19 (Volume 3).

1

Press [Change Xpt].

The Router >Router Control >Router Control >Change Xpt menu appears.

Destination Select buttons appear in groups of 16.
Source Select buttons appear by group (maximum 24 buttons).

Press one of the Destination Select buttons, to select the destination for
which you want to switch the source.

To change the group
Press one of the [1-16], [17-32], [33-48], and [49-64] buttons.

Press one of the Source Select buttons, to select the source you want to
switch.

To change the group
Press one of the [1-24], [25-48], ... [97-120], and [121-128] buttons.

Router Control Menu Operations
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Video Process

The term “video process” is applied to adjustments to the luminance and hue
of the input video signal.

There are two types of adjustment, depending on the application:

* Adjustment of an individual primary input signal

* Image effects on a particular bus

These types of adjustment may be carried out independently. However, since
they are implemented by the same hardware, if the same signal is subjected to
processing twice, there may be limitations on the range of effects obtained in
the final result.

Video Process Adjustments of a Primary Input Signal

For each of primary inputs 1 to 80, you can switch video process adjustments
on or off, and can adjust the parameters (Video Gain, Y Gain, C Gain, Hue
Delay, and Black Level) in the Setup menu. The adjustments do not, however,
apply to the output video on the MON (monitor) bus.

For details of the settings, see “Signal Input Settings” in Chapter 20 (Volume
3).

Video Process Adjustments on a Particular Bus

Buses to which the adjustments apply
For each of the following buses, you can switch video process adjustments on
or off, and adjust the parameters.
* Following buses in the M/E-1 to M/E-3, and PGM/PST banks
— Key fill buses for keys 1 to 4
— Background A and background B buses
— Utility 1 and utility 2 buses
* Frame memory source 1 and frame memory source 2 buses
e Aux 1 to 48 buses
These settings also apply to keyframes and snapshots.

Video Process



Making the adjustments
Adjust VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, and HUE DELAY
in the following menus.

Utility 1 and 2 buses

PGM/PST bank Key fill buses for PGM/PST menu page 233
DSK1 to DSK4
Background A and B | Video Process menu page 444
buses

Utility 1 and 2 buses

Frame memory source 1 and 2 buses Frame Memory menu page 378

Aux 1 to 48 buses AUX/MON menu page 438

Video Process Memory

When using video process adjustments for an image effect on a bus, this
function saves the final values for each pair number for the signals. The video
process on/off setting is not saved.
When you change the adjustments the values are automatically saved, and
these last values are recalled when the pair number is selected.
In other words, by switching video process memory on, regardless of the video
process information for each bus, you can carry out video process adjustments
for each input signal.
The parameters saved are as follows.

VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, HUE DELAY

Switch the video process memory on or off in the Setup menu.

For details of setting operations, see “Settings Relating to Keys, Wipes, Frame
Memory and Color Correction (Key/Wipe/FM/CCR Menu)” in Chapter 20
(Volume 3).

Video Process
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Applicable bus Menu used for operation | See page
M/E-1 to M/E-3 Key fill buses for keys | M/E-1 to M/E-3 menus page 233 —
banks 1to 4 —
Background A and B | Video Process menu page 444
buses
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Video Process Settings

This section describes operations on the M/E-1 to M/E-3, and PGM/PST
background A and B buses, and utility buses 1 and 2.

For these operations, use the Misc >Video Process menu in the respective
operating bank.

Forvideo process settings on other buses, see the following.

e Settings for a particular input signal: “Signal input settings” in Chapter 20
(Volume 3)

* Key fill bus settings: “Video Processing” (page 233)

o Settings for frame memory source buses 1 and 2: “Setting video processing”
(page 378)

o Settings for Aux 1 to 48 buses: “Making video process settings for an AUX
bus” (page 438)

* Overview of video process: “Video Process” (page 442)

This section describes an example on the background A bus of the M/E-1 bank.

For the background B bus or utility bus 1 or 2, make the adjustment with a
similar procedure.

Making video process settings for each bus

1 In the menu control block, press the top menu selection button [M/E1] and
select VF7 ‘Misc’ and HF2 “Video Process.’

2 In the <Bkgd-A> group, press [Video Process], turning it on.

3 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal gain —200.00 to +200.00
2 Y Gain Luminance signal gain —200.00 to +200.00
3 C Gain Chrominance signal gain | —200.00 to +200.00
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level Black level —7.31to +109.59

To return the parameter settings to the defaults, press [Unity] in the
<Bkgd-A> group.

444 | video Process Settings
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Preparations

Preparations

The color corrector enables video signal color correction (black balance/white
balance adjustment, gamma correction, knee correction, etc.).

Note

To use the color corrector on the MVS-8000A, the MKS-8420M Color
Corrector Board is required. To use the color corrector on the MVS-8000G
requires the MKS-8442G Frame Memory Board and BZS-8420 Color
Corrector Software. To use the software, you are required to input an install
key.

For the method of inputting an install key, see “Installation and Device Setup
(Install/Unit Config Menu)” in Chapter 18 (Volume 3).

Note on using a format other than 720P
When using the color corrector on a 4M/E system or a 3M/E system with
a board with multi-format support: It is not possible to use an M/E
reentry signal in an overlaid manner on the key bus or utility 1 bus.
Example 1: When M/E-1 is selected on the M/E-2 background A bus (or
background B bus, key bus, utility 1 bus, or utility 2 bus), it is not
possible to select M/E-2 on the M/E-3 key bus or utility 1 bus.
Example 2: When M/E-2 is selected on the M/E-3 background A bus (or
background B bus, key bus, utility 1 bus, or utility 2 bus), it is not
possible to select M/E-3 on the PGM/PST key bus or utility 1 bus.
In the case of a 3M/E system with a board with multi-format support, by setting
bit 1 of switch S101 on the CA-44 or CA-54 board to the “Off” position, you
can remove this restriction. Note, however, that, in the case of 4801 or 5764, this
slightly reduces the input window.

Note on using 720P format
The following restrictions apply depending on the system configuration.

Restriction 1: M/E reentry signals cannot be selected on the key bus and utility
1 bus. For example, you cannot select M/E-1 on the M/E-2 key bus or
utility 1 bus.

Restriction 2: It is not possible to use an M/E reentry signal in an overlaid
manner on the key bus or utility 1 bus.

Example 1: When M/E-1 is selected on the M/E-2 background A bus (or
background B bus, key bus, utility 1 bus, or utility 2 bus), it is not
possible to select M/E-2 on the M/E-3 key bus or utility 1 bus.



Example 2: When M/E-2 is selected on the M/E-3 background A bus (or
background B bus, key bus, utility 1 bus, or utility 2 bus), it is not
possible to select M/E-3 on the PGM/PST key bus or utility 1 bus.

* When using the color corrector on a 3M/E system with a board with
multi-format support

The above restriction 1 applies.

By setting bit 1 of switch S101 on the CA-44 or CA-54 board to the “Off”

position, you can remove this restriction for M/E reentry signals unless they are

overlaid triply or more. Note, however, that this slightly reduces the input

window.

* When using the color corrector on a 3M/E system with an HD dedicated
board
The above restriction 2 applies.

* When not using the color corrector on a 3M/E system with a board with
multi-format support

The above restriction 2 applies.

By setting bit 1 of switch S101 on the CA-44 or CA-54 board to the “Off”

position, you can remove this restriction. Note, however, that this slightly

reduces the input window.

* When using the color corrector on a 4M/E system
The above restriction 1 applies.

* When not using the color corrector on a 4M/E system
The above restriction 2 applies.

Assigning the color corrector input buses to AUX delegation

buttons

There are two inputs for capturing material to the color corrector: the CCR1
bus and the CCR2 bus.

For details of the input assignment operation, see “Auxiliary Bus Control
Block Settings (Aux Assign Menu)” in Chapter 19 (Volume 3).

Selecting the color correction input signal

After assigning CCR1 and CCR2 to AUX buses, use the following procedure.

1 Press the AUX delegation buttons assigned to CCR1 (or CCR2).

2 In the cross-point button row, select the signal to which you want to apply
color correction.

Preparations
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Selecting

The signals you can select on the CCR1 and CCR2 buses are limited to the
primary inputs and frame memory outputs (FM1 to FMS8). However you
can make all the internal signals of the switcher selectable by a setting in

the Setup menu.

For details, see “Selecting the Bank to Make the Settings” in Chapter 20
(Volume 3).

the color corrector output signal

By assigning the signal output from the color corrector to a cross-point button,
you can make that signal available on that button.

For details of the assignment process, see “Cross-Point Settings (Xpt Assign
Menu)” in Chapter 19 (Volume 3).

Accessing the CCR menu

Preparations

For color correction operations, use the CCR menu.

To access the CCR menu, in the menu control block, press the top menu
selection button [CCR].

The following description uses CCR1 as an example. To apply color correction
to CCR2, replace VF1 ‘CCR1’ by VF2 ‘CCR2,” and follow the same

procedure.



Overall Color Corrector Operations

Enabling Color Corrector

To enable the functions of color corrector 1, for example, use the following
procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and any HF.

2 In the <CCR> group, press [CCR], turning it on.

This enables the functions of color corrector 1.

Returning all color corrector settings to their defaults

1 In the <CCR> group, press [Unity].
A confirmation message appears.
2 Press [Yes].

This returns all color corrector settings to their defaults, whether [CCR] is
on or off.

Copy and Swap Operations

Copying color corrector data

1 In the CCR menu, press VF3 ‘Copy/Swap.’

The Copy/Swap menu appears.
The status area shows a copy source list on the left and a copy destination
list on the right.

2 Using any of the following methods, select the copy source data and copy
destination data.

* Press directly on the list in the status area.
* Press the arrow keys to scroll the reverse video cursor.
e Turn the knobs.

Overall Color Corrector Operations 449
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Knob Parameter Adjustment Setting values
1 Left No Select copy source data |1 or2
2 Right No Select copy destination 1or2

data

3 Press [Copy].

This carries out the copy.

Swapping color corrector data
Refer to the procedure described in the previous item “Copying color corrector

data.” In step 3, press [Swap] instead of [Copy].

To undo copy or swap

In the Copy/Swap menu, press [Undo].
The state before carrying out the copy or swap is restored.

Overall Color Corrector Operations




Color Corrector Functions

This section describes the color corrector functions.
For each of the following operations, it is possible to copy or swap data
between two color correctors (CCR1 and CCR2).

Input Video Processing Operations

Carry out the following corrections to a YUV signal before conversion to an
RGB signal.

* Opverall gain adjustment of the video signal

* Gain adjustment of the Y signal

* Gain adjustment of the C signal

* Hue delay

* Black level adjustment

To apply input video processing effects, use the following procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and HF1 ‘Input Process.’

The Input Process menu appears.
2 In the <Input Process> group, press [Input Process], turning it on.

3 Adjust the following parameters.

Knob | Parameter | Adjustment Setting values

1 Video Gain | Video signal gain —200.00 to +200.00
2 Y Gain Y signal gain —200.00 to +200.00
3 C Gain Chrominance signal gain —200.00 to +200.00
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level | Black level -116.90 to +116.90

To return the parameters to their default settings
Press [Unity] in the <Input Process> group.

Color Corrector Functions 451
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Primary Color Correction Operations

Carry out the following corrections to each of the R, G, and B signals.

Black balance adjustment: setting the output level for a 0% level input signal.

White balance adjustment: setting the output level for a 100% level input
signal.

Gamma correction: adjusting the curvature of the gamma curve.

Knee correction: adjusting the position of the maximum point of the gamma

curve.
Output level White balance adjustment Output level
A
i
1
A Input level Input level
i Knee correction
v

Black balance adjustment
= Unadjusted signal

—— Adjusted signal

It is also possible to mask part of the region to be corrected.

Applying primary color correction
1 In the CCR menu, press VF1 ‘CCR1’ and HF2 ‘Primary CCR.’
The Primary CCR menu appears.
2 In the <Primary CCR> group, press [Primary CCR], turning it on.

3 In the <Primary CCR Adjust> group, select the setting item.

Black: black balance adjustment
White: white balance adjustment
Gamma: gamma correction
Knee: knee correction

452 Color Corrector Functions



4 Depending on the selection in step 3, adjust the following parameters.

¢ When Black or Gamma is selected

Knob |Parameter |Adjustment Setting values

1 Red Red signal adjustment —100.00 to +100.00
2 Green Green signal adjustment —100.00 to +100.00
3 Blue Blue signal adjustment —100.00 to +100.00
4 All Simultaneous RGB adjustment Red value is shown

¢ When White is selected

* When Knee is selected

Knob |Parameter |Adjustment Setting values
1 Red Red signal adjustment 20.00 to 75.00
2 Green Green signal gain 20.00 to 75.00
3 Blue Blue signal gain 20.00 to 75.00
4 All Simultaneous RGB adjustment Red value is shown

To return the parameters to their default settings
In the <Primary CCR> group, press [Unity].

Masking a part of the primary color correction

Here the procedure for mask 1 operation is described by way of example. You

can carry out mask 2 operation in a similar way.

1 In the <Primary Mask> group of the Primary CCR menu, press [Mask1],

2

turning it on.

Press [Mask1 Adjust].

The Mask1 Adjust menu appears.

In the <Mask Source> group, select the mask source.

Box: signal from dedicated box generator
Pattern: signal from dedicated pattern generator

Color Corrector Functions
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Knob | Parameter |Adjustment Setting values

1 Red Red signal adjustment 0.00 to 200.00 —
2 Green Green signal adjustment 0.00 to 200.00 -—-
3 Blue Blue signal adjustment 0.00 to 200.00 e
4 All Simultaneous RGB adjustment Red value is shown
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4 Depending on the selection in step 3, adjust the following parameters.

¢ When Box is selected

Knob | Parameter | Adjustment Setting values

1 Top Top position —100.00 to +100.00
2 Left Left position —100.00 to +100.00
3 Right Right position —100.00 to +100.00
4 Bottom Bottom position —100.00 to +100.00
5 Soft Degree of softness of box 0.00 to 100.00
* When Pattern is selected

Knob | Parameter |Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softness of pattern 0.00 to 100.00

edge
5 Pattern Pattern number 1to 24

For the pattern selection, you can also press [Mask Ptn Select] in the
Mask1 Adjust menu, then use the Mask Ptn Select menu.

Press any of the displayed patterns (standard wipe patterns 1 to 24) to
select it, then you can adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of softness of pattern 0.00 to 100.00
edge

5 When selecting the pattern as a mask source, set the pattern modifiers as
required.

* When turning [Position] on and setting the pattern position

Knob | Parameter | Adjustment Setting values
1 Position H Horizontal position —200.00 to +200.00 @
2 Position V Vertical position —200.00 to +200.00 @

a) See “Setting the wipe position (Positioner)” (page 290).

* When turning [Multi] on and replicating the same pattern

Knob

Parameter

Adjustment

Setting values

1

H Multi

Number of repetitions of pattern
horizontally

1to 63

Color Corrector Functions




Knob |Parameter |Adjustment Setting values

2 V Multi Number of repetitions of pattern 1to 63
vertically
3 Invert Type | Replication layout 1t04 2

a) See “Setting the wipe pattern replication (Multi)” (page 295).

* When turning [Aspect] on and setting the aspect ratio of the pattern

Knob |Parameter |Adjustment Setting values

1 Aspect aspect ratio —100.00 to +100.00 &

a) See “Setting the wipe pattern aspect ratio (Aspect ratio)” (page 294).

* When turning the [Angle] on in the <Rotation> group and slanting

the pattern
Knob | Parameter | Adjustment Setting values
1 Angle Angle of pattern rotation —100.00 to +100.00 &

a) See “Angle” (page 292).

* When turning [Speed] on in the <Rotation> group and rotating the
pattern at a fixed rate

Q
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Knob | Parameter |Adjustment Setting values

1 Speed Rotation rate of pattern —100.00 to +100.00 &

a) See “Speed” (page 293).

6 To invert the mask source, return to the Primary CCR menu and press
[Mask Invert], turning it on.

The mask function is common to the primary color correction, secondary color
correction luminance processing, and spot color adjustment functions. For
example, if in primary color correction you set mask 1 to a box, then in
secondary color correction set mask 1 to a pattern, this also changes the setting
in primary color correction to the pattern.

Color Corrector Functions 455
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Secondary Color Correction Operations

For the six colors R (red), G (green), B (blue), Y (yellow), C (cyan), and M
(magenta), adjust the luminance and saturation, and also the hue within a range
of £30 degrees of the center value for each color.

You can mask a part of the region to be corrected.

When spot color adjustment is enabled in the setup settings, this function is
disabled. On the MVS-8000G, secondary color correction and spot color
adjustment can be enabled at the same time.

For details, see “Switching the Color Correction Function” in Chapter 18
(Volume 3).

Applying secondary color correction

1 In the CCR menu, select VF1 ‘CCR1’ and HF3 ‘Secondary CCR.’

The Secondary CCR menu appears.
2 In the <Secondary CCR> group, press [Secondary CCR], turning it on.

3 In the <Secondary CCR Adjust> group, select the color for which you
want to make the setting.

4 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance —100.00 to +100.00
Saturation Saturation 0.00 to 200.00
Hue Delay Hue delay —180.00 to +180.00

To return the parameter settings to their default values
In the <Secondary CCR> group press [Unity].

Masking a part of the secondary color correction

In the <Secondary Mask> group, press [Mask1] or [Mask2], turning it on, then
carry out the same operation as described under “Masking a part of the primary
color correction” (page 453).
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RGB Clip Operations

For each of the R, G, and B signals, you can make dark clip and white clip
adjustments.

Making RGB clip adjustments

1 In the CCR menu, press VF1 ‘CCR1’ and HF4 ‘RGB Clip.’

The RGB Clip menu appears.
2 In the <RGB Clip> group, press [RGB Clip], turning it on.

3 In the <RGB Clip Adjust> group, select the item you want to adjust.

Dark: dark clip adjustment
White: white clip adjustment

4 Adjust the following parameters.

Knob | Parameter | Adjustment Setting values

1 Red Red signal adjustment -50.00 to +149.99 @
—49.99 to +150.00 ?)

2 Green Green signal adjustment -50.00 to +149.99 @
—49.99 to +150.00 ©)

3 Blue Blue signal adjustment —50.00 to +149.99 2
—49.99 to +150.00 ©)

4 All Simultaneous RGB adjustment Red value is shown

a) When Dark is selected
b) When White is selected

To return the parameters to their default settings
In the <RGB Clip> group, press [Unity].

Luminance Processing Operations

After converting a signal to which RGB color correction has been applied to a
YUV signal, divide the luminance levels into three regions, referred to as Dark,
Middle, and Bright, and apply video signal adjustments to these regions.
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Under Dark point Middle/Dark point Bright/Middle point Over Bright point

| Dark Middle Bright |
>

Input signal

luminance level
0% 100%

There are three modes for luminance processing, as follows.
Tint mode: adding a specified color to the original video signal.
Color Modify mode: adjusting the original video signal.
Y Modify mode: adjusting the output levels of the input luminance signal.
* White balance adjustment: setting the output level for an input
luminance signal at the 100% level.
* Black balance adjustment: setting the output level for an input
luminance signal at the 0% level.
* Y lift correction: adjusting the curvature of the curve.
* Y dark correction: adjusting the position of the maximum point of the

curve.

Output signal
luminance level i i
. White balance adjustment Output signal luminance level
i
1
A Input signal Input signal
: luminance Y Dark luminance
V level level

Black balance adjustment
= Unadjusted signal

—— Adjusted signal

It is also possible to mask part of the region to be corrected.

Applying luminance processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF5 ‘Luminance Process.’
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The Luminance Process menu appears.

2 In the <Luminance Process> group, press [Luminance Process], turning it

on.

3 In the <Mode> group, specify the adjustment mode.

Tint: add a specified color to the original video signal.
Color Modify: adjust the original video signal.
Y Modify: adjust the output levels of the input luminance signal.

When tint mode or color modify mode is selected, skip to step 4.
When Y modify mode is selected, adjust the following parameters.

4 In the <Bound> group, make the settings for the three regions (Dark,

Middle, and Bright).

* [Level] parameters: set the boundaries of the three regions.

Knob |Parameter |Adjustment Setting values
1 Over B Level | Luminance level of the Over 50.00 to 150.00
Bright point
2 Mid B Level |Luminance level of the Bright/ 10.00 to 120.00
Middle point
3 Dark Mid Luminance level of the Middle/ —20.00 to +90.00
Level Dark point
4 Under D Luminance level of the Under —50.00 to +50.00
Level Dark point

* [Soft] parameters:

set the degree of boundary softness of the three

regions.
Knob | Parameter | Adjustment Setting values
1 Over B Soft | Degree of softness at Over Bright | 15.00 to 70.00
point
2 Mid B Soft Degree of softness at Bright/ 15.00 to 42.50
Middle point
3 Dark Mid Degree of softness at Middle/Dark | 15.00 to 42.50
Soft point
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Knob |Parameter |Adjustment Setting values
1 White White balance adjustment 0.00 to 200.00 —
2 Black Black balance adjustment -100.00 to +100.00 ——
3 Y Lift Curvature of curve —100.00 to +100.00
4 Y Dark Position of maximum point of —7.31 to +109.59

curve
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Knob |Parameter |Adjustment Setting values

4 Under D Soft | Degree of softness at Under Dark | 15.00 to 70.00
point

5 In the <Luminance Process Adjust> group, press [Dark], [Mid], or
[Bright], and adjust the following parameters for the three regions.

¢ In tint mode

Knob | Parameter |Adjustment Setting values

1 Luminance |Luminance —100.00 to +100.00
Saturation Saturation 0.00 to 100.00
Hue Hue 359.99 to 0.00

¢ In color modify mode

Knob |Parameter |Adjustment Setting values
1 Luminance | Luminance -100.00 to +100.00
2 C Gain Chrominance signal gain 0.00 to 200.00
3 Hue Delay Hue delay —180.00 to +180.00

To return the parameters to their default settings
In the <Luminance Process> group, press [Unity].

Masking a part of luminance processing
In the <Luminance Mask> group, press [Mask1] or [Mask2], turning it on, then
carry out the same procedure as in “Masking a part of the primary color
correction” (page 453).

Spot Color Adjustment

You can change the color of a specified color region to a different color,
without affecting other regions. You can also mask part of such a region.
Then for the region other than the region whose color you have changed, you
can make the following corrections.

* Video signal overall gain adjustment

* Y signal gain adjustment

* Y signal offset adjustment

¢ C signal gain adjustment

¢ C signal hue adjustment
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When secondary color correction is enabled in the setup settings, this function
is disabled. On the MV S-8000G, secondary color correction and spot color
adjustment can be enabled at the same time.

For details, see “Switching the Color Correction Function” in Chapter 18
(Volume 3).

Adjusting the color of the specified region (key)

1

2

In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot CCR/Output.’
The Spot CCR/Output menu appears.

In the <Spot CCR> group, press [Spot CCR], turning it on.

In the <Auto> group, press [Sample Mark], turning it on.

When [Sample Mark] is on, the effects of color adjustment outside the
region of spot color adjustment (see page 462) and output video processing
(see page 463) are temporarily disabled.

Turning [Sample Mark] off restores the former state.

Adjust the parameters so that the color you want to change is included
within the sample mark.

Knob |Parameter |Adjustment Setting values
1 Position H Horizontal position —100.00 to +100.00
2 Position V Vertical position —100.00 to +100.00
3 Size Size 1.00 to 100.00

In the <Auto> group, press [Auto Start], to adjust the key automatically.

This automatic adjustment does not carry out key gain adjustment. If
required, adjust the key gain as shown in step 6.

Press [Key Adjust], and adjust the following parameters.

Knob | Parameter |Adjustment Setting values

1 Luminance |Luminance —7.31t0 +109.59

Color Corrector Functions
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Knob |Parameter |Adjustment Setting values
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 359.99 to 0.00
4 Gain Key gain —100.00 to +100.00

7 Press [Window], turning it on, to adjust the key detection range for spot
color adjustment.

Knob | Parameter |Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
2 Saturation Saturation 0.00 to 100.00
3 Hue Hue 0.00 to 100.00

8 In the <Spot CCR> group, press [Spot CCR] to display the parameters, and
adjust the replacement color.

Knob | Parameter | Adjustment Setting values
1 Luminance |Luminance 0.00 to 100.00
Saturation Saturation 0.00 to 100.00
Hue Hue 359.99 to 0.00

To return the parameters to their default settings
In the <Spot CCR> group, press [Unity].

Masking a part of the spot color adjustment

In the <Spot CCR Mask> group, press [Mask1] or [Mask?2], turning it on, then
carry out the same procedure as in “Masking a part of the primary color

correction” (page 453).

Adjusting the color outside the spot color adjustment region

1 In the Spot CCR/Output menu, press [Outer Out Proc] in the <Outer Out
Proc> group, turning it on.

2 Adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Video Gain | Video signal gain —200.00 to +200.00
2 Y Gain Y signal gain —200.00 to +200.00
3 C Gain Chrominance signal gain —200.00 to +200.00
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Knob |Parameter |Adjustment Setting values
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level | Black level -116.90 to +116.90

To return the parameters to their default settings
In the <Outer Out Proc> group, press [Unity].

Output Video Processing Operations

Carry out the following corrections are available on the YUV signal.
* Video signal overall gain adjustment
* Y signal gain adjustment

* Y signal offset adjustment

¢ C signal gain adjustment

* C signal hue adjustment

Applying output video processing effects

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Output Process> group, press [Output Process], turning it on.

3 Adjust the following parameters.

Knob |Parameter |Adjustment Setting values

1 Video Gain | Video signal gain —200.00 to +200.00
2 Y Gain Y signal gain —200.00 to +200.00
3 C Gain Chrominance signal gain —200.00 to +200.00
4 Hue Delay Hue delay —180.00 to +180.00
5 Black Level | Black level -116.90 to +116.90

To return the parameters to their default settings
In the <Output Process> group, press [Unity].

Color Corrector Functions
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YUV Clip Operations

For each of the luminance and color difference signals, the following

processing is available.

White clip: setting the maximum level of the luminance signal.

Dark clip: setting the minimum level of the luminance signal.

Positive clip: setting the maximum amplitude in the positive direction of the
color difference signal.

Negative clip: setting the maximum amplitude in the negative direction of the
color difference signal.

Applying YUV clip processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF7 ‘“YUV Clip.’

The YUV Clip menu appears.

2 In the <YUV Clip> group, press [YUV Clip], turning it on.

3 In the <YUYV Clip Adjust> group, select the target for adjustment.

Luminance: settings for the luminance signal.

Chroma: settings for the color difference signal.

4 Depending on the selection in step 3, adjust the following parameters.

¢ When Luminance is selected

signal

Knob | Parameter |Adjustment Setting values
1 White Clip White clip adjustment —6.85to +109.13
2 Dark Clip Dark clip adjustment —6.85t0 +109.13
* When Chroma is selected
Knob | Parameter | Adjustment Setting values
1 U Posi Clip | Positive clip adjustment for U —-113.39to +113.39
signal
2 U Nega Clip | Negative clip adjustment for U -113.39to +113.39
signal
3 V Posi Clip | Positive clip adjustment for V —-113.39t0 +113.39
signal
4 V Nega Clip | Negative clip adjustment for V -113.39to +113.39
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To return the parameters to their default settings
In the <YUYV Clip> group, press [Unity].
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Side Flags

Overview

The term “side flags” refers to the areas to left and right of an image with aspect
ratio 4:3 embedded within a 16:9 frame, when these areas are filled with a
separate image selected from the utility 1 bus.

You can adjust the width of the side flag area.

The side flag function is only supported on the MVS-8000A/8000G.

Side Flag Settings

Input source aspect ratio, auto side flags, and auto crop settings

Aspect ratio 4:3 setting
Set the input signal to aspect ratio 4:3. If set to 16:9, the side flags are disabled.

Auto side flag setting
This function automatically applies side flags when a 4:3 signal is selected in
the cross-point control block.

Auto crop setting
When carrying out a DME wipe, this function automatically crops the image

during transition to 4:3.
Adjusting the width of the side flag area
You can set the left and right sides separately.

For the operation for the above setting, see “Settings for Switcher
Configuration (Config Menu)” in Chapter 20 (Volume 3).

Enabling and disabling side flags with a menu operation

Side Flags

You can enable or disable side flags for the backgrounds (A and B) of each of
the M/E and PGM/PST banks.

As an example, to enable side flags for background B row on the M/E-1 bank,
use the following procedure.



1 In the menu control block, press the top menu selection button [MISC],
then select VF1 ‘Enable’ and HF3 ‘Side Flags.’

The Misc >Enable >Side Flags menu appears.
The status area shows the buttons for Bkgd A and Bkgd B for each of the
M/E-1 to M/E-3, and PGM/PST (P/P) banks.

2 In the <M/E-1 Side Flags> group, press [Bkgd B].

Each time you press the button toggles between Enable and Disable.

To display a menu for the aspect ratio 4:3, auto side flags, and auto
crop settings
In the Misc >Enable >Side Flags menu, press [Setup >SWER >Side Flags].

To display a menu for assigning the side flags on/off function to a
cross-point button
In the Misc >Enable >Side Flags menu, press [Side Flags Button Assign].

Enabling and disabling side flags with a button operation

For example, to enable side flags for the background B row of the M/E-1 bank,
use the following procedure.

1 First, in the Setup menu assign the rightmost cross-point button to the
[SIDE FLAG] button.

For details of the assignment operation, see “Cross-Point Settings (Xpt
Assign Menu)” in Chapter 19 (Volume 3).

2 Press the [SIDE FLAG] button at the right end of the background B row of
the M/E-1 bank.

The button you pressed lights amber, and this enables the side flags.

* The operations of enabling or disabling the side flags by menu operation
and by control panel button operation are linked.

* When the auto side flags are on, selecting a 4:3 video material
automatically lights the [SIDE FLAG] button, but if you press this
button, turning it off, the side flags are temporarily disabled.

However, when you select a different 4:3 video material, the [SIDE
FLAG] button automatically lights once again, enabling the side flags.

Side Flags
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Creating an image with side flags

For example, to create an image with side flags in the background B row of the
M/E-1 bank, use the following procedure.

1

In the M/E-1 bank cross-point control block, hold down the [UTIL] button,
and in the background A row select the signal (utility bus 1 signal) you
want to insert in the side flag areas.

In the background B row, press the cross-point button corresponding to the
4:3 video material.

At this point, if auto side flags are on, this automatically adds side flags to
the 4:3 video material. (See “Settings for Switcher Configuration (Config
Menu)” in Chapter 20 (Volume 3).)

Use either of the following methods to turn the side flags on.

* Use the Misc >Enable >Side Flags menu. (See page 468)
» Use a cross-point button operation. (See previous item.)

This adds side flags to the 4:3 video material.
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Wipe Action on Images With Side Flags

When a wipe is carried out on an image with side flags, all wipe patterns can
be used.
The following illustration shows the action in a wipe.

Wipe from a 4:3 image to a 16:9 image

Side flag areas

16:9 image

4:3 image (Side flags on)

Side Flags




Wipe from a 4:3 image to another 4:3 image (when side flags are
on for both images)

Side flag areas Side flag areas

4:3 image

coaaeih 3
(Side flags on) The circles indicate the
position of the wipe pattern
edge when the transition is
half finished.

DME Wipe Action for an Image With Side Flags

When a DME wipe is carried out on an image with side flags, all wipe patterns
can be used.

Depending on the setting (On/Off) of [Auto Crop] in the Engineering Setup
>Switcher >Config menu, the appearance of the 4:3 image changes.

* When using the MVE-9000/MVE-8000A through SDI interface with [Auto

Crop] being off, side flags are not added to the new image during DME wipe.

* For signals with the following DME wipe pattern selected on the DME
external video bus (gray part shown in the pattern illustration), side flags are
not applied when auto side flags are set to Off.

— Two-channel page turn

— Two-channel page roll

— Two-channel frame in-out
— Two-channel brick

— Three-channel brick

The following illustration shows the action in a DME wipe.

Side Flags
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DME wipe from a 4:3 image to a 16:9 image

Wipe action using slide (No. 1001)

Side flag area

Auto crop off

Side flag areas

Auto crop on

4:3 image (Side flags on)

16:9 image

DME wipe from a 4:3 image to another 4:3 image (when side flags
are on for both images)

Wipe action using squeeze (No. 1031)

Side flag areas @
Auto crop off

Side flag areas

Side flag areas »
| Auto crop on

4:3 image (Side flags on)

4:3 image (Side flags on)

a) When using the MVE-9000/M VE-8000A through SDI interface, side flags are not added during
a DME wipe.

Side Flags



Multi Program 2

Overview

What is Multi Program 2?

By operating the switcher in Multi Program 2 mode, a single switcher mix/
effects bank can be used to create two separate video outputs, referred to as
“main” and “sub.” You can set backgrounds, keys, and transitions for each of
main and sub. Keys 2 to 4, however, are common to main and sub.

For example, immediately after a score in baseball two versions of the scene
can be provided as shown below, and switched simultaneously.

The Multi Program 2 function is only supported on the MVS-8000A/8000G.
To enable this function requires the BZS-8200 Multi Program 2 software.
Depending on the CPU module, this function may not be supported.

For details, consult your Sony service representative or sales representative.

Using the software

To use the Multi Program 2 software, you are required to enter an install key
which validates the software. (If the software has been factory installed, the
install key is not required.)

For the method of obtaining an install key, contact your Sony representative.
To obtain a key, you may be required to submit the unique device ID of the
switcher you are using. You can check the unique device ID in the Install menu
of the switcher.

For details of the operation, see “Installation and Device Setup (Install/Unit
Config Menu)” in Chapter 18 (Volume 3).

Assigning main and/or sub to switcher banks

For Multi Program 2 operations, a single switcher bank may be shared, and
switched between main and sub, or two separate switcher banks may be used,
each dedicated to main or sub.

Multi Program 2 473
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Example 1: Assigning M/E-1 main and sub to a single switcher bank, and
switching between them

Used switched between M/E-1 main and sub

Example 2: Assigning separate switcher banks as “M/E-1 main dedicated” and
“M/E-1 sub dedicated”

Used for M/E-1 main operations

Used for M/E-1 sub operations

Video creation operations in Multi Program 2 mode

For each of main and sub, there are differences from the operations in standard
mode.

For details, see “Differences Between Multi Program 2 Mode and Standard
Mode” (page 485).

Sequence of Operations in Multi Program 2

Basic operation sequence

Enter the BZS-8200 install key (first time only)
\

Set Multi Program 2 operating mode for each switcher bank

{
Assign output signals, and set the background configuration, key
configuration, and key preview configuration

Multi Program 2



A

For each switcher bank, make a main/sub assignment (one of main dedicated,
sub dedicated, and main and sub shared)

For a switcher bank assigned to main and sub shared, assign the [MAIN] and
[SUB] delegation buttons
\2

Create the main and sub images

Execute the transition

Optional operations

Making cross-point settings

Enabling DME wipe operations for sub

Inhibiting utility 2 bus signal selection

Including Multi Program 2 data in keyframes and snapshots

Changing the key assignment for each output

Assigning sub preview output to preview selection buttons in the fade-to-
black control block

* Changing the matrix size to Standard

* Making settings for keyframe timeline operation

Basic Operations (Required)

Entering the BZS-8200 install key (first time only)

After installing the BZS-8200 Multi Program 2 software in the switcher, carry
out the following procedure.

1 In the status area of the Engineering Setup >System >Install/Unit Config
menu, select the switcher (SWRx), and press [License].

The License menu appears.

2 In the License menu, enter the BZS-8200 install key.

For details of the operation, see “Installation and Device Setup (Install/
Unit Config Menu)” in Chapter 18 (Volume 3).

Multi Program 2
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3 Shut down the menus. (see page 125.)

4 Power the switcher and SCU off and on again.

Setting the operating mode for each switcher bank

To set a desired switcher bank to Multi Program 2 mode, use the following
procedure.

1 Display the Engineering Setup >Switcher >Config menu.
2 Select the switcher bank from M/E-1 to M/E-3, and P/P.

3 In the <M/E Config> group, select [Multi Program?2].

Note]
In the PGM/PST when using the simple P/P software (see page 488),
[Multi Program?2] cannot be selected.

4 Repeat steps 2 and 3 as required, to set the operating mode for all desired
switcher banks.

Assigning output signals for Multi Program 2 mode

To assign signals to outputs

Use the Engineering Setup >Switcher >Config >M/E Output Assign menu.

The difference from standard mode is that OUT]1 is fixed, set to PGM1 (main

program), and OUT® is fixed, set to PGM2 (sub program), and that for the

OUT2 to OUTS signals you can assign any signal selected from the following.
PGM1, PGM2, PGM3, PGM4, PYW1, PVYW2, K-PVW1, K-PYVYW2,
CLEAN, SUB CLEAN

Each of main and sub can use a maximum of four of the six outputs (OUT1 to
OUT6). The outputs can be used within the following limits.

e OUTI1, OUT2: main only

¢ OUT3, OUT4: can be used for either main or sub

* OUTS, OUT6: sub only

For details, see “Making Settings Required to Use the Software” in Chapter
18 (Volume 3).

To set the background and key configuration
Use the Engineering Setup >Switcher >Config >PGM Config menu.
The following are the differences from standard mode.

Multi Program 2



Background configuration: Consists of the following combinations.
* For main: Clean, Bkgd A, Bkgd B
* For sub: Sub Clean, Utility 2, Utility 3

Key configuration: Key1 can be set to “Enable” only when the background is
Clean, Bkgd A, or Bkgd B.

For details, see “Setting the Operation Mode” in Chapter 20 (Volume 3).

To set the key preview configuration

Use the Engineering Setup >Switcher >Config >K-PVW Config menu.

The following are the differences from standard mode.

Background configuration: Clean or Sub Clean

Key configuration: Key1 can be set to “On” or “Link” only when the
background is Clean.

For details, see “Setting the Operation Mode” in Chapter 20 (Volume 3).
To assign sub outputs to output ports

Use the Engineering Setup >Switcher >Output >Output Assign menu.
You can assign a sub output signal to a switcher output port number.

For details, see “Assigning Output Signals” in Chapter 20 (Volume 3).

Assigning main and/or sub to switcher banks

For each switcher bank for which Multi Program 2 mode is selected, set
whether this is main dedicated, sub dedicated, or main and sub shared.

To assign main and sub to a single switcher bank

1 In the Engineering Setup >Panel >Config >MP2 Main/Sub Assign menu,
select the switcher bank.

2 In the <Main/Sub Assign> group, select [Main&Sub].

Main: use for main operations.
Sub: use for sub operations.
Main&Sub: use for both main and sub operations.

When “Main&Sub” is selected, it is necessary to assign [MAIN] and
[SUB] delegation buttons to the control panel.

To assign main and sub to two consecutive switcher banks

For example, to assign the first row (first switcher bank) to M/E-1 main, and
the second row (second switcher bank) to M/E-1 sub, use the following
procedure.

Multi Program 2
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1 In the status area of the Engineering Setup >Panel >Config >MP2 Main/
Sub Assign menu, select 1st Row (M/E-1), then press [Main] in the <Main/
Sub Assign> group.

2 Press [Dual M/E Assign] to assign M/E to two banks.

In this state, both 1st Row and 2nd Row are set to main.

3 Set “2nd Row” to [Sub].

This cancels the shift/non-shift assignment for dual M/E in standard mode.

It is not possible to assign the combinations of Main with Main&Sub, or Sub
with Main&Sub.

Assigning the [MAIN] and [SUB] delegation buttons to buttons
on the control panel

You can assign the [MAIN] and [SUB] delegation buttons to any of the
following three places.

To assign to the pattern limit buttons (PTN LIMIT and LIMIT SET) in
the transition control block (standard type)

For details of the transition control block (standard type), see page 49.

1 In the Engineering Setup >Panel >Config menu, press [Program Button].

The Program Button menu appears.

2 Press [Transition Module].

The Transition Module menu appears.

3 Select the switcher bank, then in the <PTN LIMIT/LIMIT SET/KF Button
Assign> group, press [Main/Sub].

You can now use the [PTN LIMIT] button as [MAIN], and the [LIMIT
SET] button as [SUB].

To assign to the wipe direction selection buttons (NORM and
NORM REV) in the transition control block

This applies to a standard type and compact type transition control block and
the CCP-6224/6324 Control Panel.

For details of the transition control block (standard type), see page 49, and for
details of the transition control block (compact type), see page 94.
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For details of the CCP-6224 2M/E control panel, see page 97, and for the
details of the CCP-6324 3M/E control panel, see page 98.

1 In the Transition Module menu, select the switcher bank.

2 In the <NORM/NORM REV/REV Button Assign> group, press [Main/
Sub].

You can now use the [NORM] button as [MAIN], and the [NORM/REV]
button as [SUB].
To assign to macro buttons in the cross-point control block

For details of the cross-point control block, see page 45.

1 In the Engineering Setup >Panel >Config menu, press [Program Button].

The Program Button menu appears.

2 Press [Xpt Module].

The Xpt Module menu appears.

3 Select the switcher bank, then in the <PRE MCRO/POST MCRO> group,
press [Main Sub].

You can now use the [PRE MCRO] button as [MAIN], and the [POST
MCRO] button as [SUB].

To assign macro operations to different buttons

If in the above operation you assigned a Multi Program 2 function to the macro
buttons, you can assign the PRE MCRO and POST MCRO functions to
different buttons.

For details, see “Assigning Functions to User Preference Buttons” or
“Assigning a Function to a Memory Recall Button in the Utility/Shotbox
Control Block” in Chapter 19 (Volume 3).

Examples of Operations in the Multi Program 2 Mode
(When Sharing a Switcher Bank)

To create video on the M/E or PGM/PST bank assigned to both main and sub
operations, use the following procedure.

1 Press the [MAIN] button, turning it on, and turning off the [SUB] button.

Multi Program 2
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2 With the normal operations, create the main video.

3 Press the [SUB] button, turning it on, and turning off the [MAIN] button.

Now you can create the sub video.

4 Create the sub video.

The basic method of operation is the same as for the main video, except
that the utility 2 bus signal is assigned to background A, and the utility 3
bus signal is assigned to background B.

For sub, only keys 2 to 4 can be used, and for wipes, standard wipe patterns
only. There are also other differences in operation from standard mode.

For details, see “Differences Between Multi Program 2 Mode and
Standard Mode” (page 485) and “Restrictions on Using Multi Program 2
Mode” (page 486).

5 Press the [MAIN] and [SUB] buttons simultaneously, turning them on.

If both buttons are lit, the control panel shows the status of main.

6 Carry out the transition.

Both main and sub video images are switched.

Optional Operations

Making cross-point settings

Cross-point assign tables can be set not only for main output but also for sub
output.
You can set cross-point assign tables for the following banks.

M/E-1 SUB to M/E-3 SUB

P/P SUB
The table actually used is that for which the control panel delegation button is
lit.

For details, see “Cross-Point Settings (Xpt Assign Menu)” in Chapter 19
(Volume 3).

Enabling DME wipe operations for sub

By factory default, DME wipe operations are inhibited for sub background. To
enable them, in the Engineering Setup >Switcher >Config menu, set [DME
Wipe Sub Enable] to On.
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This enables DME wipe operations for sub background.
This setting applies to the whole control panel (all M/E banks and PGM/PST
bank).

If a DME wipe for sub is recalled in a snapshot or keyframe, the image will not
be handled correctly.

Inhibiting utility 2 bus signal selection

In Multi Program 2 mode, you can inhibit other uses of the utility 2 bus signal
in order to use the signal as the background for sub.

This setting applies to the whole control panel (all M/E banks and PGM/PST
bank).

In the Engineering Setup >Panel >Config >MP2 Main/Sub Assign menu, set
[Util2 Inhibit] to On.

This inhibits operations of selecting from the background B row while holding
down the [UTIL] button in the cross-point control block.

Including Multi Program 2 data in recall operations of keyframes
and snapshots

In the Engineering Setup >Switcher >Config menu, set [Recall M/E Config] to
On.

When a keyframe or snapshot is stored or recalled, the following data is
included.

M/E Config, PGM Config, M/E Output Assign, and Key PVW Config

For details of the above data, see “Setting the operating mode for each
switcher bank” (page 476) and “Assigning output signals for Multi Program
2 mode” (page 476).

This setting applies to the whole control panel (all M/E banks and PGM/PST
bank).

M/E Config data is saved, even when this setting is Off.

Changing the key assignment for each output (Misc menu)

In Multi Program 2 mode you can change the key assignments independently.
The following describes an example using M/E-1, but the operation is the same
for other banks.
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* This setting is linked to the setting in the Engineering Setup >Switcher >

Config >PGM Config menu.
* It is not possible to make this setting while the above PGM Config menu is
locked, or [Recall M/E Config] (see previous item) is set to Off.

1 In the M/E-1 menu, select first VF7 ‘Misc,” then HF5 ‘Key Assign.’

The Key Assign menu appears, and the current key assignment is shown
in the status area.

2 Change the setting in “Key Enable” as required.

Keys recalled in a snapshot recall

If a snapshot is recalled independently on main or sub, this only retrieves the

settings for the key assigned to the recalled side. For example, if key 1 and key
2 are assigned on main, and key 3 and key 4 are assigned on sub, then if you

recall a snapshot on main, this only retrieves the settings for key 1 and key 2,
and the state of key 3 and key 4 assigned on sub is not affected.

Assigning sub preview output to preview selection buttons

You can assign the sub preview output to a preview selection button in the
fade-to-black control block or downstream key/fade-to-black control block.

For details, see “Overall Control Panel Settings (Config Menu)” in Chapter
19 (Volume 3).

When the Multi Program 2 license is valid, by assigning the “Shift” function to
a button, you can assign two preview outputs, “Shift” and “Unshift” to a single
button. To use the shift output, always assign “Shift” to some button.

Changing the matrix size to Standard

When using a router, if the matrix size is set to [Compact (128x128)], it is not
possible to control the utility 3 bus on the S-Bus. When using Multi Program
2, in the <Matrix Size> group of the Engineering Setup >Router/Tally >Router
menu, select [Standard (136x138)].

For details, see “Assigning Switcher Inputs and Outputs to S-Bus Space” in
Chapter 23 (Volume 3).

As for the bus number of the utility 3 bus, a DME Key bus number is used as
follows.

No. Bus (Standard) Bus (MP2)

70 M/E-1 DME Key M/E-1 Utility3
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No. Bus (Standard) Bus (MP2)
85 M/E-2 DME Key M/E-2 Utility3
100 | M/E-3 DME Key M/E-3 Utility3
115 | P/P DME Key P/P Utility3

Making settings for timeline-related keyframe operations

To assign sub regions to the region selection buttons in the
numeric keypad control block

In the Engineering Setup >Panel >Config >10 Key Region Assign menu,
assign regions to the region selection buttons in the numeric keypad control
block.

For details, see “Overall Control Panel Settings (Config Menu)” in Chapter
19 (Volume 3).

To make region and reference region selections using a menu
During snapshot or keyframe operations, you can select a region (including
sub) in the Key Frame >Region Select menu. This is convenient for selecting
some of the regions assigned to the numeric keypad control block or changing
the reference region.

For details, see “Specifying the Region and Edit Points” in Chapter 13
(Volume 2).

To assign regions shown in the Timeline menu
You can select how regions assigned to region selection buttons appear in the
Key Frame >Timeline menu.

For details, see “Settings in the Timeline Menu” in Chapter 13 (Volume 2).

Enabling re-entry between the main and sub sides of the same
M/E bank

In the Engineering Setup >Panel >Config menu, set [MP2 Free Re-Entry] to
On.

* Re-entry adds a 1H delay to the video. Nested re-entry may lead to problems
in the video.

* A maximum of eight re-entry stages are possible, with the final output having
a delay of 4H.

* The selection order of re-entry signals affects the number of lines by which
the output signal is lowered.
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* If a delay occurs in the image, even when the through mode is set, the
ancillary data does not pas through.

* For example, it is possible to select the re-entry of M/E-1 main on M/E-1
main.

Restrictions on Mutual Re-entry When Using Multi Program 2

The snapshot function is affected by this re-entry function.

When the [MP2 Free Re-Entry] button is On, and any of the switcher banks are
in Multi Program 2 mode, then the following restrictions apply.

If you save and recall snapshots simultaneously with more than one region
specified, the recorded state is played back in the order of precedence of
regions (M/E-1 >M/E-2 >M/E-3 >P/P). Therefore, if you save and recall
snapshots with more than one region specified, the cross-point settings may not
be recalled correctly.

To recall the snapshots correctly, press the cross-point button before recalling
the snapshots, to select a signal other than the re-entry signal, then recall the
snapshots.

Functions Added in Multi Program 2 Mode

* You can set video processing for the utility 3 bus signal.

* In the control panel and DCU GPI input settings and switcher GPI link
settings, the actions that can be selected now also include “Sub Cut” and
“Sub Auto Trans.”

* A switcher GPI link can now be set also for the utility 3 bus.

* To the macro event configuration parameters and macro attachment settings,

“Main & Sub” and “Sub” have been added.

For cross-point button link settings, M/E-1 to M/E-3, and P/P “Sub

Program,” “Sub Preset,” and “Sub Trans PGM” have been added to the link

source bus.

Snapshot attributes can now be set independently for main and sub.

There are additional menus for sub which can be recalled by pressing a

button twice.

* You can set [MP2 Auto Correct] to On or Off in the Effect menu or Snapshot
menu. When this is set to On, for example, copy destination and source data
is automatically recognized as main or sub, and the data interchanged.
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Differences Between Multi Program 2 Mode and

Standard Mode

The differences from operation in standard mode are as follows.

Multi Program 2
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ltem Main Sub
Keys @ Keys 1 to 4 can be used Keys 2 to 4 only can be
used
Wipes Patterns Same as standard mode ¢ Only standard patterns
(background) can be used
* Pattern mix is not
possible
Modifiers Same as standard mode * Pairing, modulation,
spring, spiral, and split
cannot be used
* Edge fill mattes are
single-color only
* Replication can be
selected from four
patterns
Wipes (key) Same as wipes (background) for sub
DME wipes | Use Can be used Cannot be used (Can be
used, with a setting -
change) p—
Patterns for 1 | For a dedicated interface, each of main and sub can be —
channel used.
For the SDI interface, only one of main and sub can be Q
used. S
(0]
Patterns for2 | Only one of main and sub can be used o
channels (For each M/E, the number of DMEs that can be used is °
the same as in standard mode.) (%)
Patterns for 3 3
channels o
o
Backgrounds | Wipe edge fill matte Wipe edge fill matte Ly
(including color mix and (single-color only) 5.
other settings in the Matte S
Adjust menu) )
Modifiers Same as standard mode Wipe border colors are
single-color only
Transitions Key priority | Cannot be used
Transition Cannot be used
preview
Preset color | Color matte or video signal | Color matte only
mix selected on the utility 2 bus
Snapshots Cross-point | Utility 2 cannot be set Utility 3 is added. BKGD
hold A/B and Key1 cannot be
set.
Control from an editor Same as standard mode Cannot be used
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Item Main Sub

Operation setting for Same as standard mode Cannot be used
switcher GPI inputs and
outputs

a) Keys 2 to 4 are common to main and sub.

¢ Allow a transition to complete before carrying out main and sub delegation

switching.

* The sub background A bus (utility 2 bus) is shared with wipe edge border fill.

Making a change to one affects the other.

* Even if the wipe border width is set to the same numeric value for main and

sub, the same image is not obtained.

* Changing the position of the wipe pattern for sub also changes the pattern

size.

Restrictions on Using Multi Program 2 Mode

* The following functions are not available for sub:

— Data copy and swap

— Default recall (except for parametric recall)
— M/E link

— [TRANS] button function (see page 57)

— [TRACE] button function (see page 59)

— [AUTO] button function (see page 93)

* Re-entry is limited to four levels. Re-entry is not possible for main and sub

of the same M/E.

However, this restriction can be removed. For details, see “Enabling re-
entry between the main and sub sides of the same M/E bank” (page 483).
In the following cases, a transition using the fader lever may not be
performed correctly:

— When the main and sub bus toggle modes are set differently

— For a pattern mix, preset color mix, and so on

¢ For an Internal bus link, GPI link, or External bus link, the “Utility 2” bus

cannot be selected.

* Screen aspect, show key, and [MCRO ATTCH ENBL] button settings are

common to main and sub.

* If a snapshot is recalled simultaneously for main and sub, or a keyframe is
executed simultaneously for main and sub, then for the following common
to main and sub the main settings are reflected.

- Key
— M/E Config
— DME external video bus and utility 1 bus

Multi Program 2




When a macro attachment is set on the DME utility 1 bus or DME utility 2

bus, it is not possible to make separate main and sub settings.

When snapshots with different M/E Config settings are recalled:

— If M/E Config data is not to be included in the snapshot data, the current
system settings are used for snapshot reproduction.

— If M/E Config data is to be included in the snapshot data and if it was
created before Version 5.30, then standard mode is used. If created in
Version 5.30 or later, first M/E Config data is set, and then other snapshot
data is recalled.

The bus override function is only available on the following buses:

— M/E-1 to M/E-3 Main BKGD A/B buses

— M/E-1 to M/E-3 Sub BKGD A/B buses (UTIL-2, UTIL-3 buses)

— P/P Main PGM/PST bus

— P/P Sub PGM/PST buses (UTIL-2, UTIL-3 buses)

When a master snapshot or master timeline is executed with a key being

assigned to both main and sub, it is uncertain which data will be reflected.

When recalling a master snapshot with different register numbers for main

and sub, the recall timing may differ by one field or more between main and

sub.

The link state is maintained even when M/E Config is changed. Set the link

setting again, as required.

Since keys 2 to 4 are shared between main and sub, when the main and sub

fader lever positions are different, if you move the fader lever, the video

changes instantaneously to the value of the most recently moved fader lever.

When the transition type for main or sub is set to preset color mix, it is not
possible to carry out independent key transition operation (common to main
and sub).

Multi Program 2
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Simple P/P Software

Overview

By installing the BZS-8250 Simple P/P Software in the MVS-8000A/
8000ASF/8000G/8000GSF Switcher Processor, you can use a separate
program/preset function without using the M/E hardware.

Getting access to the software

To use the Simple P/P Software, you are required to enter an install key which
validates the software. (If the software has been factory installed, the install key
is not required.)

For the method of obtaining an install key, contact your Sony representative.
On that occasion, you may be required to submit the unique device ID of the
switcher you are using. You can check the unique device ID in the Install menu
of the switcher. For details of operating procedures, see “Installation and
Device Setup (Install/Unit Config Menu)” in Chapter 18 (Volume 3).
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Restrictions on Use

Since this software is a simple version of the program/preset function, there are
some restrictions on use. The following lists the points at which operation is
different from a normal program/preset function. For details of the normal
operations, set the relevant sections of this manual.

Restrictions on using a downstream key

* DSK3 and DSK4 cannot be used.
For the key priority, set priority 1 or priority 2.
* The following downstream key types cannot be used.
— Chroma key
— Color vector key
— Wipe pattern key
— Key wipe pattern key
* When using a matte as the key fill for a downstream key, a mix color cannot
be used.
« It is not possible to modify a downstream key edge. The edge blink also
cannot be used.
* For a downstream key, main mask and sub-mask cannot be used.
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* A processed key cannot be used. Therefore, it is not possible to apply a DME

effect to a downstream key.

* As an independent key transition type, wipe and DME wipe cannot be used.

* The resizer cannot be used.
* The key frame delay mode cannot be used.

Restrictions on executing transitions in the transition control

block

* DME wipes cannot be used.

* Wipes can be used, but there are restrictions on use. For details, see the next

item, “Restrictions when using wipes.”

Restrictions when using DME wipes

* The wipe patterns that can be used are standard wipes (pattern numbers 1 to

24) only.
* A pattern mix cannot be used.
* A split (splitting the wipe pattern) cannot be used.

e When a border or soft border is selected for a wipe edge, the signal to be

inserted in the edge (edge fill) is restricted as follows.
— The utility 2 bus cannot be selected.
— When using a matte, a mix color cannot be used.

— Even if the wipe border width is set to the same numeric value for M/E and

Simple P/P, the same image is not obtained.
* The following wipe modifiers cannot be used:

— Replication “Shift” and Multi Adjust menu adjustments

— Pairing

— Modulation
— Spring

— Spiral

» Changing modifier parameter settings changes the wipe pattern size.

Restrictions on utility buses
The utility 1 and utility 2 buses cannot be used.

Assignment of signals to output connectors

Connectors to which the P/P row output signal assignment is fixed
The assignment of the following signals to output connectors OUT17 to OUT2

2 is fixed.

Simple P/P Software
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Output Fixed assigned outputs

connector Standard mode Multi-program mode | psSK mode @
ouT17 Program P/P OUT1D Program 1
OouT18 Program P/P OUT1D Program 2
ouT19 Preview P/P OUT2P) Key preview 1
ouT20 Clean P/P OUT3P) Key preview 2
ouT21 Key preview P/P OUT4D Clean 1
ouT22 Preset Preset Clean 2

a) In DSK mode, the backgrounds that can be selected in the PGM Config menu are restricted to

background 1 and background 2.
b) Depends on the setting in the Engineering Setup >Switcher >Config >M/E Output Assign menu.
OUTS and OUT6 cannot be used.

Connectors for which a P/P row output signal can be selected
For an edit preview bus or AUX bus assigned to output connector OUT23 or
OUT24, you can select a P/P row output signal.

If these buses are assigned to other than OUT23 or OUT?24, then it is not
possible to select a P/P row output signal. (Assigning these buses to the two
connectors is recommended.)

Output connector Assignable bus
ouT23

ouT24

Edit preview bus
AUX bus

Format converter output restrictions

On the MVS-8000G, the signal output from the format converter output

connectors (FC1, FC2) can be assigned in either of the following ways.

¢ Out#15-16: Assignment fixed, signals OUT15 (for FC1), and OUT16 (for
FC2).

e Out#17-22: Select from the OUT17 to OUT22 signals. (It is not, however,
possible to select the same signal for FC1 and FC2.)

It is not possible to select FC1 and FC2 differently. For example, it is not

possible to select “Out#15-16" for FC1 and “Out#17-22” for FC2.

FC3 and FC4 always have the same signals assigned: OUT39 and OUT40

respectively, and therefore it is not possible to select OUT17-OUT22.

Logical assignment of the physical PGM/PST

In the Engineering Setup >Switcher >Config >Logical M/E Assign menu, it is
not possible to assign the physical PGM/PST as a logical PGM/PST.

In the <Logical M/E to Physical P/P> group, you can select from M/E-1, M/E-
2, and M/E-3.
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Configuration of the switcher bank outputs

If Multi Program mode is selected in setup (M/E Config in the Switcher
>Config menu), then for Bkgd in the PGM Config menu, it is only possible to
select Clean.

Simple P/P Software
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Dual Link Support

By installing the BZS-8560 switcher upgrade software in the MVS-8000G, or
the BZDM-8560 DME upgrade software in the MVE-8000A, you can switch
the signal format to 1080P/59.94 or 1080P/50. In this case, signal input/output
uses a dual link &

a) Standard specified by SMPTE 372M-2002. One video signal is carried by two HD-SDI signals,
allowing data with an increased frame rate to be carried.

Getting access to the software

To use the switcher upgrade software and DME upgrade software, you are
required to enter an install key which validates the software. (If the software
has been factory installed, the install key is not required.)

For the method of obtaining an install key, contact your Sony representative.
On that occasion, you may be required to submit the unique device ID of the
switcher you are using. You can check the unique device ID in the Install menu
of the switcher. For details of operating procedures, see “Installation and
Device Setup (Install/Unit Config Menu)” in Chapter 18 (Volume 3).

Switching the signal format to 1080P/59.94 or 1080P/50 requires the optional
multi-format software.

For details of this software option, see “Making Settings Required to Use the
Software” in Chapter 18 (Volume 3).

An MKS-8110G 17-input board and MKS-8160G 24-output board set are also
required.

Setting the signal format to 1080P/59.94 or 1080P/50

You can switch the signal format to 1080P/59.94 or 1080P/50 in setup.

For details, see “Setting the Signal Format (Format Menu)” in Chapter 18
(Volume 3).

You can also switch the signal format with a GPI input.

For details, see the following sections in Volume 3, depending on the device.

* “Interfacing With External Devices (Device Interface Menu)” in Chapter 20
“Switcher Setup (Switcher)”
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* “Interfacing With External Devices” in Chapter 19 “Panel Setup (Panel)”

* “Interfacing With External Devices (Device Interface Menu)” in Chapter 21
“DME Setup (DME)”

e “GPI Input Settings (GPI Input Assign Menu)” in Chapter 22 “Setup (DCU)”

The available input reference signals are as follows.

Signal format Input reference signal

Tri Sync Black burst
1080P/59.94 59.94 Black Burst 59.94 | Sync 59.94
1080P/50 50 Black Burst 50 Sync 50

Switching the signal type of DME output (video/key) assigned to
a monitor signal

The function for switching the signal type of the monitor output (one channel)
to video or key is assigned to one of the Prefs buttons of the Menu control block
or one of the buttons of the Utility/Shotbox control block (DME MON KEY
command).

For details of the assignment, see “Settings Button Assignment (Prefs/Utility
Menu)” in Chapter 19 (Volume 3).

To switch the signal type of DME output (video/key) assigned to a
monitor signal

Press the DME MON KEY command assigned button and turn it on to assign
DME key output to a monitor signal. Then press the button and turn it off to
assign DME video output to a monitor signal. For selection of the DME
channels to be assigned to a monitor signal, see “Assigning a DME output
signal as a monitor signal” (page 230).

Selecting the signal output from the DME monitor output
connector

Display the Engineering Setup >DME >Output >Monitor Output menu.
Press [DME1] or [DMEZ2] to select the DME to operate on.

On the left, select MONI OUT#1 or MONI OUT#3.

2 W N =

On the right, select the signal.

You can select any of Chl Video, Chl Key, Ch2 Video, and Ch2 Key.

5 Press [Set].
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This assigns the signal.

Restrictions when using a dual link

When using a dual link, the switcher and DME resources are linked in duplex
(link A and link B), resulting in the following restrictions.

Restrictions Details

Functions that cannot be | Functions of the following items in the Engineering
used in the system Setup >Switcher >Config menu
Single Simul, Dual Simul

Primary inputs numbers 41 to 80
Qutputs number 25 to 48
Monitor buses 2/4/6/8

M/E-2 bank a)

M/E-3 bank

DME utility 1 and 2 buses

Color background 2 °)

Color corrector 2

Frame memory

Format converter

Functions of the following items in the Engineering
Setup >Switcher >Config menu

Switching Timing, M/E Config excluding Standard, and
Logical M/E Assign

Functions that cannot be
used in the switcher

Functions that cannot be |* DME channels 3, 4, 7, and 8

used on the DME Freeze in film mode

“Freeze Timing” in the following effects

Input Freeze, Trail, Decay, KF Strobe (always set to
Frame)

Brick

Editor ports 3 and 4 when the editor port operation mode
is set to “Independent.”

Auto chroma keying operates on the image of link A.
Tallies are generated for the link A signal.

Key frames are created in units of two frames.

It is not possible to change the interpolation method in
the DME.

Other restrictions

a) When the simple P/P software is not installed
b) When the switcher is a 2M/E system only
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Wipe Pattern List

Standard Wipes

Appendix (Volume 1)
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Wipe Pattern List



(1 awnjop) xipuaddy

498

Enhanced Wipes

Wipe Pattern List

300 301 302 303
304




Rotary Wipes

- " - -

" - - "

Appendix (Volume 1)
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Wipe Pattern List



Mosaic Wipes

203

201

200

206

210

224

232

Appendix (Volume 1)

Wipe Pattern List
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Appendix (Volume 1)
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Wipe Pattern List
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Random/Diamond Dust Wipes

270

271

272

273

274

Wipe Pattern List




DME Wipe Pattern List

DME Wipe Patterns Available in One-Channel Mode

Slide

1001 1002 1003 1004

1005 1006 1007 1008

Split

1011 1012 1013

DME Wipe Pattern List
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Squeeze

Door

1+
1029 Ll bl 1030 1031

|+ |
1041 1042 1043 1044
1045 1046 1047 1048

DME Wipe Pattern List




2D trans

3D trans

1051 1052 1053 1054
1055 1056 1057 1058
1061 1062 1063 1064
1068
1071 1072 1074 1076
1077 1088 '{H 1091 1092
1093 1094

DME Wipe Pattern List
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Flip tumble

1101 1102 1103 1104
1109 1110 1121 1122
1124 1131 1132 1133
1135
Frame in-out
1201 1202 :- 1203 1204 +-+
3T
1205 1206 1207 1208
1221 1222 1223 1224

DME Wipe Pattern List




Picture-in-picture

Page turn

'Y a
1251
ol
"4 b
1309 E 1310 a 1311 132 lw w
K A Jr Y
o o
1313 @ 1315 1316 1317
AR
[, >
1318 1341 x 1342 E 1343 H k]
[0}
=)
g
x
s
c
L
[0
1344 n 1345 =
r =
DME Wipe Pattern List | 507
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Page roll

Mirror

1321 1322 1323 1324 g

1325 1326 1327 1328

1329 BE 1330 !@ 1331 !mﬂ 1332 w__w
K A [

1333 1335 1336 1337

1338 1346 1347 1348

1349 1350

1355 1356 1357 1358

DME Wipe Pattern List




Sphere

B

Character trail

1371

1372

Wave

1378

1379

Ripple

o D

DME Wipe Pattern List
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Split slide

Sparkle

Mosaic

Defocus

Fffff/4’4’4 ;/
1384 1385 1386 7l 1387 xﬁ"'
iﬂ'ffff/ffj
Ffff/fffq
1388 I3 1389
b
[t
1391 1393 1394 1396
1398 1399
1701 MOSAIC
1
1702

DME Wipe Pattern List




User programmable DME

The illustrations for patterns 1901 to 1999 show an effect register number or

register name.

1901

1999

DME Wipe Patterns Available in Two-Channel Mode

Slide

Squeeze

2601 2602 2603 2604

2605 2606 2607 2608
2621 2622 2623 2624
2625 2626 2627 2628

DME Wipe Pattern List
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3D trans

2631

2632

2633

2634

2642

2644

Picture-in-pict

ure

2651

2652

DME Wipe Pattern List




Page turn

2701 2702 2703 2704
2705 . 2706 2707 2708
N
4
2709 . 2710 2711 2712
R
2713 2715 2716 2717
2718 2741 2742 2743
2744 2745

DME Wipe Pattern List
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Page roll

- - - .
2725 ’ 2726 ‘ 2727 \ 2728 (
" A
4 *u '
2729 D 2730 g 2731 F K, 2732 y s
A » 7
2733 2735 2736 2737
2738 2746 2747 2748
2749 2750

DME Wipe Pattern List




Brick

2801 2802 2803 l 2804
— — | 1 I
— e l‘
2811 2812 2813 2814 I
Frame in-out
i o
2851 2852 '--' 2853 2854
2861 @ 2862 iﬁFAﬁEi‘ 2863 2864

User programmable DME

The illustrations for patterns 2901 to 2999 show an effect register number or
register name.

2901

201

® 2999

299

DME Wipe Pattern List

515
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DME Wipe Patterns Available in Three-Channel Mode

Brick

User programmable DME

The illustrations for patterns 3901 to 3999 show an effect register number or
register name.

3901 301 e o o (3909 399

(1 awnjop) xipuaddy
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DME Wipe Pattern List



Resizer DME Wipe Pattern List

Slide

7001 7002 7003 7004

7005 7006 7007 7008

Squeeze

7021 7022 7023 7024

7025 7026 7027

7031

7029 7050

Resizer DME Wipe Pattern List 517
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Frame in-out

7201

7202

7203

7204

+1
7205 [ ]

7206

7207

7208

7221

7222

7223

7224

Resizer DME Wipe Pattern List




Menu Tree

Recalling Menus

This section details the menu structure, and shows the top menu selection
buttons in the menu control block which are used to access the menus.

Top menu selection buttons

ONONONONG)

Menu control block

Some menus can also be accessed by pressing other buttons twice in rapid
succession.

For more details, see “Menu Organization” (page 103).

Some menus may not appear, depending on the model.

M/E-1 to M/E-3 Menus

The functions in the M/E-1, M/E-2, and M/E-3 menus are the same, but the
menu page numbers are distinguished as follows.
M/E-1 menus: 11xx, M/E-2 menus: 12xx, M/E-3 menus: 13xx

Menu Tree

519
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In this section, the numbers for the M/E-1 menus are given as examples.

M/E

[M/E 1], [M/E 2], and [M/E 3] buttons

M/E-1
VF1: K!3y1 ’T—|F1:Type (1111) Chroma Adjust (1111.1)
VF2: Key2 — Matte Adjust (1111.2) — {Mix Pin Select (1112.2)
VF3: Key3— Key Priority (1173) Pattern Select (1116.2)
VF4: Keyd — Matte Adjust (1112.1)
VF5: Wipe (Wipe Adjust (1116.1)
VF6: DME Wipe HF2: Edge (1112) Matte Adjust (1112.1) —————— Mix Ptn Select (1112.2)
VF7: Misc Zabton Adjust (1112.3) (Pattern Select (1116.2)
o next page Key Delay Mode (1112.4)2) Mix Ptn Select (1112.2)
Main Mask(1113)
Matte Adjust (1112.1)
| Wipe Adjust (1116.1)
HF3: Main Mask (1113) —— Mask Ptn Select (1113.1)

Menu Tree

HF4: Sub Mask (1114) Main Pattern(1151)
HF5: Processed Key (1115) = Monitor (1115.1)
Border/Crop (1115.2)

Resizer Process (1115.3)2)

(Enhanced Effect (1115.4)2) Mask (1115.5)a)
HF6: Transition (1 116)—'_Wipe Adjust (1116.1) — Pattern Select (1116.2)
( DME Wipe Adjust (1116.3) 1ch Pattern Select
(1116.4)
(HF7: Video Process (1117) (210 1h 1Za;’;ern Select

~ The functions in the Key 2 to Key 4 menus are the Remove From Begin
same as those in the Key 1 menu, with the following (1116.7)

menu page numbers.

Key 2 menu: 112x, Key 3 menu: 113x, Key 4 menu:

— 114x

a) For MVS-8000G only



M/E
q

M/E

M/E
]

[M/E 1], [M/E 2], and [M/E 3] buttons

M/IIE-1
VF1: Key1
VF2:Key2 |— to previous page
VF3: Key3
VF4: Key4 (HF1: Main Pattern (1151)a)
VF5: Wipe HF2: Pattern Mix (1152)

HF3: Sub Pattern (1153)

HF4: Edge/Direction (1154)a- Matte Adjust (1154.1) ———— Mix Pattern Select (1154.2)
HF5: Main Modify (1155)8)— Multi Adjust (1155.1)

HF6: Sub Modify (1156) —— Multi Adjust (1156.1)

| HF7: Wipe Snapshot (1157)a)

(HF1: 1ch (1161))

VF6: DME Wipe—— HF2: 2ch (1162)2)

VF7: Misc

HF3: 3ch (1163)2)

HF4: Edge/Direction (1164)2)

HF5: Modify (1165)2) Remove From Begin (1165.1))
| HF7: DME Wipe Snapshot (1167)2)

(HF1: Transition (1171)a)

HF2: Video Process (1172)

HF3: Key Priority (1173)

HF4: Next Key Priority (1174)

HF5: Key Assign (1175)

HF6: Clip Transition (1176)3)-{Clip (1176.1)a)

| HF7: Snapshot (1177) Transition (1171)2)
Snapshot (1177)a)

a) In Multi Program 2 mode, the menus for
sub are displayed with 400 higher
numbers than the aboves for main.

Menu Tree
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PGM/PST Menu

.I [P/P] button

PGM/PST

VF1: DISK1 —(HF1: Type (1411)
VF2: DSK2 —
VF3: DSK3 —
VF4: DSK4 —
VF5: Wipe
VF6: DME Wipe HF2: Edge (1412)

VF7: Misc
I

to next page

HF4: Sub Mask (1414)

(HF7: Video Process (1417)

(Chroma Adjust (1411.1)
Matte Adjust (1411.2)
| Key Priority (1473)

(Matte Adjust (1412.1)
Zabton Adjust (1412.3)
| Key Delay Mode (1412.4)

HF3: Main Mask (1413) —— Mask Ptn Select (1413.1)

Main Pattern(1451)

HF5: Processed Key (1415)—’_Monitor (1415.1)

Border/Crop (1415.2)
Resizer Process (1415.3)2)
| Enhanced Effect (1415.4)2)

HF6: Transition (1416) —’_Wipe Adjust (1416.1)

| DME Wipe Adjust (1416.3)

— (Pattern Select (1416.2)

Mix Ptn Select (1412.2)
Matte Adjust (1412.1)
(Wipe Adjust (1416.1)
Mix Ptn Select (1412.2)

—?attern Select (1416.2)

Mix Ptn Select (1412.2)
Main Mask(1413)
Matte Adjust (1412.1)
(Wipe Adjust (1416.1)

Mask (1415.5)2)
Pattern Select (1416.2)

1ch Pattern Select
(1416.4)

2ch Pattern Select
(1416.5)

Remove From Begin
(1416.7)

The functions in the DSK 2 to DSK 4 menus are the same as those in the DSK
1 menu, with the following menu page numbers.

DSK 2 menu: 142x, DSK 3 menu: 143x, DSK 4 menu: 144x

Menu Tree

a) For MVS-8000G only



.I [P/P] button

PGM/PST

VF1: DSK1
VF2: DSK2
VF3: DSK3
VF4: DSK4

I to previous page

(HF1: Main Pattern (1451)2)

VF5: Wipe

HF2: Pattern Mix (1452)

HF3: Sub Pattern (1453)

HF4: Edge/Direction (1454)28)— Matte Adjust (1454.1) —————— Mix Pattern Select (1454.2)
HF5: Main Modify (1455)2) — Multi Adjust (1455.1)

HF6: Sub Modify (1456) Multi Adjust (1456.1)

| HF7: Wipe Snapshot (1457)2)

(HF1: 1ch (1461))

VF6: DME Wipe —— HF2: 2ch (1462)2)

VF7: Misc

HF3: 3ch (1463))

HF4: Edge/Direction (1464)2)

HF5: Modify (1465)2) Remove From Begin (1465.1)2)
| HF7: DME Wipe Snapshot (1467)2)

(HF1: Transition (1471)2

HF2: Video Process (1472)

HF3: Key Priority (1473)

HF4: Next Key Priority (1474)

HF5: Key Assign (1475)

HF6: Clip Transition (1476)3)]ECIip (1476.1)a)

| HF7: Snapshot (1477)2) Transition (1471)2)
Snapshot (1477)2)

a) In Multi Program 2 mode, the menus for sub
are displayed with 400 higher numbers than
the aboves for main.

Menu Tree
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Frame Memory Menu

|| [FRAME MEM] button

Frame Memory

VF1: Still

HF1

VF2: Clip
VF3: Reposition/Lock
VF4: File

VF5: Folder (2551)
VF6: External HDD —

Menu Tree

HF2

—

HF1
HF2

HF2:
HF3:
HF4:
HF5:
(HF7:
(HF1:
HF2:
HF3:
HF4:
HF1:

(HF1:
HF4:
— HF5:
HF6:
(HF7:

: Recall (2511)
Freeze/Store (2512)

Create Key Frame (2515)
Field Invert (2517)

Recall (2521)

Play (2522)

Record (2523)

Ancillary Enable (2525)
Reposition (2531)

: Lock (2532)

Pair Recombination (2541)
Move (2544)

Delete (2545)

Rename (2546)
Backup/Restore (2547)

: Format (2561)
: Backup/Restore (2562)

Composite (2513) Input Adjust (2513.1)
Animation Record (2514) Pattern Adjust (2513.2)

|—Pattern Select (2513.3)



Color Bkgd Menu

[COLOR BKGD] button

Color Bkgd

VF1: Color Bkgd1 (2210) ———
VF2: Color Bkgd2 (2220) ———

Mix Pattern Select (2210.1)
Mix Pattern Select (2220.1)

AUX/MON Menu

[AUX MON] button

Aux/Mon

VF1: Aux Bus (2311)

Menu Tree
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CCR Menu

|| [CCRY] button

CCR _
HF1: Input Process (2411)

VF1: CCR1———1 HF2: Primary CCR (2412)

HF3: Secondary CCR (2413)
HF4: RGB Clip(2414)

HF6: Spot CCR/Output (2416)
LHF7: YUV Clip (2417)

(HF1: Input Process (2421)

VF2: CCR2 ——— HF2: Primary CCR (2422)

VF3: Copy/Swap
(2431)

HF3: Secondary CCR (2423)

HF4: RGB Clip(2424)

HF6: Spot CCR/Output (2426)
\WHF7: YUV Clip (2427)

Menu Tree

HF5: Luminance Process (2415) ——

HF5: Luminance Process (2425) —

’_Mask 1 Adjust (2412.1) Mask Ptn Select (2412.2)
(Mask 2 Adjust (2412.3) Mask Ptn Select (2412.4)
(Mask 1 Adjust (2412.1) Mask Ptn Select (2412.2)
(Mask 2 Adjust (2412.3) Mask Ptn Select (2412.4)
(Mask 1 Adjust (2412.1) Mask Ptn Select (2412.2)
(Mask 2 Adjust (2412.3) Mask Ptn Select (2412.4)
(Mask 1 Adjust (2412.1) Mask Ptn Select (2412.2)
(Mask 2 Adjust (2412.3) Mask Ptn Select (2412.4)
(Mask 1 Adjust (2422.1) Mask Ptn Select (2422.2)
(Mask 2 Adjust (2422.3) Mask Ptn Select (2422.4)
(Mask 1 Adjust (2422.1) Mask Ptn Select (2422.2)
(Mask 2 Adjust (2422.3) Mask Ptn Select (2422.4)
(Mask 1 Adjust (2422.1) Mask Ptn Select (2422.2)
(Mask 2 Adjust (2422.3) Mask Ptn Select (2422.4)
(Mask 1 Adjust (2422.1) Mask Ptn Select (2422.2)
(Mask 2 Adjust (2422.3) Mask Ptn Select (2422.4)




Copy/Swap Menu

|| [COPY SWAP] button
SWAP

Copy/Swap
(HF1: M/E (3111)
VF1: Copy/Swap HF2: Key (3112)
VF2: Copy HF3: Wipe (3113)
HF4: DME Wipe (3114)
HF5: Matte (3115)
HF6: Color (3116)
|HF7: DME (3117)
— HF1: Format Converter (3121)2)
a) For MVS-8000G only
Misc Menu
|| [MISC] button
Misc
HF1: Port Enable (3211)
VF1: Enable

HF2: Plug-In Editor (3212)

VF2: Safe Title (3221) HF3: Side Flags (3213) Side Flags (7331.7)
VF3: Transition (3231) Side Flags Button Assign (7322.10)

Menu Tree

527

(1 swnjop) xipuaddy



(1 awnjop) xipuaddy

528

Status Menu

|| [STATS] button

Status

VF1: DME Status (3311)

Menu Tree



DME Menu

|| [DME] button

DME

VF1: Edge

VF2: Video Modify
VF3: Freeze
VF4: Non-Linear

—

(HF1: Border/Crop (4111)
HF2: Beveled Edge (4112)
HF3: Key Border (4113)
HF4: Art Edge (4114)
HF5: Flex Shadow (4115)
HF6: Wipe Crop (4116)

| HF7: Color Mix (4117)

(HF1: Defocus/Blur (4121)

HF2: Multi Move (4122)

HF3: Color Modify (4123)

HF4: Mosaic (4124)

VF5: Light/Trail ——
VF6: Input/Output

VF7: Enhanced
Video Modify —

(HF7: Mask (4127)
HF1: Freeze (4131)
HF1: Type (4141)
(HF1: Lighting (4151)
HF2: Trail (4152)
HF3: Motion Decay (4153)
HF4: KF Strobe (4154)
HF5: Wind (4155)

| HF6: Spot Lighting (4156) —
(HF1: Bkgd (4161) —
HF2: Video/Key (4162)
HF3: Process (4163)

| HF4: Graphic (4164)

Pattern Select (4116.1)
Mix Pattern Select (4117.1)
Mask (4127)

Mask (4127)
Mask (4127)

(Wave (4141.1)

Mosaic Glass (4141.2)
Flag (4141.3)

Twist (4141.4)

Ripple (4141.5)

Rings (4141.7)

Broken Glass (4141.8)
Flying Bars (4141.9)
Blind (4141.10)

Split (4141.11)

Split Slide (4141.12)
Mirror (4141.13)
| Multi Mirror (4141.14)

Kaleidoscope (4141.15)
Lens (4141.16)

Circle (4141.17)
Panorama (4141.18)
Page Turn (4141.19)
Roll (4141.20)

Cylinder (4141.21)
Sphere (4141.22)
Explosion (4141.25)
Swirl (4141.26)

Melt (4141.27)
Character Trail (4141.28)

HF1: Sketch (4171)
HF2: Metal (4172)

HF3: Dim & Fade (4173)
HF4: Glow (4174)

Color Mix (4117) —— Mix Pattern Select (4117.1)
(Texture Ptn Select (4156.1)

Copy/Swap (4156.2)

Light1 (4156.3) — Light Color Adjust (4156.4)

Light2 (4156.5) Light Color Adjust (4156.6)
| Light3 (4156.7) Light Color Adjust (4156.8)

Mask(4127)

Mask(4127)

Mask(4127)

Menu Tree
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Global Effect Menu

|| [GLB EFF] button

Global Effect

VF1: Ch1-Ch4a) (HF1: Combiner Priority (4211)
VF2: Ch5-Ch8 HF2: Brick (4212)

HF3: Shadow (4213)

| HF7: Combine Gp Select (4217)
(HF1: Combiner Priority (4221)
HF2: Brick (4222)

HF3: Shadow (4223)

HF7: Combine Gp Select (4227) @ When using the MKS-6470 DME
~ ! P ( ) Board Set, the button is indicated

as “VF1: Ch1-Ch2".

Device Menu

|| [DEV] button

Device
VF1: GPI Timeline ——— HF1: GPI Timeline (5311) Rewind Action (5311.1)
VF2: P-Bus Timeline ——— HF1: P-Bus Timeline (5321) —— Rewind Action (5321.1)
VF3: DDR/VTR HF1: Cueup & Play (5331)
HF2: Timeline (56332) ——  Rewind Action (56332.1)
HF3: File List (5333)
Menu Tree



Macro Menu

|| [MCRO] button

Macro

VF1: Register
VF2: Attachment (5421)

VF3: Menu Macro Register—T—IFt Recall & Run (5431) ———

VF4: Timeline

(HF2: Lock (5412)

HF3: Copy (5413)
HF6: Delete (5416)
(HF7: Rename (5417)

HF2: Lock (5432)
HF3: Copy (5433)
HF6: Delete (5436)

(HF7: Rename (5437)
HF1: Timeline (5441)

(On Line Edit (7142.2)
bff Line Edit (7143.2)

Menu Macro Edit (7144.2)

Rewind Action (5441.1)

Menu Tree
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Key Frame Men

u

[KEY FRAME] button
FRAME

Key Frame —|_

(HF1: Time Line (6111)

HF3: Path (6113)

HF4: DME User PGM (6114)
HF5: Timeline Assign (6115)

Menu Tree

| HF7: Region Select (6117)

(M/E-1 (6113.1)
M/E-2 (6113.2)
M/E-3 (6113.3)
P/P (6113.4)
User1 (6113.5)
User2 (6113.6)
User3 (6113.7)
User4 (6113.8)
User5 (6113.9)
User6 (6113.10)

User7 (6113.11)

User8 (6113.12)

DME 3D Trans Local (6113.13)
DME 3D Trans Global (6113.14)
DME Effect (6113.15)

| DME Gilobal Effect (6113.16)

10 Key Region Assign (7321.7)



Effect Menu

|| [EFF] button (HF1: Store (6211) ———— Edit (6211.1)

HF2: Lock (6212)
Effect HF3: Copy (6213)

| HF4: Move (6214)
Status (6200) HF5: Swap (6215)

| HF6: Delete (6216)
VF1: Master Timeline HF7: Rename (6217)

VF2: Effect 1-99 (HF1: Attribute (6221)
VF3: Effect 101-199 —

HF2: Lock (6222)
VF4: Effect201-299 — | | | jea conMerge (6229)
VF5: Effect 301-399 -

HF4: Move (6224)

HF5: Swap (6225)

HF6: Delete (6226)

HF7: Rename (6227)
HF1: Attribute (6231)
HF2: Lock (6232)

HF3: Copy/Merge (6233)
— HF4: Move (6234)

HF5: Swap (6235)

HF6: Delete (6236)
HF7: Rename (6237)
(HF1: Attribute (6241)
HF2: Lock (6242)

HF3: Copy/Merge (6243)
L HF4: Move (6244)

HF5: Swap (6245)

HF6: Delete (6246)

HF7: Rename (6247)
HF1: Attribute (6251)
HF2: Lock (6252)

HF3: Copy/Merge (6253)
HF4: Move (6254)

HF5: Swap (6255)

HF6: Delete (6256)
(HF7: Rename (6257)

Menu Tree 533
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Snapshot Menu

|| [SNAPSHOT] button
SHOT

Snapshot
I
Status (6300)

VF1: Master Snapshot
VF2: Snapshot

VF3: Wipe Snapshot
VF4: DME Snapshot —
VF5: Key Snapshot —

(HF1

Menu Tree

(HF1:
HF2:
HF3:
HF4:
HF5:
HF6:
(HF7:
(HF1:
HF2:
HF3:
HF4:
HF5:
HF6:
(HF7:
(HF2:
HF3:
HF4:
HF5:
HF6:
(HF7:
(HF2:
HF3:
HF4:
HF5:
HF6:
(HF7:

Store (6311)
Lock (6312)
Copy (6313)
Move (6314)
Swap (6315)
Delete (6316)
Rename (6317)
Attribute (6321)
Lock (6322)
Copy (6323)
Move (6324)
Swap (6325)
Delete (6326)
Rename (6327)
Lock (6332)
Copy (6333)
Move (6334)
Swap (6335)
Delete (6336)
Rename (6337)
Lock (6342)
Copy (6343)
Move (6344)
Swap (6345)
Delete (6346)
Rename (6347)

: Attribute (6351)
HF2:
HF3:
HF4:
HF5:
HF6:
HF7:

Lock (6352)
Copy (6353)
Move (6354)
Swap (6355)
Delete (6356)
Rename (6357)

Edit (6311.1)

Xpt Hold (6321.1)
Clip Event (6321.2)



Shotbox Menu

|| [SHOTBOX] button
BOX

Shotbox

VF1: Register

(HF1: Store/Recall (6411)

VF2: Module Like Control - HF2: Lock (6412)

HF3: Copy (6413)
HF4: Move (6414)
HF5: Swap (6415)
HF6: Delete (6416)
(HF7: Rename (6417)

——HF2: Bank1-4

Edit (6411.1)

Menu Tree

535

(1 swnjop) xipuaddy



(1 awnjop) xipuaddy

536

File Menu

|| [FILE] button

File

I
VF1: Setup, Init, VK Mem
VF2: Effect

VF3: Snapshot

VF4: Shotbox, Macro
VF5: Frame Mem
VF6: All, External File
VF7: Configure

(HF1:
HF2:
HF3:

| HF4:

(HF1:
HF2:
HF3:
HF4

—
—

HF1:
HF2:
HF3:
(HF4:
(HF1:
HF2:

HF3:
(HF4:

HF1

HF2:
(HF1

Menu Tree

HF2:

(HF3:

: Effect 301-399 (7124)

: Frame Memory (7151)
: Frame Memory Folder (7152)
Al (7161)

Setup (7111) File Edit (7111.1
Initial Status (7112) File Edit (7112.1
Key Memory (7113) File Edit (7113.1

( )
( )
( )
Video Proc Memory (7114) — File Edit (7114.1)
Effect 1-99 (7121) File Edit (7121.1)
Effect 101-199 (7122) File Edit (7122.1)
Effect 201-299 (7123) File Edit (7123.1)
File Edit (7124.1)

( )

( )

( )

( )

( )

( )

1

Snapshot (7131) File Edit (7131.1
Wipe Snapshot (7132) File Edit (7132.1
DME Snapshot (7133) File Edit (7133.1
Key Snapshot (7134) — File Edit (7134.1
Shotbox (7141) File Edit (7141.1
Macro (7142) File Edit (7142.1

On Line Edit

Off Line Edit

Macro Attachment (7143) — File Edit (7143.1)
Menu Macro (7144) File Edit (7144.1)

(7142.2)
(7142.3)

1

|—Menu Macro
File Edit (7151.1)

Import / Export (7162)

: Directory (7171)

Unit ID Copy (7172)
Group ID Copy (7173)

Edit (7144.2)



Engineering Setup Menu

|| [ENG SETUP] button
SETUP

Engineering Setup

VF1: System —

VF2: Panel

VF3: Switcher
VF4: DME

VF5: DCU

VF6: Router/Tally

to following pages

(HF1: Network Config (7311) Panel Assign (7312.1)
HF2: System Config (7312) Switcher Assign (7312.2)

Aspect (7313.1) 4‘ Switcher Aspect (7313.2)
HF3: Format (7313) —I_ Detail Information (7316.1) DME Aspect (7313.3)
HF4: Start Up (7314) License (7316.6) ——— License Management (7316.7)
HF5: Initialize (7315) Unit Config (7316.8)

HF6: Install/Unit Config (7316)-{ Texture Package (7316.9)
Install (7316.10)

| HF7: Maintenance (7317) Setup Operation Lock (7317.1)

Menu Tree
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ENG
SETUP

Engineering Setup

VF1: System
VF2: Panel

VF3: Switcher
VF4: DME

VF5: DCU

VF6: Router/Tally

to following
pages

Menu Tree

to previous pages

('DSK Fader Assign (7321.1)
10 Key Region Assign (7321.7)
Link/Program Button (7321.8)
MP2 Main/Sub Assign (7321.11)
Compact Key Module Assign (7321.15)

| IM/E Operation Inhibit (7321.18)

HF1: Config (7321)

a) For CCP-6224/6324 only

Src Name/LCD Color (7322.6)

Table Copy (7322.8)

Name Export (7322.9)

Side Flags Button Assign (7322.10)
| Mixer Xpt Assign (7322.11)

| Key 2/4 Bus Button Assign (7324.2)
(GPI Input (7325.1)

GPI Output (7325.3)

i)CU Serial Port Assign (7325.4)
(‘Effect Mode (7326.2)

Flexi Pad Mode (7326.3)

Custom Button (7326.4)

Sensitivity (7326.5)

Macro (7326.6)

HF5: Device Interface (7325) ]

HF6: Operation (7326) —

| HF7: Maintenance (7327) | Button Tally (7326.9)

Link Table Adjust (7321.5)

Link Matrix Adjust (7321.4)
Link Bus Adjust (7321.6)

(Key Trans Link (7321.2)
External Bus Link (7321.3) ——
Transition Module (7321.9)

Flexi Pad Module (7321.10)

Xpt Module (7321.12)

Fade To Black Module (7321.13)
DSK/FTB Module (7321.14)
Device Control Module (7321.16)
Joystick/Trackball Module (7321.17)
Menu Panel (7321.19)
Multi Function (7321.20)2)

fxtension Panel (7321.24)

Mode Sel Assign (7321.21)
Eff Edit Assign (7321.22)
Macro Edit Assign (7321.23)

’:I'able Button Assign (7322.1) Main, V/K Pair Assign (7322.5)
HF2: Xpt Assign (7322) —— Main,V/K Pair Assign (7322.5) Src Name/LCD Color (7322.6)

Main,V/K Pair Assign (7322.5)

HF3: Aux Assign (7323) —— RTR Mode Setting (7323.1) Source Table Assign (7323.2)
HF4: Prefs/Utility (7324) —’_Utility Module Assign (7324.1) Level Button Assigh (7323.4)

Table Assign (7323.3)
HIL Set (7325.2)

CCP-6000/8000 Button (7326.7)



[ENG SETUP] button

Engineering Setup

VF1: System
VF2: Panel

| to previous pages

VF3: Switcher

— (HF1: Config (7331)

VF4: DME
VF5: DCU
VF6: Router/Tally

to next page

HF2: Input (7332)

HF3: Output (7333)

HF4: Transition (7334)

HF6: Link (7336)

| HF7: Device Interface (7337)—

(W/E Output Assign (7331.1)
PGM Config (7331.2)
K-PVW Config (7331.3)
User 1-8 Config (7331.4)
Logical M/E Assign (7331.5)
DME Config (7331.6)

(Video Process (7332.1)
LFC Adjust (7332.2) @
’_Output Assign (7333.1)
Video Clip (7333.2)

V Blank/Through (7333.3)
Safe Titile (7333.4)

4:3 Crop (7333.5)

FC Adjust (7333.6) @

|FC Output Assign (7333.7)
(Preset Color Mix (7334.1)
_Transition Curve (7334.2)

HF5: Key/Wipe/FMICCR (7335) —{ Show Key (7335.1)

| Key Auto Drop (7335.2) Link Bus Select (7336.2)

(Internal Bus Link (7336.1) Link Table Select (7336.3)
GPI Link (7336.4) —— GPI Link Adjust (7336.5)
M/E Link (7336.6)

| Key Transition Link (7336.7)

(Remote Assign (7337.1)

GP!I Input (7337.2) ———— H/L Set (7337.3)

GPI Output (7337.4)

Aux Control (7337.5)

DME Type Setting (7337.6) — DME SDI I/F (7337.7)

| Editor IF (7337.8)

a) For MVS-8000G with the optional board installed only

Menu Tree

Side Flags (7331.7) Side Flags (3213)
| Switching Timing (7331.8) Side Flags Button Assign (7322.10)
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[ENG SETUP] button

Engineering Setup
I

VF1: System

VF2: Panel I to previous pages

VF3: Switcher

VF4: DME
VF5: DCU
VF6: Router/Tally —

Menu Tree

HF1: Input (7341)
HF3: Output (7343)
HF4: Device Interface (7344)

HF1: Input Config (7351)

TBC Center (7341.1)

Monitor Output (7343.1)

DME1 GPI Input (7344.1) — H/L Set (7344.2)
DME1 GPI Output (7344.3)

DME2 GPI Input (7344.4) — H/L Set (7344.5)
DME2 GPI Output (7344.6)

HF2: GPI Input Assign (7352)— HIL Set (7352.1)

HF3: Output Config (7353)
HF4: GPI Output Assign (7354)
HF5: Serial Port Assign (7355)

(HF1: Router (7361)
HF2: Group Tally (7362)

P-Bus Setting (7355.1)

VTR Setting (7355.2)

DDR SD9P Setting (7355.3)
DDR VDCP Setting (7355.4)
Extended VTR Setting (7355.5)
External Box Assign (7361.1)

HF3: Wiring (7363) (New (7363.1)
 Modify (7363.2)
HF4: Tally Enable (7364) —{ New (7364.1)
| Modify (7364.2)
HF5: Tally Copy (7365) New (7365.1)
| Modify (7365.2)
HF6: Parallel Tally (7366) Set (7366.1)
J—IF7: Serial Tally (7367) Source Assign (7367.1)



Diagnostic Menu

[DIAG] button

Diagnostic

VF1: Error Info HF1: Error Status (7411)
HF2: Error Log (7412)

VF3: System Info ———— LAN Status (7431)

Menu Tree
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Index

A

Additive mix 207
Ancillary data 394, 406
Angle 292
Aspect ratio 294, 306
Audio mixer 143
Auto
chroma key adjustments
210
transition 170
AUTO button 74
AUTO DELEG button 59
AUTO INS button 71
AUTO TRANS button 51,53,
96
Auto/manual transition
combination 172
AUX
bus settings 438
delegation buttons 75
menu operations 438
AUX Panel-less Function 139
AUX/MON menu 525
Auxiliary bus control block
for AUX buses 75
for router control 77

Background
A/B row 46
changing 21
mask 202
Bank selection buttons 83
Basic menu operations 103
Blink
function 232
Border 199
parameters 238
BS button 123
Bus fixed mode
fader operation 173

Index

wipe direction 175
Bus selection 136
Button

numbers 140, 141

Cc

Caps Lock button 123

CCP-6224
AUX Panel-less Function

139
CCP-6224 2M/E Control
Panel 97

CCP-6324

AUX Panel-less Function
139
CCP-6324 3M/E Control
Panel 98

CCR menu 526

Chroma key 198
adjustments 208
composition 207
shadow 210
shadow adjustment 213
window 209

Clean mode 197

Clear button 122, 124

Clip function 394

Clip transition 147
operations 408

Close button 121, 123

Color
combination 422, 423
matte settings 158
vector key 197

Color background
selection 422
setting operations 422
settings menu 422

Color Bkgd menu 525

Color cancel 209
adjustments 211

Color corrector 445

Color data
copy 428
swap 428
Color mix 422,423
for edge fill matte 288
for key fill 216
Color palette window 126
Control panel 39
configuration 1 39
configuration 2 42
configuration 3 44
Copy 426,430
Copy/Swap menu 527
Cross-point
button numbers 46
buttons 45
control block 45
Cut 147
CUT button 51, 96

D

Dead zone 357
Default recall button 114
Del button 124
Delegation buttons 56
DEST button 76
Device
menu 530
DEVICE connectors 80
Device control block
joystick 64
search dial 66
trackball 60
Diagnostic menu 541
Digital multi effects 31
Direction 285, 304, 337
Display 58,73
DME 31, 50, 52,95
applying to akey 228,
243
channel selection buttons
58



menu 529
DME channel
copy 429
swap 429
DME monitor 58, 74, 93
DME override 434
DME patterns
user programmable 353
DME wipe pattern 322
edge modification 338
groups 322
selection 334
DME wipe pattern list
for one-channel mode 503
for two-channel mode
511
DME wipe settings 334
for independent key
transitions 345
DME wipes 27, 321
copy 427,428
direction 337
modifiers 337
modify clear 344
position 339, 346
resizer 349
snapshot 351
swap 427,428
Door 504
Downstream key control block
90
Drop border 200
parameters 239
dual resizer effects 268
Duration
setting buttons 71
Dust mix 281, 284

E

Edge

fill 201

modifiers 199
EDIT ENBL button 69
Edit point specification

buttons 70

Editing buttons 70
EFF LOOP button 71

Effect

menu 533

resizer 263
Effect execution direction

selection buttons 71

Emboss 200
Engineering Setup menu 537
Enhanced wipes 498
Enter button 122, 124
External

key 382

processed key 59, 231,

245

External devices 32
External hard disk drive 416

F

Fade to black 187
control block 74
transition rate 188
Fader lever 51,91, 95
File menu 536
Files 35
backups 415
deleting 413
renaming 414
restoring 415
Flexi Pad control block
simple type 84
standard type 54
Flip tumble 506
Frame
in-out 506, 518
Memory menu 524
Frame input mode 162
Frame memory
clip function 394
continuously capturing
still images (record)
388

feed 59,231,246

pair file processing 411

recalling a continuous
sequence of still images
(animation) 390

Frame memory operations
369

capturing an input image
375
clip 396
input image selection 373
menu display 370
preparations 369
selecting frame memory
374
selecting outputs 374
Fringe 299
FTB button 74
FULL LINK 282
Function
button area 113
selection buttons 73

G

Global
Effect menu 530

H
HF buttons 113

Image
data management 411
Image file
deletion 413
renaming 414
Independent key transition
24,177
DME wipe settings 345
simple transitions 192
type 182
type selection buttons 52,
88,90
wipe modifiers 304
wipe settings 303
Independent key transition
control block
simple type 88
standard type 180
Independent key transition
execution section 52, 89,
91, 96

Index
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Independentkey transitionrate
183
display 185
setting by a menu
operation 185
setting in the Flexi Pad
control block 183
setting in the numeric
keypad control block
184
Input
string 123
value 121
Item display 121, 123

J
Joystick 64

K

Key 25
1/2 row 45
bus selection buttons 47
control block 56
default 203
delegation buttons 52, 90
deleting 22
edge modifications 217,
238
Frame menu 532
inserting 22
mask 202
memory 202
modifier buttons 57
modifiers 199
modify clear 231
output destination 231
output status display 155,
191
signal adjustments 212
status display 52, 87, 96
Key active 208
adjustment 211
KEY button 76
Key fill
selection 214
selection buttons 57

Index

Key priority 151
display 155, 191
selecting 151
setting by a menu
operation 153
setting in the transition
control block 151
Key setting
using menus 204
Key snapshot 269
buttons 53, 91
recalling 270, 274
saving 269, 273
setting buttons 53, 91
using simple transition
module 272
Key source
name display 53, 91
selection 214
selection buttons 57
Key transition
selection buttons 86
Key type
selection buttons 57
setting 205
Keyboard window 122
Keyer
copy 426
swap 426
Keyframe 32
control block 69
status 114
KF button 52
Knob 58, 80
parameter buttons 114
K-SS button 89

L

Left button 124

Level selection buttons 76
Line feed button 124
Linear key 197

Lock function 388
Luminance key 197

M/E
bank display 47
copy 426
swap 426
M/E-1 to M/E-3 menus 519
Macro 34
attachment 35
menu 531
timeline 34
Magnitude 293
MAIN and SUB delegation
button 478
Main mask 202
using 225,242
Main menu site 127
Main/sub modifier link 282
Manual transition 171
Masks 201, 225, 242
Matte data
copy 428
swap 428
Max./min. value indication
121
Memory
card slot 80
recall buttons 83
Memory card/USB adaptor
block 80
“Memory Stick”/USB
connections block 81
“Memory Sticks” 81
Menu
accessing 104, 112
control block 79
display 80
operations 114
organization 103
page number button 113
screen 113
shortcut menu 127
shutting down 125
switching between the
main menu sites 127
title button 113
top menu list 103
MENU button 63



Menu tree 519
Minus button 122
Misc menu operations 433
MIX 50, 52,95, 383
Mix 145,279
Mode selection buttons 54,
72,87
Modulation 298
MORE button 58
Morphing 280
Mosaic
wipes 500
Multi 295, 307
Multi Program 2 29
basic operation 475
restriction 486
Multifunction Flexi Pad
Control Block
DME Wipe Pattern
Operations 358
Key Adjustment
Operations 248
Wipe Pattern Operations
314

N

NAM 50, 95, 145, 383
Negative NAM 279
Next transition 145
selecting 145
selection buttons 50, 94
Non-additive mix 50, 95, 145
Non-Sync state 172
Normal
edge 241
mix 207
Numeric display 55, 87
Numeric keypad 73
control block 72

o)

ON AIR indicators 58
One-stroke mode 158
One-time mode 158
Operation

buttons 61

modes 368
Outline 200
parameters 240
Output
destination specification
buttons 58
OVERRIDE button 59

P

Page Roll 508
Page turn 507
Pair file processing 411
Pair mode 367
Pairing 297
Parameter group button 113
Pattern key 382
Pattern limit 167

buttons 51, 86

setting by a menu

operation 168
setting with the fader lever
168

transition 169
Pattern mix 279

types 279
PGM/PST

menu 522
Picture-in-picture 507, 512
Plane function 207
Positioner 290, 304, 339, 346
Positive NAM 279
Preset color mix 146
Preview 175

selection buttons 74
Previous page button 114
PRIOR SET button 52, 96
PST COLOR MIX 50, 95

R

Random/diamond dust wipes
502
Reentry buttons 46, 136
Regions
selection buttons 73
Related manuals 17
Replication 307

Resizer DME wipe 349

Resizer DME wipe patterns
517

Right button 124

Rotary wipes 499

Rotation 292, 306

RTR button 76

S

Search dial 66
Second (2ND) button 76
Selected
bus display 76
source name displays 76
SEMI LINK 282
Setup 36
Shadow 200
parameters 239
SHIFT button 47
Shift button 123
Shortcut 127
Shotbox 34
Shotbox menu 535
SHOW KEY button 58
Show key function 246
Side flags
DME wipe action 471
MISC menu 468
wipe action 470
Signal
assignment to buttons 140
name display 143
selection 135
Simple
transition 189
Simple P/P Software 488
Slide 503, 511, 517
Snapshot 33
menu 534
Soft edge 200, 304
Softening
edge 241
wipe pattern edge 304
Source
name displays 76
Space button 123
Speed 293

xapu|
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Spiral 300
Split 286, 503
fader 192
Spring 300
Squeeze 504, 511, 517
Standard wipe patterns 276
Standard wipes 497
Status area 113
Status menu 439, 528
STOP NEXT KF button 71
Sub (subsidiary) mask 202
using 227, 243
Subsidiary menu site 127
SUPER MIX 50,95
Super mix 146
settings 157
Swap 426, 430
System
features 19

T

TC button 121
Time offset execution 178
Timecode input mode 162
Top menu list 103
Top menu selection buttons
79
Top menu window 124
TRACE button 59
TRANS PVW button 51, 96
Transition
execution 161
indicator 91
next 145
preview 175
Transition control block
simple type 84
standard type 49
Transition execution
section 51, 86, 95
with the fader lever 171
Transition indicator 51, 95
function 161
Transition rate 162
display 51,95
setting by a menu
operation 166

Index

setting in the Flexi Pad
control block 163
setting in the MISC menu
436
setting in the numeric
keypad control block
164
Transition type 145
selecting by a menu
operation 156
selection buttons
95
Trim button 122

50, 85,

U

UNDO button 55, 87
User preference button 80
User programmable DME
511,515
Notes on keyframe
creation 354
patterns 353
transition mode 325, 353
UTIL button 47
Utility 34
Utility/shotbox control block
83

V/K mode 368
VF buttons 113
Video
processing 133, 233
signal adjustment 210
Video process 442
memory 443
settings 444

w

Window adjustment 209, 213
WIPE 50, 52,95
Wipe 26, 146
copy 427
enhanced 276
modify clear 302
mosaic 276

pattern list 497
random/diamond dust
276
rotary 276
standard 276
swap 427
Wipe direction 285, 304
selection buttons 51, 86,
96
Wipe modifiers 284
Wipe pattern
aspect ratio 294, 306
edge modification 286
key 198
modulation 298
replication 295, 307
rotation 292
selection 277
types 276
Wipe pattern/modifier
combinations 301
Wipe position 290, 304
Wipe settings 277
for independent key
transitions 303
Wipe snapshot 308
deleting 311
recalling 311
saving 310

X

XPT HOLD
buttons 46, 76
status display 87

Y

Y balance 209
adjustment 213

y4

Zabton 200, 224, 241
Z-ring 62
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